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eLearning Course Structure  

Office 2007, Office 2010, Windows 

7, Windows 8, and Windows 8.1 

Each eLearning course for these products 

contains the following elements: 

− A graphic cover page summarizing 

the course contents. 

− A text-based introductory page 

summarizing the course contents. 

This page also provides sample files, 

with downloading and saving 

instructions. 

− Four to six lessons, each with four to 

six sub-topics: This reading material 

will walk students through the theory 

of the topic at hand. Clickable tips 

highlight key points, fun facts, and 

other useful information.  

− Step-By-Step exercises: At the end 

of each lesson, students are asked to 

complete a guided exercise reviewing 

the concepts in the lesson.  

− Skill Sharpeners: Finally, students 

are given a freeform exercise 

designed to get them thinking and 

working on their own. One Skill 

Sharpener is provided at the end of 

each lesson, after the Step-By-Step 

exercise.  

− Case Studies: After students have 

completed all lessons in the course, 

they are given a larger freeform 

exercise designed to give them 

experience in completing a real-life 

project. One Case Study is provided 

at the end of each course. 

 

 

 

 

− Review Questions: Each course 

concludes with 10 multiple choice 

questions that review the 

information covered. 

Office 2013 

Each Office 2013 eLearning course 

contains the following elements: 

− A graphic cover page summarizing 

the course contents. 

− A text-based introductory page with 

a link to sample files, as well as 

downloading and saving instructions. 

− Four to six mini-lessons, with 

textbook information that students 

can follow along with using the 

sample files provided. Clickable tips 

highlight key points, fun facts, and 

other useful information. 

− Review Questions: After all lessons 

are complete, students are asked to 

answer five review questions 

summarizing the material covered. 

− Review Answers: Each course wraps 

up with the answers to the review 

questions. 
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Office 2016, Windows 10 

Each Office 2016 eLearning course 

contains the following elements: 

− A graphic cover page summarizing 

the course contents. 

− A text-based introductory page with 

a link to sample files, as well as 

downloading and saving instructions. 

− Two to seven topics, with textbook 

information that students can follow 

along with using the sample files 

provided. Clickable tips highlight key 

points, fun facts, and other useful 

information. 

− Review Questions: After all lessons 

are complete, students are asked to 

answer five review questions 

summarizing the material covered. 

− Review Answers: Each course wraps 

up with the answers to the review 

questions. 

− Lesson Labs: Each course wraps up 

with one or more lesson labs so you 

can practice applying the information 

you have learned. 

Total Number of Courses 

Velsoft currently offers 1118 computer 

eLearning courses. 
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Detailed Course Information 

 

Microsoft Windows Courses 

Windows 11: Part 1 

Getting to Know Personal Computers and the Windows 11 User Interface 

Course Overview and Learning Objectives 

This course will identify the components of a personal computer. Students will learn how 

to sign into Windows 11, navigate the desktop, and explore the Start menu. 

Course Outline 

✓ Identify the components of a personal computer 

✓ Set up Windows 11 

✓ Sign into Windows 11 

✓ Navigate the desktop 

✓ Explore the Start menu 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 1 

 

Using Microsoft Store Apps and Navigation Features 

Course Overview and Learning Objectives 

This course begins with how to multitask with apps, search your computer, and view 

notifications. Then, students will learn about Microsoft Store apps and Windows 11 

navigation techniques. 

Course Outline 

✓ Multitask with apps 

✓ Search your computer 

✓ View notifications 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 2 
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Working with Desktop Applications 

Course Overview and Learning Objectives 

In this course, working with desktop windows, managing files and folders with File 

Explorer, and creating files with desktop applications will be covered. 

Course Outline 

✓ Work with desktop windows 

✓ Manage files and folders with File Explorer 

✓ Create and modify files with desktop applications 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 3 

 

Using Microsoft Edge 

Course Overview and Learning Objectives 

In this course, students will learn how to navigate the user interface of Microsoft Edge. It 

also covers browsing the web, managing tabs, and modifying Microsoft Edge options. 

Course Outline 

✓ Navigate the Microsoft Edge user interface 

✓ Browse the web using Microsoft Edge 

✓ Manage tabs 

✓ Modify Microsoft Edge options 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 4 
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Customizing the Windows 11 Environment 

Course Overview and Learning Objectives 

Students will learn how to change basic Windows settings, customize the Lock screen, and 

personalize the desktop. 

Course Outline 

✓ Change basic Windows settings 

✓ Customize the lock screen 

✓ Customize the desktop 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 5 

 

Using Windows 11 Security Features 

Course Overview and Learning Objectives 

This course will teach students how to configure passwords, use Windows Security, and 

store and share files with OneDrive. 

Course Outline 

✓ Configure passwords 

✓ Use Windows Security 

✓ Store and share files with OneDrive 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 1, Lesson 6 
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Windows 11: Part 2 

Working with Windows 11 

Course Overview and Learning Objectives 

This course teaches students about various display settings in Windows 11, virtual 

desktops and how to work with them, and how to manage apps that have been installed on 

a PC. 

Course Outline 

✓ Use the Settings window 

✓ Work with virtual desktops 

✓ Manage apps 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 1 

 

Configuring User Accounts 

Course Overview and Learning Objectives 

This course covers creating new user accounts, modifying them, and deleting them. We 

also go over family safety features that Windows 11 has to offer. 

Course Outline 

✓ Configure user accounts using the Settings window 

✓ Use family safety features 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 2 
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Working with Apps in Windows 11 

Course Overview and Learning Objectives 

In this course, students will learn how to configure and use both the Mail and Calendar 

apps. How to use the webcam with the Camera app, and how to use the Media Player, 

Films & TV, and Xbox apps to have fun with your PC are also covered. 

Course Outline 

✓ Use Mail 

✓ Use Calendar 

✓ Use Media Player 

✓ Use Films & TV 

✓ Use Camera 

✓ Use Xbox 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 3 

 

Working with Devices 

Course Overview and Learning Objectives 

Students will learn how to work with devices in Windows 11. Modifying mouse, pen, and 

AutoPlay settings are also covered. 

Course Outline 

✓ Connect devices to their PC 

✓ Modify device settings 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 4 
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Managing Networks 

Course Overview and Learning Objectives 

This course explains how networks operate within Windows 11, basic networking 

concepts, viewing network information, and sharing information with your network. 

Course Outline 

✓ About networks in Windows 11 

✓ How to manage network settings in Windows 11 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 5 

 

Securing System Data 

Course Overview and Learning Objectives 

Ways that you can secure your system, the concept of File History and how to enable it, 

and various system recovery methods are covered in this course, as well as checking for 

Windows updates and using Windows Security to keep your PC safe. 

Course Outline 

✓ Work with file history and data backups 

✓ Use system recovery tools, including System Restore and Advanced Startup 

✓ Configure security settings 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 6 
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Configuring System Settings 

Course Overview and Learning Objectives 

In this course, we will take a closer look at viewing system information, using the Task 

Manager, optimizing power consumption, and troubleshooting problems. 

Course Outline 

✓ View system information 

✓ Use the Task Manager 

✓ Optimize power consumption 

✓ Troubleshoot problems 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 11: Part 2, Lesson 7 
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Windows 10: Part 1 

Getting to Know PC’s and the Windows 10 User Interface 

Course Overview and Learning Objectives 

The first course will identify the components of a personal computer. Students will learn 

how to sign into Windows 10, navigate the desktop, and explore the Start menu. 

Course Outline 

✓ Identify Components of a Personal Computer  

✓ Sign Into Windows 10 

✓ Navigate the Desktop 

✓ Explore the Start Menu 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 1 

 

 

Using Windows Store Apps and Navigation Features 

Course Overview and Learning Objectives 

This course begins with how to multitask with apps, search your computer, and view 

notifications. Then, students will learn about Windows Store apps and Windows 10 

navigation techniques. 

Course Outline 

✓ Multitask with Apps 

✓ Search Your Computer 

✓ View Notifications 

✓ Windows Store Apps 

✓ Windows 10 Navigation Summary 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 2 
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Working with Desktop Applications 

Course Overview and Learning Objectives 

Working with desktop windows, managing files and folders with File Explorer, and 

creating files with desktop applications are covered in this course. 

Course Outline 

✓ Work with Desktop Windows  

✓ Manage Files and Folders with File Explorer  

✓ Create and Modify Files with Desktop Applications 

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 3 

 

 

Using Microsoft Edge 

Course Overview and Learning Objectives 

In this course, students will learn how to navigate the user interface of Microsoft Edge, 

the new default web browser. It also covers browsing the web, managing tabs, and 

modifying Microsoft Edge options. 

Course Outline 

✓ Navigate Microsoft Edge 

✓ Use Microsoft Edge 

✓ Manage Tabs  

✓ Modify Microsoft Edge Options 

✓ Review Questions 

✓ Lesson Labs  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 4 
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Customizing the Windows 10 Environment 

Course Overview and Learning Objectives 

In this course, students will learn how to change basic Windows settings, customize the 

Lock screen, and personalize the desktop. 

Course Outline 

✓ Change Basic Windows Settings 

✓  Customize the Lock Screen  

✓ Customize the Desktop 

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 5 

 

 

Using Windows 10 Security Features 

Course Overview and Learning Objectives 

The final lesson will teach students how to configure passwords, use Windows Defender, 

and store and share files with OneDrive. 

Course Outline 

✓ Configure Passwords 

✓ Use Windows Defender  

✓ Store and Share Files with OneDrive  

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 1, Lesson 6 
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Windows 10: Part 2 

Working with Windows 10 

Course Overview and Learning Objectives 

The first course will teach students how to use the Settings window and the Control Panel, 

as well as how to work with virtual desktops and manage apps. 

Course Outline 

✓ The Settings Window 

✓ The Control Panel 

✓ Work with Virtual Desktops 

✓ Manage Apps 

✓ Explore the Start Menu 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 1 

 

 

Configuring User Accounts 

Course Overview and Learning Objectives 

This course begins with information on how to configure user accounts using the Control 

Panel and the Settings window. Then we will take a look at how to use family safety 

features. 

Course Outline 

✓ Configure User Accounts Using the Control Panel  

✓ Configure User Accounts Using the Settings Window 

✓ Use Family Safety Features 

✓ Summary 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 2 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 12 

Working with Apps in Windows 10 

Course Overview and Learning Objectives 

Students will learn how to use key Windows 10 apps, including Mail, Calendar, Groove 

Music, Movies & TV, Camera, and Xbox. 

Course Outline 

✓ Use Mail 

✓ Use Calendar 

✓ Use Groove Music 

✓ Use Movies & TV 

✓ Use Camera 

✓ Use XBox 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 3 

 

Working with Devices 

Course Overview and Learning Objectives 

Students will learn how to connect devices to a PC and modify device settings in this 

lesson.  How to manage devices and printers in the Control Panel will also be covered. 

Course Outline 

✓ Connect Devices to Your PC 

✓ Modify Device Settings 

✓ Devices and Printers in the Control Pane 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 4 
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Managing Networks 

Course Overview and Learning Objectives 

In this course, students will learn about networks and how to manage them, as well as how 

to share files and folders with the Homegroup feature. 

Course Outline 

✓ Overview of Networks 

✓ Share Files and Folders with a Homegroup 

✓ Manage Networks 

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 5 

 

 

Securing System Data 

Course Overview and Learning Objectives 

Working with file history and data backups, recovering your PC, and configuring security 

settings will be covered in this course. 

Course Outline 

✓ Files History 

✓ System Recovery 

✓ Configure Security Settings 

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 6 
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Configuring System Settings 

Course Overview and Learning Objectives 

In this final course, we will take a closer look at viewing system information, using the Task 

Manager, optimizing power consumption, and troubleshooting problems. 

Course Outline 

✓ View System Information 

✓ Use the Task Manager 

✓ Optimize Power Consumption 

✓ Troubleshoot Problems 

✓ Review Questions 

✓ Lesson Lab  

Corresponding Instructor-Led Course 

✓ Windows 10: Part 2, Lesson 7 
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Windows 10: Transition from Windows 8.1 

Navigating the Windows 10 Environment 

Course Overview and Learning Objectives 

To begin, students will learn how to use the desktop and the Start menu. Students will also 

learn how to multitask with apps, with a focus on the new Snap Assist feature. 

Course Outline 

✓ Navigate the Desktop 

✓ Explore the Start Menu 

✓ Multitask with Apps 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 1 

 

 

Working with the Windows 10 Environment 

Course Overview and Learning Objectives 

In this course, students will learn about basic elements of the Windows 10 environment, 

including notifications, the Action Center, Cortana, the search field, and virtual desktops. 

Students will also learn how to connect devices to their PC. 

Course Outline 

✓ View Notifications 

✓ Search Your Computer 

✓ Work with Virtual Desktops 

✓ Connect Devices to Your PC 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 2 
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Customizing the Windows 10 Environment 

Course Overview and Learning Objectives 

This lesson is all about making Windows 10 truly your own. Students will learn how to 

change basic Windows settings using both the Settings window and the Control Panel, 

customize the Lock screen, and personalize the desktop. An introduction to OneDrive, 

which features more prominently than ever in this release of Windows, is also included. 

Course Outline 

✓ Change Basic Windows Settings 

✓ Customize the Lock Screen 

✓ Customize the Desktop 

✓ Store and Share Files with OneDrive 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 3 

 

 

Working with Apps in Windows 10 

Course Overview and Learning Objectives 

In this course, students will be introduced to three key productivity apps in Windows 10: 

Mail, Calendar, and Camera. 

Course Outline 

✓ Use Mail 

✓ Use Calendar 

✓ Use Camera 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 4 
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Having Fun in Windows 10 

Course Overview and Learning Objectives 

This lesson offers a look at the lighter side of Windows 10, with in-depth information on 

the Groove Music, Movies & TV, and Xbox apps. 

Course Outline 

✓ Use Groove Music 

✓ Use Movies & TV 

✓ Use Xbox 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 5 

 

 

Using Microsoft Edge 

Course Overview and Learning Objectives 

The final course takes an in-depth look at Microsoft Edge, the new default Internet 

browser offered with Windows 10. 

Course Outline 

✓ Navigate Microsoft Edge 

✓ Use Microsoft Edge 

✓ Manage Tabs 

✓ Modify Microsoft Edge Options 

✓ Review Questions  

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Windows 10: Transition from Windows 8.1, Lesson 6 
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Windows 10: Navigating the New Windows Environment 

Getting to Know PC’s and the Windows 10 User Interface 

Course Overview and Learning Objectives 

This introductory course discusses the components that make up a PC and shows learners 

how to sign into Windows 10 and how to navigate the Start menu. 

Course Outline 

✓ Identify Components of a Personal Computer 

✓ Start and Sign into Windows 10 

✓ Navigate the Start Menu 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 1 

 

 

Working with the Windows 10 Environment 

Course Overview and Learning Objectives 

The Windows desktop figures prominently for PC users. In this course, students will learn 

how to use the desktop and use components of the desktop window. They will also learn 

how to create and modify files with desktop applications, and manage files and folders 

with File Explorer. 

Course Outline 

✓ Using the Desktop 

✓ Elements of a Desktop Window 

✓ Manage Files and folders with File Explorer 

✓ Create and Modify Files with Desktop Applications 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 2 
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Using Microsoft Edge 

Course Overview and Learning Objectives 

Students will learn about the Internet here and then learn how to use Microsoft Edge and 

manage tabs in Edge. 

Course Outline 

✓ Components of the Internet 

✓ Use Microsoft Edge 

✓ Manage Tabs in Microsoft Edge 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 3 

 

 

Using Windows Store and Working with Universal Apps 

Course Overview and Learning Objectives 

The topics under consideration here are using the Windows Store and using Universal 

Apps. 

Course Outline 

✓ Using Windows Store 

✓ Universal Apps in Windows 10 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 4 
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Other Windows 10 Features 

Course Overview and Learning Objectives 

At this point, students will shift their focus to learning how to interact with Microsoft 

Cortana and how to store and share files with OneDrive. 

Course Outline 

✓ Interact with Microsoft Cortana 

✓ Store and Share Files with OneDrive 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 5 

 

 

Customizing the Windows 10 Environment 

Course Overview and Learning Objectives 

This course looks at creating new user accounts and customizing the Start menu. 

Course Outline 

✓ Configure User Accounts Using the Settings Window 

✓ Personalize Windows 10 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 6 
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Using Windows 10 Security Features 

Course Overview and Learning Objectives 

The final course shows students how to configure account passwords and use Windows 

Defender. 

Course Outline 

✓ Account Passwords 

✓ Use Windows Defender 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: Navigating the New Windows Environment, Lesson 7 
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Windows 10: May 2019 Update 

Getting Started 

Course Overview and Learning Objectives 

In this course, students will learn about the different types of updates that Microsoft 

provides for Windows 10. They will learn what the Windows 10 May 2019 Update is, 

what it includes, and how to obtain it. Additionally, they will become familiar with the lock 

screen, the various options that the sign-in screen provides, and how to sign in to a 

Windows 10 account. 

Course Outline 

✓ The Windows 10 May 2019 Update and what it includes 

✓ Update Windows 10 to the May 2019 Update 

✓ Sign into Windows 10 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: May 2019 Update, Lesson 1 

 

Navigation, Productivity, and Customization 

Course Overview and Learning Objectives 

In this course, we explore the many different changes to the Start menu, taskbar, and 

Action Center. Additionally, how to change the theme, use the updated emoji and symbol 

picker, as well as use the new interface of the cloud clipboard are covered. 

Course Outline 

✓ Navigate the updated Start menu 

✓ Use the updated taskbar and Action Center 

✓ Use themes and emojis 

✓ Use the updated clipboard settings 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: May 2019 Update, Lesson 2 
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Troubleshooting, Updates, and Security 

Course Overview and Learning Objectives 

In this course, students will learn about the various improvements and additions to 

troubleshooting, Windows Update, and Windows Security. We cover how to pause 

updates and enable intelligent active hours, and how Windows Update behaves in 

reserving space for updates and how future feature updates may be installed. 

Course Outline 

✓ Use automatic troubleshooting 

✓ Use the Windows Update tool 

✓ Use updated Windows Security features 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: May 2019 Update, Lesson 3 

 

Windows Settings and Storage 

Course Overview and Learning Objectives 

This course looks at the changes that have been made to the Settings app, installing new 

fonts, adjusting search settings, and managing storage settings. 

Course Outline 

✓ Use the updated Settings app 

✓ Use the updated Storage settings 

✓ Review Questions  

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Windows 10: May 2019 Update, Lesson 4 
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Upgrading to Microsoft Windows 8.1 

Getting Started 

Course Overview and Learning Objectives 

This course gives students a look at what’s new in Windows 8.1 and how to get the update. 

It explores the Start screen, the desktop, the Charms bar, and gestures. Students are also 

shown how to switch users, lock/unlock the computer, put the computer to sleep, restart 

it, and shut it down. 

Course Outline 

1.1. The Basics of Windows 8.1 

✓ What is Windows 8.1? 

✓ What’s New in Windows 8.1? 

✓ Getting the Update 

✓ Logging In and Logging Out 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Interface Basics 

✓ Understanding the Windows 8.1 

Start Screen 

✓ Understanding the Windows 8.1 

Desktop 

✓ Viewing the Charms Bar 

✓ Viewing Running Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Common Gestures and Keyboard 

Shortcuts 

✓ Windows Key Shortcuts 

✓ Tapping and Swiping Basics 

✓ Pinch Zoom 

✓ Swiping to Show or Switch Apps 

✓ Using the Help + Tips App 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exiting Windows 8.1 

✓ Switching Users 

✓ Locking and Unlocking the Computer 

✓ Putting the Computer to Sleep 

✓ Restarting the Computer 

✓ Turning Off the Computer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Upgrading to Microsoft Windows 8.1, 

Section 1 
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Updated Windows 8.1 Apps 

Course Overview and Learning Objectives 

This course gives students a comprehensive look at updated Windows 8.1 apps. The first 

two lessons of this course are devoted to Internet Explorer 11, including how to open and 

navigate it, how to pin a page to the Start screen, and ways to customize the browser. The 

focus then shifts to using the most important new and updated apps: Mail, Skype, Reading 

List, and OneDrive. 

Course Outline 

1.1. Using Internet Explorer 11, Part One 

✓ Opening Internet Explorer 

✓ Navigating in Internet Explorer 

✓ Refreshing the Page 

✓ Moving Back and Forward 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Internet Explorer 11, Part Two 

✓ Opening Tabs 

✓ Closing Tabs 

✓ Pinning a Page to the Start Screen 

✓ Side-By-Side Browsing 

✓ Customizing Internet Explorer 11 

✓ Switching to Internet Explorer 

Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Mail 

✓ Starting Mail 

✓ Viewing Mail Messages 

✓ Composing Mail Messages 

✓ Replying to Messages 

✓ Deleting Messages 

✓ Organizing Mail 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Skype 

✓ Starting Skype 

✓ Logging into Skype 

✓ Finding and Adding Contacts 

✓ Starting a Call 

✓ Changing Your Status 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Reading List 

✓ Starting Reading List 

✓ Sharing Items to Reading List 

✓ Viewing Items 

✓ Searching Your Reading List 

✓ Removing Items 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using OneDrive 

✓ Opening and Configuring OneDrive 

✓ Viewing Files 

✓ Creating Folders 

✓ Adding Files 

✓ Syncing Files 

✓ Deleting Files 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Upgrading to Microsoft Windows 8.1, 

Section 4 
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Working with the New Start Screen 

Course Overview and Learning Objectives 

This course, as the name implies, delves into the Start screen and its improvements. 

Students are given lessons on using the new Start screen, using the updated Windows 8.1 

apps, searching in Windows 8.1, customizing settings, and using the Windows Store. 

Course Outline 

1.1. Using the New Start Screen 

✓ Viewing All Apps 

✓ Turning Live Tiles On or Off 

✓ Working with Notifications 

✓ Customizing Notifications 

✓ Changing the Start Screen 

Background to Match the Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Windows 8.1 Apps 

✓ Pinning Apps to the Start Screen 

✓ Pinning Apps to the Taskbar 

✓ Displaying the Taskbar 

✓ Moving and Resizing Tiles 

✓ Multitasking with Apps 

✓ Closing and Minimizing Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Searching in Windows 8.1 

✓ Searching for Apps 

✓ Using Bing Smart Search 

✓ Searching by Category 

✓ Changing Search Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing PC Settings 

✓ Opening PC Settings 

✓ Changing Display Settings 

✓ Changing Mouse Settings 

✓ Disabling Hotspots 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using the Windows Store 

✓ Launching the Store 

✓ Searching for Apps 

✓ Downloading Apps 

✓ Launching Recently Installed Apps 

✓ Toggling Automatic Update for Apps 

✓ Uninstalling Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Upgrading to Microsoft Windows 8.1, 

Section 2 
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Working with the Windows 8.1 Desktop  

Course Overview and Learning Objectives 

This course takes a look at the Windows 8.1 desktop. Learners are taught how to switch to 

the desktop, use its features and applications, and use File Explorer on the desktop. 

Course Outline 

1.1. Introducing the Windows 8.1 Desktop 

✓ Switching to the Desktop 

✓ Using the Desktop 

✓ Using the Taskbar 

✓ Using the System Tray 

✓ Using the Start Button 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Desktop Features 

✓ Using Snap 

✓ Using Peek 

✓ Using Shake 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Desktop Application Basics 

✓ Starting a Program 

✓ Opening Files from the Desktop 

✓ Launching Help from Within an 

Application 

✓ Ending a Frozen Program 

✓ Exiting a Program 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using File Explorer on the Desktop 

✓ Opening and Closing File Explorer 

✓ Understanding the Locations in the 

Navigation Pane 

✓ Customizing the Favorites Section of 

the Navigation Pane 

✓ Using File Explorer with OneDrive 

✓ Displaying Libraries 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Upgrading to Microsoft Windows 8.1, 

Section 3 
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Microsoft Windows 8 

Customizing the Start Screen  

Course Overview and Learning Objectives 

In this course, students will learn how to customize and manage tiles. They will also learn 

how to customize the Lock and Start screens. To wrap up the course, students will learn 

about the options in the Settings charm, including how to create picture passwords. 

Course Outline 

1.1. Customizing Tile Display 

✓ Moving Tiles 

✓ Resizing Tiles 

✓ Deleting Tiles 

✓ Creating Groups 

✓ Rearranging Groups 

✓ Renaming Groups 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Tiles 

✓ Showing and Hiding Administrative 

Tools 

✓ Clearing Personal Information from 

Tiles 

✓ Turning off Live Tiles 

✓ Pinning Apps and Folders as Tiles 

✓ Pinning Websites as Tiles 

✓ Uninstalling Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Modifying the Start Screen 

✓ Changing Your Account Picture 

✓ Changing the Color of the Start 

Screen 

✓ Adding a Background to the Start 

Screen 

✓ Changing the System Time 

✓ Changing the Time Zone 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Lock Screen 

✓ Choosing a New Background Image 

✓ Changing Lock Screen Apps 

✓ Changing the Detailed Status App 

✓ Testing the Lock Screen 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing Other Settings 

✓ Changing Search Settings 

✓ Changing Sharing Settings 

✓ Changing Privacy Settings 

✓ Creating a Picture Password 

✓ Creating a PIN 

✓ Syncing Your Settings to the Cloud 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Intermediate, 

Section 1 
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Getting Organized  

Course Overview and Learning Objectives 

In this course, students will learn how to use libraries and how to search in Windows 8. 

Course Outline 

1.1. Customizing Libraries 

✓ Understanding the Default Libraries 

✓ Using the Library Tools – Manage 

Tab 

✓ Adding Folders to a Library 

✓ Removing Folders from a Library 

✓ Pinning a Library to the Start Screen 

✓ Restoring Default Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a New Library 

✓ Creating a New Library 

✓ Setting the Library Type 

✓ Customizing the Library Icon 

✓ Deleting a Library 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Searching from the Charms Bar 

✓ Searching Apps 

✓ Searching Settings 

✓ Searching Files 

✓ Working with Search Results 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Searching from the Desktop 

✓ Understanding Search Indexing 

✓ Using the Search Box 

✓ Using the Search Tools – Search Tab 

✓ Searching Tips and Tricks 

✓ Searching By Other Properties 

✓ Setting Search Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Advanced, 

Section 2 
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Getting Started 

Course Overview and Learning Objectives 

This course will begin with the basics of Windows 8, including an introduction to the 

Windows 8 Start screen and desktop. Then, basic keyboard, mouse, and touch techniques 

will be covered. Finally, students will learn about Windows 8 power options (such as sleep, 

shut down, and restart). 

Course Outline 

1.1. The Basics of Windows 8 

✓ What’s New in Windows 8? 

✓ Windows 8 Versions 

✓ Logging In 

✓ Understanding the Windows 8 Start 

Screen 

✓ Understanding the Windows 8 

Desktop 

✓ Using Hotspots 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Interacting with the Computer Using a 

Mouse and Keyboard 

✓ Pointing the Mouse 

✓ Using Click and Double-Click 

✓ Using Click and Drag 

✓ Using Right-Click 

✓ Using the Keyboard 

✓ Windows Key Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Interacting with the Computer Using 

Touch Gestures, Part One 

✓ The Basics of Tapping and Swiping 

✓ Swiping to View Charms 

✓ Swiping to Show, Switch, or Snap 

Apps 

✓ Pinch Zooming 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Interacting with the Computer Using 

Touch Gestures, Part Two 

✓ Selecting and Sliding Items 

✓ Opening Menus 

✓ Moving Back and Forward in Internet 

Explorer 

✓ Closing Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Exiting Windows 8 

✓ Locking and Unlocking the Computer 

✓ Signing Out of Your Account 

✓ Switching Users 

✓ Putting the Computer to Sleep 

✓ Restarting the Computer 

✓ Turning off the Computer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 1 
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Hardware and Software  

Course Overview and Learning Objectives 

In this course, students will how to manage software, enable and disable Windows 

features, and manage file types. Students will also learn how to use Device Manager and 

Disk Management to manage their computer’s hardware. 

Course Outline 

1.1. The Basics of Managing Software 

✓ Opening Programs and Features 

✓ Installing Software Packages 

✓ Removing Software Packages 

✓ Setting Program Compatibility 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Program Management Tools 

✓ Enabling or Disabling Windows 

Features 

✓ Changing Default Applications 

✓ Changing AutoPlay Options 

✓ Associating File Types 

✓ Setting Program Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Hardware 

✓ Opening Device Manager 

✓ Viewing Hardware and Devices 

✓ Viewing Device Properties 

✓ Updating Device Drivers 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Hardware Management 

✓ Opening Disk Management 

✓ Viewing and Managing Drives 

✓ Creating a Partition 

✓ Formatting a Partition 

✓ Deleting a Partition 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Improving System Performance 

✓ Disabling Visual Elements 

✓ Disabling Startup Items 

✓ Running Disk Cleanup 

✓ Defragmenting Your Hard Drive 

✓ About Hardware Upgrades 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 4 
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Having Fun in Windows 8 

Course Overview and Learning Objectives 

In this course, students will learn about the lighter side of Windows 8. First, they will be 

introduced to the Video, Music, Camera, and Games apps. Then, they will learn about 

Windows Media Player. 

Course Outline 

1.1. Using the Music App 

✓ Opening Music 

✓ Playing Your Music 

✓ Using the Now Playing List 

✓ Browsing Music from the Xbox Music 

Store 

✓ Searching for Music 

✓ Previewing and Purchasing Music 

from the Xbox Music Store 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Video App 

✓ Opening Video 

✓ Viewing Videos 

✓ Exploring Movies and TV Shows 

✓ Searching for Videos 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Playing Games 

✓ Opening Games 

✓ Signing Into the Games App 

✓ Viewing Achievements 

✓ Adding Friends 

✓ Viewing Friend Details 

✓ Purchasing Games 

✓ Playing Games 

✓ Searching for Games 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Using the Camera App 

✓ Opening Camera 

✓ Taking Photos 

✓ Taking Video 

✓ Setting Options 

✓ Using the Timer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Windows Media Player, Part One 

✓ Opening Windows Media Player 

✓ Setting Up Windows Media Player 

✓ Interface Overview 

✓ Closing Windows Media Player 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Windows Media Player, Part Two 

✓ Playing a Media File 

✓ Using Media Controls 

✓ Playing a CD or DVD 

✓ Ripping a CD 

✓ Burning a CD or DVD 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Intermediate,  

Section 2 
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Maintaining and Optimizing your Computer  

Course Overview and Learning Objectives 

This course begins with information on viewing and customizing user accounts. Then, 

students will learn different ways to monitor system performance. Next, common 

maintenance tasks (such as defragmentation and disk repair) will be covered. Finally, 

students will learn all about Task Manager, which has been rebuilt for Windows 8. 

Course Outline 

1.1. Customizing User Accounts with the 

Control Panel 

✓ Viewing User Accounts 

✓ Adding a User Account 

✓ Changing the Account Type 

✓ Changing User Account Control 

Settings 

✓ Removing a User Account 

✓ Using PC Settings to Modify an 

Account 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Monitoring System Performance 

✓ Viewing Performance Information 

✓ Viewing System Information 

✓ Opening the Event Viewer 

✓ Using the Performance Monitor 

✓ Using the Resource Monitor 

✓ Generating System Health Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Maintaining Your Computer 

✓ Cleaning Up Your Hard Drive 

✓ Understanding Defragmentation 

✓ Defragmenting and Optimizing Your 

Hard Drive 

✓ Repairing Hard Drive Errors 

✓ Setting Power Options 

✓ Changing Mobility Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Optimizing Your Computer 

✓ Using Windows Update in PC 

Settings 

✓ Using Windows Update in Control 

Panel 

✓ Clearing Temporary Internet Files 

and Cookies 

✓ Using the Task Scheduler 

✓ Creating Custom Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Task Manager, Part One 

✓ Starting Task Manager 

✓ Interface Overview 

✓ Viewing Processes 

✓ Analyzing Performance 

✓ Viewing Resource History 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using Task Manager, Part Two 

✓ Changing Startup Items 

✓ Viewing Usage by User 

✓ Viewing Process Details 

✓ Viewing Service Details 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 3 
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Making Windows 8 Work for You  

Course Overview and Learning Objectives 

In this course, students will learn how to add administrative icons to the Start screen and 

the desktop taskbar. They will also receive an introduction to the Control Panel and an 

overview of various customization options. 

Course Outline 

1.1. Adding Administrative Icons to the Start 

Screen 

✓ Hiding and Showing Administrative 

Icons on the Start Screen 

✓ Running Tools as an Administrator 

✓ Pinning Tools to the Desktop Taskbar 

✓ Unpinning Tools from the Start 

Screen 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Meet the Control Panel 

✓ Opening the Control Panel 

✓ Control Panel Overview 

✓ Navigation Basics 

✓ Changing the View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Personalizing Your Desktop 

✓ Changing Your Theme 

✓ Changing the Desktop Background 

✓ Customizing Screen Colors 

✓ Changing Sound Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Changing Display Options 

✓ Changing Item Size 

✓ Changing Your Screen Resolution 

✓ Working with Multiple Monitors 

✓ Projecting to a Second Screen 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Changing Regional Options 

✓ Changing the Date and Time 

✓ Changing the Time Zone 

✓ Setting Your Language 

✓ Changing Location Settings 

✓ Changing Your Region 

✓ Changing Date, Time, and Number 

Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Advanced Customization Techniques 

✓ Customizing Mouse Behavior 

✓ Changing System Volume 

✓ Customizing the Taskbar 

✓ Customizing the System Tray 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 1 
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Managing Files and Folders 

Course Overview and Learning Objectives 

This course will focus on creating, managing, and editing files and folders. Administrative 

file tools (including command prompt and PowerShell) will also be covered. 

Course Outline 

1.1. Creating Files and Folders 

✓ Creating and Naming Folders 

✓ Renaming Folders 

✓ Deleting Folders 

✓ Creating and Naming Files 

✓ Renaming and Deleting Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Files and Folders 

✓ Selecting Files and Folders 

✓ Cutting and Pasting Files and Folders 

✓ Copying Files and Folders 

✓ Moving Files and Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Files 

✓ Opening and Editing Files 

✓ Viewing File and Folder Properties 

✓ Enabling File History 

✓ Viewing File History 

✓ Copying File Paths 

✓ Pasting File and Folder Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Making a File or Folder Easy to Access 

✓ Pinning Folders to the Start Screen 

✓ Including a Folder in a Library 

✓ Adding a Folder to Favorites 

✓ Mapping a Folder as a Drive 

✓ Setting Offline Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Administrative File Tools 

✓ Using Command Prompt 

✓ Using Windows PowerShell 

✓ Accessing the Run Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Advanced, 

Section 3 
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Networking with Windows 8 

Course Overview and Learning Objectives 

This course is all about networking, including wired and wireless networking and 

Homegroups. Advanced networking tasks (such as network drives, printers, and domains) 

will also be covered. 

Course Outline 

1.1. Overview of Networking 

✓ Networking Terms 

✓ Hardware Requirements 

✓ Using the Networking and Sharing 

Center 

✓ Setting Up a Dial-Up Internet 

Connection 

✓ Setting Up a High-Speed Internet 

Connection 

✓ Connecting to a Wireless Network 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Homegroup 

✓ Setting up a Homegroup 

✓ Joining a Homegroup 

✓ Sharing Files, Libraries, and Devices 

✓ Viewing Shared Files 

✓ Viewing the Homegroup Password 

✓ Troubleshooting a Homegroup 

✓ Leaving a Homegroup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Other Networking Tasks 

✓ Changing Networking Sharing and 

Discovery 

✓ Sharing Drives, Folders, and 

Resources 

✓ Browsing the Network 

✓ Basic Network Troubleshooting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Networking Tasks 

✓ Mapping a Network Drive 

✓ Connecting to a Network Printer 

✓ Connecting to a Domain or 

Workgroup 

✓ Managing Network Connections and 

Protocols 

✓ Using a Static IP Address 

✓ Using Credential Manager 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Wireless Networking 

✓ Types of Wireless Networks 

✓ Wireless Networking Hardware and 

Terms 

✓ Connecting to a Wireless Network 

✓ Wireless Networking 

Troubleshooting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 5 
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Other Windows 8 Programs  

Course Overview and Learning Objectives 

This course will show students how to use Windows Fax and Scan, Sticky Notes, Snipping 

Tool, Sound Recorder, and XPS Viewer. 

Course Outline 

1.1. Using Windows Fax and Scan, Part One 

✓ Opening Windows Fax and Scan 

✓ Interface Overview 

✓ Setting up a Fax Account 

✓ Closing Windows Fax and Scan 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Windows Fax and Scan, Part Two 

✓ Creating Fax Cover Pages 

✓ Creating New Faxes 

✓ Using Scan 

✓ Saving Files in Fax and Scan 

✓ Printing Files in Fax and Scan 

✓ E-mailing Files from Fax and Scan 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Snipping Tool 

✓ Opening the Snipping Tool 

✓ Interface Overview 

✓ Creating a New Snip 

✓ Using Markup Tools 

✓ Saving Your Snip 

✓ E-mailing Your Snip 

✓ Closing the Snipping Tool 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Sticky Notes 

✓ Creating a New Note 

✓ Formatting Note Text 

✓ Moving Notes 

✓ Resizing Notes 

✓ Changing the Color of a Note 

✓ Deleting Notes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using the XPS Viewer 

✓ Opening the XPS Viewer 

✓ Interface Overview 

✓ Opening Files 

✓ Searching a Document 

✓ Printing a Document 

✓ Closing the XPS Viewer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using the Sound Recorder 

✓ Opening the Sound Recorder 

✓ Creating a Recording 

✓ Playing Clips 

✓ Closing Sound Recorder 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft  Windows 8: Intermediate, 

Section 5 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 38 

Sharing Files and Folders  

Course Overview and Learning Objectives 

In this course, students will learn various ways to share, including using the Charms bar 

and File Explorer.  

Course Outline 

1.1. Sharing Files from the Charms Bar 

✓ Choosing What to Share 

✓ Sharing with People 

✓ Sharing with Mail 

✓ Sharing with OneDrive 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Sending Files from File Explorer 

✓ Burning Files and Folders 

✓ E-mailing Files 

✓ Printing Files 

✓ Faxing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Sharing Files from File Explorer 

✓ Choosing Who to Share With 

✓ Customizing File Sharing 

✓ Stopping Sharing 

✓ Setting Advanced Permission 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Zipped Folders 

✓ Zipping Files and Folders 

✓ Using the Compressed Folder Tools – 

Extract Tab 

✓ Extracting a Folder 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Advanced, 

Section 4 
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Staying Safe with Windows 8 

Course Overview and Learning Objectives 

This course will cover Windows 8 security tools. Topics will include the Action Center, 

Windows Defender, Windows Firewall, and the Family Safety Center. 

Course Outline 

1.1. Using the Action Center 

✓ Opening the Action Center 

✓ Action Center Overview 

✓ Viewing Security Information 

✓ Viewing Maintenance Information 

✓ Resolving Problems 

✓ Changing Action Center Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Windows Defender 

✓ Opening Windows Defender 

✓ Interface Overview 

✓ Performing a Scan 

✓ Removing Malicious Objects 

✓ Using Quarantine 

✓ Setting Defender Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Windows Firewall 

✓ Opening Windows Firewall 

✓ Interface Overview 

✓ Understanding Rule Types 

✓ Enabling or Disabling the Firewall 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Keeping Your Family Safe, Part One 

✓ Opening Family Safety 

✓ Interface Overview 

✓ Choosing Accounts to Monitor 

✓ Turning Activity Reporting On or Off 

✓ Changing User Settings 

✓ Viewing Activity Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Keeping Your Family Safe, Part Two 

✓ Configuring Web Filtering 

✓ Managing the Allow and Block Lists 

✓ Setting Games Ratings 

✓ Restricting Windows Store and 

Games 

✓ Setting Time Limits 

✓ Restricting Applications 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Advanced, 

Section 5 
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The Basic Windows 8 Applications, Part One  

Course Overview and Learning Objectives 

To start this course, students will learn about creating and customizing local and 

Microsoft accounts. Next, students will dive into some of the applications included in 

Windows 8: Mail, Calendar, People, Messaging, and Photos. 

Course Outline 

1.1. Getting Started 

✓ About Local Accounts and Microsoft 

Accounts 

✓ Converting Your Account 

✓ Adding a Password 

✓ Adding Users 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Accounts 

✓ Viewing Accounts 

✓ Editing Accounts 

✓ Removing an Account 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Mail 

✓ Opening Mail 

✓ Configuring Mail Accounts 

✓ Viewing Mail Messages 

✓ Composing Mail Messages 

✓ Replying to Messages 

✓ Deleting Messages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Calendar 

✓ Opening and Configuring Calendar 

✓ Adding Events 

✓ Editing Events 

✓ Deleting Events 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using People and Messaging 

✓ Opening People and Messaging 

✓ Configuring the People App 

✓ Viewing Social Network Information 

✓ Viewing Contacts 

✓ Configuring Facebook Messaging 

✓ Chatting with Messenger and 

Facebook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using Photos 

✓ Starting Photos 

✓ Choosing a Source 

✓ Viewing Photos 

✓ Importing Photos 

✓ Set As Options 

✓ Deleting Photos 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 3 
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The Basic Windows 8 Applications, Part Two  

Course Overview and Learning Objectives 

This course will continue the exploration of Windows 8 apps, with a look at the Internet 

Explorer, General News, Bing, Finance, Travel, Sports, Maps, and OneDrive apps. 

Course Outline 

1.1. Using Windows 8 Internet Explorer, 

Part One 

✓ Opening Internet Explorer (Windows 

8) 

✓ Navigating in Internet Explorer 

✓ Refreshing the Page 

✓ Moving Back and Forward 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Windows 8 Internet Explorer, 

Part Two 

✓ Opening Tabs 

✓ Closing Tabs 

✓ Pinning a Page to the Start Screen 

✓ Switching to Internet Explorer 

(Desktop) 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using News Apps 

✓ Viewing General News 

✓ Viewing Bing 

✓ Viewing Finance News 

✓ Viewing Travel News 

✓ Viewing Sports News 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Maps 

✓ Starting Maps 

✓ Navigating in the Map 

✓ Showing Traffic 

✓ Choosing a Map Style 

✓ Viewing Your Location 

✓ Getting Directions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using OneDrive 

✓ Opening and Configuring OneDrive 

✓ Viewing Documents 

✓ Uploading Documents 

✓ Deleting Documents 

✓ Creating Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 4 
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The Basic Windows Desktop Applications  

Course Overview and Learning Objectives 

In this course, students will learn about the desktop edition of Internet Explorer, as well as 

Calculator and Paint. 

Course Outline 

1.1. The Basics of Internet Explorer 

(Desktop) 

✓ Opening Internet Explorer 

✓ Interface Overview 

✓ Customizing Internet Explorer 

✓ Using the Address Bar 

✓ Closing Internet Explorer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Doing More with Internet Explorer 

(Desktop) 

✓ Accessing a Web Site via a Hyperlink 

✓ Opening a New Window 

✓ Opening a New Tab 

✓ Using Tabs 

✓ Using Web Accelerators 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Calculator 

✓ Opening Calculator 

✓ Interface Overview 

✓ Using the Calculator 

✓ Changing Calculator Views 

✓ Using Advanced Calculator Tools 

✓ Closing Calculator 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Paint 

✓ Opening Paint 

✓ Interface Overview 

✓ Drawing in Paint 

✓ Saving Files 

✓ Opening Files 

✓ Closing Paint 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Intermediate, 

Section 3 
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Troubleshooting Your Computer  

Course Overview and Learning Objectives 

This course focuses on Windows 8’s troubleshooting tools, including Remote Desktop, the 

Action Center, Steps Recorder, and System Configuration utility. System Restore and the 

new Refresh and Reset features will also be covered. 

Course Outline 

1.1. Using Remote Desktop 

✓ Preparing to Use Remote Desktop 

✓ Opening Remote Desktop 

✓ Configuring Remote Desktop 

✓ Accessing a Computer Using Remote 

Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Troubleshooting Your Computer with 

the Action Center 

✓ Opening the Action Center 

✓ Action Center Overview 

✓ Troubleshooting Your Computer 

✓ Using the Windows Program 

Compatibility Troubleshooter 

✓ Using the Steps Recorder 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using System Configuration 

✓ Opening System Configuration 

✓ Using Preset Startup Options 

✓ Manually Modifying Services 

✓ Manually Modifying Startup 

Programs 

✓ Using System Configuration Tools 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Refreshing and Resetting Your 

Computer 

✓ Refreshing Your Computer 

✓ Resetting Your Computer 

✓ Using Advanced Startup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using System Restore 

✓ Creating a System Restore Point 

✓ Restoring Your Computer to an 

Earlier Time 

✓ Undoing a System Restore 

✓ Changing System Restore Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 6
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Using File Explorer 

Course Overview and Learning Objectives 

In this course, students will learn about the revamped File Explorer application (formerly 

called Windows Explorer). Topics will include using the program, customizing it, and 

changing folder and search options. Information on the Recycle Bin is also provided. 

Course Outline 

1.1. Using File Explorer 

✓ Opening File Explorer 

✓ Interface Overview 

✓ About Standard Tabs 

✓ About Contextual Tabs 

✓ About the File Menu 

✓ Using the Quick Access Toolbar 

✓ Customizing the Quick Access 

Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing File Explorer 

✓ Customizing the Navigation Pane 

✓ Showing and Hiding the Preview 

Pane and Details Pane 

✓ Choosing a Layout 

✓ Sorting and Grouping Items 

✓ Showing and Hiding File Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. Changing Folder and Search Options 

✓ Accessing Folder Options 

✓ Changing General Options 

✓ Changing View Options 

✓ Changing Search Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with the Recycle Bin 

✓ Opening the Recycle Bin 

✓ Emptying the Recycle Bin 

✓ Restoring Items 

✓ Viewing Recycle Bin Properties 

✓ Permanently Deleting Items 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Advanced, 

Section 1 
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Windows 8 and Accessibility  

Course Overview and Learning Objectives 

This course will cover Windows 8’s accessibility options, including the Ease of Access 

Center, Magnified, On-Screen Keyboard, Screen Reader, and Speech Recognition. 

Course Outline 

1.1. Setting Accessibility Options 

✓ Opening the Ease of Access Center 

✓ Changing Mouse Options 

✓ Optimizing Your Display 

✓ Changing Input Methods 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Ease of Access Tools 

✓ Using the Magnifier 

✓ Using the On-Screen Keyboard 

✓ Using the Narrator 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Speech Recognition 

✓ Opening Speech Recognition 

✓ Setting up Speech Recognition 

✓ Training Your Computer 

✓ Using Speech Recognition 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Expert, 

Section 2 
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Word Processing with Windows 8 

Course Overview and Learning Objectives 

This course takes an in-depth look at WordPad, Notepad, and Windows Journal. 

Course Outline 

1.1. WordPad Basics 

✓ Opening WordPad 

✓ Interface Overview 

✓ Customizing the Quick Access 

Toolbar 

✓ Entering Text 

✓ Editing Text 

✓ Closing WordPad 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Doing More with WordPad 

✓ Formatting Text 

✓ Inserting Pictures 

✓ Saving Files 

✓ Opening Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Notepad 

✓ Opening Notepad 

✓ Interface Overview 

✓ Entering Text 

✓ Formatting Text 

✓ Saving Files 

✓ Opening Files 

✓ Closing Notepad 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Windows Journal 

✓ Opening Windows Journal 

✓ Interface Overview 

✓ Entering Text 

✓ Editing Text 

✓ Saving and Exporting Files 

✓ Closing Windows Journal 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Intermediate, 

Section 4 
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Working with Files and Folders  

Course Overview and Learning Objectives 

This course will introduce students to files and folders. First, they will learn about the 

basic file structure in Windows 8. Then, they will learn how to open, use, and customize 

File Explorer. Next, they will learn about the Recycle Bin. The course wraps up with a look 

at help and support tools. 

Course Outline 

1.1. The Basic Components 

✓ Understanding Files, Folders, and 

Libraries 

✓ Opening File Explorer 

✓ Interface Overview 

✓ Understanding the Locations in the 

Navigation Pane 

✓ Customizing the Favorites Section of 

the Navigation Pane 

✓ Navigating Through Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The File Explorer Tabs 

✓ File Menu 

✓ Home Tab 

✓ Share Tab 

✓ View Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Customizing File Explorer 

✓ Customizing the Navigation Pane 

✓ Customizing the Quick Access 

Toolbar 

✓ Moving the Quick Access Toolbar 

✓ Minimizing and Expanding the 

Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using the Recycle Bin 

✓ Opening the Recycle Bin 

✓ Using the Recycle Bin Tools – 

Manage Tab 

✓ Searching for Items 

✓ Restoring Items 

✓ Emptying the Recycle Bin 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Getting Help in Windows 8 

✓ Opening Help and Support 

✓ Searching Help and Support 

✓ Navigating in Help and Support 

✓ Printing Help Topics 

✓ Customizing Help and Support 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 6 
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Working with the Windows 8 Desktop  

Course Overview and Learning Objectives 

In this course, students will learn about the Windows desktop. First, they will learn how to 

display the desktop and identify its components. Then, they will learn about window 

management features, jump lists, and the basics of desktop applications. 

Course Outline 

1.1. Introducing the Windows 8 Desktop 

✓ Switching to the Desktop 

✓ Anatomy of the Desktop 

✓ Using the Desktop 

✓ Using the Taskbar 

✓ Using the System Tray 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Desktop Windows 

✓ Using Minimize, Maximize, and 

Restore 

✓ Scrolling in a Window 

✓ Moving a Window 

✓ Switching Between Windows 

✓ Resizing Windows 

✓ Cascading and Arranging Windows 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Desktop Features 

✓ Using Snap 

✓ Using Peek 

✓ Using Shake 

✓ Quickly Viewing the Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Jump Lists 

✓ Viewing a Jump List 

✓ Pinning and Unpinning Applications 

✓ Using Recent Items in Jump Lists 

✓ Using Frequent Tasks in Jump Lists 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Desktop Application Basics 

✓ Starting a Program 

✓ Parts of the Application Window 

✓ Moving Around in a Program 

✓ Launching Help from Within an 

Application 

✓ Ending a Frozen Program 

✓ Exiting a Program 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Interface Basics 

✓ Using Menus and Toolbars 

✓ Using Ribbon Tabs 

✓ Using Shortcut Menus 

✓ Using Keyboard Shortcuts 

✓ About the Shortcut Key and 

Windows Keys 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 5 
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Working with the Windows 8 Start Screen  

Course Overview and Learning Objectives 

This course will focus on the Windows 8 Start screen. First, students will learn about the 

basic elements of the screen. Then, students will learn how to customize app tiles and 

notifications. Next, students will learn how to open and manage apps, as well as how to 

use the Charms bar. The course will wrap up with a look at the Windows Store. 

Course Outline 

1.1. Introducing the Windows 8 Start Screen 

✓ Anatomy of the Start Screen 

✓ Working with App Tiles 

✓ Viewing all Apps 

✓ Using Charms 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Windows 8 Start Screen 

✓ Changing Icon Display 

✓ Switching Between Apps 

✓ Working with Notifications 

✓ Customizing Notifications 

✓ Viewing System Information at a 

Glance 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Windows 8 Apps 

✓ Starting an App from the Start Screen 

✓ Pinning Apps to the Start Screen 

✓ Snapping and Resizing Apps 

✓ Returning to the Start Screen 

✓ Closing Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using the Charms Bar 

✓ Searching for Apps 

✓ Sharing App Content 

✓ Viewing Connected Devices 

✓ Modifying Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using the Windows Store 

✓ Launching the Store 

✓ Searching for Apps 

✓ Downloading Apps 

✓ Launching Installed Apps 

✓ Uninstalling Apps 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 8: Foundation, 

Section 2 
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Microsoft Windows 7  

Advanced File and Folder Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to use libraries and how to search in Windows 7. 

They will also learn how to manage files and folders. 

Course Outline 

1.1. Using Search 

✓ What is File Indexing? 

✓ Using a Search Box 

✓ Using Search in the Start Menu 

✓ Search Results Window 

✓ Searching Tips and Tricks 

✓ Setting Search Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Windows Explorer and Libraries 

✓ Launching Windows Explorer 

✓ Windows Explorer Overview 

✓ Choosing a Layout 

✓ View Options 

✓ Creating a New Library 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Files and Folders 

✓ Creating and Naming Folders 

✓ Renaming and Deleting Folders 

✓ Creating and Naming Files 

✓ Renaming and Deleting Files 

✓ Cutting, Copying, and Pasting Files 

and Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced File Management 

✓ Viewing File Properties 

✓ Viewing Folder Properties 

✓ Sharing a File or Folder 

✓ Burning Files, Folders, and ISOs 

✓ Printing a File 

✓ Using Command Prompt 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Intermediate, 

Section 4 
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Advanced Topics 

Course Overview and Learning Objectives 

This course covers Windows’ hardware administrative tools (such as paging files and 

event logs) in depth. Windows XP Mode and Speech Recognition are also covered. 

Course Outline 

1.1. Speech Recognition 

✓ Opening Speech Recognition 

✓ Setting Speech Recognition Options 

✓ Training your Computer 

✓ Using Speech Recognition 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Hardware Administrative Tools, 

Part One 

✓ Editing your Paging File 

✓ Scheduling the Processor 

✓ Setting Advanced Visual Effect 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Hardware Administrative Tools, 

Part Two 

✓ Viewing Advanced System 

Information 

✓ Using Event Logs 

✓ Using the Performance Monitor 

✓ Generating System Health Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Windows XP Mode 

✓ What is XP Mode? 

✓ Downloading and Installing Windows 

Virtual PC 

✓ Launching Windows XP Mode 

✓ Using Windows XP Mode Controls 

✓ Changing Windows Virtual PC 

Settings 

✓ Managing Different Virtual Machines 

✓ Closing Windows XP Mode 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Expert, 

Section 4 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 52 

Computer Management Tools 

Course Overview and Learning Objectives 

This course focuses on some of Windows 7’s most advanced features, including 

ReadyBoost, BitLocker, Encrypting File System, Windows Services Hardening, Data 

Execution Prevention, and Access Control Lists. Mobility features and the Math Input 

Panel are also covered. 

Course Outline 

1.1. Hard Disk Management Utilities 

✓ Enabling ReadyBoost 

✓ Using BitLocker 

✓ Using the Encrypting File System 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Computer Management 

✓ About Windows Services Hardening 

and Security 

✓ Using Data Execution Prevention 

✓ Setting up Access Control Lists 

✓ About Network Access Protection 

✓ About User Account Control 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Mobility and Touch Features 

✓ Using the Mobility Center 

✓ Setting Power Options 

✓ Setting Tablet PC Options 

✓ Touch and Multi-Touch Options 

✓ Using the Math Input Panel 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Expert, 

Section 3 
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Customizing Your Desktop 

Course Overview and Learning Objectives 

In this course, students will learn how to customize the parts of the Windows desktop, 

including the taskbar, Start menu, and desktop appearance. 

Course Outline 

1.1. Customizing the Taskbar 

✓ Locking and Unlocking the Taskbar 

✓ Moving the Taskbar 

✓ Resizing the Taskbar 

✓ Other Taskbar Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Taskbar Options 

✓ Interacting with Inactive Icons 

✓ Customizing Icons in the System Tray 

✓ Adding Toolbars 

✓ Creating Custom Toolbars from a 

Folder 

✓ Removing Toolbars 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Customizing the Start Menu 

✓ Using the Start Menu 

✓ Customizing the Start Menu 

✓ Using the Pinned List 

✓ Other Start Menu Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Desktop 

✓ Changing Your Wallpaper 

✓ Moving Icons 

✓ Sorting Icons 

✓ Setting View Options 

✓ Deleting Icons 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Intermediate, 

Section 3 
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Doing More with Windows 7 

Course Overview and Learning Objectives 

This course will introduce students to Internet features in Windows 7, with a focus on 

Internet Explorer 8 and Windows Live. Students will also learn how to make sure their 

computer is secure when working on the Internet. 

Course Outline 

1.1. Staying Safe 

✓ Opening the Action Center 

✓ Action Center Overview 

✓ Security Essentials 

✓ Modifying Basic Security Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Basics of Internet Explorer 8 

✓ Launching Internet Explorer 8 

✓ Initial Setup 

✓ Other Setup Options 

✓ Interface Overview 

✓ Closing Internet Explorer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing More with Internet Explorer 8 

✓ Using the Address Bar 

✓ Accessing a Web Site via a Hyperlink 

✓ Opening a New Window 

✓ Opening a New Tab 

✓ Using Tabs 

✓ Using Web Slices 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Windows Live 

✓ What is Windows Live? 

✓ Downloading and Installing Windows 

Live Essentials 

✓ Windows Live Messenger 

✓ Using Windows Live Hotmail 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Foundation, 

Section 4 
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Getting Help in Windows 7 

Course Overview and Learning Objectives 

This course will focus on Windows 7 help features. The Windows Help and Support tool 

will be covered in-depth. Students will also get an introduction to Remote Assistance. 

Course Outline 

1.1. The Basics of Help 

✓ Launching Help from the Start Menu 

✓ Launching Help from within a Windows Application 

✓ Overview of the Help and Support Window 

✓ Searching for a Help Topic 

✓ Ask Someone 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Windows Basics 

✓ Choosing a Preset Topic 

✓ Choosing Subtopics 

✓ Moving Back and Forward 

✓ Printing a Topic 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Table of Contents 

✓ Opening the Table of Contents 

✓ Choosing a Topic 

✓ Choosing a Subtopic 

✓ Moving Back and Forward 

✓ Printing a Topic 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Help and Support Tools 

✓ Remote Assistance 

✓ Setting Help Options 

✓ Online vs. Offline Help 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Foundation, Section 5 
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Getting Started 

Course Overview and Learning Objectives 

This course will begin with the basics of Windows 7, including an introduction to the 

desktop. Then, basic keyboard and mouse techniques will be covered. Finally, students 

will learn about Windows 7 power options (such as logging off, shutting down, and 

restarting). 

Course Outline 

1.1. The Basics of Windows 7 

✓ What’s New in Windows 7? 

✓ Windows 7 Versions 

✓ Logging In 

✓ The Windows 7 Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Interacting with the Computer 

✓ Pointing the Mouse 

✓ Using Click and Double-Click 

✓ Using Click and Drag 

✓ Using Right-Click 

✓ Using the Keyboard 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. A Quick Look at Windows 7 

✓ Using the Getting Started Center 

✓ Using the Desktop 

✓ Using the Start Menu 

✓ Using the Taskbar 

✓ Using the System Tray 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exiting Windows 7 

✓ Shutdown Options 

✓ Logging Off the Computer 

✓ Restarting the Computer 

✓ Turning off the Computer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Foundation, 

Section 1 
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Hardware and Software 

Course Overview and Learning Objectives 

In this course, students will how to manage software, enable and disable Windows 

features, and manage file types. Students will also learn how to use Device Manager and 

Disk Management to manage their computer’s hardware.  

Course Outline 

1.1. The Basics of Managing Software 

✓ Installing Software Packages 

✓ Removing Software Packages 

✓ Changing Startup Programs 

✓ Setting Program Compatibility 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Software Management 

✓ Enabling or Disabling Windows 

Features 

✓ Using Windows Task Manager 

✓ Changing Default Applications 

✓ Setting File Types 

✓ Setting Processor Affinity 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Hardware 

✓ Viewing System Information 

✓ Checking your System’s Score 

✓ Opening the Device Manager 

✓ Viewing Hardware and Devices 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Hardware Management 

✓ Updating Device Drivers 

✓ Improving System Performance 

✓ Managing Your Hard Disks 

✓ Creating a Partition 

✓ Deleting a Partition 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Advanced, 

Section 4 
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Harnessing the Power of the Internet 

Course Overview and Learning Objectives 

This course begins with an in-depth look at Remote Desktop and Remote Assistance. 

Windows Contacts and People Near Me will also be covered. 

Course Outline 

1.1. Using Remote Desktop 

✓ Preparing to Use Remote Desktop 

✓ Opening Remote Desktop 

✓ Configuring Remote Desktop 

✓ Accessing a Computer using Remote 

Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Remote Assistance 

✓ Remote Desktop vs. Remote 

Assistance 

✓ Inviting Someone to your Computer 

✓ Responding to a Remote Assistance 

Invitation 

✓ Offering Help with Remote 

Assistance 

✓ Asking for Help with Remote 

Assistance 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Windows Contacts 

✓ Opening Contacts 

✓ Contacts Overview 

✓ Adding Contacts 

✓ Using Contact Views 

✓ Closing Contacts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. People Near Me 

✓ What is People Near Me? 

✓ Opening People Near Me 

✓ Setting Your Sign-In Options 

✓ Using People Near Me 

✓ About Windows CardSpace 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Expert, 

Section 1 
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Maintaining and Optimizing your Computer 

Course Overview and Learning Objectives 

In this course, students will learn how to perform common maintenance and optimization 

tasks (such as defragmentation, disk repair, and Windows Update). Windows Defender 

and the Parental Controls Center will also be covered. 

Course Outline 

1.1. Maintaining your Computer 

✓ Cleaning Up Your Hard Disk 

✓ Defragmenting your Hard Disk 

✓ Repairing Hard Disk Errors 

✓ Setting Power Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Optimizing your Computer 

✓ Using Windows Update 

✓ Clearing Temporary Internet Files 

and Cookies 

✓ Scheduling Tasks 

✓ About Fast User Switching 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Windows Defender 

✓ Opening Windows Defender 

✓ Interface Overview 

✓ Performing a Scan 

✓ Removing Malicious Objects 

✓ Using Quarantine 

✓ Setting Defender Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Keeping your Family Safe 

✓ Opening the Parental Controls 

Center 

✓ Setting Games Ratings 

✓ Setting Time Limits 

✓ Restricting Applications 

✓ Web Filtering and Activity Reporting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Advanced, 

Section 3 
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Making Windows 7 Work for You 

Course Overview and Learning Objectives 

In this course, students will receive an introduction to the Control Panel and an overview 

of various customization options. Students will also learn how to set accessibility options. 

Course Outline 

1.1. Meet the Control Panel 

✓ Opening the Control Panel 

✓ Control Panel Overview 

✓ Navigation Basics 

✓ Changing the View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Common Customization Tasks 

✓ Personalizing Your Computer 

✓ Modifying Screen Resolution 

✓ Working with Multiple Monitors 

✓ Changing your Sound Scheme 

✓ Changing the Date and Time 

✓ Setting the Volume and Sound 

Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Customization Tasks 

✓ Changing How Your Mouse Behaves 

✓ Setting Your Language 

✓ Modifying Startup Programs 

✓ Viewing System Information 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Setting Accessibility Options 

✓ Opening the Ease of Access Center 

✓ Changing Mouse Options 

✓ Optimizing Your Display 

✓ Changing Input Methods 

✓ Accessing Commonly Used Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing User Accounts 

✓ Opening User Accounts 

✓ Adding a User Account 

✓ Changing User Account Properties 

✓ Removing a User Account 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Advanced, 

Section 1 
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Networking with Windows 7 

Course Overview and Learning Objectives 

This course is all about networking, including wired and wireless networking. Advanced 

networking tasks (such as network drives, printers, and domains) will also be covered. 

Course Outline 

1.1. Overview of Networking 

✓ Networking Terms 

✓ Hardware Requirements 

✓ Using the Networking and Sharing 

Center 

✓ Setting up an Internet Connection 

✓ Setting up a Simple Network 

✓ Using the Homegroup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Other Networking Tasks 

✓ Viewing your Network Map 

✓ Network Sharing and Discovery 

✓ Sharing Drives, Folders, & Resources 

✓ Browsing the Network 

✓ Basic Network Troubleshooting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Networking Tasks 

✓ Mapping a Network Drive 

✓ Connecting to a Network Printer 

✓ Connecting to a Domain or 

Workgroup 

✓ Managing Network Connections and 

Protocols 

✓ The Credential Manager and 

Windows Vault 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Wireless Networking 

✓ Types of Wireless Networks 

✓ Wireless Networking Hardware and 

Terms 

✓ Connecting to a Wireless Network 

✓ Wireless Network Troubleshooting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Advanced, 

Section 2 
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The Basic Windows 7 Applications 

Course Overview and Learning Objectives 

In this course, students will learn about three of the most popular Windows 7 

applications: WordPad, Calculator, and Paint. Students will also receive an introduction to 

Notepad, Windows Media Player, Windows Media Center, Snipping Tool, and Sticky 

Notes. 

Course Outline 

1.1. WordPad Basics 

✓ Launching WordPad 

✓ Interface Overview 

✓ Entering Text 

✓ Closing WordPad 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Doing More with WordPad 

✓ Editing Text 

✓ Formatting Text 

✓ Saving your File 

✓ Opening a File 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Windows Calculator 

✓ Launching Calculator 

✓ Interface Overview 

✓ Using the Calculator 

✓ Advanced Calculator Tools 

✓ Closing Calculator 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Paint 

✓ Launching Paint 

✓ Interface Overview 

✓ Drawing in Paint 

✓ Closing Paint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Other Windows 7 Ultimate Programs 

✓ Notepad 

✓ Windows Media Player 

✓ Windows Media Center 

✓ Snipping Tool 

✓ Sticky Notes 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Foundation, 

Section 3 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 63 

The Windows 7 Applications 

Course Overview and Learning Objectives 

In this course, students will learn about Windows Media Center, Windows Media Player, 

Windows DVD Maker, and Windows Fax and Scan. 

Course Outline 

1.1. Windows Media Center 

✓ Setting up Windows Media Center 

✓ Navigating Through Windows Media 

Center 

✓ Using Tasks 

✓ Using TV and Movies 

✓ Using Pictures + Videos 

✓ Using Extras 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Windows Media Player 

✓ Opening Windows Media Player 

✓ Setting Up Windows Media Player 

✓ Windows Media Player Overview 

✓ Playing a Media File 

✓ Playing a CD 

✓ Ripping a CD 

✓ Burning a CD 

✓ Closing Windows Media Player 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Windows DVD Maker 

✓ Opening Windows DVD Maker 

✓ Adding Content to your DVD 

✓ Adding and Customizing Menus 

✓ Burning the DVD 

✓ Closing Windows DVD Maker 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Windows Fax and Scan 

✓ Opening Windows Fax and Scan 

✓ Fax and Scan Overview 

✓ Setting up a Fax Account 

✓ Using Fax 

✓ Using Scan 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Intermediate, 

Section 2 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 64 

Troubleshooting your Computer 

Course Overview and Learning Objectives 

This course focuses on Windows 7’s troubleshooting tools, including the Backup and 

Restore Center, the Action Center, and the System Configuration utility. System Restore 

will also be covered. 

Course Outline 

1.1. Backing Up Your Computer 

✓ Launching the Backup and Restore 

Center 

✓ Backing Up Your Files 

✓ Creating a System Repair Disc 

✓ Restoring Files 

✓ Using Windows Easy Transfer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Troubleshooting your Computer with 

the Action Center 

✓ Opening the Action Center 

✓ Action Center Overview 

✓ Troubleshooting Your Computer 

✓ Using the Windows Program 

Compatibility Troubleshooter 

✓ Using the Problem Steps Recorder 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the System Configuration Utility 

✓ Opening MSCONFIG 

✓ Using Preset Startup Options 

✓ Manually Modifying Programs and 

Services 

✓ Using MSCONFIG Tools 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using System Restore 

✓ Opening System Restore 

✓ Creating a System Restore Point 

✓ Restoring your Computer to an 

Earlier Time 

✓ Undoing a System Restore 

✓ Changing System Restore Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Expert, 

Section 2 
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Working with Windows 7 (Fundamentals) 

Course Overview and Learning Objectives 

In this course, students will learn about the essential features of Windows 7. First, they 

will learn how to open a program and identify its components. Then, they will learn about 

window management features, working with files and folders, and the basics of both menu 

and ribbon-based interfaces. 

Course Outline 

1.1. Application Basics 

✓ Starting a Program 

✓ Parts of the Application Window 

✓ Moving Around in a Program 

✓ Launching Help from Within an 

Application 

✓ Ending a Frozen Program 

✓ Exiting a Program 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with a Window 

✓ Using Minimize, Maximize, and 

Restore 

✓ Scrolling in a Window 

✓ Moving a Window 

✓ Switching Between Windows 

✓ Sizing Windows 

✓ Window Management 

✓ Windows Aero Desktop 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Files and Folders 

✓ Understanding Files 

✓ Understanding Folders 

✓ Understanding Libraries 

✓ Opening the Computer Folder 

✓ Overview of the Computer Folder 

✓ Navigating through Your Computer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Basics of Menus and the Ribbon 

✓ Basics of Menus 

✓ Basics of Ribbons 

✓ Using Shortcut Menus 

✓ Using Shortcut Keys 

✓ Using Shortcut Keys and Menus 

Together 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Foundation, 

Section 2 
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Working with Windows 7 (Advanced) 

Course Overview and Learning Objectives 

In this course, students will review the basics of Windows 7, including keyboard shortcuts, 

the Start menu, Jump Lists, the Recycle Bin, and gadgets. 

Course Outline 

1.1. Windows 7 Basics 

✓ What’s New in Windows 7? 

✓ Windows 7 Versions 

✓ Aero Desktop Features 

✓ Windows Key Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Windows 7 

✓ The Start Menu 

✓ Jump Lists 

✓ Overview of Libraries 

✓ Other Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Recycle Bin 

✓ Opening the Recycle Bin 

✓ Restoring Items 

✓ Emptying the Recycle Bin 

✓ Closing the Recycle Bin Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Gadgets 

✓ What are Gadgets? 

✓ Adding Gadgets 

✓ Customizing Gadgets 

✓ Getting More Gadgets Online 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Windows 7: Intermediate, 

Section 1 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 67 

Adobe Acrobat 

Acrobat XI Pro: Part 1 

Accessing PDF Documents 

Course Overview and Learning Objectives 

In the first course, students will become familiar with the Adobe Acrobat XI Pro interface. They 

will also learn how to open and browse PDF documents.  

Course Outline 

✓ Opening a PDF Document 

✓ Browse a PDF Document 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 1 

 

Creating and Saving PDF Documents 

Course Overview and Learning Objectives 

This course explores how to create and save PDF documents from existing documents and web 

pages. It also covers how to combine multiple PDF documents and how to create and use PDF 

portfolios.  

Course Outline 

✓ Create and Save a PDF Document from an Existing Document 

✓ Create a PDF Document from a Web Page 

✓ Combine Multiple PDF Documents 

✓ PDF Portfolios 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 2 
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Navigating Content in a PDF Document 

Course Overview and Learning Objectives 

Students will learn how to perform a search in PDF documents, work with bookmarks, and create 

links and buttons.  

Course Outline 

✓ Perform a Search in a PDF Document 

✓ Search Multiple PDF Documents 

✓ Work with Bookmarks 

✓ Create Links and Buttons 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 3 

 

Modifying PDF Documents 

Course Overview and Learning Objectives 

This course looks at ways to manipulate PDF document pages, edit content and add page 

elements.  

Course Outline 

✓ Manipulate PDF Document Pages 

✓ Edit Content in a PDF Document 

✓ Add Page Elements 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 4 
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Reviewing PDF Documents 

Course Overview and Learning Objectives 

In this course, adding comments and markup will be covered. We will also take a look at how to 

compare PDF documents, and how to initiate and manage a review.  

Course Outline 

✓ Add Comments and Markup 

✓ Compare PDF Documents 

✓ Initiate and Manage a Review 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 5 

 

Converting PDF Files 

Course Overview and Learning Objectives 

We will cover how to reduce the file size of a PDF document, optimize PDF files, and convert and 

reuse PDF document content.  

Course Outline 

✓ Reduce the File size of a PDF Document 

✓ Optimize PDF Files 

✓ Convert and Reuse PDF Document Content 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 6 
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Acrobat XI Pro on Touchscreen Devices 

Course Overview and Learning Objectives 

The final course focuses on how to enter and use Touch mode. Viewing and changing Touch mode 

preferences is also covered.  

Course Outline 

✓ Using Touchscreen Devices 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Acrobat XI Pro: Part 1, Lesson 7 
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Microsoft Office 2016 Courses 

Introduction to Microsoft Power BI 

Getting Started 

Course Overview and Learning Objectives 

This course focuses on the components of Power BI. Students will learn how to work with 

Power BI files, connect to data sources with the Power BI desktop client, create a report, 

and work with visualizations. 

Course Outline 

✓ Describe the components of Power BI 

✓ Work with Power BI files 

✓ Connect to data sources with the Power BI desktop client  

✓ Create a report and visualizations  

✓ Work with visualizations 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Introduction to Microsoft Power BI, Lesson 1 

 

Working with Data 

Course Overview and Learning Objectives 

This course covers how to transform and sanitize data, use the query editor, model data 
and manage relationships. 

Course Outline 

✓ Transform and sanitize data 

✓ Use the Query Editor 

✓ Model data 

✓ Manage relationships 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Introduction to Microsoft Power BI, Lesson 2 
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Working with Reports and Visualizations 

Course Overview and Learning Objectives 

Next, we look at managing report pages, changing report view options, working with 

visualizations and their data, and adding static objects to a report. 

Course Outline 

✓ Manage report pages 

✓ Change report view options 

✓ Work with visualizations and their data 

✓ Add static objects to a report 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Introduction to Microsoft Power BI, Lesson 3 

 

A Closer Look at Visualizations 

Course Overview and Learning Objectives 

This course is all about creating and managing visualizations to generate visual reports 
and reveal data insights. Types of visualizations include Matrixes, Tables, Charts, Maps, 
gauges, Cards, KPIs and Slicers.  

Course Outline 

✓ Matrixes 

✓ Tables 

✓ Charts 

✓ Maps 

✓ Gauges 

✓ Cards 

✓ KPIs 

✓ Slicers 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Introduction to Microsoft Power BI, Lesson 4 
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Introduction to the Power BI Web App 

Course Overview and Learning Objectives 

In the final course, students will learn how to use the Power BI web app, connect to data 

sources from the Power BI app, use workspaces, dashboards, reports, and other Power BI 

app features. 

Course Outline 

✓ Matrixes Use the Power BI web app 

✓ Connect to data sources from the Power BI app 

✓ Use workspaces, dashboards, reports, and other Power BI app features 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Introduction to Microsoft Power BI, Lesson 5 
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Microsoft Access 2016: Part 1 

Getting Started with Access 

Course Overview and Learning Objectives 

In the first course, students will learn how to orient themselves with Microsoft Access 

2016, create a simple Access database, and get help in Microsoft Access.  

Course Outline 

✓ Orientation to Microsoft Access 

✓ Create a Simple Access Database 

✓ Get Help in Microsoft Access 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 1 

 

Working with Table Data 

Course Overview and Learning Objectives 

Students will learn how to modify table data, work with, sort and filter records, and how to 

create lookups.  

Course Outline 

✓ Modify Table Data 

✓ Work with Records 

✓ Sort and Filter Records 

✓ Create Lookups 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 2 
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Querying a Database 

Course Overview and Learning Objectives 

This course covers how to join data from different tables in a query, sort and filter data in 

a query, and perform calculations in a query.  

Course Outline 

✓ Join Data from Different Tables in a Query 

✓ Sort and Filter Data in a Query 

✓ Perform Calculations in a Query 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 3 

 

Creating Advanced Queries 

Course Overview and Learning Objectives 

In this course, students will learn how to create parameter queries, action queries, 

unmatched queries, and duplicate queries. They will also learn how to summarize data 

with queries.  

Course Outline 

✓ Create Parameter Queries 

✓ Create Action Queries 

✓ Create Find Duplicate and Find Unmatched Queries 

✓ Summarize Data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 4 
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Generating Reports 

Course Overview and Learning Objectives 

Creating reports, adding controls to a report, enhancing the appearance of a report, and 

preparing a report for print are all covered in this course.  

Course Outline 

✓ Create a Report 

✓ Add Controls to a Report 

✓ Enhance the Appearance of a Report 

✓ Prepare a Report for Print 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 5 

 

Customizing the Access Environment 

Course Overview and Learning Objectives 

Students will learn about the Access Options dialog box.  

Course Outline 

✓ The Access Options Dialog Box 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 6 
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 Designing a Relational Database 

Course Overview and Learning Objectives 

This course covers relational database design, creating a table, managing table fields, and 

creating table relationships.  

Course Outline 

✓ Relational Database Design 

✓ Create a Table 

✓ Modify a Table and Fields 

✓ Create Table Relationships 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 7 

 

Joining Tables 

Course Overview and Learning Objectives 

Creating query joins, joining tables that have no common fields, relating data within a 

table, working with subdatasheets, and creating subqueries will be covered in this course.  

Course Outline 

✓ Create Query Joins 

✓ Join Tables That Have No Common Fields 

✓ Relate Data within a Table 

✓ Work with Subdatasheets 

✓ Create Subqueries 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 8 
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Organizing a Database for Efficiency 

Course Overview and Learning Objectives 

In this course, students will learn about data normalization and how to create a junction 

table.  

Course Outline 

✓ Data Normalization 

✓ Create a Junction Table 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 9 

 

Sharing Data Across Applications 

Course Overview and Learning Objectives 

Importing data into Access, exporting Access data to text file formats, exporting Access 

data to Excel, and creating a mail merge will be covered.  

Course Outline 

✓ Import Data into Access 

✓ Export Data to Text File Formats 

✓ Export Access Data to Excel 

✓ Create a Mail Merge 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 10 
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Advanced Reporting 

Course Overview and Learning Objectives 

This course covers how to organize report information, format reports, include charts in a 

report, add a calculated field to a report, and add a subreport to an existing report.  

Course Outline 

✓ Organize Report Information 

✓ Format Reports 

✓ Include Charts in a Report 

✓ Add a Calculated Field to a Report 

✓ Add a Subreport to an Existing Report 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 11 

 

Additional Reporting Options 

Course Overview and Learning Objectives 

In the final course, how to create a mailing label report and how to publish a report as a 

PDF will be covered.  

Course Outline 

✓ Create a Mailing Label Report 

✓ Publish a Report as PDF 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 12 
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Microsoft Access 2016: Part 2 

Implementing Advanced Form Design 

Course Overview and Learning Objectives 

This course takes a look at several topics to increase your students’ knowledge of Access 

2016. Here, students will learn how to add controls to forms, set form controls, create 

subforms, organize information with tab pages, enhance database navigation with forms, 

format a form, and apply conditional formatting.  

Course Outline 

✓ Add Controls to Forms 

✓ Set Form Controls 

✓ Create Subforms 

✓ Organize Information with Tab Pages 

✓ Enhance Navigation with Forms 

✓ Format a Form 

✓ Apply Conditional Formatting 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 1 

 

Using Data Validation 

Course Overview and Learning Objectives 

In this second course, the focus switches to data validation. Covered here is field 

validation along with form and record validation.  

Course Outline 

✓ Field Validation 

✓ Form and Record Validation 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 2 
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Using Macros to Improve User Interface Design 

Course Overview and Learning Objectives 

This course turns to macros and using them to improve user interface design. The topics 

covered here are: create a macro, restrict records using a condition, validate data using a 

macro, automate data entry using a macro, and convert a macro to VBA.  

Course Outline 

✓ Create a Macro 

✓ Restrict Records Using a Condition 

✓ Validate Data Using a Macro 

✓ Automate Data Entry Using a Macro 

✓ Convert a Macro to VBA 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 3 

 

Using Advanced Database Management 

Course Overview and Learning Objectives 

Some advanced database management skills come under scrutiny in this course. Topics in 

this lesson teach your students how to: link tables to external data sources, manage a 

database, determine object dependency, document a database, and analyze the 

performance of a database.  

Course Outline 

✓ Link Tables to External Data sources 

✓ Manage a Dataase 

✓ Determine Object Dependency 

✓ Document a Database 

✓ Analyze the Performance of a Database 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 82 

Distributing and Securing a Database 

Course Overview and Learning Objectives 

In this course, the topics covered are: split a database for multiple user access, implement 

security, set passwords, convert an Access database to an ACCDE file, and package a 

database with a digital signature.  

Course Outline 

✓ Split a Database for Multiple User Access 

✓ Implement Security 

✓ Set Passwords 

✓ Convert an Access Database to an ACCDE File 

✓ Package a Database with a Digital Signature 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 5 

 

Managing Switchboards 

Course Overview and Learning Objectives 

The final course of Microsoft Access 2016 Part Two, is all about switchboards. Students 

are taught how to create a database switchboard, how to modify a database switchboard, 

and how to set startup options.  

Course Outline 

✓ Create a Database Switchboard 

✓ Modify a Database Switchboard 

✓ Set Startup Options 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2016: Part 2, Lesson 6 
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Microsoft Excel 2016: Part 1 

Getting Started with Microsoft Excel 2016 

Course Overview and Learning Objectives 

In this course, students will learn how to identify the elements of the Excel interface, 

create a basic worksheet, and use the help system. 

Course Outline 

✓ Identify the Elements of the Excel Interface 

✓ Create a Basic Worksheet 

✓ Use the Help System 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 1 

Performing Calculations 

Course Overview and Learning Objectives 

This course covers how to create formulas in a worksheet, insert functions in a worksheet, 

and reuse formulas. 

Course Outline 

✓ Create Formulas in a Worksheet 

✓ Insert Functions in a Worksheet 

✓ Reuse Formulas  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 2 
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Modifying a Worksheet 

Course Overview and Learning Objectives 

In this course, students will learn how to manipulate data, as well as how to insert, 

manipulate, and delete cells, columns, and rows. Searching for and replacing data and how 

to spell check a worksheet are also discussed. 

Course Outline 

✓ Manipulate Data 

✓ Insert, Manipulate, and Delete Cells, Columns, and Rows 

✓ Search For and Replace Data 

✓ Spell check a Worksheet  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 3 

Formatting a Worksheet 

Course Overview and Learning Objectives 

This course covers how to modify fonts, add borders and colors to cells, apply number 

formats, align cell contents, and apply cell styles. 

Course Outline 

✓ Modify Fonts 

✓ Add Borders and Colors to Cells 

✓ Apply Number Formats 

✓ Align Cell Contents 

✓ Apply Cell Styles  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 4 
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Printing Workbook Contents 

Course Overview and Learning Objectives 

In this course, students will learn how to define the basic page layout for a workbook, 

refine the page layout, and apply print options. 

Course Outline 

✓ Define the Basic Page Layout for a Workbook 

✓ Refine the Page Layout and Apply Print Options  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 5 

Managing Large Workbooks 

Course Overview and Learning Objectives 

This course will teach students how to format worksheet tabs, manage worksheets, and 

manage the view of worksheets and workbooks. 

Course Outline 

✓ Format Worksheet Tabs 

✓ Manage Worksheets 

✓ Manage the View of Worksheets and Workbooks  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 6 
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Customizing the Excel Environment 

Course Overview and Learning Objectives 

In this course, students will learn how to customize general, language, formula, proofing, 

and saving options. It also covers how to use Excel’s version control features, customize 

the ribbon and the Quick Access toolbar, enable add-ins, and customize advanced and 

Trust Center options. 

Course Outline 

✓ Customize General and Language Options 

✓ Customize Formula Options 

✓ Customize Proofing and Save Options 

✓ Customize the Ribbon and Quick Access Toolbar 

✓ Customize the Functionalify of Exel by Enabling Add-ins 

✓ Customize Advanced and Trust Center Options  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 1, Lesson 7 
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Microsoft Excel 2016 Part 2 

Creating Advanced Formulas 

Course Overview and Learning Objectives 

In this lesson, students will learn how to use range names in formulas and functions, as 

well as how to use specialized functions. 

Course Outline 

✓ Apply Range Names 

✓ Use Specialized Functions 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 1 

Analyzing Data with Logical and Lookup Functions 

Course Overview and Learning Objectives 

Next, students will learn how to analyze data by using text, logical, lookup, date and 

financial functions. 

Course Outline 

✓ Use Text Functions 

✓ Use Logical Functions 

✓  Use Lookup Functions 

✓ Use Date Functions 

✓ Use Financial Functions 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 2 
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Organizing and Analyzing Datasets and Tables 

Course Overview and Learning Objectives 

This lesson covers how to create and modify tables, sort and filter data, use subtotal 

features, and work with database functions. 

Course Outline 

✓ Create and Modify Tables 

✓ Sort and Filter Data 

✓ Use Subtotal and Database Functions to Calculate Data 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 3 

Analyzing Data with Logical and Lookup Function Visualizing Data with Charts 

Course Overview and Learning Objectives 

Students will learn how to create charts, as well as how to modify and format existing 

charts. They will also learn how to create a trendline and advanced charts. 

Course Outline 

✓ Create Charts 

✓ Modify and format Charts 

✓ Create a Trendline 

✓ Create Advanced Charts  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 89 

Analyzing Data with PivotTables, Slicers, and PivotCharts 

Course Overview and Learning Objectives 

Creating a PivotTable, filtering data using slicers and, analyzing data using PivotCharts 

will be covered in this lesson. 

Course Outline 

✓ Create a PivotTable  

✓ Filter Data by Using Slicers 

✓ Analyze Data with PivotCharts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 5 

Inserting Graphics 

Course Overview and Learning Objectives 

Students will learn how to insert, modify, layer and group graphical objects. We will also 

take a look at how to incorporate SmartArt into workbooks. 

Course Outline 

✓ Insert and Modify Graphic Objects 

✓ Layer and Group Graphic Objects 

✓ Incorporate SmartArt  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 6 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 90 

Enhancing Workbooks 

Course Overview and Learning Objectives 

In this final lesson, students will learn how to customize workbooks, manage themes and, 

create and use templates. Protecting files and preparing a workbook for multiple 

audiences will also be covered. 

Course Outline 

✓ Customize Workbooks 

✓ Manage Themes 

✓ Create and Use Templates 

✓ Protect Files 

✓ Preparing a Workbook for Multiple Audiences 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 2, Lesson 7 
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Microsoft Excel 2016: Part 3 

Automating Worksheet Functionality 

Course Overview and Learning Objectives 

This course gives students the skills to dig into automating worksheet functionality. Along 

the way they will learn how to update worksheet properties, create and edit a macro, 

apply conditional formatting, and add data validation criteria to a workbook. 

Course Outline 

✓ Update Workbook Properties  

✓ Create and Edit a Macro  

✓ Apply Conditional Formatting 

✓ Add Data Validation Criteria 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 1 

 

Auditing Worksheets 

Course Overview and Learning Objectives 

This course digs deeper into worksheets and students will learn here how to: trace cells, 

troubleshoot invalid data and formula errors, watch and evaluate formulas, and create a 

data list online. 

Course Outline 

✓ Trace Cells 

✓ Troubleshoot Invalid Data and Formula Errors 

✓ Watch and Evaluate Formulas 

✓ Create a Data List Outline 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 2 
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Analyzing and Presenting Data 

Course Overview and Learning Objectives 

Now that students are very well versed in worksheets, it’s time to move into a deeper look 

at data with this course. Students will learn here how to: create Sparklines, create 

scenarios, perform a what-if analysis, perform statistical analysis with the Analysis 

ToolPak, and create interactive data with Power View. 

Course Outline 

✓ Create Sparklines  

✓ Create Scenarios 

✓ Perform a What-If Analysis 

✓ Perform a Statistical Analysis with the Analysis ToolPak 

✓ Create Interactive Data with Power View 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 3 

 

Working with Multiple Workbooks 

Course Overview and Learning Objectives 

Often times, users of Excel will be juggling multiple workbooks at once and this lesson 

takes a look at that skill. This course will teach students how to: consolidate data, link cells 

in different workbooks, and merge workbooks. 

Course Outline 

✓ Consolidate Data 

✓ Link Cells in Different Workbooks 

✓ Merge Workbooks 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 4 
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Exporting Excel Data 

Course Overview and Learning Objectives 

Students have their data and they want to export it, well they can learn about that here. 

This course covers how to: export Excel data, import an delimited text file, integrate Excel 

data with the web, and create a web query. 

Course Outline 

✓ Export Excel Data 

✓ Import a Delimited Text File 

✓ Integrate Excel Data with the Web 

✓ Create a Web Query 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 5 

 

Importing and Exporting XML Data 

Course Overview and Learning Objectives 

This course wraps up here with this lesson showing your students how to import and 

export XML data. 

Course Outline 

✓ Import and Export XML Data  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: Part 3, Lesson 6 
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Microsoft Excel 2016 and VBA 

Developing Macros 

Course Overview and Learning Objectives 

This course gets students right into the thick of developing macros for Excel 2016. It 

shows how to create a macro using the Macro Recorder, how to edit a macro, and how to 

debug a macro. It also covers how to customize the Quick Access toolbar and hotkeys and 

looks at how to set macro security. 

Course Outline 

✓ Create a Macro Using the Macro Recorder 

✓ Edit a Macro 

✓  Debug a Macro 

✓ Customize the Quick Access Toolbar and Hotkeys 

✓ Set Macro Security 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: and VBA, Lesson 1 

 

Formatting Worksheets Using Macros 

Course Overview and Learning Objectives 

This course digs into the skills of worksheet formatting. Covered in this course is how to: 

insert text with a macro, format text with a macro, sort data with a macro, duplicate data 

with a macro, and generate a report with a macro. 

Course Outline 

✓ Insert Text 

✓ Format Text 

✓ Sort Data 

✓ Duplicate Data 

✓ Generate a Report  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: and VBA, Lesson 2 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 95 

Creating an Interactive Worksheet 

Course Overview and Learning Objectives 

The third of five courses covers interactive worksheets. Up for consideration here are the 

topics of how to determine the appropriate dialog box types to use and how to capture 

user input using a variety of techniques.  

Course Outline 

✓ Determine the Dialog Box Type  

✓ Capture User Input 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: and VBA, Lesson 3 

 

Working with Multiple Worksheets 

Course Overview and Learning Objectives 

The topics of this course are how to: insert, copy, and delete worksheets using macros, 

rename worksheets using macros, modify the order of worksheets using macros, and print 

worksheets using macros. 

Course Outline 

✓ Insert, Copy, and Delete Worksheets 

✓ Rename Worksheets 

✓ Modify the Order of Worksheets 

✓ Print Worksheets 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: and VBA, Lesson 4 
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Performing Calculations 

Course Overview and Learning Objectives 

The final course covers how to create user-defined functions in macros and how to 

automate SUM functions with a macro. 

Course Outline 

✓ Create User-Defined Functions  

✓ Automate SUM Functions 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: and VBA, Lesson 5 
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Microsoft Excel 2016: PowerPivot 

Getting Started with PowerPivot 

Course Overview and Learning Objectives 

This initial course shows students how to: explore the PowerPivot application, import 

data from sources, refresh data, and create linked tables. 

Course Outline 

✓ Enable and Navigate 

✓ Import Data from Various Data sources 

✓ Refresh Data from a Data source 

✓ Create Linked Tables 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: PowerPivot, Lesson 1 

 

 Manipulating PowerPivot Data 

Course Overview and Learning Objectives 

Students will learn how to: organize and format tables, create calculated columns, sort 

and filter PowerPivot data, and create and manage table relationships. 

Course Outline 

✓ Organize and Format Tables 

✓ Create Calculated Columns 

✓ Sort and Filter PowerPivot Data 

✓ Create and Manage Table Relationships  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: PowerPivot, Lesson 2 
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Creating PowerPivot Reports 

Course Overview and Learning Objectives 

In this course, students build upon what they have learned by being shown how to: create 

PivotTables and PivotCharts, filter data using slicers, and present PivotTable data visually. 

Course Outline 

✓ Create PivotTables 

✓ Create PivotCharts 

✓ Create Power Views 

✓ Filter Data Using Slicers 

✓ Present PivotTable Data Visually 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: PowerPivot, Lesson 3 

 

Using DAX Functions in PowerPivot 

Course Overview and Learning Objectives 

Students will learn how to: manipulate PowerPivot data using DAX functions, extract data 

from tables using functions, and work with time dependent data. 

Course Outline 

✓ Manipulate PowerPivot Data Using DAX Functions 

✓ Extract Data from Tables Using Functions 

✓ Work with Time Dependent Data 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: PowerPivot, Lesson 4 
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Distributing PowerPivot Data 

Course Overview and Learning Objectives 

This course looks at how to protect reports and how to save reports in different file 

formats. 

Course Outline 

✓ Protect Reports 

✓ Save Reports in Different File Formats 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2016: PowerPivot, Lesson 5 
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Microsoft Office 2016: Transition Between 2007/2010 

Getting Started with Microsoft Office 2016 

Course Overview and Learning Objectives 

This course looks at differences between Office 2016 and Office 365, and also looks at 

some defining new features. The course then moves on to discuss how Office 2016 

interacts with the cloud. 

Course Outline 

✓ Common Features 

✓ Office 2016 and the Cloud  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 1 

 

Working with Microsoft Word 2016 

Course Overview and Learning Objectives 

This course delves into Word 2016 and looks at how to reflow and edit PDFs, edit and 

read documents, work with tables, and embed videos. 

Course Outline 

✓ Edit a PDF 

✓ Work with Tables 

✓ Embed Videos 

✓ Edit documents 

✓ Read documents 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 2 
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Working with Microsoft Excel 2016 

Course Overview and Learning Objectives 

Excel is always a popular component in Office and it’s up for consideration here. Students 

will learn how to: streamline workflow in Excel using templates, accelerate data entry 

with flash fill, incorporate charts, analyze data, and use business intelligence. 

Course Outline 

✓ Streamline Workflow in Excel Using Templates 

✓ Accelerate Data Entry with flash Fill 

✓ Incorporate Charts 

✓ Analyze Data 

✓ Business Intelligence Features  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 3 

 

Working with Microsoft PowerPoint 2016 

Course Overview and Learning Objectives 

Now we’ve gotten around to looking at working with PowerPoint 2016. The objectives of 

this course are to teach students how to: apply a template and theme, incorporate objects 

into a presentation, use enhanced presentation tools, and collaborate with others on a 

single presentation. 

Course Outline 

✓ Apply a Template and Theme 

✓ Incorporate Objects 

✓ Using enhanced Presenter Tools 

✓ Collaborate with Others on a Single Presentation 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 4 
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Working with Microsoft Access 2016 

Course Overview and Learning Objectives 

In this course, students are going to learn about: Access web apps, web app templates, 

web app views, database templates, and user-created templates. 

Course Outline 

✓ Explore Web Apps 

✓ Utilize Templates in Access  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 5 

Working with Microsoft Outlook 2016 

Course Overview and Learning Objectives 

The final course teaches students how to: navigate through the Mail, Calendars, People, 

and Tasks workspaces. It also shows how to manage a mailbox. 

Course Outline 

✓ Navigation Through Mail, Calendars, People and Tasks 

✓ Manage Your Mailbox 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 2016: Transition Between 2007/2010, Lesson 6 
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Microsoft OneNote 2016  

Exploring Notebook Structure 

Course Overview and Learning Objectives 

This session gets users in the on the ground floor with a look at the basics. Here, students 

will learn how to navigate their way around OneNote 2016, how to create a notebook, use 

templates, and customize the interface. 

Course Outline 

✓ Navigate the OneNote 2016 Environment 

✓ Create a Notebook 

✓ Use Predesigned Templates for OneNote Notebooks 

✓ Customize the User Interface  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 1 

 

Adding Content and Formats to a OneNote Notebook 

Course Overview and Learning Objectives 

This course shows students how to: modify notebook formatting, add images and tables, 

add audio and video while also adding Quick Notes and links. Students are also shown how 

to use tags, symbols, drawing tools, and pen options. 

Course Outline 

✓ Modify Formatting in a Notebook 

✓ Add Images to a Notebook 

✓ Add Tables to a Notebook 

✓ Add Audio and Video to a Notebook 

✓ Add Quick Notes and Links 

✓ Use Tags, Symbols, Drawing Tools, and Pen Options 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 2 
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Managing OneNote Notebooks, History, and Backups 

Course Overview and Learning Objectives 

Over the span of this course, students will learn ways to save and export content as well 

as use alternate file types. The lesson wraps up with a look at how to manage notebook 

recycle bins and backups. 

Course Outline 

✓ Save and Export Content and Use Alternate File Types 

✓ Manage Notebook Recycle Bins and Backups 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 3 
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Working with Embedded Files 

Course Overview and Learning Objectives 

OneNote can mesh seamlessly with other Microsoft programs such as Excel and Visio and 

this course looks at ways to work with their spreadsheets and diagrams. Students are also 

shown how to work with other embedded files. 

Course Outline 

✓ Work with Excel Spreadsheets and Visio Diagrams 

✓ Work with Embedded Files  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 4 
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Sharing and Collaborating with Notebooks 

Course Overview and Learning Objectives 

Sharing and collaborating are the hallmarks of the modern linked workplace and those 

skills are covered here. Students will learn to send a notebook and use Outlook 

integration. They will also learn how to share and collaborate on notebooks. 

Course Outline 

✓ Send a Notebook and Use Outlook Integration 

✓ Share and Collaborate on Notebooks  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 5 

 

Working with Embedded Files 

Course Overview and Learning Objectives 

This OneNote 2016 course wraps up with a look at finalizing a notebook and various 

related aspects. Students are taught how to finalize a notebook using proofing and print 

settings, how to configure notebooks settings, properties, and security. They will also 

learn how to search notebooks. 

Course Outline 

✓ Finalize a Notebook Using Proofing and Print Settings 

✓ Configure Notebook Properties and Security 

✓ Search Notebooks 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2016, Lesson 6 
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Microsoft Outlook 2016: Part 1 

Getting Started with Outlook 2016 

Course Overview and Learning Objectives 

To begin this course, students will learn how to navigate the Outlook interface, perform 

basic e-mail functions, and use Outlook help (including the new Tell Me feature). 

Course Outline 

✓ Navigate the Outlook Interface 

✓ Perform Basic E-mail Functions 

✓ Use Outlook Help  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 1 

 

Composing Messages 

Course Overview and Learning Objectives 

This lesson covers how to create an e-mail message, check spelling and grammar, and 

format message content. Then, students will learn about e-mail attachments, enhancing 

messages, and managing automatic message content. 

Course Outline 

✓ Identify the Elements of the Excel Interface 

✓ Create a Basic Worksheet 

✓ Use the Help System 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 2 
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Reading and Responding to Messages 

Course Overview and Learning Objectives 

To begin this course, students will learn how to navigate the Outlook interface, perform 

basic e-mail functions, and use Outlook help (including the new Tell Me feature) Next, 

students will learn how to customize reading options, work with attachments, and manage 

message responses. 

Course Outline 

✓ Customize Reading Options 

✓  Work with Attachments 

✓ Manage Your Message Responses 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 3 

 

Managing Your Messages 

Course Overview and Learning Objectives 

This lesson focuses on managing messages using tags, flags, and other commands, as well 

as organizing messages using folders. 

Course Outline 

✓ Manage Messages Using Tags, Flags, and Other Commands 

✓ Organize Messages Using Folders  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 109 

Managing Your Calendar 

Course Overview and Learning Objectives 

In this lesson, students will learn how to view and print the calendar, as well as how to 

manage appointments and meetings. 

Course Outline 

✓ View the Calendar 

✓ Manage Appointments 

✓ Manage Meetings 

✓ Print Your Calendar 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 5 

 

Managing Your Contacts 

Course Overview and Learning Objectives 

How to create, update, view, and organize contacts using the People workspace will be 

covered in this lesson. 

Course Outline 

✓ Create and Update Contacts 

✓  View and Organize Contacts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 6 
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Working with Tasks and Notes 

Course Overview and Learning Objectives 

This lesson is all about managing tasks and notes. 

Course Outline 

✓ Create Tasks 

✓ Manage Tasks 

✓ Manage Notes  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 7 

 

Customizing the Outlook Environments 

Course Overview and Learning Objectives 

This final lesson covers how to customize the Outlook interface, as well as creating and 

managing Quick Steps. 

Course Outline 

✓ Customize the Outlook Interface 

✓ Create and Manage Quick Steps  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 1, Lesson 8 
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Microsoft Outlook 2016: Part 2 

Configuring Advanced Message Options 

Course Overview and Learning Objectives 

This lesson gives students a look at how to insert advanced characters and objects, how to 

modify message settings, properties, and options, and how to use automatic replies. 

Course Outline 

✓ Insert Advanced Characters and Objects 

✓ Modify Message Settings, Properties, and Options 

✓ Using Automatic Replies 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 1 

 

Advanced Message Management 

Course Overview and Learning Objectives 

Several topics are covered in this course, including: sort, filter, organize and search 

messages, manage junk mail, and manage your mailbox. 

Course Outline 

✓ Sort Messages 

✓ Filter Messages 

✓ Organize Messages 

✓ Search Messages 

✓ Manage Junkmail 

✓ Manage Your Mailbox 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 2 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 112 

Advanced Calendar and Task Management 

Course Overview and Learning Objectives 

Here, students are introduced to how to: manage advanced calendar options, manage 

additional calendars, manage meeting responses, and how to assign and manage tasks. 

Course Outline 

✓ Manage Advanced Calendar Options 

✓ Manage Additional Calendars 

✓ Manage Meeting Responses 

✓ Assign and Manage Tasks 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 3 

 

Advanced Contact Management 

Course Overview and Learning Objectives 

This course takes a look at dealing with contacts and how to edit an electronic business 

card, manage advanced contact options, forward contacts, and export contacts. 

Course Outline 

✓ Edit an Electronic Business Card 

✓ Manage Advanced Contact Options 

✓ Forward Contacts 

✓ Export Contacts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 4 
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Sharing Workspaces with Others 

Course Overview and Learning Objectives 

In this lesson, students are taught how to delegate access to mail folders, how to share 

your calendar, and how to share your contacts. 

Course Outline 

✓ Delegate Access to Mail Folders 

✓ Share Your Calendar 

✓ Share Your Contacts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 5 

 

Managing Outlook Data Files 

Course Overview and Learning Objectives 

Covered in this course is how to back up Outlook items and how to change data file 

settings. 

Course Outline 

✓ Back Up Outlook Items 

✓ Change Data File Settings 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 6 
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Managing E-mail Security 

Course Overview and Learning Objectives 

Email security is the focus of this course and how to configure e-mail message security. 

Course Outline 

✓ Configure e-mail Message Security Settings 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2016: Part 2, Lesson 7 
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Microsoft PowerPoint 2016: Part 1 

Getting Started with PowerPoint 2016 

Course Overview and Learning Objectives 

Students will learn how to navigate the PowerPoint environment, create and save a 

PowerPoint presentation, and use PowerPoint help (including the new Tell Me feature). 

Course Outline 

✓ Navigate the PowerPoint Environment 

✓ Create and Save a PowerPoint Presentation 

✓ Use Help  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 1 

 

Developing a PowerPoint Presentation 

Course Overview and Learning Objectives 

This course covers the key steps in developing a PowerPoint presentation: selecting a 

presentation type, building the presentation itself, laying out the presentation, editing 

text, and viewing and navigating the presentation. 

Course Outline 

✓ Select a Presentation Type 

✓ Build a Presentation 

✓ Lay Out a Presentation  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 2 
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Performing Advanced Text Editing 

Course Overview and Learning Objectives 

This lesson provides techniques for formatting characters, paragraphs, and text boxes. 

Course Outline 

✓ Format Characters 

✓ Format Paragraphs 

✓ Format Text Boxes 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 3 

 

Adding Graphical Elements to Your Presentation 

Course Overview and Learning Objectives 

Students will learn how to add images, screenshots, screen recordings, shapes, and 

WordArt to a presentation. 

Course Outline 

✓ Insert Images 

✓ Insert Shapes 

✓ Insert WordArt 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 4 
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Modifying Objects in Your Presentation 

Course Overview and Learning Objectives 

Topics covered in this lesson include how to edit, format, group, and arrange objects. 

Students will also be introduced to PowerPoint’s animation features. 

Course Outline 

✓ Edit Objects 

✓ Format Objects 

✓ Group Objects 

✓ Arrange Objects 

✓ Animate Objects 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 5 

 

Adding Tables to Your Presentation 

Course Overview and Learning Objectives 

This course focuses on how to create and format a table. Ways to add data from other 

Microsoft Office applications are also discussed. 

Course Outline 

✓ Create a Table 

✓ Format a Table 

✓ Insert a Table from Other Microsoft Office Applications 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 6 
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Adding Charts to Your Presentation 

Course Overview and Learning Objectives 

Students will learn how to create, format, and manipulate a chart. The course will 

conclude with a brief look at inserting a chart from Microsoft Excel. 

Course Outline 

✓ Create a Chart 

✓ Format a Chart 

✓ Manipulate a Chart 

✓ Insert a Chart from Microsoft Excel 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 7 

 

Preparing to Deliver Your Presentation 

Course Overview and Learning Objectives 

In this final course, students will learn how to review, print, and deliver a presentation. 

Techniques for applying transitions to slides will also be covered. 

Course Outline 

✓ Review Your Presentation 

✓ Apply Transitions 

✓ Print Your Presentation 

✓ Deliver Your Presentation 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 1, Lesson 8 
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Microsoft PowerPoint 2016: Part 2 

Modifying the PowerPoint Environment 

Course Overview and Learning Objectives 

This lesson gives students a look at the PowerPoint environment and how to modify it. 

They will learn about how to customize the user interface and how to set options. 

Course Outline 

✓ Customize the User Interface  

✓ Set PowerPoint 2016 Options  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 1 

 

Customizing Design Templates 

Course Overview and Learning Objectives 

Making the most of the customizability of PowerPoint is the focus of this lesson, 

templates in particular. This lesson gives your students a look at how to create and 

manage sections, modify slide masters and slide layouts, add headers and footers, and 

modify the notes master and the handout master. 

Course Outline 

✓ Create and Manage Sections  

✓ Modify Slide Masters and Slide Layouts 

✓ Add Headers and Footers 

✓ Modify the Notes Master and the Handout Master  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 2 
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Adding SmartArt to a Presentation 

Course Overview and Learning Objectives 

SmartArt can add so much to any presentation and help bring it to life. This lesson shows 

your students how to create SmartArt and how to modify SmartArt. 

Course Outline 

✓ Create SmartArt  

✓ Modify SmartArt  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 3 

 

Working with Media and Animations 

Course Overview and Learning Objectives 

Various types of media and animations are also items that can be used to enhance 

presentations. This lesson looks at them and how students can add audio and video to a 

presentation and how to customize animations and transitions. 

Course Outline 

✓ Add Audio to a Presentation  

✓ Add Video to a Presentation 

✓  Customize Animations and Transitions 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 4 
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Collaborating on a Presentation 

Course Overview and Learning Objectives 

Sometimes a presentation is the work of many hands and therefore collaboration is 

possible in PowerPoint. Students are shown in this lesson how to add comments to a 

presentation, how to review a presentation, and how to store and share presentations on 

the web. 

Course Outline 

✓ Add Comments to a Presentation 

✓ Review a Presentation 

✓ Store and Share Presentations on the Web  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 5 

 

Customizing a Slide Show 

Course Overview and Learning Objectives 

Here’s where your students get a better grip on how to customize their slide shows. This 

lesson covers how to: annotate a presentation, set up a slide show, create a custom slides 

show, add hyperlinks and action buttons, and record a presentation. 

Course Outline 

✓ Annotate a Presentation 

✓ Set Up a Slide Show 

✓ Create a Custom Slide Show 

✓ Add Hyperlinks and Action Buttons 

✓  Record a Presentation 

✓  Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 6 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 122 

Securing and Distributing a Presentation 

Course Overview and Learning Objectives 

This course wraps up with the security and distribution of a presentation. The topic here 

are: secure a presentation, present a slide show online and create a video or CD. 

Course Outline 

✓ Secure a Presentation 

✓ Present a Slide Show Online 

✓ Create a Video or a CD 

✓  Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2016: Part 2, Lesson 7 
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Microsoft Project 2016: Part 1 

Starting a Project 

Course Overview and Learning Objectives 

You need to walk before you can run, and that’s why this lesson starts with the basics such 

as Project Management 101, how to navigate and customize the Project 2016 Interface, 

add tasks to a project, add resources to a project, and save a project. 

Course Outline 

✓ Project Management 101 

✓ Navigate and Customize the Project 2016 Interface 

✓ Add Tasks to a Project 

✓ Add Resources to a Project 

✓ Save a Project 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 1, Lesson 1 

 

Working with Project Calendars 

Course Overview and Learning Objectives 

Once students are familiar with the basics, it’s time to move onward. The second lesson 

takes a look at how to manage project time frames and how to change working time. 

Course Outline 

✓ Manage Project Time Frames 

✓ Change Working Time 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 1, Lesson 2 
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Working with Project Tasks 

Course Overview and Learning Objectives 

Tasks get a full consideration here as students are shown how to manage project tasks 

and add summary tasks and milestones. 

Course Outline 

✓ Manage Project Tasks 

✓ Add Summary Tasks and Milestones  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 1, Lesson 3 

 

Working with Project Resources 

Course Overview and Learning Objectives 

This is where students will learn more about project resources as the topics here include: 

manage project resources, and allocate and level work resources. 

Course Outline 

✓ Manage Project Resources 

✓ Allocate and Level Work Resources 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 1, Lesson 4 
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Delivering a Project Plan 

Course Overview and Learning Objectives 

This final course covers project plans and looks at how to print project views, share 

projects, and export projects. 

Course Outline 

✓ Print Project Views 

✓ Share Projects 

✓ Export Projects  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 1, Lesson 5 
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Microsoft Project 2016: Part 2 

Managing the Project Environment 

Course Overview and Learning Objectives 

Students will start in this course by learning how to link projects. They will then progress 

through learning how to create and user resource pools, how to baseline a project, how to 

work with custom fields, how to change project options and extend Project with apps. 

Course Outline 

✓ Link Projects 

✓ Create and Use Resource Pools 

✓ Baseline a Project 

✓ Work with Custom Fields 

✓ Change Project Options 

✓ Extend Project with Apps 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 2, Lesson 1 

Managing Task Structures 

Course Overview and Learning Objectives 

This course covers several topics. Here, students will learn how to: change a task list, 

create a network diagram, manage the critical path, use lag and lead, update project work, 

and analyze earned value. 

Course Outline 

✓ Change a Task List 

✓ Create a Network Diagram 

✓ Manage the Critical Path 

✓ Use Lag and Lead 

✓ Update Project Work 

✓ Analyze Earned Value 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 2, Lesson 2 
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Generating Project Views 

Course Overview and Learning Objectives 

The four topics in this course are: Use View Commands, Use Existing Views, Create 

Custom Views, and Format and Share the Timeline View. 

Course Outline 

✓ Use View Commands 

✓ Use Existing Views 

✓ Create Custom Views 

✓ Format and Share the Timeline View 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 2, Lesson 3 

Producing Project Reports 

Course Overview and Learning Objectives 

Topics in this final course show students ways to: use existing reports and create custom 

ones, and export visual reports. 

Course Outline 

✓ Use Existing Reports 

✓ Create Custom Reports 

✓ Export Visual Reports 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2016: Part 2, Lesson 4 
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Microsoft Publisher 2016  

Getting Started with Microsoft Publisher 2016 

Course Overview and Learning Objectives 

This lesson gives students a look at the PowerPoint environment and how to modify it. 

They will learn about how to customize the user interface and how to set options. 

Course Outline 

✓ Explore the Interface 

✓ Customize the Publisher Interface 

✓ Create a Publication 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 1 

 

Adding Content to a Publication 

Course Overview and Learning Objectives 

Making the most of the customizability of PowerPoint is the focus of this lesson, 

templates in particular. This lesson gives your students a look at how to create and 

manage sections, modify slide masters and slide layouts, add headers and footers, and 

modify the notes master and the handout master. 

Course Outline 

✓ Add Text to a Publication 

✓ Organize Text Boxes and Picture Placeholders in a Layout 

✓ Control the Display of Content in Text Boxes 

✓ Use Building Blocks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 2 
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Formatting Text in a Publication 

Course Overview and Learning Objectives 

This lesson gives students a look at the PowerPoint environment and how to modify it. 

They will learn about how to customize the user interface and how to set options. 

Course Outline 

✓ Format Text and Paragraphs 

✓ Apply Paragraph Styles 

✓ Apply Schemes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 3 

 

Editing Text in a Publication 

Course Overview and Learning Objectives 

Making the most of the customizability of PowerPoint is the focus of this lesson, 

templates in particular. This lesson gives your students a look at how to create and 

manage sections, modify slide masters and slide layouts, add headers and footers, and 

modify the notes master and the handout master. 

Course Outline 

✓ Edit Text in a Publication 

✓ Present Content in Tables 

✓ Insert Symbols and Special Characters 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 4 
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Adding and Formatting Graphics in a Publication 

Course Overview and Learning Objectives 

This lesson gives students a look at the PowerPoint environment and how to modify it. 

They will learn about how to customize the user interface and how to set options. 

Course Outline 

✓ Add Graphical Objects to a Publication 

✓ Manipulate the Appearance of Pictures 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 5 

 

Preparing a Publication for Printing and Sharing 

Course Overview and Learning Objectives 

Making the most of the customizability of PowerPoint is the focus of this lesson, 

templates in particular. This lesson gives your students a look at how to create and 

manage sections, modify slide masters and slide layouts, add headers and footers, and 

modify the notes master and the handout master. 

Course Outline 

✓ Save a Publication 

✓ Run the Design checker 

✓ Preview and Print a Publication 

✓ Share a Publication 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2016, Lesson 6 
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Microsoft SharePoint 2016 for Users 

Opening and Navigating SharePoint Team Sites 

Course Overview and Learning Objectives 

First things first, this course is going to teach users how to access SharePoint sites and 

navigate through them. 

Course Outline 

✓ Access SharePoint Sites 

✓ Navigate SharePoint Sites 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 1 

Working with SharePoint Content  

Course Overview and Learning Objectives 

This is where students will learn how to add documents to SharePoint and search a 

SharePoint site. 

Course Outline 

✓ Adding Documents 

✓ Searching SharePoint 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 2 
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Using Lists 

Course Overview and Learning Objectives 

We’re going to take a look at lists here. Up for discussion is how to: add items to lists, 

modify list items, configure list views, and filter, group, and sort lists. 

Course Outline 

✓ Add Items to Lists 

✓ Modifying List Items 

✓ Configure List Views 

✓ Filter, Group, and Sort List Data 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 3 

Using Collaboration and Communication Features 

Course Overview and Learning Objectives 

Collaboration is what SharePoint is all about, the name basically says that: share point. In 

this course, your students will learn how to update and share a profile, share and follow 

content, and create a blog post. 

Course Outline 

✓ Update and Share Your Profile 

✓ Share and Follow SharePoint Content 

✓ Create a Blog Post 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 4 
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Using SharePoint with Microsoft Office 

Course Overview and Learning Objectives 

SharePoint is a Microsoft product, and so it Office, it only makes sense that they would 

work together and that’s what is covered here. This course looks at: how to open and save 

SharePoint documents in Office, how to use document version, and how to access 

SharePoint using Outlook 2016. 

Course Outline 

✓ Open and Save SharePoint Documents with Microsoft Office 

✓ Use Document Versions in Microsoft Office 

✓ Access SharePoint Using Outlook 2016 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 5 

Accessing SharePoint Using Alternate Methods 

Course Overview and Learning Objectives 

Finally, students will look at how to synchronize OneDrive with SharePoint and how to 

use SharePoint with a mobile device. 

Course Outline 

✓ Synchronize OneDrive with SharePoint 

✓ Use SharePoint with a Mobile Device 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Users, Lesson 6 
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Microsoft SharePoint 2016 for Site Owners 

Creating a New Site 

Course Overview and Learning Objectives 

This introductory course shows students how to create a site and design a SharePoint site. 

Course Outline 

✓ Create a Site 

✓ Design Your SharePoint Site 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Owners, Lesson 1 

Adding and Configuring Libraries  

Course Overview and Learning Objectives 

Here, students are going to learn how to: configure a document library for a team site, 

configure the site assets library for a site, and add a wiki to your site. 

Course Outline 

✓ Configure a Document Library for a Team Site 

✓ Configure the Site Assets Library for a Site 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Owners, Lesson 2 
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Adding and Configuring Lists 

Course Overview and Learning Objectives 

This course is all about lists and shows learners how to add: an announcement list, a task 

list, contact lists, calendar lists, and a custom list. It also looks at how to add a blog. 

Course Outline 

✓ Add an Announcement List 

✓ Add a Task List 

✓ Add Contact and Calendar Lists 

✓ Add a Blog 

✓ Add a Custom List 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Owners, Lesson 3 

Configuring Site Settings  

Course Overview and Learning Objectives 

Site search options, site administration settings, and site navigation settings are all up for 

consideration here. 

Course Outline 

✓ Configure Site Search Options 

✓ Configure Site Administration Settings 

✓ Configure Site Navigation Settings 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Owners, Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 136 

Creating a New Site 

Course Overview and Learning Objectives 

In this final course, your students are going to learn about configuring site permissions 

and security options as well as securing site components. 

Course Outline 

✓ Access SharePoint Sites 

✓ Navigate SharePoint Sites 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Owners, Lesson 5 
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Microsoft SharePoint 2016 for Site Administrators 

Creating and Configuring Site Collections  

Course Overview and Learning Objectives 

This first course covers how to create a site collection, set quotas, configure audit options, 

and how to back up a site collection. 

Course Outline 

✓ Create a Site Collection 

✓ Set Quotas 

✓ Configure Audit Options 

✓ Back Up a Site Collection 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 1 

Configuring Top-Level Sites  

Course Overview and Learning Objectives 

Here, students are shown how to manage features and apps, how to add an RSS feed to a 

site, and how to create and configure document sets. 

Course Outline 

✓ Managing Features and Apps 

✓ Add an RSS Feed to Your Site 

✓ Create and Configure Document Sets 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 2 
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Configuring Site Collection Metadata  

Course Overview and Learning Objectives 

This course looks at creating content types and adding columns to content types. 

Course Outline 

✓ Create a New Content Type 

✓ Add Columns to Content Types 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 3 

Archiving and Compliance  

Course Overview and Learning Objectives 

Students are taught in this course how to configure site policies, configure in-place 

records management, configure information management policies, and configure and use 

the Content Organizer. 

Course Outline 

✓ Configure Site Policies 

✓ Configure In-Place Records Management 

✓ Configure Information Management Policies 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 4 
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Creating Workflows 

Course Overview and Learning Objectives 

Workflows get a discussion here with the topics covering what workflows are, about the 

components of a workflow and how to plan and develop a SharePoint workflow. 

Course Outline 

✓ Understanding Workflows 

✓ Create and Run a Workflow 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 5 

Implementing and Configuring Search  

Course Overview and Learning Objectives 

Search no more, this course is at an end and covered in this final course is: how to 

configure search options and how to configure search alerts. 

Course Outline 

✓ Configure Search Options 

✓ Create Search Alerts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint 2016 for Site Administrators, Lesson 6 
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Microsoft Skype for Business 2016 

Getting Started 

Course Overview and Learning Objectives 

This course is an introduction to Skype for Business — teaching how to launch and exit the 

program, how to communicate with contacts, and how to update your status information. 

Course Outline 

✓ Get started with Skype for Business 2016 

✓ Communicate with contacts 

✓ Update your status information 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business 2016, Lesson 1 

 

Working with Messages and Contacts 

Course Overview and Learning Objectives 

Sending instant messages, managing contacts and customizing the contacts view are 

among the topics covered in this course.  

Course Outline 

✓ Send instant messages and use related features 

✓ Manage contacts 

✓ Customize the contacts view 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business 2016, Lesson 2 
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Joining Meetings and Calls 

Course Overview and Learning Objectives 

In this course, various aspects of running Skype meetings are taught, including set-up, 

participation, presentation of content, and the addition of interactivity. 

Course Outline 

✓ Set up a Skype meeting 

✓ Participate in meetings 

✓ Present content in meetings 

✓ Add interactivity to meetings 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business 2016, Lesson 3 

 

Customizing Skype for Business 

Course Overview and Learning Objectives 

This course is all about customization of Skype for Business, from contact groups to 

options and using recording features.  

 

Course Outline 

✓ Customize contact groups 

✓ Use recording features 

✓ Customize Skype for Business options 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business 2016, Lesson 4 
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Microsoft Sway 

Getting Started with Sway  

Course Overview and Learning Objectives 

This course focuses on how to launch Sway, and how to begin using it — how create a new 

project, which is made up of cards, and how to save, edit, search and play projects.  

Course Outline 

✓ Launch Sway 

✓ Create a new Sway project 

✓ Create and manage cards 

✓ Manage Sway projects 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Sway, Lesson 1 

Working with Text and Images  

Course Overview and Learning Objectives 

Now that we know how to create projects and cards, we’ll turn our attention to working 

with text and adding media to Sway projects.  

Course Outline 

✓ Format text 

✓ Add media to a Sway project 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Sway, Lesson 2 
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Graphics and Design  

Course Overview and Learning Objectives 

Once media is inserted into a Sway project, images and design options can be customized 

to suit an individual’s preferences.   

Course Outline 

✓ Work with images 

✓ Customize image display 

✓ Set design options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Sway, Lesson 3 

Working with a Sway Project  

Course Overview and Learning Objectives 

This course concentrates on editing and sharing the project that’s been created, showing 

how to make it accessible, and how to print and export it. 

Course Outline 

✓ Edit Sway projects 

✓ Share a Sway project 

✓ Set Sway project options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Sway, Lesson 4 
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Microsoft Teams 

Getting Started 

Course Overview and Learning Objectives 

In this course, learn how to begin using Microsoft Teams: using channels, posting 

messages and getting help.  

Course Outline 

✓ Describe what Microsoft Teams is all about 

✓ Use channels and post messages 

✓ Get help in Teams 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Teams, Lesson 1 

Communicating in Channels 

Course Overview and Learning Objectives 

This course focuses on communicating within Microsoft Teams channels: working with 

messages, dealing with files and using the Wiki, which is a place to store information and 

make it accessible.  

Course Outline 

✓ Manage messages 

✓ Do more with messages 

✓ Manage files in a channel 

✓ Use the wiki 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Teams, Lesson 2 
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Using Other Communication Tools  

Course Overview and Learning Objectives 

Channels in Microsoft Teams facilitate group communication, but private messages can be 

sent using chat. Learn how to use chat in this course. 

Course Outline 

✓ Use chat 

✓ Manage meetings and files 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Teams Lesson 3 

Customizing Channels 

Course Overview and Learning Objectives 

Channels can be customized. Learn how to rename and delete channels, as well as add 

tabs and connectors. 

Course Outline 

✓ Customize channels 

✓ Add tabs and connectors to a channel 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Teams, Lesson 4 
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Customizing Your Teams Experience 

Course Overview and Learning Objectives 

This Microsoft Teams course teaches how to update your profile picture, change your 

status, and alter settings, along with adding bots and apps.  

Course Outline 

✓ Manage your Teams profile 

✓ Manage teams 

✓ Add bots and apps to Teams 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Teams, Lesson 5 
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Microsoft Visio 2016: Part 1 

Getting Started with Visio 2016 

Course Overview and Learning Objectives 

We start at the beginning with a look at how to navigate the Visio environment, create a 

basic drawing, and use the help system. 

Course Outline 

✓ Navigate the Visio Environment 

✓ Create a Basic Drawing 

✓ Use the Help System 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 1 

Creating a Workflow Diagram 

Course Overview and Learning Objectives 

This is where students will begin to delve into how to use drawing components, modify 

drawings, and work with callouts and groups. 

Course Outline 

✓ Use Drawing Components 

✓ Modify a Drawing 

✓ Work with Callouts and Groups 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 2 
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Creating an Organization Chart 

Course Overview and Learning Objectives 

As the title of this course indicates, organization charts are the focus here. Learners are 

shown how to create organization charts and then do more with them such as modifying 

the layout, positioning, and spacing. They are also shown how to create and use 

synchronized copies and compare charts. 

Course Outline 

✓ Create a Basic Organization Chart 

✓ Do More with Organization Charts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 3 

Making a Floor Plan 

Course Overview and Learning Objectives 

esson 4 looks at floor plans. Covered in this lesson is how to: create a basic floor plan and 

custom room shapes, use Visio as a modeling tool, and model a room layout. 

Course Outline 

✓ Make a Basic Floor Plan 

✓ Model a Room Layout 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 4 
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Creating a Cross-Functional Flowchart 

Course Overview and Learning Objectives 

 Well, here it is. This course looks at cross-functional flowcharts, swimlanes and 

separators, changing orientation and direction, modifying margins, and choosing styles. 

Course Outline 

✓ Create a Cross-Functional Flowchart 

✓ Modify a Cross-Functional Flowchart 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 5 

Creating a Network Diagram 

Course Overview and Learning Objectives 

This course is divided into three separate topics which show your students how to: create 

network diagrams, use shape data, and use layers. Along the way they will learn about: 

additional network shapes, shape data, adding layers, activating, coloring and locking 

layers, plus other relevant subtopics.  

Course Outline 

✓ Create Network Diagrams 

✓ Use Shape Data 

✓ Use Layers 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 6 
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Styling a Diagram 

Course Overview and Learning Objectives 

Once students have created a diagram, this course is going to teach them how to enhance 

it to their tastes and needs. They will be shown how to work with shape and connector 

styles, work with themes and variants, and how to work with containers. 

Course Outline 

✓ Work with Shape and Connector Styles 

✓ Work with Themes and Variants 

✓ Work with Containers 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 1, Lesson 7 
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Microsoft Visio 2016: Part 2 

 Enhancing the Look of Drawings 

Course Overview and Learning Objectives 

Students have learned how to make drawings and now they’re going to learn how to add 

some pizzazz to them in this first course. They will be shown how to work with shape 

styles, how to use 3D shapes, and then learn how to apply backgrounds, borders, and 

titles. 

Course Outline 

✓ Work with Shape Styles 

✓ Use 3D Shapes 

✓ Apply Backgrounds, Borders, and Titles 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 2, Lesson 1 

Creating Shapes, Stencils, and Templates 

Course Overview and Learning Objectives 

This course takes a meat-and-potatoes approach to working with Visio, in that it shows 

how to create components from the ground up. Discussed in this course is how to create: 

custom stencils, simple custom shapes, master shapes, and custom templates. 

Course Outline 

✓ Create Custom Stencils 

✓ Create Simple Custom Shapes 

✓ Create Master Shapes 

✓ Create Custom Templates 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 2, Lesson 2 
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Connecting Drawings to External Data 

Course Overview and Learning Objectives 

One of the benefits of working with the Microsoft Office suite is the compatibility 

between programs. This course seizes on that usability by looking at how to generate a 

pivot diagram from and Excel spreadsheet, how to create a chart and a timeline from a 

Project file, and how to connect to an Access database. 

Course Outline 

✓ Generate a Pivot Diagram from an Excel Spreadsheet 

✓ Create a chart from a Poject File 

✓ Create a Timeline from a Project File 

✓ Connect to an Access Database 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 2, Lesson 3 

Leveraging Development Tools 

Course Overview and Learning Objectives 

Learners will be introduced, and shown how to use several development tools in this 

course. They include: macros, ShapeSheets, and advanced shape tools. 

Course Outline 

✓ Create Macros 

✓ Modify ShapeSheets 

✓ Use Advanced Shape Tools 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 2, Lesson 4 
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Sharing Drawings 

Course Overview and Learning Objectives 

The course talks about OneDrive, how to review drawings and insert them into other 

Office files, how to export drawings, and print drawings. 

Course Outline 

✓ Save and Share Drawings with OneDrive 

✓ Review Drawings 

✓ Insert Drawings into Other Office Files 

✓ Export Drawings 

✓ Print Drawings 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2016: Part 2, Lesson 5 
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Microsoft Word 2016: Part 1 

Getting Started with Word 

Course Overview and Learning Objectives 

To begin this course, students will learn about the parts of the Microsoft Word 2016 

interface, how to create a basic document, and how to find help in Microsoft Word. 

Course Outline 

✓ Identify the Components of the Word Interface 

✓ Create a Word Document 

✓ Help 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 1 

Editing a Document 

Course Overview and Learning Objectives 

In this course, students will learn how to navigate through and select text. Modifying, 

finding, and replacing text is also covered. 

Course Outline 

✓ Navigate and Select Text 

✓ Modify Text 

✓ Find and Replace Text 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 2 
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Formatting Text and Paragraphs 

Course Overview and Learning Objectives 

This course explores Microsoft Word’s formatting tools. To begin, commands on the 

Home tab and mini toolbar will be discussed. Then, students will learn how to arrange text 

using tabs and lists. Paragraph layout tools, borders, shading, styles, and formatting 

management techniques will also be covered. 

Course Outline 

✓ Apply Character Formatting 

✓ Align Text Using Tabs 

✓ Display Text as List Items 

✓ Control Paragraph Layout 

✓ Apply Borders and Shading 

✓ Apply Styles 

✓ Manage Formatting 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 3 

 

Adding Tables 

Course Overview and Learning Objectives 

This course is all about creating, modifying, and formatting tables. Table conversion tools 

will also be covered. 

Course Outline 

✓ Insert a Table 

✓ Modify a Table 

✓ Format a Table 

✓ Convert Text to a Table 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 4 
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Managing Lists 

Course Overview and Learning Objectives 

Sorting, renumbering, and customizing lists will be covered in this course. 

Course Outline 

✓ Sort a List 

✓ Renumber a List 

✓ Customize a List 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 5 

Inserting Graphic Objects 

Course Overview and Learning Objectives 

This course teaches students how to insert symbols and special characters. Techniques for 

adding images are also discussed. 

Course Outline 

✓ Insert Symbols and Special Characters 

✓ Add Images to a Document 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 6 
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Controlling Page Appearance 

Course Overview and Learning Objectives 

This course covers page formatting options, such as page color and borders, watermarks, 

headers, footers, and the Page Setup dialog box. 

Course Outline 

✓ Apply a Page Border and Color 

✓ Add a Watermark 

✓ Add Headers and Footers 

✓ Control Page Layout 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 7 

Proofing a Document 

Course Overview and Learning Objectives 

This course explores the commands on the Review tab, including spell check, the Research 

pane, and the thesaurus. Components of making a document accessible and how to check 

accessibility are also covered. 

Course Outline 

✓ Check the Spelling and Grammar 

✓ Other Proofing Tools 

✓ Check Accessibility 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 8 
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Customizing the Word Environment 

Course Overview and Learning Objectives 

In this course, students will learn how to customize the Microsoft Word interface, modify 

save options, and manage other file types. 

Course Outline 

✓ Customize the Word Interface 

✓ Additional Save Options 

✓ Manage Additional File Types 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 1, Lesson 9 
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Microsoft Word 2016: Part 2 

Working with Tables and Charts 

Course Overview and Learning Objectives 

To begin the course, students will learn how to work with tables by sorting data, 

controlling cell layout, and performing calculations. Students will also learn how to create 

and modify chart. 

Course Outline 

✓ Sort Table Data 

✓ Control Cell Layout 

✓ Perform Calculations in a Table 

✓ Create a Chart  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 1 

Customizing Formats Using Styles and Themes 

Course Overview and Learning Objectives 

This lesson focuses on creating and modifying text, list, and table styles. Applying and 

customizing document themes will also be covered. 

Course Outline 

✓ Create and Modify Text Styles 

✓ Create Custom List or Table Styles 

✓ Apply and Customize Document Themes  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 2 
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Using Images in a Document 

Course Overview and Learning Objectives 

This lesson will cover resizing images, adjusting image appearance,  and integrating 

pictures and text. Adding screenshots and videos to a document are also discussed. 

Course Outline 

✓ Resize an Image 

✓ Adjust Image Appearance 

✓ Integrate Pictures and Text 

✓ Insert and Format Screenshots 

✓ Insert Video  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 3 

 Creating Custom Graphic Elements 

Course Overview and Learning Objectives 

Several other types of graphics are covered in this lesson, including text boxes, shapes, 

WordArt, and SmartArt. 

Course Outline 

✓ Create Text Boxes and Pull Quotes 

✓  Draw Shapes 

✓ Add WordArt and Other Text Effects 

✓ Create Complex Illustrations with SmartArt 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 4 
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Inserting Content Using Quick Parts 

Course Overview and Learning Objectives 

This lesson takes a closer look at Building Blocks, particularly Quick Parts and fields. 

Course Outline 

✓ Insert Building Blocks 

✓ Create and Modify Building Blocks 

✓  Insert Fields Using Quick Parts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 5 

Controlling Text Flow  

Course Overview and Learning Objectives 

This lesson covers four main techniques for controlling text flow: setting paragraph 

options, using section breaks, formatting text as columns, and linking text boxes. 

Course Outline 

✓ Control Paragraph Flow 

✓ Insert Section Breaks 

✓ Insert Columns 

✓ Link Text Boxes to Control Text Flow  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 6 
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Using Templates 

Course Overview and Learning Objectives 

This lesson explores how to create, modify, and manage templates. 

Course Outline 

✓ Resize an Image 

✓ Adjust Image Appearance 

✓ Integrate Pictures and Text 

✓ Insert and Format Screenshots 

✓ Insert Video  

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 7 

 Using Mail Merge 

Course Overview and Learning Objectives 

This lesson focuses on performing a mail merge. Information is also provided on creating a 

data source and merging envelopes and labels. 

Course Outline 

✓ Create a Document Using a Template 

✓ Create a Template 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 8 
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Using Macros 

Course Overview and Learning Objectives 

The final lesson of this course looks at automating tasks using macros. 

Course Outline 

✓ The Mail Merge Features 

✓ Merge Envelopes and Labels 

✓ Create a Data Source Using Word 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 2, Lesson 9 
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Microsoft Word 2016: Part 3 

Collaborating on Documents 

Course Overview and Learning Objectives 

This course begins with a look at modifying user information and sharing documents. We 

also take a look at working with comments and comparing document changes. The lesson 

concludes with reviewing a document, merging document changes and coauthoring 

documents. 

Course Outline 

✓ Modify User Information 

✓ Share a Document 

✓ Work with Comments 

✓ Compare Document Changes 

✓ Review a Document 

✓ Merge Document Changes 

✓ Coauthor Documents 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 1 

Adding Reference Marks and Notes 

Course Overview and Learning Objectives 

This course explores how to annotate documents with reference tools, such as captions, 

cross-references, bookmarks, hyperlinks, footnotes, endnotes, citations, and 

bibliographies. 

Course Outline 

✓ Add Captions 

✓ Add Cross-References 

✓ Add Bookmarks 

✓ Add Hyperlinks 

✓ Insert Footnotes and Endnotes 

✓ Add Citations 

✓ Insert a Bibliography  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 2 
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Simplifying and Managing Long Documents 

Course Overview and Learning Objectives 

This course looks at ways to enhance and streamline long documents. Topics include 

adding cover pages; creating an index, table of contents, and ancillary tables (such as a 

table of authorities); managing outlines; and working with master documents and 

subdocuments. 

Course Outline 

✓ Insert Blank and Cover Pages 

✓ Insert an Index 

✓ Insert a Table of Contents 

✓ Insert an Ancillary Table 

✓ Manage Outlines 

✓ Create a Master Document 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 3 

Securing a Document 

Course Overview and Learning Objectives 

This course covers how to suppress information from a document, set editing restrictions, 

add a digital signature to a document, and restrict document access. 

Course Outline 

✓ Suppress Information 

✓ Set Editing Restrictions 

✓ Add a Digital Signature to a Document 

✓ Restrict Document Access  

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 4 
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Forms 

Course Overview and Learning Objectives 

In this course, students will learn how to create, and manipulate forms. Techniques for 

saving and exporting form data are also covered. 

Course Outline 

✓ Create Forms 

✓ Manipulate Forms 

✓ Form Data Conversion 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 5 

Managing Document Versions 

Course Overview and Learning Objectives 

This final course focuses on creating, comparing, and combining document versions by 

using Microsoft Office SharePoint Server with Microsoft Word 2016. 

Course Outline 

✓ Create a New Document Version 

✓ Compare Document Versions 

✓ Merge Document Versions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2016: Part 3, Lesson 6 
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Microsoft Office 365 Courses 

Getting Started with Microsoft 365  

Getting Started with Microsoft 365  

Course Overview and Learning Objectives 

In this course, students will learn about what Microsoft 365 is and how to log into their 

Microsoft 365 account, complete basic navigation tasks, search for help, and change basic 

settings. Additionally, they will learn how to download and install Office apps onto their 

computer, and sign in to their Microsoft 365 account from Office apps. 

Course Outline 

✓ Navigate your account 

✓ Find help and change your account settings 

✓ Use desktop apps with Microsoft 365 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Getting Started with Microsoft 365, Lesson 1 

 

Your Subscription Package   

Course Overview and Learning Objectives 

Students will become familiar with the applications and services offered by the Microsoft 

365 Business Standard subscription plan. The purpose of each app or service, and how to 

navigate within the interfaces of these apps and services is also covered. 

Course Outline 

✓ Office apps that come with your subscription 

✓ Services included with your subscription 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Getting Started with Microsoft 365, Lesson 2 
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File Storage and Collaboration  

Course Overview and Learning Objectives 

This course goes over how to share files and collaborate using OneDrive and Delve. In 

addition, we also cover the OneDrive for Business app and how to sync your OneDrive for 

Business account with your computer. 

Course Outline 

✓ Store files and collaborate with OneDrive for Business 

✓ Manage an organization’s activity with Delve 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Getting Started with Microsoft 365, Lesson 3 

 

Managing Users   

Course Overview and Learning Objectives 

This course introduces students to the role of an administrator, and how to use the Admin 

Center and related apps. They will also learn how to add users, create groups, and manage 

resources and sites. 

Course Outline 

✓ Get started as an administrator 

✓ Manage users, groups, and resources in Microsoft 365 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Getting Started with Microsoft 365, Lesson 4 
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Managing Security  

Course Overview and Learning Objectives 

The administrator’s role is further explored in this course. After learning about managing 

domains, students will be introduced to the Security & Compliance Center. It is there that 

you can create alerts, manage user permissions, and control data loss. 

Course Outline 

✓ Manage domains 

✓ Monitor Microsoft 365 security and compliance 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Getting Started with Microsoft 365, Lesson 5 
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Microsoft Access 365: Part 1 

Getting Started with Access 

Course Overview and Learning Objectives 

In this course, students will learn how to get started with Microsoft Access, along with the 

components that are included in a database. 

Course Outline 

✓ Create a simple database 

✓ Create a simple form 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 1 

 

Working with Table Data 

Course Overview and Learning Objectives 

This course focuses on working with table data and records, learning how to sort and filter 

records and create lookups. 

Course Outline 

✓ Work with table data 

✓ Work with records 

✓ Sort and filter records 

✓ Create lookups 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 2 
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Query a Database 

Course Overview and Learning Objectives 

This course examines how to query a database: joining data from different tables into a 

query, sorting and filtering data in a query, and performing calculations in a query. 

Course Outline 

✓ Join data from different tables in a query 

✓ Sort and filter data in a query 

✓ Perform calculations in a query 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 3 

 

Create Advanced Queries  

Course Overview and Learning Objectives 

In this course, learn how to create advanced queries (parameter and action queries), along 

with summarizing data. 

Course Outline 

✓ Create parameter queries 

✓ Create action queries 

✓ Create find duplicate and find unmatched queries 

✓ Summarize data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 4 
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Generate Reports 

Course Overview and Learning Objectives 

In this course you will learn how to generate reports — creating them; adding controls, 

images, and charts; and using advanced reporting. 

Course Outline 

✓ Create a table 

✓ Modify a table and fields 

✓ Create table relationships 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 5 

 

Design a Relational Database 

Course Overview and Learning Objectives 

Learn how to design a relational database — creating a table and table relationships, and 

modifying a table and fields. 

Course Outline 

✓ Create a table 

✓ Modify a table and fields 

✓ Create table relationships 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 6 
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Joining Tables 

Course Overview and Learning Objectives 

Joining tables is the subject of this course, with lessons on creating query joins and 

working with subdatasheets and subqueries. 

Course Outline 

✓ Create query joins 

✓ Work with subdatasheets and subqueries 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 7 

 

Importing and Exporting Data  

Course Overview and Learning Objectives 

Importing and exporting data into Access and creating a mail merge are the focus of this 

course. 

Course Outline 

✓ Import data into Access 

✓ Export data 

✓ Create a mail merge 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 1, Lesson 8 
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Microsoft Access 365: Part 2 

Implementing Advanced Form Design 

Course Overview and Learning Objectives 

This course takes a look at several topics to increase your students’ knowledge of Access 

365. Here, students will learn how to add controls to forms, set form controls, create 

subforms, organize information with tab pages, enhance database navigation with forms, 

format a form, and apply conditional formatting. 

Course Outline 

✓ Add various control types to forms 

✓ Manage form controls 

✓ Create subforms 

✓ Organize information in forms with tab pages 

✓ Add navigation elements to forms 

✓ Apply various kinds of formatting to forms 

✓ Use conditional formatting to ensure forms only collect relevant data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 1 

 

Using Data Validation 

Course Overview and Learning Objectives 

In this course, the focus switches to data validation. Covered here is field validation along 

with form and record validation. 

Course Outline 

✓ Validate fields and records 

✓ Validate forms 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 2 
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Using Macros to Improve User Interface Design 

Course Overview and Learning Objectives 

This course turns to macros and using them to improve user interface design. Students 

will learn to create basic macros that use actions, conditions, arguments, and events to 

complete a task. They should also be able to create macros that complete basic validation 

and automation tasks, as well as convert existing macros to VBA. 

Course Outline 

✓ Create macros 

✓ Restrict records using a condition 

✓ Validate data using a macro 

✓ Automate data entry using a macro 

✓ Convert a macro to VBA 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 3 

 

Using Advanced Database Management 

Course Overview and Learning Objectives 

Some advanced database management skills come under scrutiny in this course. Topics in 

this course teach students how to: link tables to external data sources, manage a 

database, determine object dependency, document a database, and analyze the 

performance of a database. 

Course Outline 

✓ Link tables to external data sources 

✓ Manage a database 

✓ Determine object dependency 

✓ Document a database 

✓ Analyze the performance of a database 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 4 
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Distributing and Securing a Database 

Course Overview and Learning Objectives 

In this course, students will learn about the many ways that you can distribute and secure 

a database. Topics covered are splitting a database, as well as implementing many of the 

security strategies that are available in Access. Students should feel comfortable 

converting a database into the ACCDE format and be able to package and digitally sign a 

database for distribution. 

Course Outline 

✓ Split a database for multiple user access 

✓ Make a database secure 

✓ Set passwords for a database 

✓ Convert an Access database to an ACCDE file format 

✓ Package a database with a digital signature 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 5 

 

Managing Switchboards 

Course Overview and Learning Objectives 

This course is all about switchboards. Students are taught how to create a database 

switchboard, how to modify a database switchboard, and how to set startup options. 

Course Outline 

✓ Create a database switchboard 

✓ Modify a database switchboard 

✓ Set startup options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Access 365: Part 2, Lesson 6 
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Microsoft 365 Excel: Part 1 

Getting Started  

Course Overview and Learning Objectives 

In this course, students will learn how to identify the elements of the Excel interface, 

create a basic worksheet, and use the help system. 

Course Outline 

✓ Identify the basic components of Excel 

✓ Create a basic worksheet 

✓ Get help in Excel 365 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 1 

 

Working with Data  

Course Overview and Learning Objectives 

This course covers using formulas and functions in a worksheet, working with data, rows 

and columns and, how to sort and filter data. 

Course Outline 

✓ Use formulas and functions 

✓ Work with data, rows, and columns 

✓ Sort and filter data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 2 
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Modifying a Worksheet 

Course Overview and Learning Objectives 

In this course, students will learn how to format text and cells and, how to align cell 

contents. Using Find & Select tools and, how to spell check a worksheet are also discussed. 

Course Outline 

✓ Format text and cells 

✓ Align cell contents 

✓ Use Find & Select tools 

✓ Use Spell Checking 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 3 

 

Printing Workbook Contents 

Course Overview and Learning Objectives 

In this course, students will learn how to define the basic page layout for a workbook, 

refine the page layout and, apply print options. 

Course Outline 

✓ Define the basic page layout for a workbook 

✓ Refine the page layout and apply print options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 4 
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Managing Large Workbooks 

Course Overview and Learning Objectives 

This course will teach students how to format worksheet tabs, manage worksheets and, 

manage the view of worksheets and workbooks. 

Course Outline 

✓ Format worksheet tabs 

✓ Manage worksheets 

✓ Manage the view of worksheets and workbooks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 5 

 

Customizing the Excel Environment 

Course Overview and Learning Objectives 

In this course, students will learn how to customize general, language, formula, proofing, 

and saving options. It also covers how to use Excel’s version control features, customize 

the ribbon and the Quick Access toolbar, enable add-ins and, customize advanced and 

Trust Center options.  

Course Outline 

✓ Customize general, language, formula, proofing, and saving options 

✓ Use Excel’s version control features 

✓ Customize the ribbon and the Quick Access toolbar 

✓ Customize the functionality of Excel by enabling add-ins 

✓ Customize advanced and Trust Center options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 1, Lesson 6   
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Microsoft 365 Excel: Part 2 

Creating Advanced Formulas  

Course Overview and Learning Objectives 

In this course, students will learn how to use range names in formulas and functions, as 

well as how to use specialized functions. 

Course Outline 

✓ Apply range names 

✓ Use specialized functions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 1 

 

Analyzing Data with Logical and Lookup Functions 

Course Overview and Learning Objectives 

In this course, students will learn how to analyze data by using text, logical, lookup, date 

and financial functions. 

Course Outline 

✓ Use text functions 

✓ Use logical functions 

✓ Use lookup functions 

✓ Use date functions 

✓ Use financial functions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 2 
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Organizing Worksheet Data with Tables 

Course Overview and Learning Objectives 

This course covers how to create, format, and modify tables. We also cover using 

structured references, as well as the subtotal and database functions. 

Course Outline 

✓ Create and format tables 

✓ Modify tables 

✓ Use table references 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 3 

 

Visualizing Data with Charts 

Course Overview and Learning Objectives 

Students will learn how to create charts, as well as how to modify and format existing 

charts. They will also learn how to create a trendline and advanced charts. 

Course Outline 

✓ Create charts 

✓ Modify and format existing charts 

✓ Create a trendline 

✓ Create advanced charts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 4 
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Organizing Worksheet Data with Tables 

Course Overview and Learning Objectives 

Analyzing Data with PivotTables, Slicers, and PivotCharts 

Course Outline 

✓ Create a PivotTable 

✓ Filter data using slicers 

✓ Analyze data using PivotCharts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 5 

 

Working with Graphical Objects 

Course Overview and Learning Objectives 

In this course, students will learn how to insert, modify, layer, and group graphical objects. 

We will also take a look at how to incorporate SmartArt into workbooks. 

Course Outline 

✓ Insert and modify graphical objects 

✓ Layer and group graphical objects 

✓ Incorporate SmartArt into your workbooks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 6 
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Enhancing Workbooks 

Course Overview and Learning Objectives 

In this course, students will learn how to customize workbooks, manage themes, protect 

files and, prepare a workbook for multiple audiences. 

Course Outline 

✓ Customize workbooks 

✓ Manage themes 

✓ Protect files 

✓ Prepare a workbook for audiences 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 2, Lesson 7 
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Microsoft 365 Excel: Part 3 

Excel Online  

Course Overview and Learning Objectives 

In this course, students will learn about using both Excel Online and the Excel desktop 

application, and the differences between them. They will become comfortable managing 

workbooks in OneDrive, opening and editing them in both applications, and 

understanding the benefits and obstacles that can be presented by each. 

Course Outline 

✓ How to access and use Excel Online 

✓ Features that differ between Excel Online and the Excel desktop application 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 1 

 

Worksheet Automation 

Course Overview and Learning Objectives 

In this course we explore ways to automate worksheets and their functionality. We also 

look at ways to manage workbook properties, record and run basic macros, create and use 

templates, and about using data validation criteria. 

Course Outline 

✓ Manage workbook properties 

✓ Record, create and edit a macro 

✓ Create and use a template 

✓ Use data validation in a workbook 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 2 
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Auditing and Error Checking 

Course Overview and Learning Objectives 

This course covers using formula auditing tools to trace errors and evaluate formulas. 

Students will be taught how to track formulas using the Watch Window, and the Camera 

tool. We also cover how to arrange and display data using the Group commands. 

Course Outline 

✓ Tracing cells 

✓ Error checking 

✓ Evaluating formulas and using the Watch Window 

✓ Data List Outlines 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 3 

 

Data Analysis and Presentation  

Course Overview and Learning Objectives 

In this course, we take a closer look at using the Quick Analysis Tool, adding Sparklines 

and, get an understanding of the What-If Analysis tools and how to use them to explore 

different outcomes. 

Course Outline 

✓ Use the Quick Analysis tool 

✓ Add sparklines 

✓ Perform What-If analysis 

✓ Load and use the Analysis ToolPak 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 4 
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Working with Multiple Workbooks   

Course Overview and Learning Objectives 

This course takes a look at arranging, viewing, and navigating between multiple 

workbooks. This course will teach students how to consolidate data from multiple 

sources, create and maintain links between different workbooks, and how to resolve 

broken connections. 

Course Outline 

✓ Arrange windows 

✓ Link to data in multiple workbooks 

✓ Consolidate data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 5 

 

Exporting and Sourcing Data  

Course Overview and Learning Objectives 

In this course, students will be taught about the available file formats for exporting data, 

and how to create them. They will gain a good understanding of the different data sources 

that can be accessed, and will learn the process of creating and sharing a Microsoft Form 

to support data collection. 

Course Outline 

✓ Export data 

✓ Use data sources 

✓ Use Microsoft Forms 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel: Part 3, Lesson 6 
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Microsoft 365 Excel: Online 

Getting Started 

Course Overview and Learning Objectives 

In this course, students will learn how to identify the components of the Excel Online 

interface as well as some Excel terminology and how to navigate the app. We also take a 

look at the basic options for managing workbooks and how to get help in Excel Online. 

Course Outline 

✓ Get started with Excel Online 

✓ Describe the basic components of Excel 

✓ Manage workbooks 

✓ Get help in Excel Online 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 1 

 

Working with Data 

Course Overview and Learning Objectives 

In this course, we explore how to use formulas and functions, how to work with data, rows, 

and columns, and how to sort and filter data. 

Course Outline 

✓ Use formulas and functions 

✓ Work with data, rows, and columns 

✓ Sort and filter data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 2 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 188 

Formatting a Worksheet 

Course Overview and Learning Objectives 

In this course, we teach students how to format text and cells, align cell contents, use find 

and select tools and how to apply, customize and clear conditional formatting. 

Course Outline 

✓ Format text and cells 

✓ Align cell contents 

✓ Use Find and Select tools 

✓ Apply conditional formatting 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 3 

 

Adding Pictures and Shapes 

Course Overview and Learning Objectives 

In this course, students will focus on how to insert, rotate, resize, and delete pictures and 

how to insert and format shapes. 

Course Outline 

✓ Insert pictures and shapes 

✓ Format shapes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 189 

Organizing Worksheet Data with Tables and Charts 

Course Overview and Learning Objectives 

In this course, we take a look at how to create and customize tables, how to insert charts 

and customize them to ensure data is displayed properly. 

Course Outline 

✓ Create and modify tables and charts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 5 

 

Using Pivot-Tables 

Course Overview and Learning Objectives 

In this course, we will teach students how to insert PivotTables, work with PivotTable 

data and how to sort and filter that data. 

Course Outline 

✓ Insert PivotTables 

✓ Work with PivotTable data 

✓ Sort and filter PivotTable data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 6 
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Finalizing Workbooks 

Course Overview and Learning Objectives 

In this course, we cover how to insert, edit, and delete comments. Creating and 

customizing additional worksheets, and some of the ways to customize the view options 

of each workbook are also discussed. 

Course Outline 

✓ Use comments 

✓ Manage worksheets 

✓ Change view options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Excel Online: Lesson 7              
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Microsoft Office 365: Part 1 

Getting Started 

Course Overview and Learning Objectives 

This course allows students to get up to speed by showing them how to navigate an 

account, find help and change account settings, and use desktop apps with Office 365.  

Course Outline 

✓ Orientation to Microsoft Access 

✓ Create a Simple Access Database 

✓ Get Help in Microsoft Access 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 1, Lesson 1 

 

Communicating with the Outlook Web App 

Course Overview and Learning Objectives 

This course focuses on communicating with the outside world. Here, students are shown 

how to: get started with the Outlook web app and configure it, manage contacts in the 

People app, and use the Calendar app.  

Course Outline 

✓ Modify Table Data 

✓ Work with Records 

✓ Sort and Filter Records 

✓ Create Lookups 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 1, Lesson 2 
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Communicating with Colleagues 

Course Overview and Learning Objectives 

Internal communications come under the spotlight in this course which focuses on how to: 

use the newsfeed, get started with Yammer, and get started with Microsoft Teams..  

Course Outline 

✓ Orientation to Microsoft Access 

✓ Create a Simple Access Database 

✓ Get Help in Microsoft Access 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 1, Lesson 3 

 

Using Skype for Business 2016 

Course Overview and Learning Objectives 

We’re all about business in this course, Skype for Business that is. This course looks at 

how to get started with Skype for Business 2016 and how to make calls with it.  

Course Outline 

✓ Modify Table Data 

✓ Work with Records 

✓ Sort and Filter Records 

✓ Create Lookups 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 1, Lesson 4 
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Working with Office Online Apps 

Course Overview and Learning Objectives 

This final course deals with the Office Online Apps, and looks at how to use the online 

versions of Word, Excel, PowerPoint, and OneNote.  

Course Outline 

✓ Orientation to Microsoft Access 

✓ Create a Simple Access Database 

✓ Get Help in Microsoft Access 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 1, Lesson 5 
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Microsoft Office 365: Part 2 

File Storage and Collaboration with OneDrive for Business 

Course Overview and Learning Objectives 

In this course, you begin by learning how to store files with OneDrive for Business, and 

how to collaborate with other users by means of OneDrive and Delve.  

Course Outline 

✓ Getting Started with OneDrive for Business 

✓ Collaborating Usine OneDrive for Business 

✓ Using Delve 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 2, Lesson 1 

 

File Storage and Collaboration with SharePoint Online 

Course Overview and Learning Objectives 

This course first covers navigating and using a SharePoint Team site. It then moves on to 

document libraries, and how to upload, view, sort, filter, edit, and delete files. You will find 

that the Checkout system is a powerful tool that allows you to manage content and file 

versions.  

Course Outline 

✓ Getting Started with SharePoint 

✓ Getting Started with Document Libraries 

✓ Working with Document Libraries 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 2, Lesson 2 
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Organizing with Office 365 

Course Overview and Learning Objectives 

The Tasks app is a great way to help stay organized by tracking individual chores and 

assignments. Then you can organize tasks into buckets, assign them to individuals or 

groups, and track the progress, using Planner.  

Course Outline 

✓ Working with Tasks 

✓ Getting Started with Planner 

✓ Working with Planner 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 2, Lesson 3 

 

Managing Users 

Course Overview and Learning Objectives 

This course introduces you to the role of an administrator, and how to use the Admin 

Center and related apps. You will also learn how to add users, create groups, and manage 

resources and sites.  

Course Outline 

✓ Getting Started as an Administrator 

✓ Managing Users 

✓ Managing Groups 

✓ Managing Resources 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 2, Lesson 4 
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Managing Security, Compliance, and Domain Settings 

Course Overview and Learning Objectives 

This administrator’s role is further explored in the final course. After learning about 

managing domains, you will be introduced to the Security & Compliance Center. It is there 

that you can create alerts, manage user permissions, and control data loss.  

Course Outline 

✓ Managing Domains 

✓ Security and Compliance 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: Part 2, Lesson 5 
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Microsoft 365 OneNote 

Getting to Know 365 OneNote 

Course Overview and Learning Objectives 

This course teaches users how notebooks are structured, as well as how to interact with 

OneNote’s working environment. Students will learn how to create a notebook; and how 

to add section groups, sections, and pages to it; how to share notebooks with others; and 

how to access OneNote through mobile devices and online versions. 

Course Outline 

✓ Navigate the 365 OneNote environment 

✓ Create a notebook 

✓ Add content elements (such as section groups, sections, and pages) to a notebook 

✓ Use OneNote viewing tools 

✓ Share and collaborate on notebooks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft  365 OneNote, Lesson 1 

 

Adding Content to a Notebook 

Course Overview and Learning Objectives 

This course shows students how to add different types of content to a notebook. They will 

learn how to enhance notebooks with images, tables, audio, and video, as well as how to 

format notebook content in different ways. 

Course Outline 

✓ Modify formatting in a notebook 

✓ Add images, tables, audio, and video to a notebook 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote, Lesson 2 
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Using Advanced Tools 

Course Overview and Learning Objectives 

During this course, adding different types of content to a notebook is covered, including 

quick notes, different types of links, symbols, equations, and drawing tools. Students will 

also learn how to use tags to organize and find content. 

Course Outline 

✓ Add quick notes, linked notes, and links 

✓ Insert symbols and equations 

✓ Use drawing tools 

✓ Use and customize tags 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft  365 OneNote, Lesson 3 

 

Managing Files 

Course Overview and Learning Objectives 

In this course, students will learn how to add different types of files to a notebook using 

both the attach and printout features. How to save and export content, and how to use 

history and backup features is also discussed. 

Course Outline 

✓ Work with embedded files 

✓ Save and export content 

✓ Manage the notebook recycle bin and backups 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote, Lesson 4 
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Finalizing a Notebook 

Course Overview and Learning Objectives 

Review and research tools, including the spell checker, thesaurus, Smart Lookup, 

Accessibility Checker, and translator are discussed in this course, along with how to 

search notebooks and print notes. 

Course Outline 

✓ Use review and research tools 

✓ Search notebooks 

✓ Print your notes 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote, Lesson 5 

 

Sharing Notebooks and Customizing OneNote 

Course Overview and Learning Objectives 

This 365 OneNote course  looks at the different sharing and collaboration tools that come 

included with 365 OneNote. Also covered are: how to send notes to yourself, emailing 

individual OneNote pages to others, and using the various services with which OneNote 

can integrate. The course concludes with using the OneNote Options dialog box and other 

tools to customize the ribbon and Quick Access toolbar. 

Course Outline 

✓ Send a notebook and use integrations 

✓ Customize the user interface 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote, Lesson 6 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 200 

Microsoft 365 OneNote: Online 

Getting Started  

Course Overview and Learning Objectives 

This course teaches students how to launch OneNote Online and identifies components 

of the interface. Opening and creating notebooks is covered as well as how to manage 

pages and sections. The course concludes with taking a look at OneNote Online’s printing 

and viewing tools. 

Course Outline 

✓ Get started with OneNote Online 

✓ Set up a notebook 

✓ Manage pages and sections 

✓ Print and view notebooks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft  365 OneNote: Online, Lesson 1 

 

Working with Notes, Part One 

Course Overview and Learning Objectives 

In this course, formatting tools, including styles and the Format Painter are covered. Adding images, 

tables, and other elements such as audio, files and links are also covered. 

Course Outline 

✓ Use formatting tools 

✓ Add images, tables, and other elements to a notebook 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote: Online, Lesson 2 
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Working with Notes, Part Two 

Course Overview and Learning Objectives 

In this course, students will learn about some of the features and tools used to help 

categorize information. We explore the ways in which you can use OneNote to record 

handwritten input as well as text highlighting tools. 

Course Outline 

✓ Use tags and symbols 

✓ Add handwritten text to a note 

✓ Use OneNote’s highlighting tools 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft  365 OneNote: Online, Lesson 3 

 

Finalizing a Notebook 

Course Overview and Learning Objectives 

In this course, proofing tools, sharing notebooks, and working with different notebook versions are 

covered. 

Course Outline 

✓ Use proofing tools 

✓ Share and collaborate on notebooks 

✓ Work with notebook versions 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 OneNote: Online, Lesson 4 
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Microsoft Outlook 365: Part 1 

Getting Started With Outlook 365 

Course Overview and Learning Objectives 

In this course, students will learn how to navigate the Outlook interface, perform basic e-

mail functions, and use Outlook help (including the new Tell Me feature). 

Course Outline 

✓ Navigate the Outlook interface 

✓ Perform basic email functions 

✓ Use Outlook help 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 1 

 

Composing Messages  

Course Overview and Learning Objectives 

This course covers how to create an e-mail message, check spelling and grammar, and 

format message content. Then, students will learn about email attachments, enhancing 

messages, and managing automatic message content. 

Course Outline 

✓ Create an email message 

✓ Check spelling and grammar 

✓ Format message content 

✓ Attach files and items to an email message 

✓ Enhance an email message 

✓ Manage automatic message content 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 2 
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Reading and Responding to Messages 

Course Overview and Learning Objectives 

In this course, students will learn how to customize reading options, work with 

attachments, and manage message responses. 

Course Outline 

✓ Customize reading options 

✓ Work with attachments 

✓ Manage your message responses 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 3 

 

Managing Your Messages 

Course Overview and Learning Objectives 

This course focuses on managing messages using tags, flags, and other commands, as well 

as organizing messages using folders. 

Course Outline 

✓ Manage messages using tags, flags, and other commands 

✓ Organize messages using folders 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 4 
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Managing Your Calendar 

Course Overview and Learning Objectives 

In this course, students will learn how to view and print the calendar, as well as how to 

manage appointments and meetings. 

Course Outline 

✓ View the calendar 

✓ Manage appointments 

✓ Manage meetings 

✓ Print your calendar 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 5 

 

Managing Your Contacts  

Course Overview and Learning Objectives 

How to create, update, view, and organize contacts using the People workspace will be 

covered in this course. 

Course Outline 

✓ Create and update contacts 

✓ View and organize contacts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 6 
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Working with Tasks and Notes 

Course Overview and Learning Objectives 

This course is all about managing tasks and notes. 

Course Outline 

✓ Create and manage tasks 

✓ Manage notes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 7 

 

Customizing the Outlook Environment  

Course Overview and Learning Objectives 

This course covers how to customize the Outlook interface, as well as creating and 

managing Quick Steps. 

Course Outline 

✓ Customize the Outlook interface 

✓ Create and manage Quick Steps 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 365: Part 1, Lesson 8 
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Microsoft 365 Outlook: Part 2 

Configuring Advanced Message Options  

Course Overview and Learning Objectives 

This course gives students a look at how to insert advanced characters and objects, how to 

modify message settings, properties, and options, and how to use automatic replies. 

Course Outline 

✓ Insert advanced characters and objects 

✓ Modify message settings, properties, and options 

✓ Use automatic replies 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 1 

 

Advanced Message Management 

Course Overview and Learning Objectives 

Several topics are covered in this course, including how to sort, filter, organize and search 

messages, managing junk mail, and managing your mailbox. 

Course Outline 

✓ Sort messages 

✓ Filter messages 

✓ Organize messages 

✓ Search messages 

✓ Manage junk mail 

✓ Manage your mailbox 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 2 
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Advanced Calendar and Task Management 

Course Overview and Learning Objectives 

Here, students are introduced to managing advanced calendar options, managing 

additional calendars, managing meeting responses, and how to assign and manage tasks. 

Course Outline 

✓ Manage advanced calendar options 

✓ Manage additional calendars 

✓ Manage meeting responses 

✓ Assign and manage tasks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 3 

 

Advanced Contact Management 

Course Overview and Learning Objectives 

This course takes a look at dealing with contacts and how to edit an electronic business 

card, manage advanced contact options, and how to forward and export contacts. 

Course Outline 

✓ Edit an electronic business card 

✓ Manage advanced contact options 

✓ Forward contacts 

✓ Export contacts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 4 
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Sharing Workspaces with Others 

Course Overview and Learning Objectives 

In this course, students are taught how to delegate access to mail folders, how to share a 

calendar, and how to share contacts. 

Course Outline 

✓ Delegate access to mail folders 

✓ Share your calendar 

✓ Share your contacts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 5 

 

Managing Outlook Data Files 

Course Overview and Learning Objectives 

This course covers how to back up Outlook data files and, how to change data file and 

account settings. 

Course Outline 

✓ Back up Outlook data files 

✓ Change data file and account settings 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 6 
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Managing E-mail Security 

Course Overview and Learning Objectives 

Email security is the focus of this course and, how to configure e-mail message security. 

Course Outline 

✓ Email security is the focus of this course and, how to configure e-mail message security. 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Part 2, Lesson 7 
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Microsoft 365 Outlook: Online 

Getting Started 

Course Overview and Learning Objectives 

In this course, students will learn how to get started with Microsoft Outlook Online. We cover logging in, 

using the interface, the purpose of each workspace, and how to customize some of Outlook’s most 

common features. They will also learn how to view and manage email messages. 

Course Outline 

✓ Get started with Outlook Online 

✓ Use the Outlook Online workspaces 

✓ View email messages 

✓ Customize Outlook 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 1 

 

Working with Email Messages 

Course Overview and Learning Objectives 

In this course, we cover email messages, from creating and responding to them, to managing the 

messages you receive. 

Course Outline 

✓ Create and send email messages 

✓ Respond to email messages in different ways 

✓ Add items to a message 

✓ Manage messages 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 2 
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Organizing Email 

Course Overview and Learning Objectives 

Students will learn how to organize the email they receive. They should feel comfortable 

using folders, categories, view settings, and Outlook tools to manage their email 

messages. 

Course Outline 

✓ Manage folders 

✓ Use categories 

✓ Use viewing tools 

✓ Clean up messages 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 3 

 

Using the Calendar Workspace 

Course Overview and Learning Objectives 

In this course, we learn about the Calendar workspace and how to use the workspace’s 

features. This will include creating simple and complex events, using the Event window, 

modifying events, as well as how to share your calendar, and view and manage other 

calendars. 

Course Outline 

✓ Get started with the Calendar workspace 

✓ Work with events 

✓ Use the Event window 

✓ Use shared calendars 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 4 
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Using the People Workspace 

Course Overview and Learning Objectives 

This course introduces the People workspace. Students will learn how to create and 

managing contacts and contact lists, and how to customize the People workspace to suit 

their workflow. 

Course Outline 

✓ Get started with the People workspace 

✓ Work with contacts 

✓ Use contact lists 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 5 

 

Using the Microsoft To Do Workspace 

Course Overview and Learning Objectives 

This course explores the To Do workspace and how to view, create and manage tasks. 

Course Outline 

✓ Get started with the Microsoft To Do workspace 

✓ Work with tasks 

✓ Manage tasks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Outlook: Online, Lesson 6 
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Microsoft 365 Power Pivot 

Getting Started 

Course Overview and Learning Objectives 

In this course, we will take a look at how to enable and navigate through Power Pivot, import data 

from various data sources, refresh data from a data source, and create linked tables. 

Course Outline 

✓ Enable and navigate through Power Pivot 

✓ Import data from various data sources 

✓ Refresh data from a data source 

✓ Create linked tables 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Power Pivot, Lesson 1 

 

Manipulating Power Pivot Data 

Course Overview and Learning Objectives 

In this course, we will take a look at how to manage tables, create calculated columns, sort and 

filter Power Pivot data, and create and manage table relationships.   

Course Outline 

✓ Manage tables 

✓ Create calculated columns 

✓ Sort and filter Power Pivot data 

✓ Create and manage table relationships 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Power Pivot, Lesson 2 
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Visualizing Power Pivot Data 

Course Overview and Learning Objectives 

In this course, we will take a look at how to create PivotTables and PivotCharts, create 

and manage Key Performance Indicators, filter data using slicers, create Sparklines , and 

apply and customize conditional formatting.   

Course Outline 

✓ Create PivotTables and PivotCharts 

✓ Create and manage Key Performance Indicators 

✓ Filter data using slicers 

✓ Create Sparklines 

✓ Apply and customize conditional formatting 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Power pivot, Lesson 3 

 

Using DAX Functions In Power Pivot 

Course Overview and Learning Objectives 

In this course, we will take a look at how to manipulate Power Pivot data using DAX 

functions, extract data from tables using functions , and work with time dependent data.   

Course Outline 

✓ Manipulate Power Pivot data using DAX functions 

✓ Extract data from tables using functions 

✓ Work with time dependent data 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Power Pivot, Lesson 4 
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Distributing Power Pivot Data 

Course Overview and Learning Objectives 

In this course, we will take a look at how to protect data , extract data from tables using 

functions , and save data in different file formats.   

Course Outline 

✓ Protect data 

✓ Save data in different file formats 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Power Pivot, Lesson 5 
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Microsoft 365 PowerPoint: Part 1 

Getting Started  

Course Overview and Learning Objectives 

Students will learn how to navigate the PowerPoint environment, create and save a 

PowerPoint presentation, and use PowerPoint help. 

Course Outline 

✓ Navigate the PowerPoint 365 environment 

✓ Create and save a PowerPoint presentation 

✓ Use PowerPoint help features 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 1, Lesson 1 

 

Developing a PowerPoint Presentation 

Course Overview and Learning Objectives 

This course covers the key steps in developing a PowerPoint presentation: selecting a 

presentation type, building the presentation itself, laying out the presentation, editing 

text, and viewing and navigating the presentation. 

Course Outline 

✓ Select a presentation type 

✓ Build a presentation 

✓ Lay out a presentation 

✓ Edit presentation text 

✓ View and navigate a presentation 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 1, Lesson 2  
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Performing Advanced Text Editing 

Course Overview and Learning Objectives 

This Microsoft PowerPoint 365 course examines how to insert graphics; modify and 

format objects; and adjust image appearance. 

Course Outline 

✓ Format characters 

✓ Format paragraphs 

✓ Format text boxes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 1, Lesson 3 

 

Adding Graphical Elements to Your Presentation 

Course Overview and Learning Objectives 

Students will learn how to add images, screenshots, screen recordings, shapes, and 

WordArt to a presentation. 

Course Outline 

✓ Insert images 

✓ Insert shapes 

✓ Insert WordArt 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 1, Lesson 4  
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Modifying Objects in Your Presentation 

Course Overview and Learning Objectives 

Topics covered in this course include how to edit, format, group, and arrange objects. 

Students will also be introduced to PowerPoint’s animation features. 

Course Outline 

✓ Edit objects 

✓ Format objects 

✓ Group objects 

✓ Arrange objects 

✓ Animate objects 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 365: Part 1, Lesson 5 

 

Adding Tables to Your Presentation 

Course Overview and Learning Objectives 

This course focuses on how to create and format a table. Ways to add data from other 

Microsoft 365 applications are also discussed. 

Course Outline 

✓ Create a table 

✓ Format a table 

✓ Insert a table from other Microsoft 365 applications 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 365: Part 1, Lesson 6  
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Adding Charts to Your Presentation 

Course Overview and Learning Objectives 

Students will learn how to create, format, and manipulate a chart. The course will 

conclude with a brief look at inserting a chart from Microsoft Excel. 

Course Outline 

✓ Create a chart 

✓ Format a chart 

✓ Manipulate a chart 

✓ Insert a chart from Microsoft Excel 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 365: Part 1, Lesson 7 

 

Preparing to Deliver Your Presentation 

Course Overview and Learning Objectives 

In this course, students will learn how to review, print, and deliver a presentation. 

Techniques for applying transitions to slides will also be covered. 

Course Outline 

✓ Review your presentation 

✓ Apply transitions 

✓ Print your presentation 

✓ Deliver your presentation 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 365: Part 1, Lesson 8 
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Microsoft 365 PowerPoint: Part 2 

Modifying the PowerPoint Environment 

Course Overview and Learning Objectives 

This course gives students a look at the PowerPoint environment and how to modify it. 

They will learn how to customize the user interface and how to set options. 

Course Outline 

✓ Customize the user interface 

✓ Set PowerPoint 365 options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 1 

 

Customizing Design Templates 

Course Overview and Learning Objectives 

Making the most of the customizability of PowerPoint is the focus of this course, 

templates in particular. This course gives students a look at how to create and manage 

sections, modify slide masters and slide layouts, add headers and footers, and modify the 

notes master and the handout master. 

Course Outline 

✓ Create and manage sections 

✓ Modify slide masters and slide layouts 

✓ Add headers and footers 

✓ Modify the notes master and the handout master 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 2 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 221 

Adding SmartArt to a Presentation 

Course Overview and Learning Objectives 

SmartArt can add so much to any presentation and help bring it to life. This course shows 

your students how to create and modify SmartArt. 

Course Outline 

✓ Create SmartArt 

✓ Modify SmartArt 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 3 

 

Working with Media and Animations 

Course Overview and Learning Objectives 

Media and animations are items that can be used to enhance presentations. This course 

looks at how students can add audio and video to a presentation and how to customize 

animations and transitions. 

Course Outline 

✓ Add audio to a presentation 

✓ Add video to a presentation 

✓ Customize animations and transitions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 4 
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Collaborating on a Presentation 

Course Overview and Learning Objectives 

Sometimes a presentation is the work of many hands and this course covers some of the 

collaboration tools and how they can be used to review a presentation in a collaborative 

manner. Students are also shown how to add comments to a presentation, and how to 

store and share presentations on the web. 

Course Outline 

✓ Add comments to a presentation 

✓ Review a presentation 

✓ Store and share presentations on the web 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 5 

 

Customizing a Slide Show 

Course Overview and Learning Objectives 

their slide shows. This course covers how to annotate a presentation, set up a slide show, 

create a custom slide show, add hyperlinks and action buttons, and record a presentation. 

Course Outline 

✓ Annotate a presentation 

✓ Set up a slide show 

✓ Create a custom slide show 

✓ Add hyperlinks and action buttons 

✓ Record a presentation 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 6 
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Securing and Distributing a Presentation 

Course Overview and Learning Objectives 

This course wraps up with the security and distribution of a presentation. Students will 

learn how to secure a presentation, present a slide show online, and about different 

exporting options for their presentations. 

Course Outline 

✓ Securing a presentation 

✓ Presenting a slide show online 

✓ Export options for a presentation 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint: Part 2, Lesson 7 
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Microsoft 365 PowerPoint Online 

Getting Started 

Course Overview and Learning Objectives 

In this course, students will learn how to log in to Microsoft 365 and launch PowerPoint 

Online and identify the components of the interface. We also cover how to create, edit, 

and view presentations, and how to use the help tools to answer any questions. 

Course Outline 

✓ Get started with PowerPoint Online 

✓ Create, edit, and view presentations 

✓ Get help in PowerPoint Online 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 368 PowerPoint Online, Lesson 1 

Developing a PowerPoint Presentation 

Course Overview and Learning Objectives 

In this course, we start to build the framework and add content using basic editing tools. 

Formatting options for text and paragraphs are also explored. 

Course Outline 

✓ Build a presentation 

✓ Edit text and objects 

✓ Format text and paragraphs 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint Online, Lesson 2 
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Working with Images and Shapes 

Course Overview and Learning Objectives 

This course goes over how to add shapes, text boxes, symbols, pictures, and videos to a 

presentation and also how to modify them. 

Course Outline 

✓ Insert graphics 

✓ Modify and format objects 

✓ Adjust image appearance 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint Online, Lesson 3 

Working with SmartArt 

Course Overview and Learning Objectives 

Inserting SmartArt is covered here as well as how to modify and customize it in your 

presentation. 

Course Outline 

✓ Create, modify, and format SmartArt 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint Online, Lesson 4 
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Working with Tables 

Course Overview and Learning Objectives 

In this course, we will show you how to create a basic table and add data to it. We will take 

a closer look at common editing tasks and formatting tools available for tables to 

customize their appearance. 

Course Outline 

✓ Create, modify, and format SmartArt 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint Online, Lesson 5 

Finishing Your Presentation 

Course Overview and Learning Objectives 

In this course you will learn how to apply animations and transitions. You will also work 

with a variety of design options to help take your slide shows to the next level as well as 

how to add comments and share and edit presentations with others. 

Course Outline 

✓ Apply animations and transitions 

✓ Customize design options 

✓ Work with comments 

✓ Co-author a presentation 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Microsoft 365 PowerPoint Online, Lesson 6 
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Microsoft 365 Project: Part 1 

Starting a Project 

Course Overview and Learning Objectives 

You need to walk before you can run, and that’s why this course starts with the basics 

such as Project Management 101, how to navigate and customize the Project interface, 

add tasks to a project, add resources to a project, and save a project. 

Course Outline 

✓ The basics of project management 

✓ Navigating and customizing the Project interface 

✓ Adding tasks and resources to a project 

✓ Saving a project 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 1, Lesson 1 

 

Working with Project Calendars 

Course Overview and Learning Objectives 

Once you are familiar with the basics, it’s time to move onward. This course takes a look at 

how to manage project time frames and how to change working time. 

Course Outline 

✓ Manage project time frames 

✓ Change working time 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 1, Lesson 2 
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Working with Project Tasks 

Course Overview and Learning Objectives 

Tasks get a full consideration here as students are shown how to manage project tasks 

and add summary tasks and milestones. 

Course Outline 

✓ Manage project tasks 

✓ Add summary tasks and milestones to a project 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 1, Lesson 3 

 

Working with Project Resources  

Course Overview and Learning Objectives 

This is where students will learn more about project resources including managing project 

resources, and allocating and leveling work resources. 

Course Outline 

✓ Manage project resources 

✓ Allocate and level work resources 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 1, Lesson 4 
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Delivering a Project Plan 

Course Overview and Learning Objectives 

This course covers project plans and looks at how to print project views, share projects, 

and export projects. 

Course Outline 

✓ Use different print views 

✓ Share projects 

✓ Export projects 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 1, Lesson 5 
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Microsoft 365 Project: Part 2 

Managing the Project Environment 

Course Overview and Learning Objectives 

Students will start in this course by learning how to link projects. They will then progress 

through learning how to create and use resource pools, how to baseline a project, how to 

work with custom fields and, how to change project options. 

Course Outline 

✓ Link projects 

✓ Create and use resource pools 

✓ Baseline a project 

✓ Work with custom fields 

✓ Change Project options 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 2, Lesson 1 

 

Managing Task Structures  

Course Overview and Learning Objectives 

This course covers several topics. Here, students will learn how to: change a task list, 

create a network diagram, manage the critical path, use lag and lead, update project work, 

and analyze earned value. 

Course Outline 

✓ Change a task list 

✓ Create a network diagram 

✓ Manage the critical path 

✓ Use lag and lead time 

✓ Update project work 

✓ Analyze earned value 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 2, Lesson 2 
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Generating Project Views 

Course Overview and Learning Objectives 

This course focuses on creating and customizing Microsoft Project’s views to suit the 

needs of any particular project. Students will learn about modifying data display using the 

Data group on the View tab, using existing views, creating custom views and, how to work 

with Timeline view. 

Course Outline 

✓ Use view commands 

✓ Use existing views 

✓ Create custom views 

✓ Format and share the Timeline view 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 2, Lesson 3 

 

Producing Project Reports 

Course Overview and Learning Objectives 

In this course we explore ways to use built-in reports, create custom reports and, export 

visual reports to Microsoft Excel and Microsoft Visio. 

Course Outline 

✓ Use existing reports 

✓ Create custom reports 

✓ Export visual reports 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Project: Part 2, Lesson 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 232 

Microsoft 365 Publisher 

Getting Started 

Course Overview and Learning Objectives 

Students will be guided in an exploration of the interface. They will learn how to 

customize the interface and create a simple publication. 

Course Outline 

✓ Explore the interface 

✓ Customize the Publisher interface 

✓ Create a simple publication 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 1 

 

Adding Content to a Publication 

Course Overview and Learning Objectives 

Students are shown how to add text to a publication, control the display of content in text 

boxes and use guides and building blocks. 

Course Outline 

✓ Add text to a publication 

✓ Control the display of content in text boxes 

✓ Use guides 

✓ Use Building Blocks 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 2 
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Formatting Text in a Publication 

Course Overview and Learning Objectives 

Students are shown how to format paragraphs and text, apply paragraph styles, and apply 

schemes. 

Course Outline 

✓ Format text and paragraphs 

✓ Apply paragraph styles 

✓ Apply schemes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 3 

 

Editing Text in a Publication 

Course Overview and Learning Objectives 

Students will pick up the skills that will allow them to edit text in a publication, present 

content in tables, and insert symbols and special characters. 

Course Outline 

✓ Edit text in a publication 

✓ Present content in tables 

✓ Insert symbols and special characters 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 4 
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Inserting and Formatting Publication Graphics 

Course Overview and Learning Objectives 

Students are shown how to add graphical objects to a publication and manipulate the 

appearance of pictures. 

Course Outline 

✓ Add graphical objects to a publication 

✓ Manipulate the appearance of pictures 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 5 

 

Preparing a Publication for Printing and Sharing 

Course Overview and Learning Objectives 

Students will look at how to save a publication, run the Design Checker, preview and print 

a publication, and share a publication. 

Course Outline 

✓ Save a publication 

✓ Run the Design Checker 

✓ Preview and print a publication 

✓ Share a publication 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Publisher: Lesson 6 
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Microsoft 365 SharePoint 

User’s Guide 

Course Overview and Learning Objectives 

In this course, we review navigating and using a SharePoint site and document libraries. 

We go over how to view, edit, create, share, and delete files as well as using file check in 

and check out, and versioning features. 

Course Outline 

✓ Get started with SharePoint 

✓ Work with files 

✓ Use advanced features 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 SharePoint, Lesson 1 

 

Configuring Site Settings 

Course Overview and Learning Objectives 

By the end of this course, students should feel comfortable configuring site search, 

navigation, administration, and security settings. Additionally, they will learn about 

changing regional settings, accessing site usage data, and configuring site permissions. 

Course Outline 

✓ Configure site search options 

✓ Change site administration and navigation settings 

✓ Configure site permissions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 SharePoint, Lesson 2 
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Adding and Configuring Libraries, Apps, Lists, and Pages 

Course Overview and Learning Objectives 

In this course, we will go over how to configure and create document libraries, and how to 

add apps, lists and pages. 

Course Outline 

✓ Configure document libraries 

✓ Add libraries, apps, lists, and pages to your site 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 SharePoint, Lesson 3 

 

Creating a New Site 

Course Overview and Learning Objectives 

In this course, we go over the steps involved in creating a SharePoint site and customizing 

its different elements. 

Course Outline 

✓ Create, customize, and design a SharePoint site 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 SharePoint, Lesson 4
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Microsoft 365 Teams 

Getting Started  

Course Overview and Learning Objectives 

In this course, learn how to use OneDrive and various versions of PowerPoint to improve 

flexibility and workflow while designing a presentation in PowerPoint. 

Course Outline 

✓ Describe what Microsoft Teams is all about 

✓ Use channels and post messages 

✓ Get help in Teams 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Teams, Lesson 1 

 

Communicating in Channels   

Course Overview and Learning Objectives 

In this course students will learn how to use messages to communicate within channels, 

how to manage messages and files, and will be introduced to the wiki – a great place to 

store and discuss channel-related information. 

Course Outline 

✓ Manage messages 

✓ Do more with messages 

✓ Manage files in a channel 

✓ Use the wiki 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Teams, Lesson 2 
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Using Other Communication Tools  

Course Overview and Learning Objectives 

Students will learn about some of the other communication tools in Teams. Using chat, 

making audio and video calls, managing meetings and, managing files are all covered in this 

course. 

Course Outline 

✓ Use chat 

✓ Make audio and video calls 

✓ Use the Teams calendar to manage meetings 

✓ Manage files 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Teams, Lesson 3 

 

Customizing Your Teams Experience   

Course Overview and Learning Objectives 

In this course, students will learn how to manage their Teams profile, how to manage 

teams and, how to add bots and apps to Teams. 

Course Outline 

✓ Manage your Teams profile 

✓ Manage teams 

✓ Add bots and apps to Teams 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Teams, Lesson 4 
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Customizing Channels 

Course Overview and Learning Objectives 

In this course, customizing channels and adding functionality using tabs and connectors to 

a channel are covered. 

Course Outline 

✓ Customize channels 

✓ Add tabs and connectors to a channel 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Teams, Lesson 5 
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Microsoft 365 Visual Basics for Applications 

Developing Macros 

Course Overview and Learning Objectives 

In this course, we will take a look at macro terminology, how to create a macro using the 

Macro Recorder, how to edit and debug a macro, how to customize the Quick Access 

toolbar and hotkeys, and will learn about macro security.   

Course Outline 

✓ About macro terminology 

✓ How to create a macro using the Macro Recorder 

✓ How to edit and debug a macro 

✓ How to customize the Quick Access toolbar and hotkeys 

✓ About macro security 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visual Basics for Application, Lesson 1 

 

Formatting Worksheets Using Macros 

Course Overview and Learning Objectives 

In this course, we will take a look at how to insert and format text, sort data, duplicate 

data, and how to generate a report. 

Course Outline 

✓ Insert and format text 

✓ Sort data 

✓ Duplicate data 

✓ Generate a report  

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visual Basics for Application, Lesson 2 
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Creating an Interactive Worksheet 

Course Overview and Learning Objectives 

In this course, we will take a look at determining the appropriate dialog box type to use, 

and capture user input using a variety of techniques. 

Course Outline 

✓ Determine the appropriate dialog box type to use 

✓ Capture user input using a variety of techniques 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visual Basics for Application, Lesson 3 

 

Working with Multiple Worksheets 

Course Overview and Learning Objectives 

In this course, we will take a look at how to insert, copy, delete and rename worksheets, 

modify the order of worksheets, and print worksheets.   

Course Outline 

✓ Insert, copy, delete, and rename worksheets 

✓ Modify the order of worksheets 

✓ Print worksheets  

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visual Basics for Application, Lesson 4 
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Performing Calculations 

Course Overview and Learning Objectives 

In this course, we will take a look at how to create user-defined functions in macros, and 

automate SUM functions with a macro. 

Course Outline 

✓ Determine the appropriate dialog box type to use 

✓ Capture user input using a variety of techniques 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visual Basics for Application, Lesson 5 
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Microsoft 365 Visio: Part 1 

Getting Started    

Course Overview and Learning Objectives 

We start at the beginning with a look at how to navigate the Visio environment, create a 

basic drawing, and use the help system. 

Course Outline 

✓ Navigate the Visio environment 

✓ Create a basic drawing 

✓ Use the help system 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 1 

 

Creating a Workflow Diagram    

Course Overview and Learning Objectives 

In this course we will take a look at how to use drawing components, modify drawings, and 

work with callouts and groups. 

Course Outline 

✓ Use drawing components 

✓ Modify existing drawings 

✓ Work with callouts and groups 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 2 
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Creating an Organization Chart   

Course Overview and Learning Objectives 

Learners will be shown how to create organization charts and then do more with them, 

such as modifying the layout, positioning, and spacing. They are also shown how to create 

and use synchronized copies and to compare charts. 

Course Outline 

✓ Create a basic organization chart 

✓ Do more with organization charts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 3 

 

Making a Floor Plan    

Course Overview and Learning Objectives 

Covered in this course is how to: create a basic floor plan and custom room shapes, use 

Visio as a modeling tool, and model a room layout. 

Course Outline 

✓ Make a basic floor plan 

✓ Model a room layout 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 4 
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Creating a Cross-Functional Flowchart    

Course Overview and Learning Objectives 

What is a course on Visio without a look at flowcharts? Well, here it is. This course looks at 

cross-functional flowcharts, swimlanes and separators, changing orientation and 

direction, modifying margins, and choosing styles. 

Course Outline 

✓ Create a cross-functional flowchart 

✓ Modify a cross-functional flowchart 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 5 

 

Creating a Network Diagram    

Course Overview and Learning Objectives 

Once students have created a diagram, this course is going to teach them how to enhance 

it. They will be shown how to work with shape and connector styles, work with themes 

and variants, and how to work with containers. 

Course Outline 

✓ Shape and connector styles 

✓ Themes and variants 

✓ Containers 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 1, Lesson 6 
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Microsoft 365 Visio: Part 2 

Enhancing the Look of Drawings 

Course Overview and Learning Objectives 

Students will learn how to work with shape styles, 3D shapes and stencils, templates, and 

how to work with master backgrounds. 

Course Outline 

✓ Work with shape styles 

✓ Use 3D shapes 

✓ Apply backgrounds, borders, and titles 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 2, Lesson 1 

 

Creating Shapes, Stencils, and Templates    

Course Overview and Learning Objectives 

This course shows how to create custom stencils, simple custom shapes, master shapes, 

and custom templates. 

Course Outline 

✓ Create custom stencils 

✓ Create simple custom shapes 

✓ Create master shapes 

✓ Create custom templates 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 2, Lesson 2 
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Connecting Drawings to External Data 

Course Overview and Learning Objectives 

In this course, students will learn about the various ways to connect Visio drawings to 

external data sources such as Microsoft Excel worksheets, Microsoft Project files, and 

Microsoft Access databases. 

Course Outline 

✓ Generate a pivot diagram from an Excel spreadsheet 

✓ Create a chart from a Project file 

✓ Create a timeline from a Project file 

✓ Connect to an Access database 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 2, Lesson 3 

 

Leveraging Development Tools    

Course Overview and Learning Objectives 

Once students have created a diagram, this course is going to teach them how to enhance 

it. They will be shown how to work with shape and connector styles, work with themes 

and variants, and how to work with containers. 

Course Outline 

✓ Create macros 

✓ Modify ShapeSheets 

✓ Create advanced shapes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 2, Lesson 4 
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Sharing Drawings    

Course Overview and Learning Objectives 

This course takes a look at sharing drawings with  OneDrive, how to review drawings and 

insert them into other Microsoft Office applications, and how to export and print 

drawings. 

Course Outline 

✓ Save and share drawings using OneDrive 

✓ Review drawings 

✓ Insert drawings into other documents 

✓ Export drawings 

✓ Print drawings 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Visio: Part 2, Lesson 5 
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Microsoft Word 365: Part 1 

Getting Started  

Course Overview and Learning Objectives 

In this course, you will become familiar with the components of the Microsoft Word 

interface, how to create a Word document and use document views, and how to get help 

in Microsoft Word. 

Course Outline 

✓ Identify the components of the Microsoft Word interface 

✓ Create a Word document 

✓ Use document views 

✓ Get help in Microsoft Word 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 1 

 

Editing a Document 

Course Overview and Learning Objectives 

This course introduces you to editing a document, including navigating through a 

document; selecting and modifying text; and finding and replacing text. 

Course Outline 

✓ Navigate through a document 

✓ Select and modify text 

✓ Find and replace text 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 2 
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Formatting Text And Paragraphs 

Course Overview and Learning Objectives 

This Microsoft Excel 365 course examines how to format text and paragraphs. 

Course Outline 

✓ Apply character formatting 

✓ Align text using tabs 

✓ Display text as list items 

✓ Control paragraph layout 

✓ Apply borders and shading to text 

✓ Apply styles to text 

✓ Manage formatting 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 3 

 

Adding Tables 

Course Overview and Learning Objectives 

In this course, learn how to work with tables, including inserting, modifying and formatting 

them; and converting text to a table. 

Course Outline 

✓ Insert, modify, and format tables 

✓ Convert text to a table 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 4 
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Managing Lists 

Course Overview and Learning Objectives 

In this course, learn how to manage lists: sorting, renumbering and customizing. 

Course Outline 

✓ Sort a list 

✓ Renumber a list 

✓ Customize a list 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 5 

 

Adding Graphics 

Course Overview and Learning Objectives 

This course teaches about adding graphics to a Word document, which involves inserting 

symbols and special characters, and adding images and other media. 

Course Outline 

✓ Insert symbols and special characters 

✓ Add images and media to a document 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 6 
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Controlling Page Appearance 

Course Overview and Learning Objectives 

In this course, you will learn about controlling page appearance. This includes applying 

page borders and colors, adding watermarks, adding headers and footers, and controlling 

layout. 

Course Outline 

✓ Apply a page border and color 

✓ Add a watermark to a document 

✓ Add headers and footers to a document 

✓ Control page layoutReview Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 7 

 

Proofing a Document 

Course Overview and Learning Objectives 

This course entails proofing documents: checking spelling and grammar; using the 

thesaurus and translator; checking accessibility and using accessibility features. 

Course Outline 

✓ Check the spelling and grammar of a document 

✓ Use other proofing tools, such as the thesaurus and translator 

✓ Check the accessibility of a document 

✓ Use accessibility features 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 8 
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Advanced Topics 

Course Overview and Learning Objectives 

In this course, advanced topics will be covered, such as customizing the Word interface, 

setting additional save options, and managing supplementary file types. 

Course Outline 

✓ Customize the Word interface 

✓ Set additional save options 

✓ Manage additional file types 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 1, Lesson 9 
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Microsoft Word 365: Part 2 

Using Macros 

Course Overview and Learning Objectives 

This course looks at automating tasks using macros. 

Course Outline 

✓ Automate tasks using macros 

✓ Create a macro 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 1 

 

Using Mail Merge 

Course Overview and Learning Objectives 

This course begins by discussing simple mail merges, moves on to creating envelopes and 

labels, and finishes by learning how to create a data source from scratch. 

Course Outline 

✓ About the mail merge features, including manual mail merge tools and the Mail Merge 

Wizard 

✓ How to use mail merge to create envelopes and labels 

✓ How to create a data source using Microsoft Word 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 2 
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Using Templates 

Course Overview and Learning Objectives 

Topics including creating, managing, modifying, and using template files are explored in 

this course. 

Course Outline 

✓ Create a document using a template 

✓ Create and manage templates 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 3 

 

Controlling Text Flow 

Course Overview and Learning Objectives 

The four main techniques for controlling text flow are discussed in this course: setting 

paragraph options, using section breaks, formatting text as columns, and linking text 

boxes. 

Course Outline 

✓ Control paragraph flow 

✓ Insert section breaks 

✓ Insert columns 

✓ Link text boxes to control text flow 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 4 
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Inserting Content Using Quick Parts 

Course Overview and Learning Objectives 

This course takes a closer look at Building Blocks, particularly Quick Parts and fields. 

Course Outline 

✓ Insert, create, and modify building blocks 

✓ Insert fields using Quick Parts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 5 

 

Creating Custom Graphic Elements 

Course Overview and Learning Objectives 

Several other types of graphics are discussed in this course, including text boxes, shapes, 

WordArt, and SmartArt. 

Course Outline 

✓ Create and format text boxes and pull quotes 

✓ Draw, format, and modify shapes 

✓ Add WordArt and drop caps to text 

✓ Create complex illustrations with SmartArt 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 6 
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Using Images in a Document 

Course Overview and Learning Objectives 

In this course, we will learn all about working with images in a document. This course 

wraps up with information on integrating pictures and text and adding supplementary 

items to a document, such as screenshots, videos, and captions. 

Course Outline 

✓ Resize an image 

✓ Adjust image appearance 

✓ Integrate pictures and text 

✓ Insert and format screenshots 

✓ Add videos to a document 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 7 

 

Customizing Formats Using Styles and Themes 

Course Overview and Learning Objectives 

In this course, we cover how to create and modify text styles, create styles for lists and 

tables, and then we will apply and customize document themes. 

Course Outline 

✓ Create and modify text styles 

✓ Create styles for lists and tables 

✓ Apply and customize document themes 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 8 
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Working with Tables and Charts 

Course Overview and Learning Objectives 

In this course, students will learn about various ways to manage numerical data in 

Microsoft Word. We take a look at how to sort table data, control cell layout, perform 

calculations in a table, and how to display numerical data as a chart or equation. 

Course Outline 

✓ Sort table data 

✓ Control cell layout 

✓ Perform calculations in a table 

✓ Create and modify a chart 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft Word 365: Part 2, Lesson 9 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 259 

Microsoft 365 Word: Part 3 

Collaborating on Documents   

Course Overview and Learning Objectives 

This course begins with a look at modifying user information and sharing documents. We 

also take a look at working with comments and comparing document changes. The course 

concludes with reviewing a document and, merging document changes. 

Course Outline 

✓ Modify user information in a document 

✓ Share a document 

✓ Work with comments 

✓ Compare document changes 

✓ Review a document with tracked changes 

✓ Merge document changes 

✓ Coauthor documents 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 1 
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Adding Reference Marks and Notes  

Course Overview and Learning Objectives 

This course explores how to annotate documents with reference tools, such as captions, 

cross-references, bookmarks, hyperlinks, footnotes, endnotes, citations, and 

bibliographies. 

Course Outline 

✓ Add captions to objects 

✓ Insert cross-references 

✓ Add bookmarks and hyperlinks 

✓ Insert footnotes and endnotes 

✓ Add citations 

✓ Insert a bibliography 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 2 

 

Simplifying and Managing Long  

Course Overview and Learning Objectives 

This course looks at ways to enhance and streamline long documents. Topics include 

adding cover pages, creating an index, table of contents, and ancillary tables (such as a 

table of authorities), managing outlines, and working with master documents and 

subdocuments. 

Course Outline 

✓ Add cover pages and blank pages to a document 

✓ Insert an index 

✓ Insert a table of contents 

✓ Insert ancillary tables, such as tables of figures and authorities 

✓ Manage document outlines 

✓ Create master and subdocuments 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 3 
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Securing a Document   

Course Overview and Learning Objectives 

This course covers how to secure important documents, set editing restrictions, add a 

digital signature to a document, and restrict document access. 

Course Outline 

✓ Suppress information 

✓ Set editing restrictions 

✓ Add a digital signature to a document 

✓ Restrict document access 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 4 

 

Forms  

Course Overview and Learning Objectives 

In this course, students will learn how to create, and manipulate forms. Techniques for 

saving and exporting form data are also covered. 

Course Outline 

✓ Create forms 

✓ Manipulate forms 

✓ Convert form data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 5 
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Managing Document Versions  

Course Overview and Learning Objectives 

This course focuses on creating, comparing, and combining document versions by using 

Microsoft SharePoint Server with Microsoft 365 Word. 

Course Outline 

✓ Create a new document version using Microsoft Word and Microsoft SharePoint 

Server 

✓ Compare document versions 

✓ Merge document versions 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Part 3, Lesson 6 
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Microsoft 365 Word: Online 

Getting Started    

Course Overview and Learning Objectives 

In this course, students will learn about the Word Online interface and creating a 

document. They will learn how to open, edit, save, share, and print documents. We also 

cover working with text, finding and replacing text, changing view options, and how to get 

help. 

Course Outline 

✓ Get started with Word Online 

✓ Manage documents 

✓ Work with text 

✓ Find and replace text 

✓ Change view options 

✓ Get help in Word Online 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Online, Lesson 1 

 

Formatting Text and Paragraphs    

Course Overview and Learning Objectives 

In this course, we go over formatting options on the mini toolbar and the Home tab. Then, 

we move on to formatting text as lists, controlling paragraph layout, and using styles. 

Course Outline 

✓ Apply character formatting 

✓ Create lists 

✓ Control paragraph layout 

✓ Apply styles to text 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Online, Lesson 2 

 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 264 

Working with Images   

Course Overview and Learning Objectives 

In this course students will learn about working with images in a document, including 

inserting, resizing, and adjusting different types of graphics. 

Course Outline 

✓ Insert images 

✓ Resize images 

✓ Adjust image appearance 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Online, Lesson 3 

 

Inserting Objects 

Course Overview and Learning Objectives 

In this course, inserting headers, footers and page numbers as well as setting their options 

is covered. We move on to inserting footnotes and endnotes and formatting them with the 

Format Options dialog box. We conclude this lesson with inserting, modifying, and 

formatting tables. 

Course Outline 

✓ Add headers and footers to a document 

✓ Insert footnotes and endnotes 

✓ Insert, modify, and format tables 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Online, Lesson 4 
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Finalizing Your Document 

Course Overview and Learning Objectives 

In this course, we will look at page layout options, customizing margins, page orientation 

and paper size. Students will learn how to use AutoCorrect, spelling and grammar tools, 

performing word counts and using the Translator. They will learn about the components 

of making documents accessible, using comments, and conclude with how to share and 

collaborate on documents. 

Course Outline 

✓ Control page layout 

✓ Use language tools 

✓ Check the accessibility of a document 

✓ Work with comments 

✓ Co-author documents 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Microsoft 365 Word: Online, Lesson 5 
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Office 365 2018 Updates 

Course Overview and Learning Objectives 

Office 365 is Microsoft’s subscription-based online office and software services suite. This 

course is intended to help users of Office 365 understand updates made in 2018. 

Course Outline 

✓ Convert SVG icons to shapes 

✓ Find and fix relevant proofing issues 

✓ Use hands-free typing 

✓ Editing with Ink Editor 

✓ Transform your documents into an interactive web page 

✓ Change the transparency of a picture using presets 

✓ Insert animated 3D graphics 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Office 365 2018 Updates 
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Microsoft Office 365: 2019 Feature Updates 

Course Overview and Learning Objectives 

This course is intended to help users of Office 365 understand updates made in 2019. It 

focuses on five Office 365 offerings — Word, Excel, PowerPoint, Outlook, and Access. 

Course Outline 

✓ Keep the Accessibility Checker running while working 

✓ Save changes automatically with AutoSave 

✓ Find out why AutoSave is not turned on 

✓ Insert and customize SVG images 

✓ Quickly find and open a file 

✓ Mention teammates in comments 

✓ Co-author 

✓ Use Focus 

✓ Open a link to a Word document in a browser or a desktop app 

✓ Generate a Map chart with an existing data set 

✓ Use different Eraser sizes for accurate editing 

✓ Customize the border with the Sketched option 

✓ Use Rewrite 

✓ Use a shortcut to file sharing 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Office 365: 2019 Feature Updates 
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Microsoft 365: 2020 Feature Updates 

Course Overview and Learning Objectives 

This course is intended to help users of Microsoft 365 understand updates made in 2020. 

It focuses on the desktop versions of the four Microsoft 365 offerings — Word (word 

processing), Excel (spreadsheets), PowerPoint (presentations), and Outlook (email and 

calendars). 

Corresponding Instructor-Led Course 

✓ Microsoft 365: 2020 Feature Updates 
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Microsoft 365: 2021 Feature Updates 

Course Overview and Learning Objectives 

This course is intended to help users of Microsoft 365 understand updates made in 2021. 

It focuses on four Microsoft 365 offerings — Word (word processing), Excel 

(spreadsheets), PowerPoint (presentations), and Outlook (email and calendars). 

Corresponding Instructor-Led Course 

✓ Microsoft 365: 2021 Feature Updates 
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Microsoft 365: 2022 Feature Updates 

Course Overview and Learning Objectives 

This course is intended to help Microsoft 365 users of all skill levels understand the 

feature updates made in 2022. It will focus on four Microsoft 365 products – Word (word 

processing), Excel (spreadsheets), PowerPoint (presentations), and Outlook (email and 

calendars).  

Corresponding Instructor-Led Course 

✓ Microsoft 365: 2022 Feature Updates 
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Computer Business Courses 

Introduction to HTML and CSS Coding: Part 1 

Getting Started with HTML  

Course Overview and Learning Objectives 

In this course, learn how to get started with HTML — properly typing code; adding basic 

elements such as headings, paragraphs, and breaks; and creating bulleted or numbered 

lists. 

Course Outline 

✓ HTML Basics 

✓ Basic Webpage Elements 

✓ Creating Lists 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 1, Lesson 1 

 

Doing More with HTML 

Course Overview and Learning Objectives 

This course expands on the Getting Started with HTML course, teaching how to add 

images, links and tables in HTML. 

Course Outline 

✓ Images in HTML 

✓ Links in HTML 

✓ Tables in HTML 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 1, Lesson 2 
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Getting started with CSS  

Course Overview and Learning Objectives  

Getting started with CSS is the focus of this course: adding the <style> tag to HTML code, 

adding colors to elements with CSS, and using identifiers to select elements to style. 

Course Outline 

✓ Basics of CSS 

✓ CSS Color 

✓ Using Additional CSS Identifiers 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 1, Lesson 3 

 

Styling Text with CSS  

Course Overview and Learning Objectives 

In this course, learn about styling text with CSS. Changing the font family and size of a 

section of text, using additional properties such as font style, font weight, line height, and 

text align are topics covered. As well, learn how to use the CSS font style shorthand. 

Course Outline 

✓ Font Families 

✓ Font Size 

✓ More CSS Text Properties 

✓ Font Shorthand 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 1, Lesson 4 
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Extended Styling Techniques using HTML and CSS  

Course Overview and Learning Objectives  

This course teaches about other styling techniques using HTML and CSS, including using 

grouping elements, changing the dimensions of a div block, and using the CSS box model 

to format a webpage. 

Course Outline 

✓ Grouping Elements 

✓ Div Dimensions 

✓ The CSS Box Model 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 1, Lesson 5 
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Introduction to HTML and CSS Coding: Part 2 

Writing Your Best Code  

Course Overview and Learning Objectives 

In this course, we will focus on the best coding practices for both HTML and CSS. These 

coding practices will serve as a framework for writing HTML and CSS and should be kept 

in mind when programming. 

Course Outline 

✓ Standards-compliant markup 

✓ Semantic elements 

✓ Proper document structure 

✓ Syntax organization 

✓ Organizing code with comments 

✓ Writing CSS with multiple lines and spaces 

✓ Using proper class names 

✓ Using shorthand properties and values 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 2, Lesson 1 

 

Responsive Web Design 

Course Overview and Learning Objectives 

Responsive design is the practice of building a website suitable to work on every device 

and every screen size, no matter how large or small, mobile or desktop. Responsive web 

design can be broken down into three main components, which include flexible layouts, 

media queries, and flexible media. 

Course Outline 

✓ Flexible layouts 

✓ Media queries 

✓ Flexible media 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 2, Lesson 2 
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Complex Selectors 

Course Overview and Learning Objectives  

Selectors are one of the most important parts of CSS. They determine how styles are to be 

applied to elements on a page. CSS3 has brought new selectors to help better improve 

existing practices and ways to better style our pages. 

Course Outline 

✓ Commonly used selectors 

✓ Child selectors 

✓ Attribute selectors 

✓ Pseudo-selectors 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 2, Lesson 3 

 

How to Position Content 

Course Overview and Learning Objectives 

In this course, we will tackle how to position our HTML content with two different CSS 

properties: float and inline-block. 

Course Outline 

✓ Positioning content with floats 

✓ Clearing and containing floats 

✓ Positioning with inline-block 

✓ Clearing white-space when using inline-block 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 2, Lesson 4 
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Performance and Organization 

Course Overview and Learning Objectives 

In this course you will learn the importance of performance and organization while using 

HTML and CSS, including different methodologies to get you started. 

Course Outline 

✓ Strategy and structure 

✓ Object-oriented CSS 

✓ Scalable and modular architecture for CSS 

✓ Reusable code 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Introduction to HTML and CSS Coding: Part 2, Lesson 5 
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Google G Suite: Connect and Access 

Google Gmail 

Course Overview and Learning Objectives 

In this first lesson, students will learn how to get started with Gmail, send, read and reply 

to messages, organize and search mail as well as how to manage contacts. 

Course Outline 

✓ Get started with Gmail 

✓ Send, read, and reply to messages 

✓ Organize and search mail 

✓ Manage your contacts 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Connect and Access, Lesson 1 

 

Google Calendar 

Course Overview and Learning Objectives 

The second lesson of this course gets students started with Google Calendar. They will 

learn how to create and manage events, create additional calendars and how to share a 

calendar.  

Course Outline 

✓ Get started with Google Calendar 

✓ Create and manage events 

✓ Create additional calendars 

✓ Share your calendar 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Google G Suite: Connect and Access, Lesson 2 
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Google Forms 

Course Overview and Learning Objectives 

Next, we get started with Google Forms and learn how to build forms and work with 

responses.  

Course Outline 

✓ Get started with Google Forms 

✓ Build forms 

✓ Work with responses 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Connect and Access, Lesson 3 

 

Google Hangouts  

Course Overview and Learning Objectives 

Students will learn what Google Hangouts are and how to exchange messages using 

Google Hangouts. We also cover video and phone hangouts. 

Course Outline 

✓ What Google Hangouts is 

✓ Exchanging messages using Google Hangouts 

✓ Video and phone hangouts 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Google G Suite: Connect and Access, Lesson 4 
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Google Plus  

Course Overview and Learning Objectives 

In the final lesson, we get started with Google Plus. Learning how to create and optimize 

your profile and creating posts will be covered. 

Course Outline 

✓ Get started with Google Plus 

✓ Create and optimize your profile 

✓ Create posts Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Connect and Access, Lesson 5 
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Google G Suite: Create 

About G Suite 

Course Overview and Learning Objectives 

We begin by explaining what Google G Suite is, and what apps are included. Then you 

move on to signing into your Google G Suite account and navigating the interface.  

Course Outline 

✓ What Google G Suite is and what apps are included 

✓ Signing into your Google G Suite account and navigating the interface. 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 1 

 

Google Drive 

Course Overview and Learning Objectives 

The next lesson starts you on Google Drive, an online file storage and synchronization 

service. You will learn how to navigate and work with files, downloading, uploading, and 

synching them. Folders, sorting, and starring will help you organize them.  

Course Outline 

✓ get started with Google Drive 

✓ work with files 

✓ organize and search Google Drive 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 2 
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Google Docs (Part 1) 

Course Overview and Learning Objectives 

Part 1 of this word processing app will start with opening and saving documents and 

navigating the interface. Composing and editing documents is broadly covered, from text 

fonts and effects, to headers and footers, page numbers and Table of Contents, and 

margins, and orientation.  

Course Outline 

✓ get started with Google Docs 

✓ create new documents 

✓ edit documents 

✓ add images and tables 

✓ collaborate with others 

✓ review and finalize a document 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 3 

 

Google Docs (Part 2) 

Course Overview and Learning Objectives 

You have not yet left word processing behind, as you advance to working with images and 

tables, collaborating with other users, and reviewing and distributing documents. 

Course Outline 

✓ how to add images and tables 

✓ how to collaborate with others 

✓ how to review and finalize a document 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 4 
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Google Sheets 

Course Overview and Learning Objectives 

The fundamentals of this online spreadsheet are the next step in your training. You will 

learn how to use and understand the concepts of the spreadsheet, and how to import data. 

Then you will be exposed to formulas and functions, and creating charts and series. The 

lesson winds up with formatting, finalizing, and sharing your work. 

Course Outline 

✓ get started with google sheets 

✓ edit spreadsheets 

✓ format and finalize spreadsheets 

✓ work with spreadsheet data 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 5 

 

Google Slides 

Course Overview and Learning Objectives 

This lesson on the presentation software begins with navigation and naming and saving 

files. Formatting the appearance of the entire presentation, and individual slides, including 

animation, is covered. Adding text, images, shapes, charts and notes is next. Finally, you 

will learn about presenting and sharing your work. 

Course Outline 

✓ get started with Google Slides 

✓ format a presentation 

✓ edit Google Slides 

✓ present and share a Google Slides presentation 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Google G Suite: Create, Lesson 6 
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Online Tools for Small Business 

Course Overview and Learning Objectives 

In today’s business climate, it is more important than ever for your organization to have as 

many advantages as possible, and this includes having access to tools that will help with 

marketing and promotion, project management, data acquisition, document review, 

graphic design and sales transactions.  

Course Outline 

✓ Know about popular free online tools for small business owners 

✓ Understand basic functions of: 

• Google Docs 

• Canva 

• Trello 

• Survey Monkey 

• MailChimp 

✓ Select tools that meet or match your business needs 

✓ Use these tools in your business 

Corresponding Instructor-Led Course 

✓ Online Tools for Small Business 
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Slack for Business 

Getting Started 

Course Overview and Learning Objectives 

The course begins with an overview of Slack, and quickly moves to creating teams, 

opening channels, communicating through messages, editing profiles, and getting help.  

Course Outline 

✓ Getting to Know Slack 

✓ Working with Slack Teams 

✓ Creating Messages in Channels 

✓ Editing Your Slack Profile 

✓ Getting Help with Slack 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 1 

 

Communicating in Channels 

Course Overview and Learning Objectives 

In this course you will delve deeply into messages, learning the basics of how to manage 

them. You continue with other features such as mentions, announcements, and sharing. 

You will also discover how to create, manage and work with threads.  

Course Outline 

✓ Managing Messages 

✓ Doing More with Messages 

✓ Using Threads 

✓ Review Questions 

✓ Lesson Lab 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 2 
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Working with Channels 

Course Overview and Learning Objectives 

This course will increase your expertise, as you explore how to search channels, invite 

members, join and leave channels, and rename and customize channels. You will also gain 

the required knowledge to convert public channels to private, and to archive channels.  

Course Outline 

✓ Searching Channels 

✓ Creating a Channel 

✓ Customizing Channels 

✓ Managing Channels 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 3 

 

Communicating with Slack 

Course Overview and Learning Objectives 

This course offers you more options, such as direct messaging, posts and snippets, and 

adding and managing files.  

Course Outline 

✓ Using Direct Messages 

✓ Creating Posts and Snippets 

✓ Adding Files to Slack 

✓ Managing Files 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 4 
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Getting Starte Customizing Your Slack Experience 

Course Overview and Learning Objectives 

The next proficiencies you will acquire consist of how to add your personal preferences to 

Slack, including creating and configuring notifications. Adding and managing apps is also 

an important part of this course.  

Course Outline 

✓ Customizing Personal Slack Preferences 

✓ Configuring Notifications 

✓ Adding Apps to Slack 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 5 

 

Working with Slack Teams 

Course Overview and Learning Objectives 

The final course is about teams.  You will learn how to customize appearances, settings, 

and permissions. Changing users’ roles, transferring ownership, exporting team data, and 

deleting teams are some of the other topics that will be covered.  

Course Outline 

✓ Customizing Your Team 

✓ Customizing Team Settings and Permissions 

✓ Managing Team Membership 

✓ Managing Slack Teams 

✓ Review Questions 

✓ Lesson Labs 

Corresponding Instructor-Led Course 

✓ Slack for Business, Lesson 6 
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Microsoft Office 2013 Courses 

Microsoft Access 2013  

Advanced Form Tasks, Part One  

Course Overview and Learning Objectives 

This is the first of three courses that looks at advanced form tasks, including limiting user 

access to a form, creating checkboxes and command buttons, building command button 

events, and creating event procedures. 

Course Outline 

✓ Limiting User Access to a Form 

✓ Creating Checkboxes and Command Buttons 

✓ Building Command Button Events 

✓ Creating Event Procedures 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 5 

Advanced Form Tasks, Part Two  

Course Overview and Learning Objectives 

This course continues the study of advanced form tasks. It looks at how to use hyperlinks 

in a form, add links to other database objects, insert a mailto link into a form, add a 

browser control to a form, and perform calculations in a form. 

Course Outline 

✓ Using Hyperlinks in a Form 

✓ Adding Links to Other Database Objects 

✓ Inserting a Mailto Link in a Form 

✓ Adding a Browser Control to a Form 

✓ Performing Calculations in a Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 6 
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Advanced Form Tasks, Part Three  

Course Overview and Learning Objectives 

The third installment of this trilogy wraps up the riveting story of advanced form tasks. 

Here students will learn how to export a form to XML, as a Word document, as HTML, and 

other formats. How to send a form as an e-mail attachment will also be covered. 

Course Outline 

✓ Exporting Your Form to XML 

✓ Exporting a Form as a Word Document 

✓ Exporting a Form as HTML 

✓ Sending a Form as an E-mail Attachment 

✓ Exporting a Form to Other Formats 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 7 

Advanced Macro Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to create event procedures, data macros, and 

submacros. 

Course Outline 

✓ Creating Event Procedures 

✓ Creating Data Macros 

✓ Creating Submacros 

✓ Grouping Submacros 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 11 
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Advanced Query Tasks 

Course Overview and Learning Objectives 

This course will give students the answers about queries. Topics covered include how to 

create SQL queries, use the Expression Builder, create SQL statements, and use SQL 

keywords. 

Course Outline 

✓ Understanding SQL Statements 

✓ Basic SQL Keywords 

✓ Creating SQL Queries 

✓ Using the Expression Builder 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 6 

Advanced Table Tasks 

Course Overview and Learning Objectives 

In this course, students are shown how to insert application parts, use the Table Analyzer 

Wizard, create validation rules, and configure validation messages. 

Course Outline 

✓ Inserting Application Parts 

✓ Using the Table Analyzer Wizard 

✓ Creating Validation Rules 

✓ Configuring Validation Messages 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 2 
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Creating Advanced Queries 

Course Overview and Learning Objectives 

Getting a more in-depth look at queries is the goal of this course. Students will learn how 

to use parameter queries, multiple table queries, crosstab queries, make-table queries, 

append queries, delete queries, and update queries. 

Course Outline 

✓ Creating and Using Parameter Queries 

✓ Creating and Using Crosstab Queries 

✓ Creating and Using Make-Table Queries 

✓ Creating and Using Multiple Table Queries 

✓ Creating and Using Append Queries 

✓ Creating and Using Delete Queries 

✓ Creating and Using Update Queries 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 10 

Creating Basic Macros 

Course Overview and Learning Objectives 

This course shows students how to create a standalone macro, use the Action Catalog, 

add comments to macros, use If-Then actions, and handle macro errors. 

Course Outline 

✓ Creating a Standalone Macro 

✓ Using the Action Catalog 

✓ Adding Comments to Macros 

✓ Using If-Then Actions 

✓ Handling Macro Errors 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 10 
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Creating Basic Queries 

Course Overview and Learning Objectives 

This course allows students to develop skills on queries. They will learn how to create a 

query with the wizard, run a query, sort and filter a query, and use and apply query views. 

Students will also learn about the types of queries that are available. 

Course Outline 

✓ Types of Queries 

✓ Creating a Query with the Wizard 

✓ Running a Query 

✓ Understanding Query Views 

✓ Sorting and Filtering a Query 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 9 

Creating Forms 

Course Overview and Learning Objectives 

This course begins with the steps to create forms from an object. It then proceeds to 

looking at creating forms using the wizard. Students will also learn to create forms from 

scratch and how to use form views. 

Course Outline 

✓ Creating a Form from an Object 

✓ Creating a Form with the Wizard 

✓ Creating a Form from Scratch 

✓ Understanding Form Views 

✓ Using a Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 5 
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Creating Modal Dialog Boxes 

Course Overview and Learning Objectives 

Modal dialog boxes get a thorough look in this course. Topics include how to create, 

format, and modify a modal dialog box. 

Course Outline 

✓ Creating a Modal Dialog Box 

✓ Adding Controls 

✓ Setting Properties 

✓ Formatting a Modal Dialog Box 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 7 

Creating Navigation Forms 

Course Overview and Learning Objectives 

Next, students are shown how to create a navigation form and add tabs to it, create a tab 

hierarchy in a navigation form, and automatically display a navigation form when the 

database opens. 

Course Outline 

✓ Creating a Navigation Form 

✓ Adding Tabs to a Navigation Form 

✓ Creating a Tab Hierarchy 

✓ Displaying the Navigation Form when the Database Opens 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 5 
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Creating Reports 

Course Overview and Learning Objectives 

Reports are the focus of this particular course. First, students are shown how to create a 

report from an object and by using the wizard. Students will also learn how to create a 

report from scratch, use report views, and print reports. 

Course Outline 

✓ Creating a Report from an Object 

✓ Creating a Report with the Wizard 

✓ Creating a Report from Scratch 

✓ Understanding Report Views 

✓ Printing Reports 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 7 

Creating Split Forms  

Course Overview and Learning Objectives 

A split form is designed to give a user two views of data simultaneously. Learners will 

come away from this course knowing how to create a split form, split an existing form, use 

a split form, and fix the form separator in place. 

 

Course Outline 

✓ Creating a Split Form 

✓ Splitting an Existing Form 

✓ Using a Split Form 

✓ Fixing the Form Separator 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 8 
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Creating Subforms 

Course Overview and Learning Objectives 

This course covers how to create and use subforms, link subforms with parent forms, and 

format a subform within a main form. 

Course Outline 

✓ Creating Subforms 

✓ Using Subforms 

✓ Linking Subforms with Parent Forms 

✓ Formatting a Subform within a Main Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 4 

Customizing Access  

Course Overview and Learning Objectives 

This final course shows students how to customize Access for their own purposes. 

Students will learn how to change user information, change the Office background and 

theme, and change the default database type and location. 

Course Outline 

✓ Changing User Information 

✓ Changing the Office Background and Theme 

✓ Setting the Default Database Type and Location 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 12 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course looks at the interface and tips for customizing it. Students are shown how to 

collapse and pin the ribbon, customize the Quick Access toolbar, hide and show ribbon 

tabs, create custom tabs, and reset changes made to the interface.  

Course Outline 

✓ Collapsing and Pinning the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 12 

Formatting Forms 

Course Overview and Learning Objectives 

Students will start this course by learning how to change the theme of a form. Also 

covered is how to use the Format Painter, add fields to a form, and add controls and 

images to a form. 

Course Outline 

✓ Understanding Bound and Unbound Controls 

✓ Changing the Theme 

✓ Using the Format Painter 

✓ Adding Fields 

✓ Adding Controls 

✓ Adding Images and Logos 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 6 
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Formatting Reports 

Course Overview and Learning Objectives 

This course continues the look at reports. Topics include how to change the theme of 

reports, use the Format Painter, and group and sort data in reports. The course also 

covers adding controls, images, logos, page numbers, headers, and footers to reports. 

Course Outline 

✓ Changing the Theme 

✓ Using the Format Painter 

✓ Grouping and Sorting Data 

✓ Adding Controls 

✓ Adding Images and Logos 

✓ Adding Page Numbers, Headers, and Footers 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 8 

Formatting Tables 

Course Overview and Learning Objectives 

Delving deeper into tables is the focus of this course. In it, students will learn to select 

data, change the size of rows and columns, apply text formatting and fill color, apply 

gridlines, and perform a spell check. 

Course Outline 

✓ Selecting Data 

✓ Changing Column and Row Width and Height 

✓ Applying Text Formatting 

✓ Applying Gridlines 

✓ Changing Fill Colors 

✓ Checking Your Spelling 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 4 
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Managing COM Add-ins  

Course Overview and Learning Objectives 

Add-ins are small programs you can install and enable to add custom commands and new 

features to Access 2013. This course covers how to view add-ins; open the Add-In 

Manager; and install, disable, and uninstall add-ins. 

Course Outline 

✓ Creating Event Procedures 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 11 

Managing Data 

Course Overview and Learning Objectives 

This course will show students how to view relationships, view object dependencies, 

enforce referential integrity, and enforce cascade update and delete. Students also will 

learn about types of relationships and referential integrity. 

Course Outline 

✓ Types of Relationships 

✓ Viewing Relationships 

✓ Viewing Object Dependencies 

✓ What is Referential Integrity? 

✓ Enforcing Referential Integrity 

✓ Using Cascade Delete and Cascade Update 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 1 
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Managing Data Entry in Tables 

Course Overview and Learning Objectives 

In this course, students will learn how to mark fields as required, mark a field for indexing, 

create lookup fields, create value lists, and create input masks. 

Course Outline 

✓ Marking Fields as Required 

✓ Marking a Field for Indexing 

✓ Creating Lookup Fields 

✓ Creating Value Lists 

✓ Creating Input Masks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 3 

Managing Your Database 

Course Overview and Learning Objectives 

In this course, students will learn to compact and repair a database and encrypt a 

database using a password. Students are also shown how to back up a database, export a 

database and database objects, and print database objects. 

Course Outline 

✓ Compacting and Repairing a Database 

✓ Encrypting a Database with a Password 

✓ Backing Up Your Database 

✓ Exporting a Database and Database Objects 

✓ Printing Database Objects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 11 
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Splitting the Database 

Course Overview and Learning Objectives 

When dealing with databases, it’s a good idea to have tools to manipulate them 

effectively. This course takes a look at how to back up a database, split a database, 

configure Access 2013 for a multi-user database, and set record locking options. 

Course Outline 

✓ Backing Up the Database 

✓ Splitting the Database 

✓ Configuring Access 2013 for a Multi-User Database 

✓ Setting Record Locking Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 8 

SQL and Microsoft Access  

Course Overview and Learning Objectives 

This course teaches students all about SQL and Access. Topics include the definition of 

SQL, SQL statements and naming conventions, as well as SQL syntax. 

Course Outline 

✓ What is SQL? 

✓ What is an SQL Statement? 

✓ What is an SQL Naming Convention? 

✓ What is SQL Syntax? 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 1 
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The Basics 

Course Overview and Learning Objectives 

This course begins with a look at how to get started with Access, create and save a 

database, and open an existing database. Then, students will learn how to sign into Office 

with a Microsoft account. The course also includes information on database terminology. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Creating a Database 

✓ Database Terminology 

✓ Saving a Database 

✓ Opening a Database 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 1 

Using Access with SharePoint Server 

Course Overview and Learning Objectives 

SharePoint Server meshes well with Access 2013 and this course takes advantage of that 

relationship. Students will learn how to link tables to lists, move a database to SharePoint, 

save a database to SharePoint, and use Access web apps. 

Course Outline 

✓ Linking Tables and Lists 

✓ Moving a Database to SharePoint 

✓ Saving a Database to SharePoint 

✓ About Access Web Apps 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 9 
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Using Digital Signatures  

Course Overview and Learning Objectives 

A digital signature ensures that a digital file is authentic and provides information on who 

created it and if it has been altered in any way. This course covers what a digital signature 

is, how to obtain a digital signature, how to attach a signature to a database, and how to 

remove a signature from a database. 

Course Outline 

✓ What is a Digital Signature? 

✓ Obtaining a Digital Signature 

✓ Attaching Your Signature to a Database 

✓ Extracting and Using a Signed Database 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 9 

Using SQL Joins  

Course Overview and Learning Objectives 

Joins are used to combine data from separate tables. This course teaches students how to 

create simple joins, use an alias, sort joins, and create outer joins. 

Course Outline 

✓ Creating Simple Joins 

✓ Using an Alias 

✓ Sorting Joins 

✓ Creating Outer Joins 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 3 
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Using Subqueries  

Course Overview and Learning Objectives 

A subquery is a SELECT statement nested in a statement or in another subquery. Usually, 

they are used to return data that will be used in the main query as a condition to help 

narrow down the data that is being retrieved. This course teaches students what 

subqueries are, how to create a subquery, how to create subqueries with aggregate 

functions, about nested subqueries, and how to use the IN keyword with subqueries. 

Course Outline 

✓ What is a Subquery? 

✓ Creating a Subquery 

✓ Subqueries with Aggregate Functions and Nested Subqueries 

✓ Using the IN Keyword with Subqueries 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 4 

Using the SELECT Statement  

Course Overview and Learning Objectives 

The SELECT statement is used to find and display specific values from a set of data. It is 

very powerful, especially when used correctly. This course gives learners insight into 

selecting all data, selecting specific data, selecting conditional data, and using the ORDER 

BY statement. 

Course Outline 

✓ Selecting All Data 

✓ Selecting Specific Data 

✓ Selecting Conditional Data 

✓ Using the ORDER BY Statement 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 2 
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Using the Trust Center  

Course Overview and Learning Objectives 

The Trust Center is where you can find all of the security and privacy settings for 

Microsoft Office programs. This course covers how to open the Trust Center, trust a 

database, configure macro security, and customize the Message Bar. 

Course Outline 

✓ Opening the Trust Center 

✓ Trusting a Database 

✓ Configuring Macro Security 

✓ Customizing the Message Bar 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Expert, Module 10 

Using Visual Basic for Applications  

Course Overview and Learning Objectives 

This course explores how to use Visual Basic for Applications. Students will learn how to 

convert a macro to Visual Basic, use Visual Basic for Applications, use modules, and build 

Visual Basic procedures. 

Course Outline 

✓ Converting a Macro to Visual Basic 

✓ Using Visual Basic for Applications 

✓ Understanding Modules 

✓ Building Visual Basic Procedures 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Advanced Essentials, Module 12 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 304 

Working with Tables and Records 

Course Overview and Learning Objectives 

This course takes a look at tables and records. Here, students will learn to create a table, 

add and edit database records, search and browse records, and delete and print records. 

How to make the most of different table views is covered here as well. 

Course Outline 

✓ Creating a Table 

✓ Understanding Table Views 

✓ Adding and Editing Records 

✓ Searching and Browsing Records 

✓ Deleting Records 

✓ Printing Records 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 3 

Your First Database 

Course Overview and Learning Objectives 

This course discusses how to search for objects along with how to open various database 

objects. Students will also learn how to change object views and how to manage objects. 

Also included is information on security warnings and data relationships. 

Course Outline 

✓ About Security Warnings 

✓ About Relationships 

✓ Searching for Objects 

✓ Opening Database Objects 

✓ Changing the Object View 

✓ Understanding the Types of Views Available 

✓ Managing Objects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2013: Core Essentials, Module 2 
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Microsoft Excel 2013 

Advanced Formula Tasks 

Course Overview and Learning Objectives 

Formulas are at the core of how Excel works. This course gives students insight into using 

relative and absolute cell references, multiple cell references, 3D references, and array 

formulas. 

Course Outline 

✓ Understanding Relative and Absolute Cell References 

✓ Using Multiple Cell References 

✓ Using 3D References 

✓ Using Array Formulas 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 1 

Advanced PivotTable Features 

Course Overview and Learning Objectives 

With this course, students will get a look at using many features of PivotTables. The 

discussion covers how to create a basic PivotTable and PivotChart, use the PivotTable 

Fields pane, add calculated fields to a PivotTable, and sort and filter pivoted data. 

Course Outline 

✓ Creating a Basic PivotTable 

✓ Creating a Basic PivotChart 

✓ Using the PivotTable Fields Pane 

✓ Adding Calculated Fields 

✓ Sorting Pivoted Data 

✓ Filtering Pivoted Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 10 
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Analyzing Data 

Course Overview and Learning Objectives 

The Analysis ToolPak is another useful Excel add-in. This course shows students how to 

enable and use the Analysis ToolPak, how to use Goal Seek, and how to use data tables. 

Course Outline 

✓ Enabling the Analysis ToolPak 

✓ Using Data Analysis Tools 

✓ Using Goal Seek 

✓ Using Data Tables 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 9 

Charting Data 

Course Overview and Learning Objectives 

Various methods to chart data in Excel 2013 are covered in this course. Topics include 

how to create Sparklines and timelines, plus how to insert PivotTables and PivotCharts, 

and use Slicers. 

Course Outline 

✓ Creating Sparklines 

✓ Inserting Charts 

✓ Inserting PivotTables 

✓ Inserting PivotCharts 

✓ Using Slicers 

✓ Creating Timelines 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 10 
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Creating Scenarios 

Course Overview and Learning Objectives 

Scenarios are useful to simulate data results based upon certain circumstances. This 

course teaches how to create, load, merge, edit, and delete scenarios, and how to create a 

scenario summary report. 

Course Outline 

✓ Creating Scenarios 

✓ Loading Scenarios 

✓ Merging Scenarios 

✓ Editing Scenarios 

✓ Creating a Scenario Summary Report 

✓ Deleting Scenarios 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 7 

Customizing the Interface 

Course Overview and Learning Objectives 

This course focuses on ways to customize the interface. Topics include how to change 

ribbon display options and how to customize the Quick Access toolbar. Also covered is 

how to hide and show ribbon tabs, create custom ribbon tabs, and reset the interface. 

Course Outline 

✓ Changing Ribbon Display Options 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 12 
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Formatting Data 

Course Overview and Learning Objectives 

There are many ways to format data in Excel 2013. This course looks at how to adjust text 

wrapping, change the size of rows and columns, adjust cell alignment, change text 

direction, and apply number formatting. 

Course Outline 

✓ Wrapping Text 

✓ Changing the Size of Rows and Columns 

✓ Adjusting Cell Alignment 

✓ Changing Text Direction 

✓ Changing Number Format 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 7 

Formatting Text 

Course Overview and Learning Objectives 

Various ways to format and work with text are the main points of this course. Ways to 

change font face, size, and color, apply text effects, and add borders and fill to cells are all 

covered. Other topics include using the Font tab of the Format Cells dialog and how to 

clear formatting from text. 

Course Outline 

✓ Changing the Font Face, Size, and Color 

✓ Applying Text Effects 

✓ Applying Borders and Fill 

✓ Using the Font Tab of the Format Cells Dialog 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 6 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 309 

Formatting the Workbook 

Course Overview and Learning Objectives 

This course will teach students how to use cell styles, format data as a table, and change 

the theme of a workbook. Also covered is inserting page breaks and adding a background 

image. 

Course Outline 

✓ Using Cell Styles 

✓ Formatting Data as a Table 

✓ Changing the Theme 

✓ Inserting Page Breaks 

✓ Adding a Background 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 8 

Inserting Art and Objects 

Course Overview and Learning Objectives 

Inserting SmartArt, text boxes, and equations into worksheets are covered in this course. 

Also touched upon is how to draw shapes on worksheets. 

Course Outline 

✓ Inserting SmartArt 

✓ Inserting Text Boxes 

✓ Inserting Pictures 

✓ Inserting Equations 

✓ Drawing Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 9 
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Linking, Consolidating, and Combining Data  

Course Overview and Learning Objectives 

When working with multiple files with interrelated data it’s handy to make the most of 

linking. This course covers how to link and consolidate workbooks, consolidate 

worksheets, and pivot consolidated data. 

Course Outline 

✓ Linking Workbooks 

✓ Consolidating Workbooks 

✓ Consolidating Worksheets 

✓ Pivoting Consolidated Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 12 

Managing Data 

Course Overview and Learning Objectives 

It’s no good to have vast amounts of data if you cannot handle it efficiently. This course 

focuses on how to consolidate data, remove duplicate values, configure data validation, 

transpose data, and convert text to columns. 

Course Outline 

✓ Consolidating Information 

✓ Removing Duplicates 

✓ Configuring Data Validation 

✓ Transposing Data 

✓ Converting Text to Columns 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 5 
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Outlining and Grouping Data 

Course Overview and Learning Objectives 

In this course, students will learn how to outline data, show and hide details of outlined 

data, group data, create subtotals, and remove outlining and grouping. 

Course Outline 

✓ Outlining Data 

✓ Showing and Hiding Outline Details 

✓ Grouping Data 

✓ Creating Subtotals 

✓ Removing Outlining and Grouping 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 6 

Resolving Formula Errors 

Course Overview and Learning Objectives 

Mistakes happen; it’s a fact of life! Luckily, Excel offers some tools to fix formula errors. 

This course covers how to trace formula precedents and dependents, show and evaluate 

formulas, set error checking options, use error option buttons, and run an error check. 

Course Outline 

✓ Tracing Formula Precedents and Dependents 

✓ Showing Formulas 

✓ Evaluating Formulas 

✓ Setting Error Checking Options 

✓ Using Error Option Buttons 

✓ Running an Error Check 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 4 
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The Basics 

Course Overview and Learning Objectives 

This course begins by covering how to open Excel and sign into a Microsoft account. Also 

covered are the parts of a workbook along with how to create, open, and save workbooks. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Creating a New Workbook 

✓ Parts of a Workbook 

✓ Saving a Workbook 

✓ Opening a Workbook 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 1 

Tracking Changes  

Course Overview and Learning Objectives 

When changes are made to a file it’s very handy to know what has been changed and when 

and by who. This course touches upon how to track and review changes, set options for 

tracking changes, and stop tracking changes. 

Course Outline 

✓ Tracking Changes 

✓ Reviewing Changes 

✓ Setting Options for Tracking Changes 

✓ Stopping Tracking Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 11 
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Using Advanced Functions 

Course Overview and Learning Objectives 

Applying the correct functions to data can save a lot of work and this course shows 

students how to accomplish that. The functions covered in this course include PMT, FV, 

VLOOKUP, and HLOOKUP, as well as IF, AND, OR functions. 

Course Outline 

✓ Using the PMT Function 

✓ Using the FV Function 

✓ Using VLOOKUP and HLOOKUP Functions 

✓ Using IF, AND, OR Functions 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 3 

Using Basic Excel Tools 

Course Overview and Learning Objectives 

Cell references and formulas are covered in this course. Also discussed are how to use 

basic formulas, how to learn basic and advanced functions, and how to run spell check. 

How to use the sort and filter tools to organize data is also covered. 

Course Outline 

✓ Understanding Cell References and Formulas 

✓ Using Basic Formulas 

✓ Using Basic Functions 

✓ Using Advanced Functions 

✓ Using Spell Check 

✓ Using Sort and Filter 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 4 
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Using Comments  

Course Overview and Learning Objectives 

Comments allow users to engage with the material and each other through making 

messages added to Excel files. This course gives students the knowledge how to insert, 

edit, navigate, and delete comments. 

Course Outline 

✓ Inserting Comments 

✓ Editing Comments 

✓ Navigating Through Comments 

✓ Deleting Comments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 10 

Using Conditional Formatting  

Course Overview and Learning Objectives 

This course delves into Conditional Formatting in a way that users can grasp and exploit 

this feature. It covers how to apply conditional formatting, apply multiple rule sets, create 

custom rule sets, view and manage rules, and clear custom formatting rules. 

Course Outline 

✓ Applying Conditional Formatting 

✓ Applying Multiple Rule Sets 

✓ Creating Custom Rule Sets 

✓ Viewing and Managing Rules 

✓ Clearing Custom Rules 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 1 
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Using Custom AutoFill Lists  

Course Overview and Learning Objectives 

An AutoFill list is a series or sequence of numbers or text strings that can be filled into 

cells automatically when you drag your mouse pointer down a column or across a row. 

This course will show users how to create and use a custom AutoFill list, and how to 

modify and delete a custom AutoFill list. 

Course Outline 

✓ Creating a Custom AutoFill List 

✓ Using a Custom AutoFill List 

✓ Modifying a Custom AutoFill List 

✓ Deleting a Custom AutoFill List 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 9 

 

Using Excel as a Database  

Course Overview and Learning Objectives 

Databases are an assemblage of data which can be manipulated in many ways. This course 

takes a look at how to filter data with wildcard characters, validate data with lists or 

formulas, and how to use database functions. 

Course Outline 

✓ Filtering with Wildcard Characters 

✓ Validating your Data 

✓ Data Validation using Lists 

✓ Data Validation using Formulas 

✓ Using Database Functions 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 8 
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Using the Inquire Add-In  

Course Overview and Learning Objectives 

The Inquire Add-In is only available in the Office Professional Plus 2013 and Office 365 

Professional Plus editions. This course shows students how to install the Inquire add-in, 

generate a workbook analysis report, view a relationship diagram or report, view cell 

relationships, and compare two workbooks. 

Course Outline 

✓ Installing Inquire 

✓ Generating a Workbook Analysis Report 

✓ Viewing Workbook and Worksheet Relationships 

✓ Viewing Cell Relationships 

✓ Comparing Two Workbooks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 5 

Using Macros 

Course Overview and Learning Objectives 

Macros are a wonderful time-saving device in Excel 2013. This concluding course teaches 

students how to record a macro, write a macro using the Visual Basic Editor, edit a macro, 

and run a macro. 

Course Outline 

✓ Recording a Macro 

✓ Writing a Macro using the Visual Basic Editor 

✓ Editing a Macro 

✓ Running a Macro 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 12 
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Using PowerPivot 

Course Overview and Learning Objectives 

At the end of this course, students will know how to enable PowerPivot, import Access 

and Excel data into PowerPivot, integrate data with relationships, and create a PivotTable 

with PowerPivot data. 

Course Outline 

✓ Enabling PowerPivot 

✓ Importing Access Data 

✓ Importing Excel Data 

✓ Integrating Data with Relationships 

✓ Creating a PivotTable with PowerPivot Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 11 

Using Power View, Part One  

Course Overview and Learning Objectives 

Power View has many applications for upper-level users of Excel 2013. Students will learn 

in this course how to enable Power View, create a Power View, add and remove fields, 

arrange fields, and filter and sort data. 

Course Outline 

✓ Enabling Power View 

✓ Creating a Power View 

✓ Adding and Removing Fields 

✓ Arranging Fields 

✓ Filtering Data 

✓ Sorting Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 3 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 318 

Using Power View, Part Two  

Course Overview and Learning Objectives 

Power View is such a useful tool that it deserves an extra-close look which takes place 

here in Part Two. This course looks at how to: refresh data, choose a visualization, change 

tile display, and set display options. 

Course Outline 

✓ Refreshing Data 

✓ Choosing a Visualization 

✓ Changing Tile Display 

✓ Setting Display Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 4 

Using Solver 

Course Overview and Learning Objectives 

Solver is an Excel add-in that can do a lot of the heavy lifting when it comes to dealing with 

a data problem. In this course, students are shown how to set up a worksheet for Solver, 

run Solver, generate reports and scenarios, modify Solver constraints, and set Solver 

options. 

Course Outline 

✓ Setting up the Worksheet 

✓ Running Solver 

✓ Generating Reports and Scenarios with Solver 

✓ Modifying Constraints 

✓ Setting Solver Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 8 
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Using Timesaving Tools 

Course Overview and Learning Objectives 

Timesaving is the focus of this course. Students will learn how to use AutoFill, Flash Fill, 

AutoSum, AutoComplete, and AutoCalculate. 

Course Outline 

✓ Using AutoFill 

✓ Using Flash Fill 

✓ Using AutoSum 

✓ Using AutoComplete 

✓ Using AutoCalculate 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 5 

Viewing, Printing, and Sharing Your Workbook 

Course Overview and Learning Objectives 

Ways to view and distribute a workbook are covered in this course. Topics include using 

views, saving a workbook as PDF or XPS, printing and e-mailing a workbook, and sharing a 

workbook on OneDrive. 

Course Outline 

✓ Using Views 

✓ Saving a Workbook as PDF or XPS 

✓ Printing a Workbook 

✓ E-Mailing a Workbook 

✓ Sharing Your Workbook on OneDrive 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 11 
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Working with Data 

Course Overview and Learning Objectives 

This course covers inserting rows and columns along with how to merge and split cells. 

Additional topics include using Paste Special, find and replace, and hiding and unhiding 

cells. 

Course Outline 

✓ Inserting Rows and Columns 

✓ Merging and Splitting Cells 

✓ Moving Cells 

✓ Using Paste Special 

✓ Using Find and Replace 

✓ Hiding and Unhiding Cells 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 3 

Working with Named Ranges 

Course Overview and Learning Objectives 

This course is all about named ranges. Students will learn what named ranges are as well 

as how to define, edit, and delete them. Students are also shown how to use named ranges 

in formulas. 

Course Outline 

✓ Understanding Named Ranges 

✓ Defining Named Ranges 

✓ Editing Named Ranges 

✓ Deleting Named Ranges 

✓ Using Named Ranges in Formulas 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Advanced Essentials, Module 2 
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Working with Slicers  

Course Overview and Learning Objectives 

Slicers allow you to quickly filter any data that is displayed within a PivotTable. In this 

course students are shown how to insert and use a slicer, rename a slicer, change slicer 

settings, format a slicer, and clear a slicer. 

Course Outline 

✓ Inserting and Using a Slicer 

✓ Renaming the Slicer 

✓ Changing Slicer Settings 

✓ Formatting a Slicer 

✓ Clearing the Slicer 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 2 

Working with Records and Fields  

Course Overview and Learning Objectives 

Records and fields are the building blocks of data. Covered in this course is what they 

actually are and how to add fields by inserting columns, add records by inserting rows, and 

delete records or fields. 

Course Outline 

✓ What are Records and Fields? 

✓ Adding Fields by Inserting Columns 

✓ Adding Records by Inserting Rows 

✓ Deleting Records or Fields 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 7 
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Working with Tables  

Course Overview and Learning Objectives 

Tables are efficient for dealing with ranges of data. Students will get the most from the 

course as they learn what tables are and how to create, resize, and clear tables, as well as 

how to choose a table style. 

Course Outline 

✓ What is a Table? 

✓ Creating Tables 

✓ Resizing the Table 

✓ Choosing a Table Style 

✓ Clearing the Table 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Expert, Module 6 

Your First Workbook 

Course Overview and Learning Objectives 

This course covers how to enter, select, and delete data. How to undo and redo is also 

covered, along with using cut, copy, and paste functions. 

Course Outline 

✓ Selecting Data 

✓ Entering and Deleting Data 

✓ Using Undo and Redo 

✓ Using Cut, Copy, and Paste 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2013: Core Essentials, Module 2 
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Microsoft InfoPath Designer 2013 

Adding Images to a Form 

Course Overview and Learning Objectives 

Images can bring a form to life or add another level of information. In this course learners 

are shown how to insert local and online images; resize, move, or delete images; and 

assign alternative text to images. 

Course Outline 

✓ Inserting Local Images 

✓ Inserting Online Images 

✓ Resizing Images 

✓ Moving Images 

✓ Deleting Images 

✓ Assigning Alternative Text to Images 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 4 

Adding Objects to a Form 

Course Overview and Learning Objectives 

Within a form there are several types of objects that can be added. This course covers 

how to create a hyperlink, insert a page break, insert a horizontal line, and insert a symbol. 

Course Outline 

✓ Creating a Hyperlink 

✓ Inserting a Page Break 

✓ Inserting a Horizontal Line 

✓ Inserting a Symbol 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 5 
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Creating a Form from a Database 

Course Overview and Learning Objectives 

In InfoPath Designer 2013 you can create a form based upon a database. In this course, 

students are shown here how to create a form from a database, add fields to a database 

form, query a database, and submit data. 

Course Outline 

✓ Creating a Form from a Database 

✓ Adding Controls to a Database Form 

✓ Querying a Database 

✓ Submitting Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 10 

Creating a Form Load Rule 

Course Overview and Learning Objectives 

A form load rule is configured to automatically run when a form is opened. Here, students 

are introduced to ways that they can create a form load rule, specify conditions, add 

actions, edit a form load rule, and enable or disable a form load rule. 

Course Outline 

✓ Creating a Form Load Rule 

✓ Specifying Conditions 

✓ Adding Actions 

✓ Editing a Form Load Rule 

✓ Enabling or Disabling a Form Load Rule 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 6 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 325 

Creating Object Controls 

Course Overview and Learning Objectives 

This course takes a close look at adding object controls to a form. Students are shown how 

to insert an object control, how to format an object control, and how to assign actions to 

buttons. 

Course Outline 

✓ Inserting an Object Control 

✓ Formatting Object Controls 

✓ Assigning Actions to Buttons 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 2 

Creating Template Parts 

Course Overview and Learning Objectives 

There are several options when it comes to template parts. This course looks at how to 

create a template part, save a template part, use a template part, and manage template 

parts. 

Course Outline 

✓ Creating a Template Part 

✓ Saving a Template Part 

✓ Using a Template Part 

✓ Managing Template Parts 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 8 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course allows students to make the InfoPath Designer interface their own. Here they 

will learn how to collapse and pin the ribbon, customize the Quick Access toolbar, hide 

and show ribbon tabs, create custom ribbon tabs, and reset the interface. 

Course Outline 

✓ Collapsing and Pinning the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 12 

Finishing the Form 

Course Overview and Learning Objectives 

When students complete this course they will know how to create a data connection to 

submit data, set advanced form options, modify template properties, and use the Design 

Checker. 

Course Outline 

✓ Creating a Data Connection to Submit Data 

✓ Setting Advanced Form Options 

✓ Modifying Template Properties 

✓ Using the Design Checker 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013; Core Essentials, Module 9 
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Formatting Text 

Course Overview and Learning Objectives 

Like all modern programs, InfoPath Designer 2013 has the functionality to format text. 

This course guides students through various text formatting options. They will learn about 

changing font face, size, and color, plus how to apply font effects and styles. The course 

also touches upon how to apply bullets, how to use the Format Painter, and how to clear 

formatting from text. 

Course Outline 

✓ Changing Font Face, Size, and Color 

✓ Applying Font Effects 

✓ Applying Bullets and Numbers 

✓ Applying Font Styles 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013; Core Essentials, Module 3 

Importing and Publishing Forms 

Course Overview and Learning Objectives 

InfoPath Designer can be used to import forms from both Word and Excel and add 

functionality to these forms. This course addresses how to import a form from both 

Microsoft Word and Microsoft Excel, how to publish a form by e-mail, and how to edit 

forms after publishing. 

Course Outline 

✓ Importing a Form from Word 

✓ Importing a Form from Excel 

✓ Publishing a Form by E-mail 

✓ Editing Forms After They Have Been Published 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 11 
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Inserting Controls 

Course Overview and Learning Objectives 

Controls are the primary components of InfoPath Designer forms. They can be used to 

enter data as well as interact with the form in a variety of different ways. In this course, 

students will learn how to insert standard, repeating, optional, choice, and master/detail 

controls. They will also learn how to use the Control Properties dialog. 

Course Outline 

✓ Inserting Standard Controls 

✓ Inserting Repeating Controls 

✓ Inserting Optional Controls 

✓ Inserting Choice Controls 

✓ Inserting Master/Detail Controls 

✓ Using the Control Properties Dialog 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 5 

Linking to External Data 

Course Overview and Learning Objectives 

This course covers how to link forms with external data by touching upon how to link to a 

web service, how to import database files, how to import XML data, and how to manage 

data connections. 

Course Outline 

✓ Linking to a Web Service 

✓ Importing Database Files 

✓ Importing XML Data 

✓ Managing Data Connections 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 7 
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Managing Data 

Course Overview and Learning Objectives 

Data is useful if you can manage it properly and that’s what students will learn here in 

relation to InfoPath Designer. This course looks at adding a data source, viewing data 

source properties, using resource files, managing fields, adding fields and groups to forms, 

and binding controls to existing fields. 

Course Outline 

✓ Adding a Data Source 

✓ Viewing Data Source Properties 

✓ Using Resource Files 

✓ Managing Fields 

✓ Adding Fields and Groups 

✓ Binding Controls to Fields 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 7 

Managing User Roles 

Course Overview and Learning Objectives 

User roles in InfoPath Designer allow designers of a form to display customized versions 

of a form to specific users or groups of users. This course will teach students how to add 

and edit a user role, set a user role as default, change the order of user roles, and remove a 

user. 

Course Outline 

✓ Adding a User Role 

✓ Editing a User Role 

✓ Setting a User as Default 

✓ Changing the Order of User Roles 

✓ Removing a User 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 1 
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Modifying Field Properties 

Course Overview and Learning Objectives 

This course will teach students how to bind a field to a control, change field bindings, 

change the control type, and create reference fields. 

Course Outline 

✓ Binding a Field to a Control 

✓ Changing Field Bindings 

✓ Changing the Control Type 

✓ Creating Reference Fields 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 3 

Publishing the Form 

Course Overview and Learning Objectives 

This course teaches students how to preview a form, protect a form, publish a form, e-mail 

a form, and print a form. 

Course Outline 

✓ Previewing the Form 

✓ Protecting the Form 

✓ Publishing the Form 

✓ E-mailing the Form 

✓ Printing the Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 11 
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The Basics 

Course Overview and Learning Objectives 

This course covers how to get started with InfoPath Designer 2013. Students will learn 

how to sign into the program with a Microsoft account and how to create, save, and open a 

form. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Creating a Form 

✓ Saving a Form 

✓ Opening a Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 1 

Using InfoPath Designer with SharePoint Server 

Course Overview and Learning Objectives 

SharePoint is a web application platform that is used by many businesses as an intranet 

portal, external website, document and file manager, collaboration space, and much more. 

This course takes learners through a look at Microsoft SharePoint and its system 

requirements along with forms and workflows. Students will also learn how to publish an 

InfoPath form to a SharePoint Server. 

Course Outline 

✓ Understanding SharePoint 

✓ SharePoint System Requirements 

✓ Publishing an InfoPath Form to a SharePoint Server 

✓ Understanding Forms and Workflows 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 12 
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Using Rules to Validate Data 

Course Overview and Learning Objectives 

More data about data is coming students’ way in this course. They will learn how to create 

built-in validation rules, custom validation rules, formatting rules, and action rules. The 

course wraps up with a look at using the Rule Inspector. 

Course Outline 

✓ Creating Built-In Validation Rules 

✓ Creating Custom Validation Rules 

✓ Creating Formatting Rules 

✓ Creating Action Rules 

✓ Using the Rule Inspector 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 8 

Validating Data 

Course Overview and Learning Objectives 

Students will be taught how to validate data in this course. They will look at how to choose 

the data type for a control, require data entry for a control, mark a control as read-only, 

modify list box choices, and set default values for a control. 

Course Outline 

✓ Choosing the Data Type 

✓ Requiring Data Entry 

✓ Marking a Control as Read-Only 

✓ Setting Default Values 

✓ Modifying List Box Choices 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 6 
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Working with Tables 

Course Overview and Learning Objectives 

Tables are an important and useful part of InfoPath Designer. This course will teach 

students the ins and outs of tables, including how to select table data; insert and delete 

rows and columns; change column and row width, height, and cell padding; show and hide 

gridlines; and customize borders and shading. 

Course Outline 

✓ Selecting Table Data 

✓ Inserting and Deleting Rows and Columns 

✓ Changing Column and Row Width and Height 

✓ Changing Cell Padding 

✓ Showing and Hiding Gridlines 

✓ Customizing Borders and Shading 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 4 

Working with Views 

Course Overview and Learning Objectives 

Here students will learn about manipulating views. They are taught how to create a view, 

switch to a view, change view properties, set a view as the default, delete a view, and 

create a print view. 

Course Outline 

✓ Creating a View 

✓ Switching to a View 

✓ Changing View Properties 

✓ Setting a View as Default 

✓ Deleting a View 

✓ Creating a Print View 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 10 
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Working with XML Form Templates 

Course Overview and Learning Objectives 

XML is one of the key components that drives the success of InfoPath. In this course 

students will learn about XML and how to create a form from an XML schema, create a 

form from an XML file, and work with an XML form template. 

Course Outline 

✓ XML 101 

✓ Creating a Form from an XML Schema 

✓ Creating a Form from an XML File 

✓ Working with an XML Form Template 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Advanced Essentials, Module 9 

Your First Form 

Course Overview and Learning Objectives 

This course provides a chance for students to dive right into the heart of an InfoPath form. 

They will learn how to choose a page layout template and theme, how to insert tables, and 

how to add headers and footers. We all know that spelling is important, so the course 

wraps up with a look at using the spell checker. 

Course Outline 

✓ Choosing a Page Layout Template 

✓ Choosing a Theme 

✓ Inserting Tables 

✓ Inserting a Header and Footer 

✓ Checking Your Spelling 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Designer 2013: Core Essentials, Module 2 
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Microsoft InfoPath Filler 2013 

Completing a Form 

Course Overview and Learning Objectives 

This course takes a look at completing forms. Here, students are taught to use basic 

controls, enable and disable AutoComplete, switch views, use Find and Replace, and check 

spelling. 

Course Outline 

✓ Using Basic Controls 

✓ Enabling and Disabling AutoComplete 

✓ Switching Views 

✓ Using Find and Replace 

✓ Checking Your Spelling 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 2 

Customizing the Interface 

Course Overview and Learning Objectives 

This course allows students to customize the interface to meet their needs. The course 

covers how to collapse and pin the ribbon, customize the Quick Access toolbar, hide and 

show the ribbon tabs, and create custom ribbon tabs. The course concludes with a look at 

resetting the interface back to the default configuration. 

Course Outline 

✓ Collapsing and Pinning the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 12 
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Customizing Your Office Account 

Course Overview and Learning Objectives 

In this course, students will learn how to change their Microsoft account photo, view their 

Microsoft profile, and change their Office background and theme. The course concludes 

with a look at customizing connected services. 

Course Outline 

✓ Changing Your Photo 

✓ Viewing Your Microsoft Profile 

✓ Changing Your Office Background and Theme 

✓ Customizing Connected Services 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 11 

Exporting the Form 

Course Overview and Learning Objectives 

This course is all about exporting forms to PDF or XPS, a web page, and Excel. 

Course Outline 

✓ Exporting a Form to PDF or XPS 

✓ Exporting a Form to a Web Page 

✓ Exporting a Form to Excel 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 10 
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Formatting Text, Part One 

Course Overview and Learning Objectives 

In this course, students are shown how to change font face, size, and color; apply 

highlighting and font effects; use the Format Painter; and clear formatting. 

Course Outline 

✓ Changing Font Face and Size 

✓ Changing Font Color 

✓ Applying Highlighting 

✓ Applying Font Effects 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 4 

Formatting Text, Part Two 

Course Overview and Learning Objectives 

In this course, students will take a deeper look at formatting text. Topics include applying 

bullets and numbers, changing the alignment and spacing of text, adding a fill color, and 

applying font styles. 

Course Outline 

✓ Applying Bullets and Numbers 

✓ Changing Alignment 

✓ Changing Spacing 

✓ Adding a Fill Color 

✓ Applying Font Styles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 5 
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Inserting Objects 

Course Overview and Learning Objectives 

This course covers how to insert tables, local and online images, hyperlinks, and lines. 

Course Outline 

✓ Inserting Tables 

✓ Inserting Local Images 

✓ Inserting Online Images 

✓ Inserting Hyperlinks 

✓ Inserting Lines 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 8 

Submitting the Form 

Course Overview and Learning Objectives 

To begin this course, students are shown how to start a workflow and view workflow 

tasks. They are also taught how to submit, e-mail, print preview, and print a form. 

Course Outline 

✓ Starting a Workflow 

✓ Viewing Workflow Tasks 

✓ Submitting the Form 

✓ E-mailing the Form 

✓ Using Print Preview 

✓ Printing the Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 9 
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The Basics 

Course Overview and Learning Objectives 

This course introduces students to getting started with InfoPath Filler 2013 and how to 

sign into an Office account. Students will also learn how to open an InfoPath form and how 

to save it. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Opening a Form 

✓ Saving a Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 1 

Using Advanced Controls, Part One 

Course Overview and Learning Objectives 

In this course, students will get a feel for working with advanced controls. They are shown 

how to upload pictures to a form, attach files, use the date picker control, and use 

calculated controls. 

Course Outline 

✓ Uploading Pictures 

✓ Attaching Files 

✓ Using Date Picker Controls 

✓ Using Calculated Controls 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 6 
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Using Advanced Controls, Part Two 

Course Overview and Learning Objectives 

This course continues the look at controls. Students are shown how to use repeating 

controls, optional controls, choice controls, and master/detail controls. 

Course Outline 

✓ Using Repeating Controls 

✓ Using Optional Controls 

✓ Using Choice Controls 

✓ Using Master/Detail Controls 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 7 

Working with Text 

Course Overview and Learning Objectives 

In this course, students will learn how to work with text. Topics include cutting, copying, 

and pasting text; inserting symbols; using undo and redo; and dragging and dropping text. 

Course Outline 

✓ Cutting, Copying, and Pasting Text 

✓ About Paste Options 

✓ Inserting Symbols 

✓ Using Undo and Redo 

✓ Dragging and Dropping Text 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath Filler 2013: Core Essentials, Module 3 
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Microsoft OneNote 2013  

Advanced Picture Tasks 

Course Overview and Learning Objectives 

This course takes an advanced look at picture tasks. When students are finished with this 

course, they will know how to make image text searchable, copy text from an image, edit 

alternative text, restore a picture to its original size, and export pictures from their notes. 

Course Outline 

✓ Making Image Text Searchable 

✓ Copying Text from an Image 

✓ Editing Alternative Text 

✓ Restoring a Picture to Its Original Size 

✓ Exporting Pictures 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 4 

Backing Up OneNote Files 

Course Overview and Learning Objectives 

In computing, a hard-learned lesson is to always back up your work. That’s the focus of 

this course. Here, students will learn how to set backup options, change the backup 

location, run a backup manually, and open and restore a backup. 

Course Outline 

✓ Setting Backup Options 

✓ Changing the Backup Location 

✓ Running a Backup Manually 

✓ Opening and Restoring a Backup 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 12 
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Creating an Outline with OneNote 

Course Overview and Learning Objectives 

This course will teach students how to write an outline, select levels by heading, expand 

and collapse headings, move outline topics, and delete an outline. 

Course Outline 

✓ Writing an Outline 

✓ Selecting Levels by Heading 

✓ Expanding and Collapsing Headings 

✓ Moving Outline Topics 

✓ Deleting an Outline 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 1 

 

Customizing OneNote, Part One 

Course Overview and Learning Objectives 

This course begins the discussion on customizing OneNote. It covers how to set interface 

options, choose a default font, change the Office background, and customize the user 

name. 

Course Outline 

✓ Setting Interface Options 

✓ Choosing Your Default Font 

✓ Changing the Office Background 

✓ Customizing Your User Name 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 4 
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Customizing OneNote, Part Two 

Course Overview and Learning Objectives 

All good stories deserve a sequel and it occurs here in the form of part two on customizing 

OneNote. Topics include how to change editing behavior, customize pen behavior, change 

OneNote’s e-mail signature, customize password behavior, and change the default 

measurement unit. 

Course Outline 

✓ Changing Editing Behavior 

✓ Customizing Pen Behavior 

✓ Changing OneNote’s E-mail Signature 

✓ Customizing Password Behavior 

✓ Changing the Measurement Unit 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 5 

 

Customizing OneNote’s Security 

Course Overview and Learning Objectives 

Keep OneNote security optimized with the skills contained in this course. Students will 

learn to manage add-ins, open the Trust Center, manage trusted publishers, and change 

privacy options. 

Course Outline 

✓ Managing Add-Ins 

✓ Opening the Trust Center 

✓ Managing Trusted Publishers 

✓ Changing Privacy Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 11 
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Customizing Pages, Part One 

Course Overview and Learning Objectives 

Customizing pages is a useful skill. This course teaches how to show and hide the page 

title and date stamp, show and hide authors, add rule lines, and add a time and/or date 

stamp. 

Course Outline 

✓ Showing and Hiding the Page Title and Date Stamp 

✓ Showing and Hiding Authors 

✓ Adding Rule Lines 

✓ Adding a Time and/or Date Stamp 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 5 

Customizing Pages, Part Two 

Course Overview and Learning Objectives 

This course offers further page customization skills for students. Here, they are taught 

how to change the page size and orientation, customize page margins, change the page 

color, and create a custom picture background. 

Course Outline 

✓ Changing the Page Size and Orientation 

✓ Customizing Margins 

✓ Changing Page Color 

✓ Creating a Custom Picture Background 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 6 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course focuses on various ways to customize the interface. How to change ribbon 

display options is first, followed by information on how to customize the Quick Access 

toolbar. Hiding and showing the ribbon is covered plus creating custom ribbon tabs. 

Resetting the interface wraps up this course. 

Course Outline 

✓ Changing Ribbon Display Options 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 12 

Drawing Shapes, Part One 

Course Overview and Learning Objectives 

Shapes can be a vital part of any OneNote file. Students will get a grasp of shape 

fundamentals in this course with a look at how to insert, resize, move, and delete shapes. 

Course Outline 

✓ Inserting Shapes 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Deleting Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 2 
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Drawing Shapes, Part Two 

Course Overview and Learning Objectives 

Like all good sequels, Drawing Shapes, Part Two, moves the story of shapes along. 

Advanced skills covered in this course include how to customize color and thickness 

options for a shape, choose how shapes are treated, lock drawing mode, and toggle Snap 

to Grid on or off. 

Course Outline 

✓ Customizing Color and Thickness 

✓ Choosing How Shapes are Treated 

✓ Locking Drawing Mode 

✓ Toggling Snap To Grid 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 3 

Formatting Text 

Course Overview and Learning Objectives 

This course focuses on dealing with text, including how to change the font face, size, and 

color; apply text effects and styles; and how to use the Format Painter. To wrap things up, 

students will learn how to remove formatting from text. 

Course Outline 

✓ Changing the Font Face, Size, and Color 

✓ Highlighting Text 

✓ Applying Text Effects 

✓ Applying Styles 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 3 
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Handwriting Text 

Course Overview and Learning Objectives 

This course allows students to add some creativity to their OneNote notebooks with 

handwriting. This course covers how to choose a pen, create a custom pen, customize pen 

mode, handwrite text, use the Eraser tool, and convert ink to text. 

Course Outline 

✓ Choosing a Pen 

✓ Creating a Custom Pen 

✓ Customizing Pen Mode 

✓ Handwriting Text 

✓ Using the Eraser 

✓ Converting Ink to Text 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 1 

Linking Notes 

Course Overview and Learning Objectives 

Linked notes are a vital part of OneNote. In this course students will learn ways to enable 

and disable automatic note linking, create linked notes, view linked notes, copy a link for 

an item, and clear links. 

Course Outline 

✓ Enabling or Disabling Linked Notes 

✓ Creating Linked Notes 

✓ Viewing Linked Notes 

✓ Copying a Link for an Item 

✓ Clearing Links 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 2 
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Managing Notebook Properties 

Course Overview and Learning Objectives 

Students are given the skills to manage notebook properties in this course. Topics covered 

here include how to change the display name of a notebook, change notebook color, move 

the notebook, and convert a notebook. 

Course Outline 

✓ Changing the Display Name 

✓ Changing the Notebook Color 

✓ Moving the Notebook 

✓ Converting a Notebook 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 10 

Managing OneNote Files 

Course Overview and Learning Objectives 

This course delves into skills that advanced users of OneNote will find handy. First up is 

how to protect a section with a password. Then, students will learn how to optimize 

OneNote files before learning how to change cache and save locations. 

Course Outline 

✓ Protecting a Section with a Password 

✓ Optimizing OneNote Files 

✓ Changing the Cache Location 

✓ Changing the Save Location 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 11 
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Saving and Printing Your Notebook 

Course Overview and Learning Objectives 

This course shows how to save a notebook as a PDF or XPS file. It also shows how to e-

mail a notebook or export it. Printing a notebook is covered as well. 

Course Outline 

✓ Saving Your Notebook as PDF or XPS 

✓ E-mailing Your Notebook 

✓ Exporting Your Notebook 

✓ Printing Your Notebook 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 11 

Sharing Your Notebook 

Course Overview and Learning Objectives 

Notebooks can be shared among OneNote users and that is the main focus of this course. 

How to create a shared notebook is covered and then how to send invitations to that 

notebook is shown. How to use a shared notebook and how to stop sharing a notebook are 

also discussed. 

Course Outline 

✓ Creating Shared Notebooks 

✓ Sending Invitations 

✓ Using Shared Notebooks 

✓ Stopping Sharing 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 10 
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Syncing Your Notebook 

Course Overview and Learning Objectives 

Sharing your notebook allows it to be used from multiple computers. This course takes a 

look at how to share and sync a notebook for a group of users. Here, students are shown 

how to share a notebook with OneDrive, view a notebook’s sync status, manually sync a 

notebook, and sync all notebooks at once. 

Course Outline 

✓ Sharing Your Notebook with OneDrive 

✓ Viewing Sync Status 

✓ Manually Syncing a Notebook 

✓ Syncing All Notebooks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 9 

The Basics 

Course Overview and Learning Objectives 

Topics in this course include how to sign into an account, use the notification icon, and 

open a notebook. This course concludes with a study of how to use the page tabs. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ About the Notification Icon 

✓ Opening Notebooks 

✓ Using the Page Tabs 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 1 
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Using Advanced Note Tools 

Course Overview and Learning Objectives 

This course covers how to use the calculator, add Outlook meetings and tasks, create 

audio and video clips, draw objects, and use page templates. 

Course Outline 

✓ Using the Calculator 

✓ Adding Outlook Meetings and Tasks 

✓ Adding Audio and Video Clips 

✓ Drawing Objects 

✓ Using Page Templates 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 6 

Using Basic Note Tools 

Course Overview and Learning Objectives 

The effective ways to use basic tools are looked at in this course, including creating lists, 

inserting tables, inserting pictures, creating links, and inserting files. 

Course Outline 

✓ Creating Lists 

✓ Inserting Tables 

✓ Inserting Pictures 

✓ Creating Links 

✓ Inserting Files 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 5 
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Using Editing Tools 

Course Overview and Learning Objectives 

The various features of OneNote’s editing tools are covered in this course. First, how to 

use cut, copy, and paste are covered. Then the lesson moves on to how to move text with 

drag and drop. Using undo and redo are also covered. Searching is the final topic. 

Course Outline 

✓ Using Cut, Copy, and Paste 

✓ Dragging and Dropping Text 

✓ Using Undo and Redo 

✓ Using Search 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 7 

Using OneNote Online 

Course Overview and Learning Objectives 

OneNote Online has many of the same useful features as OneNote and it is discussed in 

this course. Topics covered here include how to create notebooks, view notebooks, work 

with online notebooks, use Backstage view, and open online notebooks. 

Course Outline 

✓ Creating Notebooks Using OneNote Online 

✓ Viewing Notebooks Using OneNote Online 

✓ Working with Online Notebooks 

✓ Using Backstage View 

✓ Opening Online Notebooks in OneNote 2013 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 3 
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Using Page Templates 

Course Overview and Learning Objectives 

Templates allow students to quickly create pages that maintain a consistent look and 

appearance. This course will give them the skills to master templates. Covered here are 

the ins and outs of how to create a page from a template, set the default template, save 

the current page as a template, and delete a custom template. 

Course Outline 

✓ Creating a Page from a Template 

✓ Setting the Default Template 

✓ Saving the Current Page as a Template 

✓ Deleting a Custom Template 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 7 

Using Quick Notes and Docked Notes 

Course Overview and Learning Objectives 

First up in this course is how to create a Quick Note and how to manage a Quick Note. 

Then, how to dock and undock a window is covered. The course wraps up with a look at 

how to use linked note taking. 

Course Outline 

✓ Creating a Quick Note 

✓ Managing Quick Notes 

✓ Docking and Undocking a Window 

✓ Using Linked Note Taking 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 9 
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Using Tags 

Course Overview and Learning Objectives 

Tagging items with OneNote is the focus of this course. Applying tags is covered, as well as 

creating tags, removing tags, and searching for tags. 

Course Outline 

✓ Applying Tags 

✓ Creating Tags 

✓ Removing Tags 

✓ Searching for Tags 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 8 

Using the Send To OneNote Tool 

Course Overview and Learning Objectives 

The Send To OneNote Tool gets a thorough discussion in this course. How to show and 

hide this useful tool is covered, along with how to create a screen clipping and how to send 

information to OneNote. The course concludes with creating a Quick Note. 

Course Outline 

✓ Showing and Hiding the Send To OneNote Tool 

✓ Creating a Screen Clipping 

✓ Sending Information to OneNote 

✓ Creating a Quick Note 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 4 
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Working with Audio and Video Files 

Course Overview and Learning Objectives 

Get the most out of audio and video files and OneNote by learning how to view inserted 

media files, use the Audio & Video Tools – Playback tab, change audio and video settings, 

and search audio and video files. 

Course Outline 

✓ Viewing Inserted Media Files 

✓ Using the Audio & Video – Playback Tab 

✓ Changing Audio and Video Settings 

✓ Searching Audio and Video Files 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 11 

 

Working with Equations 

Course Overview and Learning Objectives 

In this course, students will learn how to insert built-in equations, create a custom 

equation, convert an equation to text, and delete an equation. 

Course Outline 

✓ Inserting Built-in Equations 

✓ Creating a Custom Equation 

✓ Converting an Equation to Text 

✓ Creating Ink Equations 

✓ Deleting an Equation 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 10 
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Working with Excel Files  

Course Overview and Learning Objectives 

Using Excel spreadsheets in OneNote is a breeze with the skills in this course. Here, users 

are shown ways to insert an existing Excel spreadsheet, insert a new spreadsheet, edit a 

spreadsheet, rename a spreadsheet, and remove a spreadsheet. 

Course Outline 

✓ Inserting an Existing Spreadsheet 

✓ Inserting a New Spreadsheet 

✓ Editing a Spreadsheet 

✓ Renaming a Spreadsheet 

✓ Removing a Spreadsheet 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module  

 

Working with Files in OneNote 

Course Overview and Learning Objectives 

The topics in this course look at how to work with files in OneNote. Topics include how to 

insert a file printout, attach a file, convert an attachment to a printout, and open 

attachments. 

Course Outline 

✓ Inserting a File Printout 

✓ Attaching a File 

✓ Converting an Attachment to a Printout 

✓ Opening Attachments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 7 
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Working with Sections and Section Groups 

Course Overview and Learning Objectives 

OneNote can be used to group similar pages in a meaningful way with sections and section 

groups. This course gives students the skills to create sections and section groups, rename 

sections and section groups, delete sections and section groups, change the color of 

sections, merge sections, and save sections. 

Course Outline 

✓ Creating Sections and Section Groups 

✓ Renaming Sections and Section Groups 

✓ Deleting Sections and Section Groups 

✓ Changing the Color of Sections 

✓ Merging Sections 

✓ Saving Sections 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Advanced Essentials, Module 8 

Working with Versions 

Course Overview and Learning Objectives 

To streamline the process of working with multiple versions OneNote has some nifty 

tricks up its sleeve. They are looked at in this course, which covers how to view page 

versions, restore old page versions, delete old page versions, disable version history, and 

use the Notebook Recycle Bin. 

Course Outline 

✓ Viewing Page Versions 

✓ Restoring Old Versions 

✓ Deleting Old Versions 

✓ Disabling Version History 

✓ Using the Notebook Recycle Bin 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 6 
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Working with Visio Files 

Course Overview and Learning Objectives 

You want to work with Visio files in OneNote? No problem. This course allows you to do 

that by teaching you how to insert an existing drawing, insert a new drawing, edit a 

drawing, rename a drawing, and remove a drawing. 

Course Outline 

✓ Inserting an Existing Drawing 

✓ Inserting a New Drawing 

✓ Editing a Drawing 

✓ Renaming a Drawing 

✓ Removing a Drawing 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Expert, Module 9 

 

Your First Notebook 

Course Overview and Learning Objectives 

The first topic of this course focuses on creating a notebook. The course then looks at 

ways to create pages and subpages, along with how to work with containers. Entering and 

deleting text, plus checking spelling, is also covered. 

Course Outline 

✓ Creating a Notebook 

✓ Creating Pages and Subpages 

✓ Working with Pages and Subpages 

✓ Working with Containers 

✓ Entering and Deleting Text 

✓ Checking Your Spelling 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2013: Core Essentials, Module 2 
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Microsoft Outlook 2013  

Advanced Calendar Options  

Course Overview and Learning Objectives 

This course will help students get the most out of the Calendar in Microsoft Outlook 

2013. They will learn how to use the Time Zone feature, create recurring appointments, 

add holidays to the calendar, and e-mail the calendar. 

Course Outline 

✓ Using the Time Zone Feature 

✓ Creating Recurring Appointments 

✓ Adding Holidays to Your Calendar 

✓ E-mailing Your Calendar 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 3 

Advanced Contact Management Options  

Course Overview and Learning Objectives 

This course will help students manage their contacts in a meaningful way. Topics include 

how to mark a contact as private, add a contact to Favorites, create a contact group, 

forward a contact, and share the contacts list. 

Course Outline 

✓ Marking a Contact as Private 

✓ Adding a Contact to Favorites 

✓ Creating a Contact Group 

✓ Forwarding a Contact 

✓ Sharing Your Contacts List 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 6 
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Advanced Message Options  

Course Overview and Learning Objectives 

Students will learn how to get the most out of the message options in Microsoft Outlook 

2013 with the skills covered in this course. Topics include how to add voting options, 

change the reply-to address, delay delivery of messages, and save a message outside the 

Sent Items folder. 

Course Outline 

✓ Adding Voting Options 

✓ Changing the Reply-To Address 

✓ Delaying Delivery 

✓ Saving Your Message Outside Sent Items 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 4 

Advanced Task Options  

Course Overview and Learning Objectives 

This course is all about tasks in Microsoft Outlook 2013. Topics include how to create 

recurring tasks, mark a task as private, assign tasks, receive assigned tasks, and send a 

status report. 

Course Outline 

✓ Creating Recurring Tasks 

✓ Marking a Task as Private 

✓ Assigning Tasks 

✓ Receiving Assigned Tasks 

✓ Sending a Status Report 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 5 
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Creating Messages 

Course Overview and Learning Objectives 

In this course, students are shown how to create a new message, format text, attach files 

or items, change message themes, check spelling, and send a message. 

Course Outline 

✓ Creating a New Message 

✓ Formatting Text 

✓ Attaching Files or Items 

✓ Changing the Theme 

✓ Checking Your Spelling 

✓ Sending the Message 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 3 

Customizing the Interface 

Course Overview and Learning Objectives 

This course looks at the interface and shares tips for customizing it. Students are shown 

how to change ribbon display options, customize the Quick Access toolbar, hide and show 

ribbon tabs, and reset changes made to the interface.  

Course Outline 

✓ Changing Ribbon Display Options 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 12 
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Customizing Your Microsoft Account  

Course Overview and Learning Objectives 

This course will help your students personalize their Microsoft Account and truly make it 

their own. They will learn how to change a profile picture, change the Office background 

and theme, add services, and remove services. 

Course Outline 

✓ Changing Your Profile Picture 

✓ Changing the Office Background and Theme 

✓ Adding Services 

✓ Removing Services 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 10 

Exchange Server Mailbox Features 

Course Overview and Learning Objectives 

Students will learn how to get the most out of Exchange Server mailbox features in this 

course, which contains information on how to set permissions on a mailbox, configure 

delegate access, view another user’s mailbox, and set up automatic replies. 

Course Outline 

✓ Setting Permissions on Your Mailbox 

✓ Configuring Delegate Access 

✓ Viewing Another User’s Mailbox 

✓ Setting Up Automatic Replies 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 8 
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Getting Organized 

Course Overview and Learning Objectives 

It pays to be organized and this course shows students how to do that in relation to 

Microsoft Outlook 2013. Topics include how to create folders, move existing items into 

folders, categorize items, use the search and filter tools, and manage junk mail. 

Course Outline 

✓ Creating Folders 

✓ Moving Items into Folders 

✓ Categorizing Items 

✓ Using Search 

✓ Using Filter 

✓ Handling Junk Mail 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 9 

Getting Started with Business Contact Manager, Part One  

Course Overview and Learning Objectives 

During this course, students will learn what Business Contact Manager is. They will also 

learn how to download and install Business Contact Manager, use Express Setup, and use 

Custom Setup. 

Course Outline 

✓ What is Business Contact Manager? 

✓ Downloading and Installing Business Contact Manager 

✓ Using Express Setup 

✓ Using Custom Setup 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 11 
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Getting Started with Business Contact Manager, Part Two  

Course Overview and Learning Objectives 

This is the sequel to the previous course and more fully explores Business Contact 

Manager. Students are shown how to open Business Contact Manager, use the interface, 

use the Welcome Center, use sample data, and switch to their own business data. 

Course Outline 

✓ Opening Business Contact Manager 

✓ Using the Interface 

✓ Reviewing the Welcome Center 

✓ Using Sample Data 

✓ Switching to Your Business Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 12 

Managing Junk Mail 

Course Overview and Learning Objectives 

Junk mail is the bane of an e-mail user’s existence. This course shows students how to 

make the most of the junk mail tools included in Outlook 2013. Here, students will learn to 

configure junk mail options, use the Junk E-mail folder, manage blocked and safe senders 

lists, and configure the phishing filter and automatic downloads. 

Course Outline 

✓ Configuring Junk Mail Options 

✓ Using the Junk E-Mail Folder 

✓ About the Phishing Filter 

✓ About Automatic Downloads 

✓ Managing Blocked and Safe Senders Lists 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 5 
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Managing Personal Folders 

Course Overview and Learning Objectives 

This course covers how to create a Personal Folders file, set a Personal Folders file as 

default, add a password to a Personal Folders file, and open and close Personal Folders 

files. 

Course Outline 

✓ Creating a Personal Folders File 

✓ Setting a Personal Folders File as Default 

✓ Adding a Password to a Personal Folders File 

✓ Opening Personal Folders 

✓ Closing Personal Folders 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 11 

Organizing Data 

Course Overview and Learning Objectives 

This course shows students how to organize their data in Outlook 2013. Topics include 

how to use the Mailbox Cleanup tool, configure AutoArchive, manually archive data, and 

import and export data. 

Course Outline 

✓ Using Mailbox Cleanup 

✓ Configuring AutoArchive 

✓ Manually Archiving Data 

✓ Exporting Data 

✓ Importing Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 10 
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Scheduling Meetings with Microsoft Exchange Server 

Course Overview and Learning Objectives 

This in-depth course takes a look at scheduling meetings with Microsoft Exchange Server. 

Students will learn how to create and send a meeting request; use the Scheduling 

Assistant and Room Finder; respond to a meeting request; track responses; manage 

attendees; and cancel a meeting. 

Course Outline 

✓ Creating a Meeting Request 

✓ Using the Scheduling Assistant 

✓ Using the Room Finder and Sending a Meeting Request 

✓ Responding to a Meeting Request 

✓ Tracking Responses 

✓ Managing Attendees 

✓ Cancelling a Meeting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 7 

Sharing Your Calendar 

Course Overview and Learning Objectives 

You can share your calendar in Outlook 2013 as a way to manage day-to-day activities. 

The topics in this course include how to share a calendar, respond to a calendar sharing 

request, view another user’s calendar, and use Schedule view. 

Course Outline 

✓ Sharing a Calendar 

✓ Responding to a Calendar Sharing Request 

✓ Viewing Another User’s Calendar 

✓ Using Schedule View 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 6 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 367 

The Basics 

Course Overview and Learning Objectives 

This course covers everything students need to get started with Outlook 2013. Students 

are shown how to use the Folder Pane, how to use Peeks, and how to use the notification 

icon. 

Course Outline 

✓ Getting Started 

✓ About the Notification Icon and Windows 8 Notifications 

✓ Using the Folder Pane 

✓ Using Peeks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 1 

Using Categories 

Course Overview and Learning Objectives 

Categories help organize messages in Outlook 2013. This course covers the following 

skills: how to configure categories, use Quick Click, use categories in a view, and create 

category search folders. 

Course Outline 

✓ Configuring Categories 

✓ Using Quick Click 

✓ Using Categories in a View 

✓ Creating Category Search Folders 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 4 
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Using Conversations 

Course Overview and Learning Objectives 

This course covers how to read and work with conversations, turn conversations on and 

off, clean up folders or conversations, and ignore a conversation. 

Course Outline 

✓ Understanding Conversations 

✓ Expanding and Collapsing Conversations 

✓ Viewing Conversation Messages 

✓ Turning Conversations On or Off 

✓ Cleaning Up a Folder or Conversation 

✓ Ignoring a Conversation 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 10 

Using Outlook Profiles 

Course Overview and Learning Objectives 

Students can manage their profiles in Outlook 2013 thanks to this course. Topics covered 

show how to create a new Outlook profile, view profile properties, set profile options, 

choose your profile, and delete a profile. 

Course Outline 

✓ Creating a New Profile 

✓ Viewing Profile Properties 

✓ Setting Profile Options 

✓ Choosing Your Profile 

✓ Deleting a Profile 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 12 
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Using Quick Steps 

Course Overview and Learning Objectives 

Students are shown how to use the default Quick Steps, create new Quick Steps, delete 

Quick Steps, and reset Quick Steps in this course. 

Course Outline 

✓ Using Default Quick Steps 

✓ Creating New Quick Steps 

✓ Deleting Quick Steps 

✓ Resetting Quick Steps 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 11 

Using Rules 

Course Overview and Learning Objectives 

Rules make a user’s life easier when working with Outlook. Topics in this course include 

how to create a simple rule, use the Rules Wizard, edit rules, and delete rules. 

Course Outline 

✓ Creating a Simple Rule 

✓ Using the Rules Wizard 

✓ Editing Rules 

✓ Deleting Rules 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 3 
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Using Search Folders 

Course Overview and Learning Objectives 

In this course, students are taught how to create default and custom search folders, use 

search folders, modify search folders, and delete search folders. 

Course Outline 

✓ Creating Default Search Folders 

✓ Creating Custom Search Folders 

✓ Using Search Folders 

✓ Modifying Search Folders 

✓ Deleting Search Folders 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 2 

Using Signatures 

Course Overview and Learning Objectives 

This course shows students how to create and edit a signature, set signature options, and 

use signatures. 

Course Outline 

✓ Creating a Signature 

✓ Editing a Signature 

✓ Setting Signature Options 

✓ Using Signatures 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 9 
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Using Social Networks 

Course Overview and Learning Objectives 

Social networks have become a part of everyday life and can be integrated into Outlook 

2013. Students will learn how to connect to a social network, how to view social network 

contacts and information, as well as how to remove social networks from Outlook. 

Course Outline 

✓ Connecting to Social Networks 

✓ Viewing Social Network Contacts 

✓ Viewing Social Network Information 

✓ Removing Social Networks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 8 

Using the Address Book, Part One  

Course Overview and Learning Objectives 

This course gives students an in-depth look at the Address Book in Microsoft Outlook 

2013. Students will learn how to open the Address Book, use components of the Address 

Book, search the Address Book, and use options in the Address Book. 

Course Outline 

✓ Opening the Address Book 

✓ Components of the Address Book 

✓ Searching the Address Book 

✓ Options in the Address Book 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 1 
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Using the Address Book, Part Two  

Course Overview and Learning Objectives 

The look at Microsoft Outlook 2013’s Address Book feature continues in this course. 

Students will learn how to add entries, edit entries, delete entries, and use the Address 

Book to send mail. 

Course Outline 

✓ Adding Entries 

✓ Editing Entries 

✓ Deleting Entries 

✓ Using the Outlook Address Book to Send Mail 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 2 

Using the Favorites List 

Course Overview and Learning Objectives 

This course takes a look at ways to use the Favorites list. Topics include how to add 

folders to the Favorites list, change the order of favorite folders, remove a folder from the 

Favorites list, and enable and disable the Favorites list. 

Course Outline 

✓ Adding Folders to the Favorites List 

✓ Changing the Order of Favorite Folders 

✓ Removing a Folder from the Favorites List 

✓ Enabling and Disabling the Favorites List 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Advanced Essentials, Module 1 
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Using the Trust Center, Part One  

Course Overview and Learning Objectives 

This course covers the basics of the Trust Center, with information on how to open it, 

identify trusted publishers, set privacy options, and set e-mail security options. 

Course Outline 

✓ Opening the Trust Center 

✓ Identifying Trusted Publishers 

✓ Setting Privacy Options 

✓ Setting E-Mail Security Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 8 

Using the Trust Center, Part Two  

Course Overview and Learning Objectives 

The look at the Trust Center continues in this course with a discussion of how to control 

attachment handling, change automatic download settings, deal with programmatic 

access, and manage add-ins. 

Course Outline 

✓ Controlling Attachment Handling 

✓ Changing Automatic Download Settings 

✓ Dealing with Programmatic Access 

✓ Managing Add-Ins 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 9 

 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 374 

Working with E-Mail Messages 

Course Overview and Learning Objectives 

This course teaches students how to open, reply to, forward, and delete messages. 

Course Outline 

✓ Opening Messages 

✓ Replying to Messages 

✓ Forwarding Messages 

✓ Deleting Messages 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 2 

Working with Macros  

Course Overview and Learning Objectives 

This course will enable students to efficiently deal with macros. They will learn how to 

enable the Developer tab, set macro security settings, create a macro, and run a macro. 

Course Outline 

✓ Enabling the Developer Tab 

✓ Setting Macro Security 

✓ Creating a Macro 

✓ Running a Macro 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Expert, Module 7 
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Working with Notes 

Course Overview and Learning Objectives 

In this course, the focus is on notes and how to work with them. Students are taught how 

to open the Notes folder, create and delete notes, arrange existing notes, and change the 

note view. 

Course Outline 

✓ Opening the Notes Folder 

✓ Creating and Deleting Notes 

✓ Changing the Note View 

✓ Arranging Notes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 6 

Working with People 

Course Overview and Learning Objectives 

Keeping a list of contacts is a handy skill to have and this course details how to do that 

with Outlook 2013. The course shows how to open the People folder and create a new 

contact. It shows how to mark a contact as a favorite and how to change the contact view. 

It wraps up with a look at how to create a new contact group. 

Course Outline 

✓ Opening the People Folder 

✓ Creating a New Contact 

✓ Marking a Contact as a Favorite 

✓ Changing the Contact View 

✓ Creating a Contact Group 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 7 
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Working with Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to open the Tasks folder, create and delete tasks, 

change the task view, and update the completion status of a task. 

Course Outline 

✓ Opening the Tasks Folder 

✓ Creating Tasks 

✓ Changing the Task View 

✓ Updating Task Completion 

✓ Deleting Tasks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 5 

Working with the Calendar 

Course Overview and Learning Objectives 

Another strength of Outlook is its calendar functionality. This course teaches students 

how to make the most of their Outlook calendar. They will learn how to find and open the 

calendar, create appointments and meetings, work with the Daily Task List, change the 

calendar view, and use the Weather Bar. 

Course Outline 

✓ Opening the Calendar 

✓ Creating a New Appointment 

✓ Creating a Meeting 

✓ Using the Daily Task List 

✓ Changing the Calendar View 

✓ Using the Weather Bar 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2013: Core Essentials, Module 4 
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Microsoft PowerPoint 2013  

Advanced Animation Techniques, Part One 

Course Overview and Learning Objectives 

This course takes students through how to choose a basic animation effect, set animation 

options, customize the trigger for an animation, edit the motion path, set start options, 

and modify the duration and delay of an animation. 

Course Outline 

✓ Choosing a Basic Effect 

✓ Setting Effect Options 

✓ Customizing the Trigger 

✓ Editing the Motion Path 

✓ Setting Start Options 

✓ Modifying Duration and Delay 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 8 

Advanced Animation Techniques, Part Two  

Course Overview and Learning Objectives 

This course shows students how to set animation options, change the order of animations, 

use the Animation Painter, and use the Animation pane. 

Course Outline 

✓ Setting Animation Options 

✓ Changing the Order of Animations 

✓ Using the Animation Painter 

✓ Using the Animation Pane 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 9 
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Advanced Presentation Techniques 

Course Overview and Learning Objectives 

Students can give their presentations a lot of extra pizzazz by using advanced 

presentation techniques. This course shows how to record and narrate a show, set 

narration options, use Presenter view, create a video from a presentation, create a show-

only file, and present slides online.  

Course Outline 

✓ Recording and Narrating a Show 

✓ Setting Narration Options 

✓ Using Presenter View 

✓ Creating a Video from a Presentation 

✓ Creating a Show-Only File 

✓ Presenting Your Slides Online 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 10 

Advanced Slide Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to add animations and transitions to their 

presentation. 

Course Outline 

✓ Creating a Basic Animation 

✓ Customizing Animations 

✓ Using the Animation Painter 

✓ Adding a Transition 

✓ Customizing Transitions 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 9 
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Checking for Compatibility   

Course Overview and Learning Objectives 

The Compatibility Checker is used to check for objects in a presentation that may not 

work or be displayed properly in earlier versions of PowerPoint. Here, students are given 

the tools to run the Compatibility Checker, convert presentations from older PowerPoint 

formats, save presentations as older PowerPoint formats, and set compatibility options. 

Course Outline 

✓ Running the Compatibility Checker 

✓ Converting Presentations from Older PowerPoint Formats 

✓ Saving Presentations as Older PowerPoint Formats 

✓ Setting Compatibility Options 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 9 

Creating a Custom Show 

Course Overview and Learning Objectives 

Custom shows are a great tool for audiences with different informational needs. This 

course looks at how to hide a single slide as well as how to create, edit, present, and delete 

a custom show. 

Course Outline 

✓ Hiding a Single Slide 

✓ Creating a Custom Show 

✓ Editing a Custom Show 

✓ Presenting a Custom Show 

✓ Deleting a Custom Show 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 11 
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Creating Macros  

Course Overview and Learning Objectives 

Macros are handy for running simple tasks in a presentation. This course provides the 

skills for users to enable the Developer tab, set macro security, create a macro, run a 

macro, and delete a macro. 

Course Outline 

✓ Enabling the Developer Tab 

✓ Setting Macro Security 

✓ Creating a Macro 

✓ Running a Macro 

✓ Deleting a Macro 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 11 

Creating Slides 

Course Overview and Learning Objectives 

In this course, students will learn how to create, select, move, duplicate, and delete slides. 

Techniques for changing and resetting the slide layout, as well as creating sections, are 

covered next. To wrap the course up, students will learn how to view their slide show. 

Course Outline 

✓ Adding Slides to a Presentation 

✓ Selecting, Moving, and Deleting Slides 

✓ Changing and Resetting the Layout 

✓ Working with Sections 

✓ Viewing the Slide Show 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 3 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course will show students how to change ribbon display options, customize the Quick 

Access toolbar, customize and create ribbon tabs, and reset interface changes. 

Course Outline 

✓ Changing Ribbon Display Options 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 12 

Doing More with Shapes  

Course Overview and Learning Objectives 

This course shows students how to edit shapes, arrange shapes, group and ungroup 

shapes, add text to shapes, rotate shapes, and flip shapes. 

Course Outline 

✓ Editing Shapes 

✓ Arranging Shapes 

✓ Grouping and Ungrouping Shapes 

✓ Adding Text to Shapes 

✓ Rotating and Flipping Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 1 
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Embedding Objects in a Presentation  

Course Overview and Learning Objectives 

PowerPoint 2013 allows you to embed several types of objects in a presentation to 

enhance your work. This course gives students the tools for inserting an embedded object, 

editing an embedded object, using embedded objects in a presentation, and deleting 

embedded objects. 

Course Outline 

✓ Inserting an Embedded Object 

✓ Editing Embedded Objects 

✓ Using Embedded Objects in a Presentation 

✓ Deleting Embedded Objects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 2 

Formatting Text 

Course Overview and Learning Objectives 

This course introduces students to PowerPoint’s text formatting tools. Topics include 

changing font face, size, and color; modifying character spacing; applying text effects; 

using the Font dialog and Format Painter; and clearing formatting from text. 

Course Outline 

✓ Changing the Font Face, Size, and Color 

✓ Changing Character Spacing 

✓ Applying Text Effects 

✓ Working with the Font Dialog 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 4 
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Formatting the Presentation 

Course Overview and Learning Objectives 

This course shows how to change the theme and variant for a presentation. Information 

on changing the slide size, formatting the slide background, and adding headers and 

footers to slides is also included. 

Course Outline 

✓ Choosing a Theme 

✓ Choosing a Variant 

✓ Changing the Slide Size 

✓ Formatting the Slide Background 

✓ Adding Headers and Footers to Slides 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 6 

Inserting Art and Objects, Part One 

Course Overview and Learning Objectives 

This course covers adding tables, charts, SmartArt, equations, and shapes to a 

presentation.  

Course Outline 

✓ Inserting Tables 

✓ Inserting Charts 

✓ Inserting SmartArt 

✓ Inserting Equations 

✓ Drawing Shapes 

✓ Inserting Text Boxes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 7 
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Inserting Art and Objects, Part Two 

Course Overview and Learning Objectives 

This course covers adding local and online images, videos, screenshots, and audio to a 

presentation. Creating a photo album is also covered. 

Course Outline 

✓ Creating Photo Albums 

✓ Inserting Pictures 

✓ Inserting Videos 

✓ Inserting Screenshots 

✓ Inserting Audio 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 8 

Inserting and Editing Videos  

Course Overview and Learning Objectives 

Videos can be used to enhance presentations in many powerful ways. This course gives 

students the tools to insert a video from their computer, apply a style to a video, crop a 

video, correct a video, recolor a video, and apply or remove a poster frame. 

Course Outline 

✓ Inserting a Video from Your Computer 

✓ Applying a Style 

✓ Cropping a Video 

✓ Correcting a Video 

✓ Recoloring a Video 

✓ Applying and Removing a Poster Frame 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 6 
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Linking Objects in a Presentation  

Course Overview and Learning Objectives 

A linked object in a presentation acts as a shortcut to the file. Changes made to the linked 

file automatically are carried over to the presentation. Here, students will learn how to: 

create a linked object, open the linked item, update linked objects, use linked objects in a 

presentation and how to delete linked objects. 

Course Outline 

✓ Creating a Linked Object 

✓ Opening the Linked Item 

✓ Updating Linked Objects 

✓ Using Linked Objects in a Presentation 

✓ Deleting Linked Objects 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 3 

 

Managing Add-Ins  

Course Overview and Learning Objectives 

Add-ins are essentially small programs that you can install and enable to add custom 

commands and new features to most Office applications, including PowerPoint 2013. 

Students are shown in this course how to view add-ins, manage add-ins, and change add-in 

settings. 

Course Outline 

✓ Viewing Add-Ins 

✓ Managing Add-Ins 

✓ Changing Add-In Settings 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 12 

 

 

 

 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 386 

Managing PowerPoint Files 

Course Overview and Learning Objectives 

This course covers how to manage files in PowerPoint. Students are shown how to 

optimize media compatibility, compress media, work with versions, recover unsaved files, 

and protect a presentation with a password. 

Course Outline 

✓ Optimizing Media Compatibility 

✓ Compressing Media 

✓ Working with Versions 

✓ Recovering Unsaved Files 

✓ Protecting a Presentation with a Password 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 12 

Playing Video Files  

Course Overview and Learning Objectives 

After you’ve added videos to your presentation, you need to know how to play them and 

this course allows students to do just that. This course shows users how to add and 

remove bookmarks, trim videos and add fades, set playback options, and play a video 

during a presentation. 

Course Outline 

✓ Adding and Removing Bookmarks 

✓ Trimming Videos and Adding Fades 

✓ Setting Playback Options 

✓ Playing a Video During a Presentation 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 7 
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Protecting Your Presentation  

Course Overview and Learning Objectives 

It’s always a good idea to inspect your presentation for personal information, invisible 

content, or comments or notes before distributing it to others. These goals will be 

accomplished by showing students how to run the Document Inspector, run the 

Accessibility Checker, mark a presentation as final, and encrypt presentations with a 

password.  

Course Outline 

✓ Running the Document Inspector 

✓ Running the Accessibility Checker 

✓ Marking a Presentation as Final 

✓ Encrypting Presentations with a Password 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 8 

Reviewing a Presentation 

Course Overview and Learning Objectives 

This course covers presentation review from start to finish, including how to send a 

presentation for review, compare presentations, navigate through markup, accept and 

reject markup, and end the review. 

Course Outline 

✓ Sending a Presentation for Review 

✓ Comparing Presentations 

✓ Navigating Through Markup 

✓ Accepting and Rejecting Markup 

✓ Ending the Review 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 7 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 388 

Saving and Sharing Your Presentation 

Course Overview and Learning Objectives 

In this course, students will learn how to save a presentation as PDF or XPS. E-mailing a 

presentation, sharing it with OneDrive or SharePoint, and packaging it for CD are also 

covered. The course wraps up with information on presenting online. 

Course Outline 

✓ Saving a Presentation as PDF or XPS 

✓ Packaging a Presentation for CD 

✓ E-Mailing a Presentation 

✓ Sharing Your Presentation on OneDrive 

✓ Publishing Your Slides to a SharePoint Site 

✓ Presenting Online 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 11 

Setting Up Your Show  

Course Overview and Learning Objectives 

Users can adjust a number of basic options before starting a presentation. This course 

shows students how to use the Set Up Show dialog, choose show elements, hide and show 

slides, and rehearse timings. 

Course Outline 

✓ Using the Set Up Show Dialog 

✓ Choosing Show Elements 

✓ Hiding and Showing Slides 

✓ Rehearsing Timings 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 10 
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The Basics 

Course Overview and Learning Objectives 

This course begins with a look at how to start PowerPoint, create a basic presentation, 

and close PowerPoint. Then, students will learn how to sign into Office with a Microsoft 

account. The course concludes with information on saving and opening presentations. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Saving a Presentation 

✓ Opening a Presentation 

✓ Creating a New Presentation 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 1 

Using Handout Masters 

Course Overview and Learning Objectives 

With this informative course, students will learn how to open Handout Master view, edit 

the handout master, set layout options, and create handouts using Microsoft Word. 

Course Outline 

✓ Opening Handout Master View 

✓ Editing the Handout Master 

✓ Setting Layout Options 

✓ Creating Handouts in Microsoft Word 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 4 
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Using Notes Masters 

Course Overview and Learning Objectives 

Students will master note masters in this course. It covers how to open Note Master view, 

edit the note master, set layout options, and print notes pages. 

Course Outline 

✓ Opening Notes Master View 

✓ Editing the Notes Master 

✓ Setting Layout Options 

✓ Printing Notes Pages 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 5 

Using Slide Masters, Part One 

Course Overview and Learning Objectives 

This course introduces students to using slide masters. It covers opening Slide Master 

view, creating slide layouts, working with placeholders, and changing a slide’s layout. 

Course Outline 

✓ Opening Slide Master View 

✓ Creating Slide Layouts 

✓ Working with Placeholders 

✓ Changing the Slide Layout 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 1 
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Using Slide Masters, Part Two 

Course Overview and Learning Objectives 

This follow-up course delves deeper into getting the most out of slide masters in 

PowerPoint 2013. Topics include how to preserve and update slide masters, use multiple 

masters in a presentation, and remove masters. 

Course Outline 

✓ Preserving Slide Masters 

✓ Updating Master Slides 

✓ Using Multiple Slide Masters in a Presentation 

✓ Removing Masters from a Presentation 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 2 

Viewing and Printing Your Presentation 

Course Overview and Learning Objectives 

This course explores the different viewing tools offered by PowerPoint 2013, including 

zoom commands and Presenter View. Techniques for printing slides, notes, and handouts 

are also covered. 

Course Outline 

✓ Viewing the Slide Show 

✓ Using Views 

✓ Using Zoom 

✓ Using Presenter View 

✓ Printing a Presentation 

✓ Printing Notes and Handouts 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 10 
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Working with Action Buttons, Part One   

Course Overview and Learning Objectives 

An action button is a special type of AutoShape and can be used for several purposes, but 

is commonly used to link to specific slides in a presentation. In this course students are 

shown how to use action buttons to link to other files, link to custom shows, link to other 

slides, and link to websites. Students will also learn how to delete an action button. 

Course Outline 

✓ Using Action Buttons to Link to Other Slides 

✓ Using Action Buttons to Link to Custom Shows 

✓ Using Action Buttons to Link to Other Files 

✓ Using Action Buttons to Link to Websites 

✓ Deleting the Button 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 4 

 

Working with Action Buttons, Part Two  

Course Overview and Learning Objectives 

This is a further look at action buttons which gives students insight into how to design an 

action button, create a basic mouse over action button, and clear the action. 

Course Outline 

✓ Designing the Button 

✓ Creating a Basic Mouse Over Button 

✓ Clearing the Action 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Expert, Module 5 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 393 

Working with Comments 

Course Overview and Learning Objectives 

Comments are very handy for collaboration amongst multiple users. In this course, 

students will learn how to insert, view, navigate through, reply to, and delete comments. 

Course Outline 

✓ Inserting Comments 

✓ Viewing Comments 

✓ Navigating Through Comments 

✓ Replying to Comments 

✓ Deleting Comments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 6 

Working with Templates 

Course Overview and Learning Objectives 

This course shows students how to create, save, use, and edit a template. 

Course Outline 

✓ Creating a Template 

✓ Saving a Template 

✓ Using a Template 

✓ Editing a Template 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Advanced Essentials, Module 3 
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Working with Text 

Course Overview and Learning Objectives 

In this course, students will learn about advanced text formatting tools, including Find, 

Replace, bullets, numbers, text alignment, column formatting, line spacing, and text 

direction.  

Course Outline 

✓ Using Find and Replace 

✓ Applying Bullets and Numbers 

✓ Changing Text Alignment 

✓ Formatting Text as Columns 

✓ Changing Line Spacing 

✓ Changing Text Direction 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 5 

Your First Presentation 

Course Overview and Learning Objectives 

This course will walk students through the basics of creating a presentation. First, adding 

slide content and notes is covered. Then, techniques for selecting text and objects are 

discussed. Next, editing tools (including cut, copy, paste, undo, and redo) are covered. The 

course wraps up with information on checking a presentation for spelling errors. 

Course Outline 

✓ Adding Content 

✓ Adding Notes 

✓ Selecting Text and Objects 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo 

✓ Checking Your Spelling 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2013: Core Essentials, Module 2 
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Microsoft Project 2013 

Adding a Graphical Indicator 

Course Overview and Learning Objectives 

Graphical indicators display the progress of a task or other information with a 

combination of symbols and/or colors. This course shows students how to set up the field, 

create the graphical indicator, use formulas with graphical indicators, and import criteria 

from other files. 

Course Outline 

✓ Understanding Graphical Indicators 

✓ Setting up the Field 

✓ Creating the Indicator 

✓ Using Formulas with Graphical Indicators 

✓ Importing Criteria from Other Files 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 7 

Adding a Shape 

Course Overview and Learning Objectives 

Shapes are useful to help illustrate the information displayed on the Gantt chart. This 

course will teach students how to draw, move, resize, and delete shapes. 

Course Outline 

✓ Drawing a Shape 

✓ Moving a Shape 

✓ Resizing a Shape 

✓ Deleting a Shape 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 5 
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Advanced Task Management 

Course Overview and Learning Objectives 

This course delves into task management. Here, students will learn how to split tasks, 

overlap tasks, delay tasks, assign variable units to a task, and change remaining work. 

Course Outline 

✓ Splitting Tasks 

✓ Overlapping Tasks 

✓ Delaying Tasks 

✓ Assigning Variable Units to a Task 

✓ Changing Remaining Work 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 2 

Advanced Task Operations 

Course Overview and Learning Objectives 

This course gives students a closer look at tasks. They will learn about fixed duration tasks 

and how to set and modify fixed tasks, add a hyperlink to a task, and add custom fields to a 

task. 

Course Outline 

✓ About Fixed Duration Tasks 

✓ Setting and Modifying Fixed Tasks 

✓ Adding a Hyperlink to a Task 

✓ Adding Custom Fields to a Task 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 3 
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Advanced Views 

Course Overview and Learning Objectives 

Views allow users of Microsoft Project 2013 to view project information in a wide variety 

of configurations. Here, students will learn how to apply advanced views, view tables, 

create custom tables, and create custom views. 

Course Outline 

✓ Applying Advanced Views 

✓ Viewing Tables 

✓ Creating Custom Tables 

✓ Creating Custom Views 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 4 

Comparing Projects 

Course Overview and Learning Objectives 

Comparing projects allows you to visually see the differences between files. This course 

covers how to compare projects, use the Compare Projects tab, analyze the results of a 

comparison, and compare resources.  

Course Outline 

✓ Comparing Projects 

✓ Using the Compare Projects Tab 

✓ Analyzing the Results 

✓ Comparing Resources 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 9 
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Creating a Timeline 

Course Overview and Learning Objectives 

In this course, students will learn how to show and hide the timeline, how to customize 

timeline tasks, how to change fonts for individual items, how to modify global text styles, 

and how to copy the timeline. 

Course Outline 

✓ Showing and Hiding the Timeline 

✓ Customizing Timeline Tasks 

✓ Changing the Font for Individual Timeline Items 

✓ Modifying Global Text Styles 

✓ Copying the Timeline 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 5 

Creating Baselines and Interim Plans 

Course Overview and Learning Objectives 

Project baselines are used to compare initial plans against the current project’s status. 

Interim plans are similar but save just the current start and finish dates. This course 

provides your students with the skills to set a project baseline and interim plan, view a 

baseline, view an interim plan, and clear a baseline or interim plan. 

Course Outline 

✓ Setting a Project Baseline or Interim Plan 

✓ Viewing a Baseline 

✓ Viewing an Interim Plan 

✓ Clearing a Baseline or Interim Plan 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 4 
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Creating Progress Lines 

Course Overview and Learning Objectives 

Progress lines provide a visual way to track the progress of a project. This course covers 

how to display, interpret, edit, format, and remove progress lines. 

Course Outline 

✓ Displaying Progress Lines 

✓ Interpreting Progress Lines 

✓ Editing Progress Lines 

✓ Formatting Progress Lines 

✓ Removing Progress Lines 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 5 

Creating Reports 

Course Overview and Learning Objectives 

Next, students will look at how to create a built-in report or create a report from scratch. 

The new dashboard feature is also covered. The course concludes with a look at how to 

create a visual report.  

Course Outline 

✓ Creating a Built-In Report 

✓ Creating a Dashboard 

✓ Creating a Report from Scratch 

✓ Creating a Visual Report 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 9 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course looks at the interface and tips for customizing it. Students are shown how to 

collapse and expand the ribbon, customize the Quick Access toolbar, hide and show 

ribbon tabs, create custom tabs, and reset changes made to the interface. 

Course Outline 

✓ Collapsing and Expanding the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 12 

File Management Tools 

Course Overview and Learning Objectives 

One of the first steps for getting the most out of any software is understanding it at a core 

level. This course helps with that as it looks at file formats, AutoSave, file passwords, and 

file properties. 

Course Outline 

✓ Understanding File Formats 

✓ Using AutoSave 

✓ Setting File Passwords 

✓ Managing Project Information 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 1 
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Formatting a Shape 

Course Overview and Learning Objectives 

This course shows students how to change the order of shapes, change the line color, 

change the fill color, and attach a drawing to a task. 

Course Outline 

✓ Changing the Order of Shapes 

✓ Changing the Line Color 

✓ Changing the Fill Color 

✓ Attaching a Drawing to a Task 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 6 

 

Formatting the Gantt Chart, Part One 

Course Overview and Learning Objectives 

In this course, students will learn how to format the Gantt chart by changing the text style, 

changing gridline settings, choosing a layout, and formatting columns. 

Course Outline 

✓ Changing the Text Style 

✓ Changing Gridline Settings 

✓ Choosing a Layout 

✓ Formatting Columns 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 8 
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Formatting the Gantt Chart, Part Two 

Course Overview and Learning Objectives 

This course provides more information on formatting Gantt charts. Topics covered 

include how to format bars and bar styles, choose tasks to view, choose a baseline, and 

show and hide task information. 

Course Outline 

✓ Formatting Bars and Bar Styles 

✓ Choosing Tasks to View 

✓ Choosing a Baseline 

✓ Showing and Hiding Task Information 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 9 

 

Managing Project Costs 

Course Overview and Learning Objectives 

Another vital topic for anyone dealing with a project is cost. Project managers must keep 

costs under control and follow a budget, and this course takes a look at some of those 

related skills. In this course, students will learn how to set currency options, enter costs 

with the Resource Sheet, enter costs with the Resource Information dialog, use cost rate 

tables, view costs, and manually update costs. 

Course Outline 

✓ Setting Currency Options 

✓ Entering Costs with the Resource Sheet 

✓ Entering Costs with the Resource Information Dialog 

✓ Using Cost Rate Tables 

✓ Viewing Costs 

✓ Manually Updating Costs 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 8 
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Managing Resources 

Course Overview and Learning Objectives 

Resources are a critical part of any project and this course takes a look at managing them. 

Students are shown how to enter resources, use the Resource Information dialog, assign 

resources to tasks, and remove and replace resource assignments. 

Course Outline 

✓ Entering Resources 

✓ Using the Resource Information Dialog 

✓ Assigning Resources to Tasks 

✓ Removing and Replacing Resource Assignments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 4 

Managing Tasks 

Course Overview and Learning Objectives 

Students will take a closer look at tasks in this course. Topics include creating recurring 

tasks, importing tasks from Microsoft Outlook, inactivating tasks, updating task 

completion, and updating a project as a whole. 

Course Outline 

✓ Creating Recurring Tasks 

✓ Importing Outlook Tasks 

✓ Inactivating Tasks 

✓ Updating Task Completion 

✓ Updating the Project 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 6 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 404 

Printing and Sharing Your Project 

Course Overview and Learning Objectives 

In this course, students are shown how to save a project as PDF or XPS, export a project as 

an Excel workbook, print a project, and e-mail a project. 

Course Outline 

✓ Saving a Project as PDF or XPS 

✓ Exporting a Project as an Excel Workbook 

✓ Printing a Project 

✓ E-mailing a Project 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 11 

Resolving Resource Conflicts 

Course Overview and Learning Objectives 

Proper and efficient resource usage allows a project to meet its goals and deadlines. It’s 

also a fact that sometimes resource conflicts arise and they have to be resolved. In this 

course, students will learn how to determine when resource conflicts exist, how to 

reassign resources, how to schedule overtime, and how to level resources automatically. 

Course Outline 

✓ Determining When Resource Conflicts Exist 

✓ Reassigning Resources 

✓ Scheduling Overtime 

✓ Leveling Resources Automatically 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 7 
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Saving Cube Data 

Course Overview and Learning Objectives 

An OLAP (Online Analytical Processing) cube is larger than a database and allows faster 

data analysis. This course shows how to choose OLAP data, use the Field Picker, save the 

cube, and save a database. 

Course Outline 

✓ Choosing the OLAP Data 

✓ Using the Field Picker 

✓ Saving the Cube 

✓ Saving a Database 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 12 

Scheduling Work 

Course Overview and Learning Objectives 

This course shows students how to organize tasks into phases; how to link, unlink, and 

move tasks; and how to reschedule, split, and delete tasks. 

Course Outline 

✓ Organizing Tasks into Phases 

✓ Linking and Unlinking Tasks 

✓ Moving Tasks 

✓ Rescheduling Tasks 

✓ Splitting Tasks 

✓ Deleting Tasks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 3 
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Setting Up a Project 

Course Overview and Learning Objectives 

In this course, students will learn how to enter project information, set working time, 

choose between automatic or manual scheduling, enter tasks, and enter resources. 

Course Outline 

✓ Entering Project Information 

✓ Setting Working Time 

✓ Choosing Automatic or Manual Scheduling 

✓ Entering Tasks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 2 

The Basics 

Course Overview and Learning Objectives 

This course covers how to get started with Project; use the welcome project; and create, 

open, and save a project. Students will also learn how to sign in with a Microsoft account.  

Course Outline 

✓ Opening Project 

✓ Using the Welcome Project 

✓ Creating a New Project 

✓ Signing In 

✓ Saving a Project 

✓ Opening a Project 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 1 
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The Finishing Touches 

Course Overview and Learning Objectives 

This course takes a look at wrapping up a project. Students are shown how to view an 

entire project; check spelling; run the Task Inspector; apply a Gantt chart style; and 

highlight critical, slack, or late tasks. 

Course Outline 

✓ Viewing the Entire Project 

✓ Checking Your Spelling 

✓ Running the Task Inspector 

✓ Applying a Gantt Chart Style 

✓ Highlighting Critical, Slack, or Late Tasks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 10 

The Work Breakdown Structure Code 

Course Overview and Learning Objectives 

The Work Breakdown Structure Code gives an idea of where a task fits into a project. This 

course covers how to understand the WBS code, assign WBS code to a task, view the WBS 

code of a project, and customize WBS code. 

Course Outline 

✓ Understanding WBS Code 

✓ Assigning WBS Code to a Task 

✓ Viewing the WBS Code of a Project 

✓ Customizing WBS Code 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 11 
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Tracking Progress 

Course Overview and Learning Objectives 

Tracking progress is vital to any project and its success. It only makes sense that you need 

to know how things are progressing so you can guarantee a successful conclusion. Here, 

students are shown how to use the Tracking Gantt view, track tasks using filters and 

grouping, view the critical path, and view task paths. 

Course Outline 

✓ Using the Tracking Gantt View 

✓ Tracking Tasks with Filters 

✓ Tracking Tasks with Grouping 

✓ Viewing the Critical Path 

✓ Viewing Task Paths 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 6 

Using the Organizer 

Course Overview and Learning Objectives 

The Organizer allows users to move elements between two local files or between a local 

file and the global template file. This course gives students the skills to open the 

Organizer, and copy, rename, and delete project elements. 

Course Outline 

✓ Opening the Organizer 

✓ Copying Project Elements 

✓ Renaming Project Elements 

✓ Deleting Project Elements 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 12 
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Using the Team Planner 

Course Overview and Learning Objectives 

The Team Planner can be used to see what work has been assigned to whom. During this 

course, students are shown how to open the Team Planner, format its items, resolve 

unassigned tasks, and allocate work using the Team Planner. 

Course Outline 

✓ Opening the Team Planner 

✓ Formatting Team Planner Items 

✓ Resolving Unassigned Tasks 

✓ Allocating Work 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 3 

Working with Calendar View 

Course Overview and Learning Objectives 

The Calendar provides a way for students to track the progression of events, tasks, and 

the entire project. This course shows students how to view the Calendar and the Task List, 

how to modify text and bar styles, as well as how to format gridlines and change the 

calendar view. 

Course Outline 

✓ Viewing the Calendar 

✓ Viewing the Task List 

✓ Modifying Text Styles 

✓ Modifying Bar Styles 

✓ Formatting Gridlines 

✓ Changing Calendar View 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 2 
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Working with Data 

Course Overview and Learning Objectives 

In this course, students will learn how to sort, filter, group, highlight, and outline data. 

Course Outline 

✓ Sorting Data 

✓ Filtering Data 

✓ Highlighting Data 

✓ Grouping Data 

✓ Outlining Data 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 8 

Working with Deadlines and Constraints 

Course Overview and Learning Objectives 

This course covers deadlines and constraints. Students will learn how to use the Task 

Information dialog, change the task calendar, use lag and lead time, and create milestones. 

Students will also be shown how to set deadlines and create constraints. 

Course Outline 

✓ Using the Task Information Dialog 

✓ Changing the Task Calendar 

✓ Using Lag and Lead Time 

✓ Creating Milestones 

✓ Setting Deadlines 

✓ Creating Constraints 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Core Essentials, Module 7 
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Working with Multiple Projects 

Course Overview and Learning Objectives 

You can insert one project into another to make it a subproject of the master project. This 

course gives students the skills to insert subprojects, unlink and remove subprojects, 

consolidate projects, and view information about inserted projects. 

Course Outline 

✓ Inserting Subprojects 

✓ Unlinking and Removing Subprojects 

✓ Consolidating Projects 

✓ Viewing Information about Inserted Projects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 11 

Working with Network Diagrams 

Course Overview and Learning Objectives 

Network Diagrams are an integral part of Project 2013; they can help users view tasks, 

dependencies, and critical paths of a project. This course shows students how to view a 

network diagram, change the network diagram layout, format boxes, and modify box 

styles. 

Course Outline 

✓ Viewing a Network Diagram 

✓ Changing the Network Diagram Layout 

✓ Formatting Boxes 

✓ Modifying Box Styles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 1 
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Working with Resource Pools 

Course Overview and Learning Objectives 

Resource pools are master lists of resources that can be used by more than one project. 

The focus in this course is on teaching students how to create a resource pool from a 

single project and multiple projects, how to link a project to the resource pool or how to 

unlink it, and how to update a resource pool. 

Course Outline 

✓ Creating a Resource Pool from a Single Project 

✓ Creating a Resource Pool from Multiple Projects 

✓ Linking a Project to the Resource Pool 

✓ Unlinking a Project from a Resource Pool 

✓ Updating a Resource Pool 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Advanced Essentials, Module 10 

Working with Variances 

Course Overview and Learning Objectives 

This course gives insight into how to use the variance table, check for variances, and 

display work and cost variances. 

Course Outline 

✓ Using the Variance Table 

✓ Checking for Variances 

✓ Displaying Work Variances 

✓ Displaying Cost Variances 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2013: Expert, Module 10 
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Microsoft Publisher 2013  

Advanced Mail Merge Tasks 

Course Overview and Learning Objectives 

In this course, students will be shown ways to use the Mailings tab, create personalized 

hyperlinks, print the recipient list, save a shortcut to the recipient list, and export the 

recipient list. 

Course Outline 

✓ Using the Mailings Tab 

✓ Creating Personalized Hyperlinks 

✓ Printing the Recipient List 

✓ Saving a Shortcut to the Recipient List 

✓ Exporting the Recipient List 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 9 

Creating a Catalog, Part One 

Course Overview and Learning Objectives 

With Microsoft Publisher 2013 you can create a professional-quality catalog. This course 

provides students with the skills they need to insert catalog pages, choose a data source, 

create a data source from scratch, and choose a layout. 

Course Outline 

✓ Inserting Catalog Pages 

✓ Choosing a Data Source 

✓ Creating a Data Source from Scratch 

✓ Choosing a Layout 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 10 
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Creating a Catalog, Part Two 

Course Overview and Learning Objectives 

In this second course about catalogs, students get a look at how to add text fields and 

picture fields, how to preview a catalog, and how to complete the merge. 

Course Outline 

✓ Adding Text Fields 

✓ Adding Picture Fields 

✓ Previewing the Results 

✓ Completing the Merge 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 11 

Customizing the Interface 

Course Overview and Learning Objectives 

In this course, students will learn how to collapse and expand the ribbon, customize the 

Quick Access toolbar, hide and show ribbon tabs, create custom ribbon tabs, and reset 

interface changes. 

Course Outline 

✓ Collapsing and Expanding the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 12 
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Formatting Text 

Course Overview and Learning Objectives 

This course takes a closer look at text. Students will learn how to change font face, size, 

and color, as well as how to apply text effects and change character spacing. The course 

also covers working with the Font dialog, how to use the Format Painter, and how to clear 

formatting from text. 

Course Outline 

✓ Changing the Font Face, Size, and Color 

✓ Applying Text Effects 

✓ Changing Character Spacing 

✓ Working with the Font Dialog 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 4 

Illustrating Your Publication 

Course Overview and Learning Objectives 

What better way to add some punch to your publication than by adding illustrations? This 

course shows students how to insert images from a local source or from online. It also 

gives students instructions on how to insert a picture placeholder, shapes, WordArt, and 

tables. 

Course Outline 

✓ Inserting Local Images 

✓ Inserting Online Images 

✓ Inserting a Picture Placeholder 

✓ Inserting Shapes 

✓ Inserting WordArt 

✓ Inserting Tables 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 6 
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Inserting Building Blocks 

Course Overview and Learning Objectives 

This handy course shows students how to insert page parts, calendars, borders and 

accents, and advertisements into a publication. The basics of modifying these objects are 

covered as well. 

Course Outline 

✓ Inserting Page Parts 

✓ Inserting Calendars 

✓ Inserting Borders and Accents 

✓ Inserting Advertisements 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 7 

Inserting Text and Links 

Course Overview and Learning Objectives 

The ability to insert text and links in Publisher 2013 can be very helpful to the user. This 

course gives students a look at how to insert symbols, files, and objects; how to insert the 

date and time; as well as how to create hyperlinks and bookmarks. 

Course Outline 

✓ Inserting Symbols 

✓ Inserting the Date and Time 

✓ Inserting Files 

✓ Inserting Objects 

✓ Creating Hyperlinks 

✓ Creating Bookmarks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 2 
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Linking Text Boxes 

Course Overview and Learning Objectives 

When there’s too much text for one text box a simple solution is close at hand in the form 

of linked text boxes. Students will find out in this course how to link text boxes, how to 

navigate through linked boxes, and how to break text box links. 

Course Outline 

✓ Understanding Text Box Links 

✓ Linking Text Boxes 

✓ Navigating Through Linked Text Boxes 

✓ Breaking Text Box Links 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 3 

Printing and Sharing Your Publication 

Course Overview and Learning Objectives 

This course looks at how to save a publication as PDF or XPS and for photo or commercial 

printing. Information on how to print and e-mail publications is also included. 

Course Outline 

✓ Saving a Publication as PDF or XPS 

✓ Saving a Publication for Commercial Printing 

✓ Saving a Publication for Photo Printing 

✓ Printing a Publication 

✓ E-mailing a Publication 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 11 
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The Basics 

Course Overview and Learning Objectives 

In this course, students will learn the basics of opening Publisher, signing in with a 

Microsoft account, how to create and save a new publication, and the benefits of the 

scratch area.  

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Creating a New Publication 

✓ About the Scratch Area 

✓ Saving a Publication 

✓ Opening a Publication 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 1 

The Finishing Touches 

Course Overview and Learning Objectives 

In this course, students will learn how to use the spell checker, insert page numbers, add 

footers and headers, and run the Design Checker. 

Course Outline 

✓ Checking Spelling 

✓ Inserting Page Numbers 

✓ Adding Headers and Footers 

✓ Running the Design Checker 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 9 
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Using Business Information 

Course Overview and Learning Objectives 

Business information can be quickly and easily copied to a publication by using Publisher’s 

business information sets. This course looks at how to set up business information, 

manage business information sets, and insert business information fields. Students will 

also learn how to add building blocks to the Business Information Gallery. 

Course Outline 

✓ Setting up Business Information 

✓ Managing Business Information Sets 

✓ Inserting Business Information Fields 

✓ Adding Building Blocks to the Business Information Gallery 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 8 

Using Master Pages 

Course Overview and Learning Objectives 

Master pages are like templates in a publication. This course describes master pages and 

shows how to create and edit them. Students are also shown how to send objects to the 

master page, apply a master page, and remove a master page. 

Course Outline 

✓ Understanding Master Pages 

✓ Creating and Editing a Master Page 

✓ Sending Objects to the Master Page 

✓ Applying a Master Page 

✓ Removing a Master Page 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 10 
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Using the Graphics Manager 

Course Overview and Learning Objectives 

The Graphics Manager is used to manage images, including embedded or linked images. In 

this course, students will learn how to open the Graphics Manager, set display and sort 

options, embed images, save linked images, replace images, and view image properties. 

Course Outline 

✓ Opening the Graphics Manager 

✓ Setting Display and Sort Options 

✓ Embedding Images 

✓ Saving Linked Images 

✓ Replacing Images 

✓ Viewing Image Properties 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 7 

Using the Mail Merge Wizard 

Course Overview and Learning Objectives 

Mail merge is used to create large numbers of documents that are almost identical but 

have unique information contained in them. The Mail Merge Wizard allows you to merge 

information in a few simple steps. Here, students will learn to start the Mail Merge 

Wizard, select recipients, preview results, create the publication, and complete an e-mail 

merge. 

Course Outline 

✓ Starting the Wizard 

✓ Selecting Recipients 

✓ Previewing Results 

✓ Creating the Publication 

✓ Completing an E-Mail Merge 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 8 
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Using Typography Tools 

Course Overview and Learning Objectives 

This course will teach students how to refine their projects with important typography 

tools. This course covers how to insert drop caps, choose a number or ligature style, ho 

choose a stylistic set, manage swashes, and choose stylistic alternates. 

Course Outline 

✓ Inserting Drop Caps 

✓ Choosing a Number Style 

✓ Choosing a Ligature Style 

✓ Choosing a Stylistic Set 

✓ Managing Swashes 

✓ Choosing Stylistic Alternates 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 5 

Working with Images 

Course Overview and Learning Objectives 

Images are an important part of most published documents. In this course, students will 

learn how to use an image as a background, crop an image to a shape, crop an image to fit 

or fill, correct images, and recolor images. 

Course Outline 

✓ Using an Image as a Page Background 

✓ Cropping to a Shape 

✓ Cropping to Fit or Fill 

✓ Correcting Images 

✓ Recoloring Images 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 6 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 422 

Working with Multiple Objects 

Course Overview and Learning Objectives 

In Publisher 2013, multiple objects can be selected in a number of ways and then grouped, 

ungrouped, aligned, and arranged. This course gives students the skills they need to 

perform these tasks. 

Course Outline 

✓ Selecting Multiple Objects 

✓ Grouping Objects 

✓ Ungrouping Objects 

✓ Aligning Objects to Each Other 

✓ Arranging Objects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 1 

Working with Objects 

Course Overview and Learning Objectives 

Objects are a big part of any publication, so this course covers how to select, resize, move, 

rotate, and delete an object. Contextual tabs and the mini toolbar are also covered. 

Course Outline 

✓ Selecting an Object 

✓ Resizing an Object 

✓ Moving an Object 

✓ Rotating an Object 

✓ Deleting an Object 

✓ About Contextual Tabs and the Mini Toolbar 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 5 
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Working with Pages 

Course Overview and Learning Objectives 

This course covers how to insert pages, navigate through pages, delete pages, and rename 

pages. The course also looks at creating a page background and how to change the color 

and font schemes for a publication. 

Course Outline 

✓ Inserting Pages 

✓ Navigating Through Pages 

✓ Deleting Pages 

✓ Renaming Pages 

✓ Creating a Page Background 

✓ Changing the Color and Font Scheme 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 3 

Working with Styles 

Course Overview and Learning Objectives 

Styles control several attributes of text and can save a lot of time for users. Instead of 

taking several steps to format text the way you want it, just apply a style. In this course, 

students will learn about how to create a new style and how to modify, delete, and import 

styles. 

Course Outline 

✓ Creating a New Style 

✓ Modifying Styles 

✓ Deleting Styles 

✓ Importing Styles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 4 
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Working with Templates 

Course Overview and Learning Objectives 

Templates save a huge amount of time in the production of publications that use similar 

layouts. This course provides the skills to create, save, edit, and use a template. 

Course Outline 

✓ Creating a Template 

✓ Saving a Template 

✓ Using a Template 

✓ Editing a Template 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Advanced Essentials, Module 12 

Your First Publication 

Course Overview and Learning Objectives 

This course gives students ways to deal with text in Publisher. Topics include how to 

create a text box and how to type, delete, and select text. The course also touches on 

handy time-saving features such as Undo and Redo; cut, copy, and paste; and drag and 

drop. 

Course Outline 

✓ Creating a Text Box 

✓ Typing and Deleting Text 

✓ Selecting Text 

✓ Using Undo and Redo 

✓ Using Cut, Copy, and Paste 

✓ Using Drag and Drop 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2013: Core Essentials, Module 2 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 425 

Microsoft SharePoint Designer 2013  

Creating and Modifying Sites 

Course Overview and Learning Objectives 

In this course, students will get a close-up look at sites. Topics include how to reset a site, 

create a blank site, create a site from a template, create a subsite, and delete a site. 

Course Outline 

✓ Resetting a Site 

✓ Creating a Site from a Template 

✓ Creating a Blank Site 

✓ Creating a Subsite 

✓ Deleting a Site 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 10 

Creating Lists and Libraries 

Course Overview and Learning Objectives 

This course is all about lists, including how to create lists, add columns to lists, create 

libraries, edit the settings page for a list or library, and delete lists and libraries. 

Course Outline 

✓ Creating Lists 

✓ Adding Columns to Lists 

✓ Creating Libraries 

✓ Editing the Settings Page 

✓ Deleting Lists and Libraries 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 7 
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Creating Site Pages 

Course Overview and Learning Objectives 

After students complete this course, they will know how to create HTML and ASPX pages; 

save a page as a template; and create, attach, detach, and reset master pages. 

Course Outline 

✓ Creating HTML Pages 

✓ Creating ASPX Pages 

✓ Saving a Page as a Template 

✓ Creating Master Pages 

✓ Attaching and Detaching Master Pages 

✓ Resetting Master Pages 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 5 

Creating Workflows 

Course Overview and Learning Objectives 

In this course, students will learn about creating workflows, adding conditions and actions, 

adding steps and impersonation steps, saving a workflow, checking a workflow for errors, 

and publishing it. 

Course Outline 

✓ Creating a Workflow 

✓ Adding Conditions and Actions 

✓ About Steps 

✓ About Impersonation Steps 

✓ Saving the Workflow 

✓ Checking a Workflow for Errors and Publishing It 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 9 
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Customizing Site Columns 

Course Overview and Learning Objectives 

This course covers how to modify site columns, create new columns, rename and delete 

columns, and push changes to the server. 

Course Outline 

✓ Modifying Site Columns 

✓ Creating a New Column 

✓ Renaming and Deleting Columns 

✓ Applying Your Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 8 

Customizing the Interface 

Course Overview and Learning Objectives 

This course looks at how to customize the interface. Students are shown how to expand 

and collapse the ribbon; customize the Quick Access toolbar; hide and show ribbon tabs; 

create custom ribbon tabs; and reset the interface. 

Course Outline 

✓ Expanding and Collapsing the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 12 
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Editing Site Objects 

Course Overview and Learning Objectives 

This course provides information on opening and editing site objects, saving changes to a 

page, and refreshing and previewing the page. 

Course Outline 

✓ Opening Site Objects 

✓ Saving Changes to the Page 

✓ Refreshing the Page 

✓ Previewing the Page 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 3 

Managing Site Security 

Course Overview and Learning Objectives 

This course covers types of roles and permissions, how to use the Permissions tab, how to 

edit permissions for a site or page, and how to add and delete users. 

Course Outline 

✓ Overview of Roles and Permissions 

✓ Using the Permissions Tab 

✓ Editing Permissions for a Site or Page 

✓ Adding Users 

✓ Deleting Users 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 11 
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Modifying the Home Page 

Course Overview and Learning Objectives 

Students will delve into the home page in this course. Here, they will learn how to define 

the parts of a home page, change the title and description of the home page, change the 

home page itself, change site settings, and change the site’s theme. 

Course Outline 

✓ Overview of the Home Page 

✓ Changing the Title and Description 

✓ Changing the Home Page 

✓ Changing Site Settings 

✓ Changing the Site Theme 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 4 

The Basics 

Course Overview and Learning Objectives 

This course shows students how to download and install SharePoint Designer 2013, open 

it, and open a site with it. Students are also shown how to use the Navigation Pane, browse 

site objects, and close the program. 

Course Outline 

✓ Downloading and Installing SharePoint Designer 2013 

✓ Opening SharePoint Designer 2013 

✓ Opening a Site 

✓ Using the Navigation Pane 

✓ Browsing Site Objects 

✓ Closing SharePoint Designer 2013 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 1 
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Using Versions 

Course Overview and Learning Objectives 

Here students get a look at working with a page. They will learn how to check out and 

check in a page, view version history, and restore a past version. The course wraps up with 

a look at undoing a checkout. 

Course Outline 

✓ Checking Out a Page 

✓ Checking In a Page 

✓ Viewing Version History 

✓ Restoring a Past Version 

✓ Undoing a Checkout 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 6 

Working with Site Objects 

Course Overview and Learning Objectives 

In this course, students will learn how to pin, rename, and delete objects; use the 

breadcrumb trail; and use object tabs. 

Course Outline 

✓ Pinning Objects 

✓ Renaming Objects 

✓ Deleting Objects 

✓ Using the Breadcrumb Trail 

✓ Using Object Tabs 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2013: Core Essentials, Module 2 
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Microsoft SharePoint Server 2013  

Advanced Customization Tasks 

Course Overview and Learning Objectives 

This course takes a look at using the Site Pages gallery; changing the home page; and 

viewing incoming links, popularity trends, and usage reports. 

Course Outline 

✓ Using the Site Pages Gallery 

✓ Changing the Home Page 

✓ Viewing Incoming Links 

✓ Viewing Popularity Trends and Usage Reports 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 10 

Configuring Permissions 

Course Overview and Learning Objectives 

This course looks at permissions for access to your SharePoint site. The course takes 

students through how to share a page, view page permissions, create groups, grant 

permissions, modify permission levels, and check permissions for a user or group. 

Course Outline 

✓ Sharing the Page 

✓ Viewing Page Permissions 

✓ Creating Groups 

✓ Granting Permissions 

✓ Modifying Permission Levels 

✓ Checking Permissions for a User or Group 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 12 
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Configuring Your Site 

Course Overview and Learning Objectives 

This course provides students with the skills on how to add users, create apps, and add a 

project summary. The “Focus on Content” feature is covered as well. 

Course Outline 

✓ Adding Users 

✓ Creating Apps 

✓ Adding a Project Summary 

✓ Focusing on Content 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 2 

Creating a Project Summary 

Course Overview and Learning Objectives 

This course shows students how to create a task list, create tasks, view task options, and 

delete tasks. 

Course Outline 

✓ Creating a Task List 

✓ Creating Tasks 

✓ Viewing Task Options 

✓ Deleting Tasks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 6 
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Creating and Managing Alerts 

Course Overview and Learning Objectives 

You can be notified by an alert when a SharePoint document, item, or library has been 

modified. Students are shown in this course how to create a basic alert, manage alerts, 

create a custom alert, and delete alerts. 

Course Outline 

✓ Creating a Basic Alert 

✓ Managing Alerts 

✓ Creating a Custom Alert 

✓ Deleting Alerts 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 11 

Creating Libraries 

Course Overview and Learning Objectives 

This course is all about libraries. Students are shown how to create a new library and add 

items to a library. They are also shown how to customize library views and settings, and 

how to delete a library. 

Course Outline 

✓ Creating a New Library 

✓ Adding Items to a Library 

✓ Customizing Library Views 

✓ Customizing Library Settings 

✓ Deleting a Library 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 4 
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Customizing Your Site 

Course Overview and Learning Objectives 

This course is where students will learn how to change the look of a site, as well as how to 

customize the title, description, and logo. The course also looks at how to edit the links in 

the Quick Launch pane and how to remove the “Get Started” tiles. 

Course Outline 

✓ Changing the Look of Your Site 

✓ Customizing the Title, Description, and Logo 

✓ Editing the Quick Launch Pane Links 

✓ Removing the “Get Started” Tiles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 3 

Getting Started with SharePoint Server 

Course Overview and Learning Objectives 

This course takes students through what SharePoint server is, its system requirements, 

and the SharePoint home page. Students are also shown how to open a SharePoint site. 

Course Outline 

✓ What is SharePoint Server? 

✓ System Requirements 

✓ Opening a SharePoint Site 

✓ Understanding the Home Page 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 1 
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Managing Site Content 

Course Overview and Learning Objectives 

This course teaches students how to view site contents, workflows, and site settings. 

Students will also learn how to use the Recycle Bin to view and restore deleted items. 

Course Outline 

✓ Viewing Site Contents 

✓ Viewing Workflows 

✓ Viewing Site Settings 

✓ Using the Recycle Bin 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 8 

Modifying Pages 

Course Overview and Learning Objectives 

In this course, students will learn how to edit pages, edit page properties, view page 

history, and delete a page. 

Course Outline 

✓ Editing Pages 

✓ Editing Page Properties 

✓ Viewing Page History 

✓ Deleting a Page 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 9 
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Working with Libraries 

Course Overview and Learning Objectives 

This course delves a little deeper into libraries. It focuses on moving and renaming items, 

using tags and notes, and how to share and delete items.  

Course Outline 

✓ Moving Items 

✓ Renaming Items 

✓ Using Tags and Notes 

✓ Sharing Items 

✓ Deleting Items 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 5 

Working with the Project Summary 

Course Overview and Learning Objectives 

This course shows students how to search tasks, mark them as complete, view completed 

tasks, add tasks to the timeline, change date display on the timeline, and view tasks as a 

calendar. 

Course Outline 

✓ Searching Tasks 

✓ Completing Tasks and Viewing Completed Items 

✓ Adding Tasks to the Timeline 

✓ Changing Date Display on the Timeline 

✓ Viewing Tasks as a Calendar 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 2013: Core Essentials, Module 7 
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Microsoft Skype for Business 

Advanced Settings 

Course Overview and Learning Objectives 

This course digs deeper into Skype for Business and shows students how to turn off all 

profile pictures, always display the Skype for Business window on top, use the Microsoft 

Skype for Business Recording Manager, and prevent Skype for Business from starting 

automatically. 

Course Outline 

✓ Turning Off All Pictures 

✓ Always Display the Skype for Business Window on Top 

✓ Using the Skype for Business Recording Manager 

✓ Preventing Skype for Business from Starting Automatically 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 11 

 

Alerts and Alert Sounds 

Course Overview and Learning Objectives 

This course focuses on alerts and alert sounds. It shows students how to disable and 

change alert sounds, set status change alerts, and configure Do Not Disturb. 

Course Outline 

✓ About Alerts 

✓ Disabling Alert Sounds 

✓ Changing Alert Sounds 

✓ Setting Status Change Alerts 

✓ Configuring Do Not Disturb 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 5 
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Audio & Video Calls 

Course Overview and Learning Objectives 

Audio and video calls are very useful major features of Skype for Business. This course will 

show students how to leverage this tool, with information on how to make an audio and 

video call, record an audio or video call, and change audio or video device settings. 

Course Outline 

✓ Making an Audio Call 

✓ Making a Video Call 

✓ Recording a Video or Audio Call 

✓ Changing Audio Device Settings 

✓ Changing Video Device Settings 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 7 

 

Managing Contacts, Part One 

Course Overview and Learning Objectives 

Just like other messaging applications, Skype for Business contacts contain the online 

identities of the people whom you communicate with. In this course, students are shown 

how to add internal and external contacts, create contact groups, move contacts to 

existing groups, add contacts to the Favorites group, and delete contacts and contact 

groups. 

Course Outline 

✓ Adding Internal Contacts 

✓ Adding External Contacts 

✓ Creating Contact Groups 

✓ Moving Contacts to Groups 

✓ Adding Contacts to Your Favorites 

✓ Deleting Contacts and Contact Groups 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 3 
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Managing Contacts, Part Two 

Course Overview and Learning Objectives 

Contacts are the continuing focus in this course, which looks at how to block contacts, use 

the Status view, use the Relationship view, and use the New view. 

Course Outline 

✓ Blocking Contacts 

✓ Using the Status View 

✓ Using the Relationships View 

✓ Using the New View 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 4 

 

Presenting with Skype for Business, Part One 

Course Overview and Learning Objectives 

Skype for Business makes presentations easy! This course shows how to display a 

PowerPoint presentation, display a whiteboard, share your screen, and share your 

programs, all from within Skype for Business. 

Course Outline 

✓ Displaying a PowerPoint Presentation 

✓ Displaying a Whiteboard 

✓ Sharing Your Screen 

✓ Sharing Programs 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 9 
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Presenting with Skype for Business, Part Two 

Course Overview and Learning Objectives 

This follow-up look at presenting with Skype for Business demonstrates how to post a 

poll, post a Q&A, send files to participants, and share notes using Microsoft OneNote. 

Course Outline 

✓ Posting a Poll 

✓ Posting a Q&A 

✓ Sending Files to Participants 

✓ Sharing Notes with OneNote 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 10 

 

Sending and Receiving Instant Messages (IM) 

Course Overview and Learning Objectives 

In this course, students will learn how to send an IM to a contact, respond to an IM, use 

spellchecker, add emoticons, change the font, and view conversation history. 

Course Outline 

✓ Sending an IM to a Contact 

✓ Responding to an Incoming IM 

✓ Using Spellcheck 

✓ Using Emoticons 

✓ Changing the Font 

✓ Viewing Conversation History 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 6 
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Setting Your Presence and Location 

Course Overview and Learning Objectives 

In this course, students will learn how to set their status, add personal notes, and set their 

location. 

Course Outline 

✓ About Presence Statuses 

✓ Setting Your Presence Status on Login 

✓ Setting Your Presence While Logged In 

✓ Adding a Personal Note 

✓ Setting Your Location 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 2 

 

Skype for Business Meetings 

Course Overview and Learning Objectives 

Meetings are a good way to get contacts together. In this course, students are given the 

tools to set up a Skype meeting using Outlook, join meetings, set up impromptu meetings 

in Skype, and take notes during a meeting with OneNote. 

Course Outline 

✓ Setting Up a Skype Meeting in Outlook 

✓ Joining a Skype Meeting 

✓ Setting Up an Impromptu Conference Call in Skype for Business 

✓ Setting Up an Impromptu Group IM Conversation 

✓ Taking Notes with OneNote 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 8 
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The Basics 

Course Overview and Learning Objectives 

This course covers how to open Skype for Business, sign into and sign out of your account, 

and close Skype for Business. 

Course Outline 

✓ Opening Skype for Business 

✓ Signing In 

✓ Signing Out 

✓ Closing Skype for Business 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 1 

Using Skype for Business on the Notification Area 

Course Overview and Learning Objectives 

This course takes a look at the Notification Area. Students will learn how to view the 

Skype for Business Notification Area icon, change their presence status, sign in and sign 

out, and open and close Skype. 

Course Outline 

✓ Viewing the Skype for Business Notification Area Icon 

✓ Changing Your Status 

✓ Signing In and Signing Out 

✓ Opening Skype for Business from the Notification Area 

✓ Closing Skype for Business from the Notification Area 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Skype for Business, Module 12 
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Microsoft Visio 2013  

Adding Callouts 

Course Overview and Learning Objectives 

Callouts are similar in appearance to thought balloons in comics and are used in Visio 

2013 to add annotations to shapes. This course looks at inserting and moving callouts, 

changing the position of a callout line, resizing a callout, and changing its style. 

Course Outline 

✓ Inserting a Callout 

✓ Moving a Callout 

✓ Changing the Position of the Callout Line 

✓ Resizing a Callout 

✓ Changing the Callout Style 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 3 

Adding Legends 

Course Overview and Learning Objectives 

Legends help decipher what graphical data on a drawing represents which value. This 

course shows how to add a legend to a drawing, edit a legend, add shapes to a legend, and 

remove a legend. 

Course Outline 

✓ Adding a Legend 

✓ Editing Legend Text 

✓ Adding Shapes to a Legend 

✓ Removing a Legend 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 8 
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Arranging Shapes 

Course Overview and Learning Objectives 

In this course, students will learn how to use Auto Align, Auto Space, and Auto Align and 

Space. It also covers how to change the layout of a page and how to rotate the entire 

diagram. 

Course Outline 

✓ Using Auto Align 

✓ Using Auto Space 

✓ Using Auto Align & Space 

✓ Changing the Layout of the Page 

✓ Rotating the Diagram 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 5 

Creating a Template 

Course Overview and Learning Objectives 

Templates can save time and help users create diagrams with uniform appearance. In this 

course, students will learn how to create, save, use, and edit a template. 

Course Outline 

✓ Creating a New Template 

✓ Saving a Template File 

✓ Using a Template 

✓ Editing a Template 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 9 
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Creating Cross-Functional Flowcharts 

Course Overview and Learning Objectives 

Cross-functional flowcharts show relationships between a process and the organizational 

or functional units. Here learners are taken through how to create a cross-functional 

flowchart, add swimlanes and separators and shapes, change diagram orientation and 

direction, modify swimlane margins, and choose a flowchart style. 

Course Outline 

✓ Creating a Cross-Functional Flowchart 

✓ Adding Swimlanes and Separators 

✓ Adding Shapes 

✓ Changing Diagram Orientation and Direction 

✓ Modifying Swimlane Margins 

✓ Choosing a Flowchart Style 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 8 

Creating Custom Stencils 

Course Overview and Learning Objectives 

This course gives users the skills to create a new stencil as well as techniques to add and 

remove shapes from a stencil. It also covers how to delete a stencil. 

Course Outline 

✓ Creating a New Stencil 

✓ Adding Shapes to a Stencil 

✓ Removing Shapes from Stencils 

✓ Deleting a Stencil 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 1 
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Creating Gantt Charts 

Course Overview and Learning Objectives 

A Gantt chart is a bar chart which is used to show the schedule of a project and to track its 

progression. This course covers creating a Gantt chart; entering tasks, dates, and 

duration; adding rows and columns; and configuring working time. 

Course Outline 

✓ Creating the Gantt Chart 

✓ Entering Tasks, Dates, and Durations 

✓ Adding Rows 

✓ Adding Columns 

✓ Configuring Working Time 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 12 

Creating Master Shapes 

Course Overview and Learning Objectives 

This course is all about master shapes, including how to create a master shape, rename a 

master shape, edit a master shape, and delete a master shape. 

Course Outline 

✓ Creating Master Shapes 

✓ Renaming Master Shapes 

✓ Editing a Master Shape 

✓ Deleting a Master Shape 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 2 
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Creating Organization Charts 

Course Overview and Learning Objectives 

Organization charts can be used to show how an organization functions and the reporting 

hierarchy within. This course shows how to create an organization chart manually, how to 

create one with the wizard, how to add shapes and images, and how to change the shape 

style. 

Course Outline 

✓ Creating an Organization Chart Manually 

✓ Creating an Organization Chart with the Wizard 

✓ Adding Shapes 

✓ Adding Images 

✓ Changing the Shape Style 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 9 

Creating Process Diagrams 

Course Overview and Learning Objectives 

Process diagrams are graphical representations of a how a step-by-step process is carried 

out. Arrows are usually used to express directional flow between shapes. In this course, 

users are taken through a look at creating a process diagram, adding shapes, creating new 

sub-processes, linking sub-processes, editing sub-processes, and checking the diagram for 

errors. 

Course Outline 

✓ Creating a Process Diagram 

✓ Adding Shapes 

✓ Creating New Subprocesses 

✓ Linking Subprocesses 

✓ Editing Subprocess Links 

✓ Checking the Diagram for Errors 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 7 
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Creating Shape Reports 

Course Overview and Learning Objectives 

Shape reports are used to catalog what shapes, and how many of each, are included in a 

drawing. This course shows users how to view existing reports, create a new report, 

modify reports, and delete reports. 

Course Outline 

✓ Viewing Existing Reports 

✓ Creating a New Report 

✓ Modifying Reports 

✓ Deleting Reports 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 4 

Creating Workflow Diagrams 

Course Overview and Learning Objectives 

This course looks at creating a workflow diagram, adding shapes, importing SharePoint 

workflows, exporting workflows to SharePoint, and creating stage outlines. 

Course Outline 

✓ Creating a Workflow Diagram 

✓ Adding Shapes 

✓ Importing SharePoint Workflows 

✓ Exporting Workflows to SharePoint 

✓ Creating Stage Outlines 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 11 
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Customizing the Interface 

Course Overview and Learning Objectives 

This course looks at the interface and tips for customizing it. Students are shown how to 

collapse and expand the ribbon, customize the Quick Access toolbar, hide and show 

ribbon tabs, create custom tabs, and reset changes made to the interface. 

Course Outline 

✓ Expanding and Collapsing the Ribbon 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 12 

Doing More with Organization Charts 

Course Overview and Learning Objectives 

This course takes a further look at organization charts. This course shows users how to 

modify the layout, change the spacing, modify the position, create and use a synchronized 

copy, and compare charts. 

Course Outline 

✓ Modifying the Layout 

✓ Changing the Spacing 

✓ Modifying Positioning 

✓ Creating and Using a Synchronized Copy 

✓ Comparing Charts 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 10 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 450 

Doing More with Shapes 

Course Overview and Learning Objectives 

This course takes a look at shapes and how to use them effectively. Topics include how to 

use Paste Special, insert a field, add ScreenTips, and add hyperlinks. 

Course Outline 

✓ Using Paste Special 

✓ Inserting a Field 

✓ Adding ScreenTips 

✓ Adding Hyperlinks 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 1 

Editing a PivotDiagram 

Course Overview and Learning Objectives 

After creating a PivotDiagram, it’s time to edit it. This course shows how to apply, move, 

collapse, expand, promote, demote, merge, and unmerge shapes. 

Course Outline 

✓ Applying Shapes 

✓ Moving Shapes 

✓ Collapsing and Expanding Shapes 

✓ Promoting and Demoting Shapes 

✓ Merging and Unmerging Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 11 
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Formatting Shapes 

Course Overview and Learning Objectives 

In this course, students will take a closer look at shapes. Topics include how to apply a 

shape style, change the fill, change the line color, and add effects. 

Course Outline 

✓ Applying a Shape Style 

✓ Changing the Fill Color 

✓ Changing the Line Color 

✓ Adding Effects 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 4 

Formatting Text 

Course Overview and Learning Objectives 

This course covers techniques to change font face, size, and color; apply text effects; use 

the Text dialog; change text alignment; and rotate text. 

Course Outline 

✓ Changing the Font Face, Size, and Color 

✓ Applying Text Effects 

✓ Using the Text Dialog 

✓ Changing Text Alignment 

✓ Rotating Text 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 6 
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Formatting the Page 

Course Overview and Learning Objectives 

Next, students will learn ways to format a page, including how to change the theme, 

choose a variant, apply a background, and apply borders and titles. 

Course Outline 

✓ Changing the Theme of the Current Page 

✓ Choosing a Variant for the Current Page 

✓ Applying a Page Background 

✓ Adding Borders and Titles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 8 

Getting Started with PivotDiagrams 

Course Overview and Learning Objectives 

PivotDiagrams display data in a hierarchical fashion. This course covers how to create a 

PivotDiagram, add categories and totals, and how to show and hide PivotDiagram 

elements. 

Course Outline 

✓ Creating a PivotDiagram 

✓ Adding Categories 

✓ Adding Totals 

✓ Showing and Hiding PivotDiagram Elements 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 10 
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Inserting Art and Objects 

Course Overview and Learning Objectives 

This course focuses on art and objects. Students will be taught how to insert online 

pictures, local pictures, charts, CAD drawings, and text boxes. 

Course Outline 

✓ Inserting Online Pictures 

✓ Inserting Local Pictures 

✓ Inserting Charts 

✓ Inserting CAD Drawings 

✓ Inserting Text Boxes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 7 

Linking Data to Shapes 

Course Overview and Learning Objectives 

Shapes in Visio 2013 can have data associated with them and this function can be looked 

at from several aspects. This course looks at how to manually add data with the Shape 

Data Window and how to manually link shape data. It also covers how to automatically 

link shapes to data, how to refresh the data source, and how to remove data links. 

Course Outline 

✓ Manually Adding Data with the Shape Data Window 

✓ Manually Linking Shape Data 

✓ Automatically Linking Shapes to Data 

✓ Refreshing the Data Source 

✓ Removing Data Links 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 5 
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Managing Pages 

Course Overview and Learning Objectives 

This course allows students to further develop their skills with managing pages. They will 

learn how to insert pages, browse through pages, rename pages, delete pages, and create 

background pages.  

Course Outline 

✓ Inserting Pages 

✓ Browsing Through Pages 

✓ Renaming Pages 

✓ Deleting Pages 

✓ Creating Background Pages 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 9 

Printing and Sharing Your Drawings 

Course Overview and Learning Objectives 

The skills taught to students in this course cover how to print and share drawings. Topics 

include how to use presentation mode; save a drawing as PDF, XPS, or as an image; print 

or e-mail a drawing; and share a drawing on OneDrive. 

Course Outline 

✓ Using Presentation Mode 

✓ Saving a Drawing as PDF or XPS 

✓ Saving a Drawing as an Image 

✓ Printing a Drawing 

✓ E-Mailing a Drawing 

✓ Sharing Your Drawings on OneDrive, Twitter, and Facebook 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 11 
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The Basics 

Course Overview and Learning Objectives 

This course begins with a look at how to open Visio 2013, as well as how to create, open, 

and save drawings. Students are also shown how to sign in with a Microsoft account.  

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Creating a New Drawing 

✓ Saving a Drawing 

✓ Opening a Drawing 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 1 

The Finishing Touches 

Course Overview and Learning Objectives 

This course gives students a chance to polish their files by learning how to check spelling, 

modify page size and orientation, use Page Setup, and add headers and footers to a page. 

Course Outline 

✓ Checking Spelling 

✓ Modifying Page Size 

✓ Modifying Page Orientation 

✓ Using Page Setup 

✓ Adding Headers and Footers 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 10 
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Using Comments 

Course Overview and Learning Objectives 

Comments are useful for adding additional information to specific elements of a drawing. 

Here, students are shown ways to add, navigate, edit, and delete comments. 

Course Outline 

✓ Adding Comments 

✓ Navigating and Viewing Comments 

✓ Editing Comments 

✓ Deleting Comments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 5 

Using Data Graphics 

Course Overview and Learning Objectives 

This course teaches students how to insert data graphics, create custom data graphics, 

edit graphics, and remove graphics. 

Course Outline 

✓ Inserting Data Graphics 

✓ Creating Custom Data Graphics 

✓ Editing Data Graphics 

✓ Removing Data Graphics 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 6 
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Using Ink Tools 

Course Overview and Learning Objectives 

This course looks at using the Pen and Highlighter tools, configuring the Pen and 

Highlighter appearance, erasing marks, and closing Ink mode. 

Course Outline 

✓ Using the Pen or Highlighter 

✓ Configuring Pen and Highlighter Appearance 

✓ Erasing Marks 

✓ Closing Ink Mode 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 7 

Using Layers 

Course Overview and Learning Objectives 

Just like an onion, a drawing in Visio 2013 is made up of layers. These layers are used to 

organize related shapes in a drawing. In this course, students will learn how to add a layer, 

show or hide a layer, activate a layer, color a layer and lock it, and preserve group member 

layers. 

Course Outline 

✓ Adding a Layer 

✓ Showing and Hiding Layers 

✓ Activating a Layer 

✓ Preserving Group Member Layers 

✓ Coloring Layers 

✓ Locking Layers 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 4 
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Using Markup Tools 

Course Overview and Learning Objectives 

Markup tools can be used to make annotations on drawings without changing the actual 

drawings themselves. This course covers how to mark up a diagram with ink, add the 

Markup command to the ribbon, enable Track Markup and the Reviewing pane, and delete 

markup. 

Course Outline 

✓ Marking Up a Diagram with Ink 

✓ Adding the Markup Command to the Ribbon 

✓ Enabling Track Markup and the Reviewing Pane 

✓ Deleting Markup 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 6 

Working with Containers 

Course Overview and Learning Objectives 

Containers in Visio 2013 allow a user to add visual boundaries around select shapes and 

then label these same boundaries in an according fashion. In this course learners are led 

through the ins and outs of manipulating containers. Topics include adding a container, 

adding shapes to and removing shapes from a container, changing container style, resizing 

the container, and disbanding the container. 

Course Outline 

✓ Adding a Container 

✓ Adding Shapes to a Container 

✓ Removing Shapes from a Container 

✓ Changing the Style of the Container 

✓ Resizing a Container 

✓ Disbanding the Container 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Advanced Essentials, Module 2 
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Working with Master Shapes 

Course Overview and Learning Objectives 

Master shapes come under more scrutiny in this course. It deals with how to edit master 

shape properties, add master shapes to a stencil, modify master shape icons, and use My 

Shapes and Quick Shapes with master shapes. 

Course Outline 

✓ Editing Master Shape Properties 

✓ Adding Master Shapes to a Stencil 

✓ Modifying Master Shape Icons 

✓ Using My Shapes and Quick Shapes with Master Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 3 

 

Working with PivotDiagrams 

Course Overview and Learning Objectives 

This course looks at working with PivotDiagrams more in depth. This course covers how 

to sort data, change the direction of the diagram, align shapes in the diagram, use the Re-

Layout command, and edit data for individual shapes. 

Course Outline 

✓ Sorting Data 

✓ Changing the Direction of the Diagram 

✓ Aligning Shapes in the Diagram 

✓ Using the Re-Layout Command 

✓ Editing Data for Individual Shapes 

✓   

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Expert, Module 12 
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Working with Shapes 

Course Overview and Learning Objectives 

This course provides an in-depth look at shapes. Students will learn how to select, move, 

rotate, resize, duplicate, and delete shapes. 

Course Outline 

✓ Selecting Shapes 

✓ Moving Shapes 

✓ Rotating Shapes 

✓ Resizing Shapes 

✓ Duplicating Shapes 

✓ Deleting Shapes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 3 

Your First Drawing 

Course Overview and Learning Objectives 

This course gets students into working with the basic features of Visio 2013. It covers the 

Shapes pane, how to add shapes to a drawing, and how to connect shapes together. This 

course also covers how to use drag and drop; cut, copy and paste; as well as undo and 

redo. 

Course Outline 

✓ Understanding the Shapes Pane 

✓ Adding Shapes to a Drawing 

✓ Connecting Shapes 

✓ Using Drag and Drop 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2013: Core Essentials, Module 2 
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Microsoft Word 2013  

Advanced Macro Tasks  

Course Overview and Learning Objectives 

Macros save time and effort in the creation of a document and are very useful for 

repetitive tasks. This course gives insight into how to copy a macro from a template, assign 

a macro to a keystroke, assign a macro to the Quick Access toolbar, and how to choose a 

macro name. 

Course Outline 

✓ Copying a Macro from a Template 

✓ Assigning a Macro to a Keystroke 

✓ Assigning a Macro to the Quick Access Toolbar 

✓ About Macro Names 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 12 

Blogging with Word  

Course Overview and Learning Objectives 

Blogs get more popular every day as a medium for distributing your message to the world. 

Blogging with Word 2013 is very easy and is covered in depth here. This course provides 

students with tips on how to create a blog post, use blogging tools, configure a blog 

account, and publish a blog post. 

Course Outline 

✓ Creating a Blog Post 

✓ Using Blogging Tools 

✓ Configuring a Blog Account 

✓ Publishing a Blog Post 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 4 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 462 

Changing Your Styles  

Course Overview and Learning Objectives 

Styles are vital for ease of use in documents that require similar formatting. This course 

will teach students how to change a style set, change a color scheme, change a font 

scheme, and make those changes permanent. 

Course Outline 

✓ Changing Your Style Set 

✓ Changing Your Color Scheme 

✓ Changing Your Font Scheme 

✓ Making Changes Permanent 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 8 

Commenting Documents 

Course Overview and Learning Objectives 

Comments are a useful tool for dealing with documents and that’s the focus here. The 

topics of this course include inserting comments, editing and replying to comments, 

deleting comments, navigating through comments, and showing and hiding comments. 

Course Outline 

✓ Inserting Comments 

✓ Editing and Replying to Comments 

✓ Deleting Comments 

✓ Navigating Through Comments 

✓ Showing and Hiding Comments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 3 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 463 

Configuring Reviewer Settings 

Course Overview and Learning Objectives 

In this course, students are shown how to change the reviewer name and initials, modify 

track changes options, lock track changes on, and use the Reviewing pane. 

Course Outline 

✓ Changing Your User Name and Initials 

✓ Modifying Track Changes Options 

✓ Locking Track Changes On 

✓ Using the Reviewing Pane 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 5 

Creating a Bibliography  

Course Overview and Learning Objectives 

Bibliographies are key to many professionally created documents. This course gives 

students a look at how to insert citations, manage sources, choose a citation style, insert a 

bibliography, and update a bibliography. 

Course Outline 

✓ Inserting Citations 

✓ Managing Sources 

✓ Choosing a Style 

✓ Inserting a Bibliography 

✓ Updating a Bibliography 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 1 
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Creating a Table of Contents 

Course Overview and Learning Objectives 

This course covers how to mark headings, insert a pre-built or custom table of contents, 

update a table of contents, and remove a table of contents. 

Course Outline 

✓ Marking Headings 

✓ Inserting a Pre-Built Table of Contents 

✓ Inserting a Custom Table of Contents 

✓ Updating a Table of Contents 

✓ Removing a Table of Contents 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 9 

Creating an Index 

Course Overview and Learning Objectives 

An index makes searching through a document so much easier, and working with them is 

the focus of this course. Students will learn how to mark index entries, insert an index, 

update an index, customize an index with styles, and remove an index. 

Course Outline 

✓ Marking Index Entries 

✓ Inserting an Index 

✓ Updating an Index 

✓ Customizing the Index with Styles 

✓ Removing an Index 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 10 
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Creating Outlines 

Course Overview and Learning Objectives 

Outlines are the focus here with a look at how to use Outline view, create an outline, 

expand and collapse headings, promote and demote headings, and move headings. 

Course Outline 

✓ Using Outline View 

✓ Creating an Outline 

✓ Expanding and Collapsing Headings 

✓ Promoting and Demoting Headings 

✓ Moving Headings 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 8 

Creating References in a Document 

Course Overview and Learning Objectives 

During this course, students are shown how to insert footnotes and endnotes, captions, 

bookmarks, cross-references, citations, and bibliographies. 

Course Outline 

✓ Inserting Footnotes and Endnotes 

✓ Inserting Captions 

✓ Inserting Bookmarks 

✓ Creating Cross-References 

✓ Inserting Citations 

✓ Inserting a Bibliography 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 11 
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Creating References to Other Documents  

Course Overview and Learning Objectives 

If you’re referencing other documents in your work, it’s a good idea to provide links to 

those documents as well. Students will learn in this course about linking to another 

document, creating and working with a master document, creating and working with 

subdocuments, and managing subdocuments. 

Course Outline 

✓ Linking to Another Document 

✓ Creating and Working with a Master Document 

✓ Creating and Working with Subdocuments 

✓ Managing Subdocuments 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 2 

Creating Templates 

Course Overview and Learning Objectives 

This course teaches students how to create, save, use, and edit templates, as well as how 

to attach a template to a document. 

Course Outline 

✓ Creating a Template 

✓ Saving a Template 

✓ Using a Template 

✓ Editing a Template 

✓ Attaching a Template to a Document 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 1 
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Creating XML Forms  

Course Overview and Learning Objectives 

Forms are very handy for use in several types of documents and creating them in Word 

2013 is easy. Students will get a good grasp on XML forms in this course while looking at 

how to create a form, insert controls, modify control properties, group controls, protect 

forms, and distribute forms. 

Course Outline 

✓ Creating a Form 

✓ Inserting Controls 

✓ Modifying Control Properties 

✓ Grouping Controls 

✓ Protecting a Form 

✓ Distributing a Form 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 3 

Customizing the Interface 

Course Overview and Learning Objectives 

This course will show students how to change ribbon display options, customize the Quick 

Access toolbar, customize and create ribbon tabs, and reset interface changes. 

Course Outline 

✓ Changing Ribbon Display Options 

✓ Customizing the Quick Access Toolbar 

✓ Hiding and Showing Ribbon Tabs 

✓ Creating Custom Ribbon Tabs 

✓ Resetting Interface Changes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 12  
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Doing More with Styles  

Course Overview and Learning Objectives 

Taking a look at styles is the focus of this course. Topics include how to create new styles 

from existing text, create new styles using the Styles pane, modify the Quick Style gallery, 

use the Style Inspector, and manage your styles. 

Course Outline 

✓ Creating Styles from Existing Text 

✓ Creating Styles Using the Task Pane 

✓ Modifying the Quick Style Gallery 

✓ Using the Style Inspector 

✓ Managing Styles 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 9 

Embedding Objects in a Word Document  

Course Overview and Learning Objectives 

In this course, students will learn how to use content from other files in their documents. 

Topics include inserting text from another file, creating objects, and linking objects. 

Course Outline 

✓ Adding Text from a File  

✓ Creating a New Object 

✓ Creating an Object from a File  

✓ Linking Objects to a Word Document  

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 5 
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Formatting Text, Part One 

Course Overview and Learning Objectives 

One of Word’s most important features is its wide array of document formatting tools. 

Students will learn about the basic tools in this course, including changing font face, size, 

and color; applying text effects; and using the Font dialog. 

Course Outline 

✓ Changing the Font Face 

✓ Changing the Font Size 

✓ Changing the Font Color 

✓ Applying Basic Text Effects 

✓ Applying Advanced Text Effects 

✓ Working with the Font Dialog 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 3 

Formatting Text, Part Two 

Course Overview and Learning Objectives 

In this course, students will learn about advanced text formatting tools, including styles, 

themes, document formatting sets, and the Format Painter. The Clear Formatting 

command will also be covered. 

Course Outline 

✓ Applying Styles 

✓ Changing the Theme 

✓ Changing Document Formatting 

✓ Choosing a New Color, Font, or Effects Scheme 

✓ Using the Format Painter 

✓ Clearing Formatting 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 4 
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Formatting the Page 

Course Overview and Learning Objectives 

In this course, students will learn how to add a cover page to a document, format text as 

columns, add a watermark, change the page color, and apply a page border. 

Course Outline 

✓ Inserting a Cover Page 

✓ Formatting Text as Columns 

✓ Adding Watermarks 

✓ Changing the Page Color 

✓ Adding a Page Border 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 6 

Getting Started 

Course Overview and Learning Objectives 

This course begins with a look at how to start Word, create a basic document, and then 

close Word. Then, students will learn how to sign into Office with a Microsoft account. 

The course concludes with information on saving and opening documents. 

Course Outline 

✓ Getting Started 

✓ Signing In 

✓ Saving a Document 

✓ Opening a Document 

✓ Creating a New Document 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 1 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 471 

Inserting Art and Objects, Part One 

Course Overview and Learning Objectives 

This course covers inserting tables, charts, SmartArt, equations, and screenshots into a 

document. 

Course Outline 

✓ Inserting Tables 

✓ Inserting Charts 

✓ Inserting SmartArt 

✓ Inserting Equations 

✓ Inserting Screenshots 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 7 

Inserting Art and Objects, Part Two 

Course Overview and Learning Objectives 

This course covers inserting local and online images, videos, shapes, and text boxes into a 

document. 

Course Outline 

✓ Inserting Local Pictures 

✓ Inserting Online Pictures 

✓ Inserting Videos 

✓ Drawing Shapes 

✓ Inserting Text Boxes 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 8 
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Performing a Mail Merge 

Course Overview and Learning Objectives 

Mail merge is a handy tool that allows you to personalize bulk mailings. This course covers 

how to start the Mail Merge wizard, select a starting document, select recipients for the 

merge, create and preview a mail merge document, and complete the mail merge. 

Course Outline 

✓ Starting the Wizard 

✓ Choosing a Document 

✓ Selecting a Starting Document 

✓ Selecting Recipients 

✓ Creating Your Document 

✓ Previewing Your Document 

✓ Completing the Merge 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 7 

Printing and Sharing Your Document 

Course Overview and Learning Objectives 

In this course, students will learn how to print, e-mail, and share documents. They will also 

learn how to open, edit, and save PDF files with Word 2013. 

Course Outline 

✓ Saving a Document as PDF or XPS 

✓ Editing PDF Documents 

✓ Printing a Document 

✓ E-Mailing a Document 

✓ Sharing Your Document on OneDrive 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 11 
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Reviewing Documents 

Course Overview and Learning Objectives 

This course takes a look at tracking changes to a document, navigating through tracked 

changes, accepting and rejecting changes, and showing and hiding markup. 

Course Outline 

✓ Tracking Changes 

✓ Navigating Through Tracked Changes 

✓ Accepting and Rejecting Changes 

✓ Showing and Hiding Markup 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 4 

The Finishing Touches 

Course Overview and Learning Objectives 

This course will cover techniques for polishing a document. Topics include running a spell 

check, inserting page numbers, adding headers and footers, creating a table of contents, 

and creating an index. 

Course Outline 

✓ Checking Spelling 

✓ Inserting Page Numbers 

✓ Adding Headers and Footers 

✓ Creating a Table of Contents 

✓ Creating an Index 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 9 
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Using Building Blocks and Quick Parts  

Course Overview and Learning Objectives 

Quick Parts offer lots of premade content that can be quickly and easily inserted into a 

document. In this course students are shown how to insert Quick Parts, use the Building 

Blocks Organizer, and save Quick Parts. 

Course Outline 

✓ Inserting Quick Parts 

✓ Using the Building Blocks Organizer 

✓ Saving Quick Parts 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 7 

Using Macros 

Course Overview and Learning Objectives 

Macros are a wonderful time-saving device in Word 2013. This course teaches students 

how to record a macro, write a macro using the Visual Basic Editor, edit a macro, and run a 

macro. 

Course Outline 

✓ Recording a Macro 

✓ Writing a Macro using the Visual Basic Editor 

✓ Editing a Macro 

✓ Running a Macro 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 12 

  



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 475 

Viewing Your Document 

Course Overview and Learning Objectives 

This course explores the different viewing tools offered by Word 2013, including zoom 

commands and the new Read mode. 

Course Outline 

✓ Using Views 

✓ Using Zoom 

✓ Using the Navigation Pane 

✓ Viewing Documents Side-by-Side 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 10 

Working with Equations  

Course Overview and Learning Objectives 

Equations can add another dimension to any document and are a useful feature of Word 

2013. This course looks at how to insert built-in equations, modify equations, create a 

custom equation, and save an equation to the gallery. 

Course Outline 

✓ Inserting Built-In Equations 

✓ Modifying Equations 

✓ Creating a Custom Equation 

✓ Saving an Equation to the Gallery 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 11 
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Working with Multiple Documents 

Course Overview and Learning Objectives 

In this course, students will learn about working with versions, comparing and combining 

documents, recovering unsaved files, restricting document editing, and password 

protecting documents. 

Course Outline 

✓ Working with Versions 

✓ Comparing Documents 

✓ Combining Documents 

✓ Recovering Unsaved Files 

✓ Restricting Editing 

✓ Password Protecting Documents 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 6 

Working with Paragraphs 

Course Overview and Learning Objectives 

In this course, students will learn how to move text, create bulleted and numbered lists, 

change line spacing, align and justify text, and use the Paragraph dialog. 

Course Outline 

✓ Moving Text 

✓ Applying Bullets and Numbers 

✓ Changing Line Spacing 

✓ Aligning and Justifying Text 

✓ Working with the Paragraph Dialog 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 5 
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Working with Sections  

Course Overview and Learning Objectives 

Sections are a good way to organize a document. This course looks at how to insert 

section breaks, customize page setup for each section, navigate through sections, and 

delete sections. 

Course Outline 

✓ Inserting Section Breaks 

✓ Customizing Page Setup for Each Section 

✓ Navigating Through Sections 

✓ Deleting Sections 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 6 

Working with SmartArt  

Course Overview and Learning Objectives 

SmartArt adds life to documents and can be easily manipulated along the way. This course 

will show students how to add SmartArt, add text, add photos, move and resize SmartArt, 

and delete SmartArt. 

Course Outline 

✓ Adding SmartArt 

✓ Adding Text 

✓ Adding Photos 

✓ Moving and Resizing SmartArt 

✓ Deleting SmartArt 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Expert, Module 10 
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Working with Styles 

Course Overview and Learning Objectives 

In this course, students will learn how to create styles, apply styles to existing text, modify 

existing styles, delete styles, and save style sets. 

Course Outline 

✓ Creating Styles 

✓ Applying Styles to Text 

✓ Modifying Styles 

✓ Deleting Styles 

✓ Saving Style Sets 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Advanced Essentials, Module 2 

Your First Document 

Course Overview and Learning Objectives 

This course is all about basic document tasks. First, typing, deleting, and selecting text are 

covered. Then, editing tools (including cut, copy, paste, undo, and redo) are covered. 

Finally, find and replace tools are covered. 

Course Outline 

✓ Typing and Deleting Text 

✓ Selecting Text 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo 

✓ Searching a Document 

✓ Using Find and Replace 

✓ Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2013: Core Essentials, Module 2 
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Microsoft Office 2010 Courses 

Microsoft Access 2010  

Advanced Data Management 

Course Overview and Learning Objectives 

In this course, students will learn about data management through table relationships, 

normalization, and referential integrity. This course also covers basic SQL structure and 

keywords as well as the use of modal dialog boxes. 

Course Outline 

1.1. Referential Integrity 

✓ Using Relationship View 

✓ Using the Relationship Tools – 

Design Tab 

✓ Types of Relationships 

✓ Establishing Referential Integrity 

✓ Enforcing Referential Integrity 

✓ Testing Referential Integrity 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Table Relationships 

✓ About Join Lines 

✓ Normalizing Tables 

✓ Using the Table Analyzer Wizard 

✓ Using Cascade Delete and 

Cascade Update 

✓ Setting Fields for Indexing 

✓ Using the Index 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. An Introduction to SQL 

✓ What is SQL? 

✓ Parts of an SQL Statement 

✓ SQL Keywords 

✓ Creating SQL Queries 

✓ Adding WHERE Clauses 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Modal Dialog Boxes 

✓ Creating a Modal Dialog Box 

✓ Adding Controls 

✓ Setting Properties 

✓ Formatting your Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Advanced, Section 1 
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Advanced File Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to perform file management tasks using Windows 

Explorer and learn how to repair and encrypt database files. This course also covers the 

additional database formats supported by Access, how to export database information to 

a variety of different file formats, and how to link a database to other files. 

Course Outline 

1.1. Using Windows Explorer within 

Access 

✓ Navigating with Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Changing Views in Windows 

Explorer 

✓ Using the Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Database Management 

✓ Compact and Repair a Database 

✓ Backing Up your Database 

✓ Editing Database Properties 

✓ Adding or Removing Database 

Passwords 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Saving Your Files 

✓ Using the Save As Dialog 

✓ An Overview of Additional 

Database Formats 

✓ Packaging a Database 

✓ About AutoRecover 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exporting Files 

✓ Exporting to PDF or XPS 

✓ Exporting to Microsoft Office 

Word and Excel 

✓ Exporting to Other Destinations 

✓ Using Saved Exports 

✓ Packaging and Signing Data 

✓ Exporting to Older Versions of 

Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Linking Files 

✓ Linking to a Microsoft Excel 

Spreadsheet 

✓ Linking to Another Database 

✓ Linking to a SharePoint Site 

✓ Other Types of Linked 

Documents 

✓ Creating Hyperlinks 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Intermediate, Section 1 
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Advanced Form Tasks 

Course Overview and Learning Objectives 

This course will focus on more advanced things that can be done with forms. Topics will 

include the creation and use of subforms, as well as navigation forms. This course also 

explores form controls like the combo box and command button. We will also discuss 

exporting a form to various formats.  

Course Outline 

1.1. Using Subforms 

✓ Creating a Subform 

✓ Creating a Form and a Subform 

✓ Modifying a Subform 

✓ Working with a Subform 

✓ Synchronizing Subform Data with 

a Parent Form 

✓ Displaying a Subform within a 

Main Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a Navigation Form 

✓ Creating a Navigation Form 

✓ Adding Tabs to a Navigation 

Form 

✓ Creating a Tab Hierarchy 

✓ Modifying a Navigation Form 

✓ Displaying the Navigation Form 

when the Database Opens 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Form Controls 

✓ Limiting User Access to a Form 

✓ Creating Check Boxes and 

Command Buttons 

✓ Building Command Button Events 

✓ Creating Event Procedures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exporting a Form 

✓ Exporting Your Form to XML 

✓ Exporting a Form as a Word 

Document 

✓ Exporting a Form as HTML 

✓ Sending a Form as an E-mail 

Attachment 

✓ Exporting a Form to Other 

Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Other Form Tasks 

✓ Using Hyperlinks in a Form 

✓ Adding Links to Other Database 

Objects 

✓ Inserting a Mailto Link in a Form 

✓ Adding a Browser Control to a 

Form 

✓ Performing Calculations in a 

Form 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Advanced, Section 2 
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Advanced Topics 

Course Overview and Learning Objectives 

Most people have experienced a computer program crash at some point, so this course 

shows students what to do when that happens and how to protect their work before it 

happens. Students will also learn about splitting databases and preparing a database for 

multiple users. We will also cover how to use Access with Outlook 2010 and SharePoint 

Server 2010. 

Course Outline 

1.1. Access and Windows 

✓ Recovering Access 

✓ Backing Up an Access Database 

✓ Restoring a Database from a 

Backup Copy 

✓ Starting Access on Windows Boot 

✓ Repairing Access 2010 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Splitting Your Database 

✓ Why Split your Database? 

✓ Splitting the Database 

✓ Configuring Access 2010 for a 

Multi-User Database 

✓ Setting Record Locking Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Outlook with Access 

✓ Importing Contacts from Outlook 

✓ Linking to an Outlook Folder 

✓ Collecting Data with an E-mail 

Form 

✓ Managing Replies 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Access 2010 with SharePoint 

Server 

✓ Understanding SharePoint Server 

✓ System Requirements 

✓ Important Terminology 

✓ Linking Tables and Lists 

✓ Moving a Database to SharePoint 

✓ Saving a Database to SharePoint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Access and Web Databases 

✓ Creating a Web Database 

✓ Using Web Database Templates 

✓ Checking Compatibility 

✓ Publishing a Web Database 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Advanced, Section 4 
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Creating a Database  

Course Overview and Learning Objectives 

In this course, students will create their first database. To begin, planning steps will be 

discussed. Then, the basics of records, tables, and formatting tools will be covered.  

Course Outline 

1.1. First Steps 

✓ Planning a Database 

✓ Creating a Blank Database 

✓ Creating a Database from a 

Template 

✓ Using Database Objects 

✓ Setting Navigation Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. About Records 

✓ What is a Record? 

✓ Navigation Tips 

✓ Adding Records 

✓ Editing Records 

✓ Deleting Records 

✓ Printing Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Table 

✓ About Tables 

✓ Creating a Table 

✓ Using Design View 

✓ Entering Data into a Table 

✓ Formatting a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Text 

✓ Using the Zoom Box 

✓ Selecting Data 

✓ Cutting, Copying, and Pasting 

✓ Using the Format Painter 

✓ Using Undo and Redo 

✓ Checking your Spelling 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Foundation, Section 3 
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Doing More with your Database  

Course Overview and Learning Objectives 

This course focuses on creating and using forms, queries, and reports. Techniques for 

viewing, sorting, filtering, and printing data are also covered. 

Course Outline 

1.1. Creating and Using Forms 

✓ What is a Form? 

✓ Bound vs. Unbound Controls 

✓ Creating a Basic Form 

✓ Creating a Form with the Wizard 

✓ Using Design View to Modify 

your Form 

✓ About the Form Design Tools 

Contextual Tabs 

✓ Using Forms 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating and Using Queries 

✓ What is a Query? 

✓ Creating a Query with the Wizard 

✓ Using Design View to Modify a 

Query 

✓ About the Query Design Tools 

Contextual Tab 

✓ Using Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating and Using Reports 

✓ What is a Report? 

✓ Creating a Report with the 

Wizard 

✓ Using Design View to Modify a 

Report 

✓ About the Report Design Tools 

Contextual Tabs 

✓ Using Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Sorting and Filtering Data 

✓ Using Find and Replace 

✓ Sorting Ascending or Descending 

✓ Toggling Filter 

✓ Using Selection Sort 

✓ Using Advanced Sort 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Viewing Data 

✓ Using the View Menu 

✓ Using the View Icons 

✓ Using the Object Tabs 

✓ Closing Individual Object Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Printing a Database Object 

✓ Print Commands 

✓ The Print Dialog Box 

✓ Using Print Preview 

✓ Printing vs. Exporting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Foundation, Section 4 
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Getting Started  

Course Overview and Learning Objectives 

In this course, students will learn the basics of Access as well as important database 

terminology. Database security and getting help in the program will also be discussed. 

Course Outline 

1.1. Starting Out 

✓ What is Microsoft Access? 

✓ What’s New in Access 2010? 

✓ Basic Database Terminology 

✓ Opening and Closing Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Interface Basics 

✓ Understanding Backstage View (File Menu) 

✓ Interface Overview 

✓ Using the Standard Tabs 

✓ Using Contextual Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Database Security 

✓ Warnings You May See when Opening a Database 

✓ Enabling Content 

✓ About Digital Signatures 

✓ About Trusted Locations 

✓ Opening the Trust Center 

✓ Assigning a Password to your Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help 

✓ Opening the Help File 

✓ Overview of the Help File 

✓ Online vs. Offline Help 

✓ Searching for Help 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: Foundation, Section 1 
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Macros and Visual Basic for Applications (VBA) 

Course Overview and Learning Objectives 

This course will show students how to build and use macros and submacros. Finally, we 

will introduce VBA and demonstrate some of its features. We’ll also touch on error 

handling and enabling and disabling form controls. 

Course Outline 

1.1. Macro Basics 

✓ Creating Macros 

✓ Macros as Event Procedures 

✓ Program Control with If-Then-

Else Statements 

✓ Using Macros in Tables 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. More about Macros 

✓ Embedded Macros 

✓ Adding Comments to Macros 

✓ Creating a Submacro 

✓ Grouping Submacros 

✓ Handling Macro Errors 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Access and VBA 

✓ Converting a Macro to VBA 

✓ Using the VBA Editor 

✓ Building VBA Procedures 

✓ Declaring Variables 

✓ Gathering Information with 

DLookup 

✓ Adding Comments to VBA Code 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Building Advanced Procedures 

✓ Using Message Boxes 

✓ Using Input Boxes 

✓ Using the DoCmd Object 

✓ Handling VBA Errors 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using VBA in a Database 

✓ Using VBA and Combo Boxes 

✓ Handling Run-Time Errors Using 

Error Numbers 

✓ Enabling and Disabling Form 

Controls 

✓ Preparing a Form for a New 

Record 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Advanced, Section 5 
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Pivoting Data 

Course Overview and Learning Objectives 

This course will focus entirely on PivotTables and PivotCharts. We’ll discuss how to 

create, modify, and enhance both PivotTables and PivotCharts. We’ll also show students 

how to import and export their data. 

Course Outline 

1.1. Creating a PivotTable 

✓ About PivotTables 

✓ Creating a PivotTable 

✓ Adding Fields to PivotTables 

✓ Basic PivotTable Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using PivotTables 

✓ Pivoting Data 

✓ Refreshing PivotTable Data 

✓ Hiding and Showing PivotTable 

Data 

✓ Grouping PivotTable Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced PivotTable Tasks 

✓ Using the Properties Dialog 

✓ Exporting a PivotTable to Excel 

✓ Importing Excel Data 

✓ Creating a PivotTable with Excel 

Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating a PivotChart 

✓ About PivotCharts 

✓ Creating a PivotChart 

✓ More about PivotChart Fields 

✓ Completing your PivotChart 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using PivotCharts 

✓ Modifying a PivotChart 

✓ Creating a PivotTable and 

PivotChart from the Same Object 

✓ Adding Axis Titles and a Legend 

✓ Changing the Chart Type 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Advanced, Section 3 
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The New Interface  

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and how to customize the command tabs. 

Course Outline 

1.1. The Quick Access Toolbar 

✓ The Default QAT Commands 

✓ Adding Commands 

✓ Removing Commands 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basics of Tabs 

✓ About Tabs 

✓ Opening Additional Dialog Boxes 

✓ Using the File (Backstage) Menu 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Home Tab 

✓ Views Commands 

✓ Clipboard Commands 

✓ Sort & Filter Commands 

✓ Records Commands 

✓ Find Commands 

✓ Text Formatting Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Create Tab 

✓ Templates Commands 

✓ Tables Commands 

✓ Queries Commands 

✓ Forms Commands 

✓ Reports Commands 

✓ Macros & Code Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The External Data Tab 

✓ Import & Link Commands 

✓ Export Commands 

✓ Collect Data Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The Database Tools Tab 

✓ Tools Commands 

✓ Macro Commands 

✓ Relationships Commands 

✓ Analyze Commands 

✓ Move Data Commands 

✓ Add-Ins Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Foundation, Section 2 
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Working with Forms 

Course Overview and Learning Objectives 

In this course, students will learn the basics of creating forms using the Wizard as well as 

from scratch. Students will also learn how to work with form controls, format their form, 

and format the form controls, both in appearance and functionality. This course also 

introduces themes, which provide one-click customization. 

Course Outline 

1.1. Basic Form Controls 

✓ Types of Forms 

✓ Types of Form Controls 

✓ Adding a Control 

✓ Using the Control Wizard 

✓ Cutting, Copying, Pasting, and 

Moving a Control 

✓ Formatting a Control 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Form Controls 

✓ Modifying a Control’s Properties 

✓ Changing a Control’s Data Source 

✓ Changing a Control’s Default 

Value 

✓ Creating a Calculated Control 

✓ Using Form Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Your Form 

✓ Formatting Gridlines 

✓ Modifying the Font 

✓ Adding Logos 

✓ Changing the Layout 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Controls 

✓ Changing the Color of a Control 

✓ Using Control Properties 

✓ Aligning and Sizing Controls 

✓ Applying Special Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Themes 

✓ Using Themes 

✓ Modifying Fonts 

✓ Modifying Colors 

✓ Saving Customized Themes 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Intermediate, Section 3 
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Working with Queries 

Course Overview and Learning Objectives 

This course will show students how to use multiple tables in queries, create calculated 

fields, and use the Expression Builder. Finally, we will cover how to create and use 

parameter, crosstab, make-table, append, delete, and update action queries. 

Course Outline 

1.1. Basic Queries 

✓ Review of Queries 

✓ Creating a Query 

✓ Sorting a Query 

✓ Filtering a Query 

✓ Showing and Hiding Fields 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Doing More with Queries 

✓ Using AND/OR Operators 

✓ About IIF Functions 

✓ Creating Multiple Table Queries 

✓ Creating a Calculated Field 

✓ About the Expression Builder 

✓ Using Queries to Summarize Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Advanced Queries 

✓ Creating a Parameter Query 

✓ Using Parameter Queries 

✓ Creating Crosstab Queries 

✓ Using Crosstab Queries 

✓ Using Make-Table Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Management (Action) 

Queries 

✓ Append Queries 

✓ Delete Queries 

✓ Update Queries 

✓ Exporting Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Intermediate, Section 5 
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Working with Reports 

Course Overview and Learning Objectives 

In this course, students will learn how to create and use reports including formatting 

report sections, working with calculated controls, and grouping and sorting report data. 

This course also discusses how to format reports, including themes, logos, and font 

changes. Finally, students will learn how to add images, page numbers, and apply 

conditional formatting. 

Course Outline 

1.1. Organizing Report Data 

✓ Adding and Removing Fields 

✓ Using Report Sections 

✓ Changing Section Properties 

✓ Grouping and Sorting in a Report 

✓ Doing More with Grouping and Sorting 

✓ Using Calculated Controls in a Report 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Reports 

✓ Formatting Gridlines 

✓ Modifying the Font 

✓ Adding Logos 

✓ Changing the Layout 

✓ Using Themes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Common Report Tasks 

✓ Adding a Photo 

✓ Adjusting Page Properties 

✓ Adding Page Numbers 

✓ Using the Label Wizard 

✓ Adding Conditional Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: Intermediate, Section 4 
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Working with Tables 

Course Overview and Learning Objectives 

This course goes deeper into table creation. Topics include field properties, how to format 

tables, how to change field data types, and how to apply various tools to control what sort 

of data is permitted in a table. This course also expands on table data entry by explaining 

how to create and use lookup fields and value lists. 

Course Outline 

1.1. Customizing Tables 

✓ Understanding Field Properties 

✓ Adding a Primary Key 

✓ Indexing a Field 

✓ Inserting, Deleting, and Moving 

Fields 

✓ Adding Quick Start Elements 

✓ Importing a Table from another 

Source 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Tables 

✓ Formatting Number Fields 

✓ Formatting Text Fields 

✓ Adding Field Descriptions 

✓ Changing Field Data Types 

✓ Adding Captions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Controlling Table Data Entry 

✓ Setting a Default Value 

✓ Setting a Required Value 

✓ Creating and Using Input Masks 

✓ Creating and Removing Table 

Relationships 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Table Data Entry 

✓ Using the Table Tools – Design 

Tab 

✓ Validating Data 

✓ Creating a Lookup Field 

✓ Modifying a Lookup Field 

✓ Creating a Value List 

✓ Modifying a Value List 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2010: 

Intermediate, Section 2 
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Microsoft Business Contact Manager 2010 

Customizing Business Contact Manager 

Course Overview and Learning Objectives 

One of the reasons Business Contact Manager is widely used is its extensive 

customization features. This course will introduce students to many of these features, 

including techniques for customizing lists, business records, contact card fields, and forms. 

Course Outline 

1.1. Customizing Lists 

✓ Getting Started 

✓ Choosing a List to Modify 

✓ Adding a Field 

✓ Editing a Field 

✓ Deleting a Field 

✓ Changing Field Order 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing Business Records 

✓ Creating a New Business Contact 

Type 

✓ Creating a New Account Type 

✓ Changing a Record’s Name and 

Icon 

✓ Deleting a Record Type 

✓ Using Custom Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Customizing Contact Card Fields 

✓ What is a Contact Card? 

✓ Getting Started 

✓ Choosing the Record Type to Edit 

✓ Adding Fields to the Contact 

Card 

✓ Removing Fields from the 

Contact Card 

✓ Changing Field Order 

✓ Resetting the Contact Card 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing Forms 

✓ Customizing Existing Forms 

✓ Saving a Form 

✓ Resetting Forms to the Default 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 5 
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Doing More with Business Contact Manager  

Course Overview and Learning Objectives 

In this course, participants will learn how to bulk edit items, use categories, assign items, 

and flag items for follow up. Business history tools and the Communication History folder 

will also be covered, as well as using automatic and manual e-mail linking. The course will 

conclude with a discussion on sales tools, including sales stages and activities, lead scoring 

criteria, and products and services. 

Course Outline 

1.1. Advanced Tasks 

✓ Bulk Editing Items 

✓ Assigning Items to a User 

✓ Categorizing Items 

✓ Customizing Categories 

✓ Marking Items for Follow-Up 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Business History 

✓ Using the Add History Item 

Group 

✓ Linking a Phone Log 

✓ Linking a Business Note 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Viewing Business History 

✓ Using the Communication 

History Folder 

✓ Viewing Items 

✓ Marking an Item for Attention 

✓ Changing Linking and Tracking 

Options 

✓ Linking Messages in Bulk 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing the Sales Pipeline, Part 

One 

✓ Setting up Sales Stages 

✓ Adding Sales Activities 

✓ Editing Sales Stages and 

Activities 

✓ Deleting Sales Stages and 

Activities 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Managing the Sales Pipeline, Part 

Two 

✓ Changing the Order of Sales 

Stages and Activities 

✓ Creating Reminders 

Automatically 

✓ Setting the Default Sales Stage 

✓ Modifying Scoring Criteria 

✓ Creating Custom Scoring Criteria 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Working with Products and Services 

✓ Opening the Products and 

Services Dialog 

✓ Adding a Product or Service 

✓ Editing a Product or Service 

✓ Deleting a Product or Service 

✓ Importing a Product or Service 

List 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 3 
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Getting Started with Business Contact Manager  

Course Overview and Learning Objectives 

In this course, students will learn how to download, install, and set up Business Contact 

Manager. Then, they will learn how to use the interface, with a focus on the new ribbon 

tools and the Navigation Pane. Next, they will learn about the Welcome Center and the 

various dashboards available. 

Course Outline 

1.1. Setting up Business Contact 

Manager 

✓ What is Business Contact 

Manager? 

✓ Downloading and Installing 

Business Contact Manager 

✓ Using Express Setup 

✓ Using Custom Setup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with the Business Contact 

Manager Interface 

✓ Opening Business Contact 

Manager 

✓ Interface Overview 

✓ Understanding the Ribbon 

Interface 

✓ Using the Business Contact 

Manager Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Getting Started with the Welcome 

Center 

✓ Changing Your Overview 

✓ Viewing Help Links 

✓ Using Sample Data 

✓ Switching to Your Business Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Understanding the Business Contact 

Manager Dashboard 

✓ Viewing the Main Dashboard 

✓ Adding Gadgets 

✓ Moving Gadgets 

✓ Deleting Gadgets 

✓ Refreshing Gadgets 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Doing More with Dashboards 

✓ Using the Contact Management 

Dashboard 

✓ Using the Sales Dashboard 

✓ Using the Marketing Dashboard 

✓ Using the Project Management 

Dashboard 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 1 
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Managing Business Contact Manager Data  

Course Overview and Learning Objectives 

This course will show students how to view, customize, save, export, and print Business 

Contact Manager reports. Then, students will learn how to view database information, 

create a new database, check a database for errors, and delete a database. The final part 

of this course will cover importing, exporting, backing up, and restoring data.  

Course Outline 

1.1. Working with Reports 

✓ Choosing a Report View 

✓ Viewing Report Charts 

✓ Customizing Charts 

✓ Saving Customized Reports 

✓ Opening Customized Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Reports 

✓ Changing the Sort Order 

✓ Filtering Data 

✓ Adding a Header and Footer 

✓ Changing the Font of the Header 

and Footer 

✓ Changing the Report Font 

✓ Adding and Removing Columns 

✓ Using the Page Setup Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Reports 

✓ Saving a Report to a Folder 

✓ E-Mailing Reports 

✓ Exporting Reports to Excel 

✓ Using Print Preview 

✓ Printing Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Business Contact 

Manager Data 

✓ Viewing Database Information 

✓ Creating a New Database 

✓ Checking Your Database for 

Errors 

✓ Deleting a Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Doing More with Business Contact 

Manager Data 

✓ Importing Data from a File 

✓ Importing Data from Outlook 

✓ Importing Data from Other 

Applications 

✓ Exporting Data 

✓ Backing Up Your Data 

✓ Restoring a Backup 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 6 
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Marketing with Business Contact Manager  

Course Overview and Learning Objectives 

This course covers BCM's marketing tools. Call lists, call scripts, mass e-mail campaigns, 

direct mail print campaigns, and mail merge are all covered in depth. 

Course Outline 

1.1. Working with Call Lists 

✓ Creating a New Call List 

✓ Filtering Contacts 

✓ Recording Call Status 

✓ Adding a Time Stamp 

✓ Recording Activity Details 

✓ Tracking Activity Results 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Call List Tasks 

✓ Creating a Call Script 

✓ Adding a History Item 

✓ Viewing and Managing Call Lists 

✓ Closing a Call List 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Generating Mass E-Mails 

✓ Creating a Mass E-Mail 

✓ Filtering Contacts 

✓ Recording E-Mail Details 

✓ Tracking Activity Results 

✓ Viewing and Managing E-Mail 

Campaigns 

✓ Closing the Campaign 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.4. Creating a Print Campaign 

✓ Creating a Direct Mail Print 

Campaign 

✓ Filtering Contacts 

✓ Recording Activity Details 

✓ Tracking Activity Results 

✓ Viewing and Managing Print 

Campaigns 

✓ Closing the Campaign 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Performing a Mail Merge 

✓ Beginning a Mail Merge 

✓ Choosing Contacts 

✓ Choosing Fields 

✓ Choosing the Document 

✓ Saving the Contact File 

✓ Setting Merge Options 

✓ Performing the Merge 

✓ Using the Mailings Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 4 
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Using Business Contact Manager  

Course Overview and Learning Objectives 

This course will get into managing BCM data. Students will learn how to create and 

manage accounts, business contacts, opportunities, opportunities, leads, business 

projects, project tasks, stores, store employees, and vendors. 

Course Outline 

1.1. Working with Accounts 

✓ Creating New Accounts 

✓ Editing Accounts 

✓ Deleting Accounts 

✓ Searching Accounts 

✓ Viewing Accounts 

✓ Accessing Accounts from 

Outlook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Business Contacts 

✓ Creating Business Contacts 

✓ Editing Business Contacts 

✓ Deleting Business Contacts 

✓ Searching Business Contacts 

✓ Viewing Business Contacts 

✓ Accessing Business Contacts 

from Outlook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Opportunities 

✓ Creating Opportunities 

✓ Editing Opportunities 

✓ Deleting Opportunities 

✓ Searching Opportunities 

✓ Viewing Opportunities 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Leads 

✓ Creating a New Lead 

✓ Converting Contacts to Leads 

✓ Viewing Lead Details 

✓ Scoring Leads 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Business Projects and 

Tasks 

✓ Creating a New Business Project 

✓ Creating Project Tasks 

✓ Using Project Templates 

✓ Assigning Tasks to Users 

✓ Marking Tasks Complete 

✓ Deleting Tasks 

✓ Viewing Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Working with Stores and Vendors 

✓ Adding Stores 

✓ Adding Store Employees 

✓ Adding Vendors 

✓ Converting Stores to Vendors 

and Vice Versa 

✓ Converting Accounts to Vendors 

and Vice Versa 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Business Contact Manager 2010: 

complete, Section 2 
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Microsoft Excel 2010 

Adding the Finishing Touches 

Course Overview and Learning Objectives 

This course covers how to finish a spreadsheet by discussing how to check spelling and 

use the Research pane to look up words, facts, and figures. Students will also learn how to 

apply and use theme effects and create text boxes, pictures, and Clip Art. Basic image 

editing will also be discussed. 

Course Outline 

1.1. Research Tools 

✓ Checking Spelling 

✓ Using the Research Pane 

✓ Using the Thesaurus 

✓ Using the Translator 

✓ Setting your Language 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Themes 

✓ Changing the Theme 

✓ Customizing Theme Colors 

✓ Customizing Theme Fonts 

✓ Customizing Theme Effects 

✓ Managing Theme Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Text Boxes 

✓ Drawing a Text Box 

✓ Using the Drawing Tools – 

Format Tab 

✓ Common Text Box Editing Tasks 

✓ Inserting WordArt 

✓ Common WordArt Editing Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Inserting Pictures and ClipArt 

✓ Adding a Picture from a File 

✓ Adding Clip Art 

✓ Adding a Screenshot 

✓ Overview of the Picture Tools – 

Format Tab 

✓ Overview of the Pictures Mini 

Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Editing Pictures 

✓ Resizing Pictures 

✓ Moving Pictures 

✓ Cropping Pictures 

✓ Rotating and Flipping Pictures 

✓ Using the Format Picture Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Intermediate, Section 4 
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Advanced Excel Tasks  

Course Overview and Learning Objectives 

This course will explore a few Excel features that we find handy for everyday chores. First, 

advanced functions (PMT, FV, VLOOKUP, and HLOOKUP) and logical functions (IF, 

IFERROR, AND, OR, NOT, FALSE, and TRUE) will be covered. Then, AutoFill lists (which 

can save time when entering data) will be discussed. The course will conclude with 

information on linking, consolidating, and combining Excel data, with a final lesson on 

using the classic PivotTable and PivotChart wizard to pivot consolidated data. 

Course Outline 

1.1. Using Advanced Functions 

✓ Using the PMT Function 

✓ Using the FV Function 

✓ Understanding Logical Functions 

✓ Using Logical Functions 

✓ Using IFERROR with Array 

Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the VLOOKUP Function 

✓ Understanding VLOOKUP and 

HLOOKUP 

✓ Using VLOOKUP to Find Data 

✓ How to Find an Exact Match with 

VLOOKUP 

✓ Finding an Approximate Match 

with VLOOKUP 

✓ Using VLOOKUP as an Array 

Formula 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. Using Custom AutoFill Lists 

✓ What is an AutoFill List? 

✓ Creating a Custom AutoFill List 

✓ Using a Custom AutoFill List 

✓ Modifying a Custom AutoFill List 

✓ Deleting a Custom AutoFill List 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Linking, Consolidating, and 

Combining Data 

✓ Linking Workbooks 

✓ Consolidating Workbooks 

✓ Combining Worksheets 

✓ Pivoting Consolidated Data 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: Advanced, 

Section 4 
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Advanced File Tasks 

Course Overview and Learning Objectives 

This course teaches students how to use the Open and Save dialogs to create new files 

and folders. It also covers file types that are compatible with Excel, how to work with 

older file formats, and how to protect a workbook against accidental or intentional 

changes to the data. Finally, this course will discuss the many file management tools and 

checkers that are used to scan workbooks for personal information and compatibility 

issues. 

Course Outline 

1.1. Using Windows Explorer within 

Excel 

✓ Navigating using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views with Windows 

Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving your Files 

✓ Using AutoRecover 

✓ Publishing to PDF or XPS 

✓ Protecting an Entire Workbook 

✓ Protecting the Current Sheet 

✓ Opening and Converting Files in 

XLS Format 

✓ Saving Spreadsheets in XLS 

Format 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using File Management Tools, Part 

One 

✓ Marking a Workbook as Final 

✓ Encrypting a Workbook 

✓ Digitally Signing a Workbook 

✓ Managing File Properties 

✓ Managing Versions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using File Management Tools, Part 

Two 

✓ Viewing a Summary of Sharing 

Issues 

✓ Using the Document Inspector 

✓ Using the Accessibility Checker 

✓ Using the Compatibility Checker 

✓ Setting Compatibility Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Intermediate, Section 1 
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Charting Pivoted Data  

Course Overview and Learning Objectives 

In this course, students will learn how to create, use, edit, and format PivotCharts. 

Students will also get experience with advanced PivotChart tasks, including creating a 

PivotChart from PowerPivot data and using PivotCharts to display scenario results. 

Course Outline 

1.1. Getting Started with PivotCharts 

✓ Creating a PivotChart from Scratch 

✓ Creating a PivotChart from Existing Data 

✓ Adding Data to your Chart 

✓ Pivoting Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the PivotChart Tools Tabs 

✓ Using the Design Tab 

✓ Using the Layout Tab 

✓ Using the Format Tab 

✓ Using the Analyze Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting a PivotChart 

✓ Renaming Fields 

✓ Changing the Chart Type 

✓ Applying a Chart Style 

✓ Manually Formatting Chart Elements 

✓ Changing the Layout of Chart Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced PivotChart Tasks 

✓ Creating a PivotChart Based on External Data 

✓ Creating a Slicer 

✓ Creating a PivotTable and PivotChart from a Scenario 

✓ Creating PivotCharts with PowerPivot Data 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: Advanced, Section 3 
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Editing your Workbook 

Course Overview and Learning Objectives 

This course will teach students how to make Excel do more than just display black and 

white data. Students will learn how to modify cells and cell data, perform a number of cell 

formatting operations, and use styles and borders. Students will also get a comprehensive 

introduction to creating and modifying different types of charts. Finally, students will 

learn the importance of relative and absolute cell referencing. 

Course Outline 

1.1. Modifying Cells and Data 

✓ Changing the Size of Rows or 

Columns 

✓ Adjusting Cell Alignment 

✓ Rotating Text 

✓ Creating Custom Number and 

Date Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Cell Formatting 

✓ Conditional Formatting 

✓ The Format Painter 

✓ Cell Merging and AutoFit 

✓ Find and Replace Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Enhancing a Worksheet’s 

Appearance 

✓ Adding Patterns and Colors 

✓ Adding Borders 

✓ Working with Styles 

✓ Working with Themes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Charts, Part 1 

✓ Creating a Chart 

✓ Styling Charts with the Design 

Tab 

✓ Modifying Charts with the Layout 

Tab 

✓ Additional Styling with the 

Format Tab 

✓ Manipulating a Chart 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Charts, Part 2 

✓ Changing the Type of Chart 

✓ Changing the Source Data 

✓ Working with the Chart Axes and 

Data Series 

✓ Saving a Chart as a Template 

✓ Absolute and Relative Cell 

References 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Foundation, Section 4 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 504 

Excel Basics 

Course Overview and Learning Objectives 

This course will teach students how to do day-to-day things in Excel. Topics include 

creating worksheet labels, printing, using features like AutoSum and AutoFill, and 

performing the ubiquitous Cut/Copy/Paste operations. Students will also be given a 

gentle introduction to using formulae, using Paste Special, dealing with advanced paste 

operations, performing Find and Replace operations, and checking their spelling.  

Course Outline 

1.1. Working with Excel 

✓ Columns, Rows, Cells, and Ranges 

✓ Creating Worksheet Labels 

✓ Entering and Deleting Data 

✓ Printing your Worksheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basic Excel Features 

✓ AutoFill 

✓ AutoSum 

✓ AutoComplete 

✓ Working with Basic Formulae 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Moving your Data 

✓ Dragging and Dropping Cells 

✓ How to Cut, Copy, and Paste 

Cells 

✓ How to Cut, Copy, and Paste 

Multiple Cells 

✓ Using the Clipboard 

✓ Using Paste Special 

✓ Inserting and Deleting Cells, 

Rows, and Columns 

✓ Using Undo, Redo, and Repeat 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Custom Actions and Options 

Buttons 

✓ What are Custom Actions? 

✓ Setting Custom Action Options 

✓ The Error Option Button 

✓ The AutoFill Option Button 

✓ The Paste Option Button 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Editing Tools 

✓ Using AutoCorrect 

✓ Using Spell Check 

✓ Using Find and Replace 

✓ Adding Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Foundation, Section 3 
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Getting Started 

Course Overview and Learning Objectives 

This course teaches students everything they need to know about opening, interacting 

with, and closing Excel. As well, students will learn about workbooks, worksheets, file 

types, and how to navigate around a spreadsheet. The Help feature is also covered in 

detail. 

Course Outline 

1.1. Starting Out 

✓ What is Microsoft Office Excel 

2010? 

✓ What’s New in Excel 2010? 

✓ Opening Excel 

✓ Interacting with Excel 

✓ Closing Excel 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. About Workbooks 

✓ Creating a New Workbook 

✓ Opening a Workbook 

✓ Saving a Workbook 

✓ About Excel File Types 

✓ Closing a Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Exploring your Workbook 

✓ Using Worksheets 

✓ The Active Cell 

✓ Selecting Cells 

✓ Exploring a Worksheet 

✓ Using Zoom 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help with Excel 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Online Help vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Foundation, Section 1 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 506 

Getting the Most from Your Data  

Course Overview and Learning Objectives 

To begin this course, students will learn about Excel’s automatic grouping, outlining, and 

subtotaling features. Students will also explore the Scenario Manager, data analysis tools, 

add-ins, one and two data input tables, goal seek, and Solver. The course will conclude 

with a discussion on hyperlinks. 

Course Outline 

1.1. Outlining and Grouping Data 

✓ Using Automatic Outlining 

✓ Displaying and Collapsing Levels 

✓ Grouping Data Manually 

✓ Creating Subtotals 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Exploring Scenarios 

✓ What is a Scenario? 

✓ Creating a Scenario 

✓ Saving Multiple Scenarios 

✓ Merging Scenarios 

✓ Creating a Scenario Summary 

Report 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Data Analysis Tools 

✓ Enabling Data Analysis Tools 

✓ An Overview of Excel’s Analysis 

Tools 

✓ An Overview of the Available 

Add-In Tools 

✓ Using a One or Two Input Data 

Table 

✓ Using Goal Seek 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Solver 

✓ Setting up a Worksheet for Solver 

✓ Running Solver 

✓ Generating Reports and 

Scenarios with Solver 

✓ Changing Solver Values 

✓ Managing Solver Constraints 

✓ Choosing a Solving Method 

✓ Using Solver as a Goal Seek Tool 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Excel and Hyperlinks 

✓ What is a Hyperlink? 

✓ Inserting Hyperlinks 

✓ Editing Hyperlinks 

✓ Formatting Hyperlinks 

✓ Using Hyperlinks in Excel 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: Advanced, 

Section 1 
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Macros, Visual Basic, and Excel Programming 

Course Overview and Learning Objectives 

This course will explore how to automate Excel tasks with macros. We will cover 

recording, running, and editing both basic and relative reference macros. Information on 

assigning a keyboard shortcut to a macro and managing macro security is also included. 

Then, Visual Basic tasks will be covered, including copying macros, using the Visual Basic 

Editor, declaring variables, iterating over a range, prompting for user input, and using 

conditional (If…Then…Else) statements. 

Course Outline 

1.1. Creating a Basic Macro 

✓ Recording a Macro 

✓ Editing a Macro 

✓ Running a Macro 

✓ Understanding Macro Security 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Visual Basic and Macros 

✓ Opening the Visual Basic Editor 

✓ Understanding the Visual Basic 

Editor 

✓ Adding Code to your Macro 

✓ Adding Comments to Visual Basic 

Code 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. More Macro Tasks 

✓ What are Relative References? 

✓ Recording a Relative Reference 

Macro 

✓ Running a Relative Reference 

Macro 

✓ Assigning a Keyboard Shortcut to 

a Macro 

✓ Copying a Macro from a 

Workbook or Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Visual Basic Tasks 

✓ Declaring Variables 

✓ Iteration over a Range 

✓ Prompting for User Input 

✓ Using If, Then, and Else 

Statements 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: Advanced, 

Section 5 
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Managing Tables 

Course Overview and Learning Objectives 

Tables are an important part of Excel because they inherently contain a lot of useful 

functionality, including sorting and filtering. This course teaches students how to add and 

edit tables, edit table information, perform sort and filter operations, and even how to use 

Excel as a database. 

Course Outline 

1.1. Working with Tables 

✓ What is a Table? 

✓ Creating Tables 

✓ Modifying Tables 

✓ Using the Table Tools – Design 

Tab 

✓ Adding a Total Row 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Records and Fields 

✓ What are Records and Fields? 

✓ Adding Fields by Inserting 

Columns 

✓ Adding Records by Inserting 

Rows 

✓ Quickly Adding Records to a Data 

Table 

✓ Deleting Records or Fields 

✓ Cleaning up Duplicate Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Tables and Filters 

✓ Sorting Data in a Table 

✓ What is an AutoFilter? 

✓ Creating a Custom AutoFilter 

✓ Using an Advanced Filter 

✓ Using an Advanced Filter with 

Logical Statements 

✓ Copying Filtered Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Excel as a Database 

✓ Filtering with Wildcard 

Characters 

✓ Validating your Data 

✓ Data Validation using Lists 

✓ Data Validation using Formulas 

✓ Using Database Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Intermediate, Section 3
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Pivoting Data 

Course Overview and Learning Objectives 

This course focuses on one of Excel’s most powerful tools: PivotTables. Students will 

explore all aspects of PivotTables, including creating a PivotTable; using the contextual 

tabs; pivoting, summarizing, and analyzing data; formatting the PivotTable; and using 

external data with a PivotTable. This course also includes information on Slicers (a new 

feature that lets users analyze and interpret pivoted data with ease) and the classic 

PivotTable frame (used in Excel 2003 and earlier). The session will conclude with a 

comprehensive introduction to integrating data with PowerPivot and creating a 

PivotTable from that data. 
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Course Outline 

1.1. Getting Started with PivotTables 

✓ What is a PivotTable? 

✓ Creating a PivotTable 

✓ Using the PivotTable Tools Tabs 

✓ Adding and Removing Data with 

the Field List 

✓ Changing the Field List Layout 

✓ Pivoting Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with PivotTable Data 

✓ Expanding and Collapsing Data 

✓ Filtering Data 

✓ Sorting Data 

✓ Grouping Data 

✓ Refreshing Data 

✓ Editing the Data Source 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting a PivotTable 

✓ Modifying Fields and Labels 

✓ Modifying Values 

✓ Using the Layout Group on the 

Design Tab 

✓ Applying a Style to a PivotTable 

✓ Changing PivotTable Style 

Options 

✓ Manually Formatting a 

PivotTable 

✓ Using the PivotTable Options 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.4. Using the Classic PivotTable Layout 

✓ Creating an Empty (Classic) 

PivotTable Frame 

✓ Switching an Existing PivotTable 

to a Classic Layout 

✓ Adding Data 

✓ Pivoting Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Advanced PivotTable Tasks 

✓ Creating a PivotTable Based on 

External Data 

✓ Refreshing External Data 

✓ Creating a Slicer 

✓ Using the Slicer Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using PowerPivot 

✓ System Requirements 

✓ Downloading and Installing 

PowerPivot 

✓ Importing Access Data 

✓ Importing Excel Data 

✓ Integrating Data with 

Relationships 

✓ Creating a PivotTable with 

PowerPivot Data 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: Advanced, 

Section 2 
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Printing and Viewing your Workbook 

Course Overview and Learning Objectives 

This course will help students display their data in different ways. Topics include an in-

depth examination of the View tab, how to work with multiple worksheets at once, and 

finally how to print the final product.  

Course Outline 

1.1. Using the View Tab 

✓ Using Normal View 

✓ Using Full Screen View 

✓ Using Page Layout View 

✓ Page Break Preview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing a Single Window 

✓ Creating a New Window 

✓ Hiding a Window 

✓ Unhiding a Window 

✓ Freezing a Pane 

✓ Splitting a Worksheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Multiple Windows 

✓ Switching Between Open 

Workbooks 

✓ Arranging Workbooks 

✓ Comparing Workbooks Side by 

Side 

✓ Synchronous Scrolling and 

Resetting a Window 

✓ Saving a Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Printing your Workbook 

✓ Print Commands 

✓ Print Preview 

✓ Using Basic Print Options 

✓ Other Print Options 

✓ Setting Printer Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Foundation, Section 5
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Showing Data as a Graphic 

Course Overview and Learning Objectives 

This course will show students how to turn data into informative visual aids. Students will 

learn how to add and edit SmartArt; add symbols, special characters, and equations; and 

add and edit shapes. Finally, the new Sparkline feature will be discussed, showing students 

how to add, edit, and customize these useful graphs-in-a-cell. 

Course Outline 

1.1. Inserting SmartArt 

✓ Inserting SmartArt 

✓ Adding Text 

✓ Adding Photos 

✓ About the SmartArt Tools Tabs 

✓ Editing SmartArt 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting SmartArt 

✓ Changing the Layout 

✓ Changing the Color Scheme 

✓ Changing the Style Scheme 

✓ Resetting the Graphic 

✓ Converting the Graphic 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Symbols, Equations, and 

Shapes 

✓ Inserting a Symbol or Special 

Character 

✓ Inserting an Equation 

✓ Using the Equation Tools – 

Design Tab 

✓ Drawing Shapes 

✓ Common Shape Editing Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding Sparklines 

✓ What are Sparklines? 

✓ Adding Sparklines 

✓ About the Sparkline Tools Tab 

✓ Editing Sparkline Data 

✓ Removing Sparklines 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Editing Sparklines 

✓ Showing and Hiding Data 

✓ Changing the Style 

✓ Changing the Sparkline and 

Marker Color 

✓ Setting Sparkline Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Intermediate, Section 5
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The Excel Interface 

Course Overview and Learning Objectives 

In order to get the most out of Excel, students need to know where to find commands. This 

course covers the basics of the Quick Access toolbar and the basics of the Home, Insert, 

Page Layout, Formulas, Data, and Review tabs. A high-level overview of each tab and its 

associated command groups is included, along with exercises that experiment with some 

of these commands. 
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Course Outline 

1.1. The Quick Access Toolbar and File 

Menu 

✓ The Default QAT Commands 

✓ Adding Commands 

✓ Removing Commands 

✓ Customizing the Toolbar 

✓ Using the File (Backstage) Menu 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Home Tab 

✓ Understanding Tabs and Groups 

✓ Clipboard Commands 

✓ Font Commands 

✓ Alignment Commands 

✓ Number Commands 

✓ Styles Commands 

✓ Cells Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Insert Tab 

✓ Tables Commands 

✓ Illustrations Commands 

✓ Charts Commands 

✓ Sparklines Commands 

✓ Filter Commands 

✓ Links Commands 

✓ Text Commands 

✓ Symbol Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Page Layout Tab 

✓ Themes Commands 

✓ Page Setup Commands 

✓ Scale to Fit Commands 

✓ Sheet Options Commands 

✓ Arrange Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Formulas Tab 

✓ The Functions Library 

✓ Defined Names Commands 

✓ Formula Auditing Commands 

✓ Calculation Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The Data Tab 

✓ Get External Data Commands 

✓ Connections Commands 

✓ Sort and Filter Commands 

✓ Data Tools Commands 

✓ Outline Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.7. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Comments Commands 

✓ Changes Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Foundation, Section 2 
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Working with Functions and Formulas 

Course Overview and Learning Objectives 

In this course, students will learn how to properly reference cells, use mathematical 

operators, and check their formulas for errors. This course also covers how to browse, 

insert, and use functions to perform complex mathematical operations. Students will also 

learn how to use the IF function, use nested functions to perform multiple operations, and 

define and use range names. Finally, array formulas will be discussed. 

Course Outline 

1.1. Using Formulas in Excel, Part 1 

✓ Understanding Relative and 

Absolute Cell References 

✓ Understanding Basic 

Mathematical Operators 

✓ Using Formulas with Multiple Cell 

References 

✓ Understanding the Formula 

Auditing Buttons 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Formulas in Excel, Part 2 

✓ Fixing Formula Errors 

✓ Modifying Error Checking 

Options 

✓ Displaying and Printing Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Exploring Excel Functions 

✓ What are Functions? 

✓ Finding the Right Functions 

✓ Inserting Functions 

✓ Some Useful and Simple 

Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Functions in Excel 

✓ Using the IF Function 

✓ Working with Nested Functions 

✓ Breaking up Complex Formulas 

✓ Using Functions and AutoFill to 

Perform Difficult Calculations 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Names and Ranges 

✓ What are Range Names? 

✓ Defining and Using Range Names 

✓ Defined Names Commands 

✓ Selecting Nonadjacent Ranges 

✓ Using AutoCalculate 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Working with Array Formulas 

✓ What are Array Formulas? 

✓ Defining Basic Array Formulas 

✓ Using Functions within Array 

Formulas 

✓ Using the IF Function in Array 

Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2010: 

Intermediate, Section 2
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Microsoft InfoPath 2010 

Adding Objects to a Form  

Course Overview and Learning Objectives 

This course will focus on adding non-control objects to a form. Objects covered will 

include pictures, Clip Art, alternative text, hyperlinks, horizontal lines, and symbols. 

Picture editing tools will also be covered. 

Course Outline 

1.1. Inserting Pictures 

✓ Adding a Picture from a File 

✓ Adding Clip Art 

✓ Overview of the Picture Tools – Format Tab 

✓ Using the Format Picture Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Pictures 

✓ Resizing Pictures 

✓ Moving Pictures 

✓ Adding Borders 

✓ Setting Alternative Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Other Objects 

✓ Creating a Hyperlink 

✓ Inserting a Horizontal Line 

✓ Resizing a Horizontal Line 

✓ Inserting a Symbol 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Intermediate, Section 4 
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Coding with InfoPath  

Course Overview and Learning Objectives 

In this course, students will receive an introduction to coding events with Visual Basic in 

InfoPath Designer 2010. ActiveX controls, custom controls, and COM add-ins will also be 

covered. 

Course Outline 

1.1. Getting Started 

✓ Installation Requirements 

✓ Setting Your Program Language and Code Options 

✓ Opening the Code Editor 

✓ An Introduction to VSTA 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Events 

✓ Creating a Basic Event 

✓ Creating a Control Event 

✓ Modifying Events 

✓ Testing Events 

✓ Removing Events 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Custom Components 

✓ Adding Custom Controls 

✓ Managing Custom Controls 

✓ Adding COM Add-Ins 

✓ Removing COM Add-Ins 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding ActiveX Controls 

✓ Adding an ActiveX Control 

✓ Modifying an ActiveX Control 

✓ Renaming an ActiveX Control 

✓ Removing an ActiveX Control 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Advanced, Section 2 
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Command Tab Overview  

Course Overview and Learning Objectives 

In this course, students will receive a complete overview of each of the five main InfoPath 

Designer command tabs. 

Course Outline 

1.1. The Home Tab 

✓ Clipboard Commands 

✓ Format Text Commands 

✓ Font Styles Commands 

✓ Controls Commands 

✓ Rules Commands 

✓ Editing Commands 

✓ Form Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Insert Tab 

✓ Tables Commands 

✓ Illustrations Commands 

✓ Links Commands 

✓ Page Format Commands 

✓ Symbols Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Page Design Tab 

✓ Views Commands 

✓ Page Layouts Commands 

✓ Themes Commands 

✓ Headers Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Data Tab 

✓ Form Data Commands 

✓ Get External Data Commands 

✓ Submit Form Commands 

✓ Rules Commands 

✓ Roles Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Developer Tab 

✓ Code Commands 

✓ Events Commands 

✓ Control Events Commands 

✓ COM Add-Ins 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Foundation, Section 3 
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Creating a Basic Form  

Course Overview and Learning Objectives 

In this course, students will get into creating a basic form. We will start with using 

templates. Then, we will look at adding, modifying, and formatting tables to organize the 

form. 

Course Outline 

1.1. Using Templates 

✓ Using Popular Form Templates 

✓ Using Advanced Form Templates 

✓ Using InfoPath 2007 Form Templates 

✓ Using Template Parts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Getting Started with Tables 

✓ Anatomy of a Table 

✓ Inserting a New Table 

✓ Creating a Custom Table 

✓ Using the Table Tools – Layout Tab 

✓ Using the Table Properties Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Modifying Tables 

✓ Selecting Table Data 

✓ Moving Tables 

✓ Adding and Deleting Rows and Columns 

✓ Resizing Rows, Columns, and Tables 

✓ Merging and Splitting Cells 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Tables 

✓ Changing Cell Height and Width 

✓ Changing Cell Alignment 

✓ Changing Cell Padding 

✓ Changing Borders and Shading 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Foundation, Section 4 
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Creating Advanced Form Parts  

Course Overview and Learning Objectives 

In this course, students will learn about various types of advanced form parts. Template 

parts, object controls, repeating controls, master/detail controls, and choice groups will all 

be covered. 

Course Outline 

1.1. Creating Template Parts 

✓ Understanding Template Parts 

✓ Creating a Template Part 

✓ Saving a Template Part 

✓ Using a Template Part 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Object Controls 

✓ Inserting an Object Control 

✓ Formatting Object Controls 

✓ Assigning Actions to Object 

Controls 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Repeating Controls 

✓ Creating a Repeating Control 

✓ Adding Existing Controls into a 

Repeating Control 

✓ Deleting Repeating Controls 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Master/Detail Controls 

✓ Creating a Master/Detail Control 

✓ Formatting Master/Detail 

Controls 

✓ Using a Master/Detail Control in 

InfoPath Filler 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating Choice Groups 

✓ Creating Choice Groups 

✓ Formatting Choice Groups 

✓ Using Choice Groups in InfoPath 

Filler 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Intermediate, Section 3 
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Creating Forms Using Advanced Templates 

Course Overview and Learning Objectives 

This course will cover how to import a form from Microsoft Word or Excel, as well as how 

to create an e-mail form. Students will also learn how to create a form from an XML 

schema or file and a database. 

Course Outline 

1.1. Importing and Publishing Forms 

✓ Importing a Form from Word 

✓ Importing a Form from Excel 

✓ Publishing a Form by E-mail 

✓ Editing Forms After They Have Been Published 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. XML Form Templates 

✓ Creating a Form from an XML Schema 

✓ Creating a Form from an XML File 

✓ Working with an XML Form Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Database Form Templates 

✓ Creating a Form from a Database 

✓ Querying a Database 

✓ Submitting Data 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Advanced, Section 4 
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Doing More with Your Form  

Course Overview and Learning Objectives 

This course will look at additional form tasks, including formatting text, managing controls 

with courses, and performing advanced tasks on controls. 

Course Outline 

1.1. Formatting Text 

✓ Applying Text Effects 

✓ Changing Font Face, Size, and 

Color 

✓ Aligning and Justifying Text 

✓ Indenting Text 

✓ Removing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Text Tools 

✓ Applying Font Styles 

✓ Using the Format Painter 

✓ Using the Paragraph Task Pane 

✓ Creating a Bulleted or Numbered 

List 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Controls with Sections 

✓ Creating a Section 

✓ Creating an Optional Section 

✓ Creating a Scrolling or Horizontal 

Region 

✓ Modifying Sections 

✓ Removing Controls from a 

Section 

✓ Deleting Sections 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Control Tasks 

✓ Setting a Default Value 

✓ Choosing the Data Type 

✓ Setting Control Properties 

✓ Formatting a Control 

✓ Using the Control Properties 

Dialog 

✓ Using the Fields Task Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Applying the Finishing Touches 

✓ Inserting Page Breaks 

✓ Checking Your Spelling 

✓ Changing the Theme 

✓ Choosing a Page Layout Template 

✓ Adding a Header or Footer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Foundation, Section 5 
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Linking Your Form to Data  

Course Overview and Learning Objectives 

This course will focus on how to link a form to a data source. First, we will cover XML 

schemas and resource files. Next, we will cover external data types, including web 

services, SharePoint data, database files, and XML files. The final two lessons will cover 

how to modify field properties, including data binding, control types, and field 

management. 

Course Outline 

1.1. Working with Data 

✓ About XML Schemas 

✓ Adding a Resource File 

✓ Refreshing Fields 

✓ Setting Default Values 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Linking to External Data 

✓ Linking to a Web Service 

✓ Importing Data from SharePoint 

✓ Importing Database Files 

✓ Importing XML Data 

✓ Managing Data Connections 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Modifying Field Properties, Part One 

✓ Using the Fields Task Pane 

✓ Creating a Data Binding 

✓ Changing a Data Binding 

✓ Viewing Control Details 

✓ Changing the Control Type 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Modifying Field Properties, Part 

Two 

✓ Grouping Fields 

✓ Re-Ordering Fields 

✓ Deleting a Field 

✓ Referencing a Field 

✓ Viewing Field Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Intermediate, Section 2
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Managing InfoPath Designer Files  

Course Overview and Learning Objectives 

In this course, students will learn how to work with InfoPath forms at the file level. Topics 

will include using Windows Explorer within InfoPath, file management tools, form views, 

form options, and user roles. 

Course Outline 

1.1. Using Windows Explorer within 

InfoPath Designer 

✓ Navigating Using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. File Management Tools 

✓ Publishing a Snapshot to PDF or 

XPS 

✓ Changing Form Template 

Properties 

✓ Working with InfoPath 2003 and 

2007 Forms 

✓ Saving Forms in Older Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Lesson 1.3: Managing Form Views 

✓ Creating a New Form View 

✓ Editing a Form View 

✓ Switching to a View 

✓ Using the Form View Properties 

Dialog 

✓ Deleting a View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Changing Form Options 

✓ Modifying Available Form Filler 

Features 

✓ Modifying Offline Behavior 

✓ Controlling E-Mail Attachments 

✓ Choosing Your Security Level 

✓ Setting Preview Options 

✓ Setting Compatibility Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Managing User Roles 

✓ Adding a User Role 

✓ Editing a User 

✓ Removing a User 

✓ Changing the Order of User Roles 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Intermediate, Section 1 
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Publishing and Printing Your Form  

Course Overview and Learning Objectives 

In this course, we will look at how to use InfoPath Form Filler to complete forms. Then, we 

will explore setting global form options, preparing a form for sharing, and printing a form. 

Course Outline 

1.1. About the InfoPath Filler 

✓ What is InfoPath Filler? 

✓ Opening the Filler 

✓ Interface Overview 

✓ Completing a Form 

✓ Submitting a Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Setting Global Form Options 

✓ Opening the View Properties Dialog 

✓ Applying a Background Color or Picture 

✓ Changing the Font 

✓ Changing the Page Orientation 

✓ Modifying Margins 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Preparing a Form for Sharing 

✓ Understanding Submission Methods 

✓ Running the Design Checker 

✓ Adding a Submit Button 

✓ Configuring the Submit Options 

✓ Publishing the Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Printing Your Form 

✓ Print Commands 

✓ About Quick Print 

✓ Using Print Preview 

✓ Setting Print Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Foundation, Section 6 
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Starting Out  

Course Overview and Learning Objectives 

In this course, students will learn the basics of InfoPath: how to open and close it, how to 

use the interface, how to create a basic form, how to save and open forms, and how to get 

help.  

Course Outline 

1.1. Meeting Microsoft Office InfoPath 

Designer 2010 

✓ What is Microsoft InfoPath 

2010? 

✓ What’s New in Microsoft Office 

InfoPath Designer 2010? 

✓ An XML Primer 

✓ Opening InfoPath Designer 

✓ Interface Overview 

✓ Interacting with InfoPath 

Designer 

✓ Closing InfoPath Designer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Form Files 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Form 

✓ Using the New Form Window 

✓ Creating a New Form 

✓ Adding a New Table 

✓ Adding Text 

✓ Adding Controls 

✓ Previewing Your Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Basic Editing Tools 

✓ Selecting Data 

✓ Dragging and Dropping Text 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo 

✓ Using Find and Replace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Adding Controls 

✓ Understanding Control Types 

✓ Resizing Controls 

✓ Moving Controls 

✓ Deleting Controls 

✓ Using the Control Tools – 

Properties Tab 

✓ Adding a Label 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in InfoPath Designer 

2010 

✓ Getting Started with Office.com 

✓ Opening Help 

✓ Using the Help Screen 

✓ Using the Help Toolbar 

✓ Searching Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Foundation, Section 1 
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Understanding and Customizing the InfoPath Designer Interface  

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and how to customize the command tabs. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu (Backstage View) 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Foundation, Section 2 
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Using InfoPath Designer with SharePoint Server 2010 

Course Overview and Learning Objectives 

This course will focus on using the power of SharePoint in InfoPath. Topics will include 

publishing forms to SharePoint, using SharePoint views, and completing forms in 

SharePoint. A complete discussion of creating a workflow, using data connections with 

workflows, and modifying forms based on workflow status is also included. 

Course Outline 

1.1. Getting Started 

✓ System Requirements 

✓ Publishing an InfoPath Form to a SharePoint Server 

✓ Submitting Forms to a SharePoint Site 

✓ Using SharePoint Lists in InfoPath 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with SharePoint 

✓ Creating SharePoint Views 

✓ Applying SharePoint Views 

✓ Creating a Form in SharePoint 

✓ Filling Out a Form in SharePoint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Forms with SharePoint Workflows 

✓ Understanding Forms and Workflows 

✓ Adding a Workflow 

✓ Adding a Data Connection to Receive Workflow Information 

✓ Creating a New Form View for the Workflow 

✓ Changing the Form in Response to Workflow Status 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: Advanced, Section 3 
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Using Rules with Your Form 

Course Overview and Learning Objectives 

This course will cover form load, validation, formatting, and action rules. The Rule 

Inspector will also be discussed. 

Course Outline 

1.1. Creating Rules 

✓ Opening the Rules Task Pane 

✓ Creating a Rule from a Template 

✓ Creating a Validation Rule 

✓ Creating a Formatting Rule 

✓ Creating an Action Rule 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Rules 

✓ Copying and Pasting Rules 

✓ Changing the Order of Rules 

✓ Editing Rules 

✓ Deleting Rules 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Form Load Rule 

✓ What is a Form Load Rule? 

✓ Creating a Form Load Rule 

✓ Specifying Conditions 

✓ Adding Actions 

✓ Editing a Form Load Rule 

✓ Enabling or Disabling a Form 

Load Rule 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Running the Rule Inspector 

✓ Starting the Rule Inspector 

✓ Understanding the Rule Inspector 

✓ Expanding and Collapsing 

Categories 

✓ Navigating Through Your Rules 

✓ Printing Information from the 

Rule Inspector 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft InfoPath 2010: 

Advanced, Section 1 
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Microsoft OneNote 2010  

Adding Shapes and Images to Notes 

Course Overview and Learning Objectives 

This course will teach students how to insert, draw, move, edit, and arrange shapes and 

images. Students will also learn how to make text in an image searchable and how to copy 

text from an image. 

Course Outline 

1.1. Drawing Shapes 

✓ Inserting Shapes 

✓ Customizing Color and Thickness 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Using the Eraser 

✓ Deleting Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Shapes 

✓ Arranging Shapes 

✓ Rotating and Flipping Shapes 

✓ Choosing How Shapes are 

Treated 

✓ Locking Drawing Mode 

✓ Toggling Snap to Grid 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Pictures 

✓ Adding a Picture from a File 

✓ Adding a Screen Clipping 

✓ Moving a Picture 

✓ Deleting a Picture 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Pictures 

✓ Resizing a Picture 

✓ Restoring a Picture to its Original 

Size 

✓ Arranging Pictures 

✓ Rotating and Flipping Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Advanced Picture Tasks 

✓ Making Image Text Searchable 

✓ Copying Text from an Image 

✓ Editing Alternative Text 

✓ Exporting Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Intermediate, Section 2
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Advanced Topics 

Course Overview and Learning Objectives 

In this course, students will learn about hyperlinks, how to create and use linked notes, 

and even how to use OneNote as a feature-rich scientific calculator. Additional 

information on equations (including equations drawn using a touch-capable device) will 

also be covered. 

Course Outline 

1.1. Working with Hyperlinks 

✓ Creating Hyperlinks 

✓ Using Hyperlinks 

✓ Editing Hyperlinks 

✓ Removing Hyperlinks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Linking Notes 

✓ Enabling or Disabling Automatic 

Note Linking 

✓ Creating Linked Notes 

✓ Viewing Linked Notes 

✓ Manually Linking Notes 

✓ Copying a Link for an Item 

✓ Clearing Links 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing Math with OneNote 

✓ Doing Simple Math 

✓ Inserting Built-In Equations 

✓ Using the Equation Tools – 

Design Tab 

✓ Creating a Custom Equation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Equations 

✓ Changing Equation Display 

✓ Converting an Equation to Text 

✓ Creating Ink Equations 

✓ Deleting an Equation 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Advanced, Section 4 
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Creating Notes 

Course Overview and Learning Objectives 

This course is all about how to create, edit, and format data in a notebook. Topics include 

using cut, copy, and paste; how to use the different selection tools; and how to format text 

and paragraphs. 

Course Outline 

1.1. Using OneNote’s Editing Tools 

✓ Using Cut, Copy, and Paste 

✓ Dragging and Dropping Text 

✓ Using Undo and Redo 

✓ Using Search 

✓ Using Spell Check 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using OneNote’s Selection Tools 

✓ Using Select & Type 

✓ Using Lasso Select 

✓ Using the Eraser 

✓ Using the Panning Hand 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Text 

✓ Applying Text Effects 

✓ Changing Font Face, Size, and 

Color 

✓ Highlighting Text 

✓ Using the Format Painter 

✓ Removing Formatting 

✓ Inserting Symbols 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Paragraphs 

✓ Aligning Text 

✓ Indenting Text 

✓ Creating a Bulleted or Numbered 

List 

✓ Applying a Quick Style 

✓ Adding Writing Space 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Foundation, Section 4 
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Customizing OneNote 

Course Overview and Learning Objectives 

In this course, students will learn how to customize OneNote. Topics include how to 

change display and language icons, customize the OneNote notification icon, change the 

look of OneNote, and change the default font. Advanced editing behavior (including 

pen/touch input) is also covered. Finally, students will learn how to customize OneNote in 

order to provide the best overall security for their information. 

Course Outline 

1.1. Using the OneNote Options Dialog 

✓ Opening the Dialog 

✓ Overview of the Options Dialog 

✓ Customizing Display Options 

✓ Customizing Language Options 

✓ Configuring the OneNote 

Notification Icon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Changing General Options 

✓ Changing the OneNote Color 

Scheme 

✓ Choosing Your Default Font 

✓ Customizing Your User Name 

✓ Changing OneNote’s Battery 

Usage 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Changing Advanced Options 

✓ Changing Editing Behavior 

✓ Customizing Pen Behavior 

✓ Changing OneNote’s E-mail 

Signature 

✓ Customizing Password Behavior 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing OneNote’s Security 

✓ Managing Add-Ins 

✓ Opening the Trust Center 

✓ Managing Trusted Publishers 

✓ Changing Privacy Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Advanced, Section 5 
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Customizing OneNote Pages 

Course Overview and Learning Objectives 

In this course, students will learn about page templates and how to set up pages in their 

notebook. Other items such as author indicators, rule lines, and time/date stamps are also 

discussed. 

Course Outline 

1.1. Using Page Templates 

✓ Creating a Page from a Template 

✓ Using the Pages Menu to Create Template Pages 

✓ Setting the Default Template 

✓ Saving the Current Page as a Template 

✓ Deleting a Custom Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Changing Page Setup 

✓ Changing the Page Size 

✓ Customizing Margins 

✓ Saving the Current Page as a Template using the Paper Size Pane 

✓ Changing Page Color 

✓ Creating a Custom Picture Background 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Customizing the Current Page 

✓ Showing and Hiding the Page Title and Date Stamp 

✓ Showing and Hiding Authors 

✓ Adding Rule Lines 

✓ Adding a Time and/or Date Stamp 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Intermediate, Section 4 
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Integration with OneNote 

Course Overview and Learning Objectives 

In this course, students will learn how to attach files to a note, create and use audio and 

video files, work with information that has been pasted into OneNote, and use OneNote in 

conjunction with Microsoft Outlook. The OneNote printer is also discussed.  

Course Outline 

1.1. Attaching Files to a Note 

✓ Attaching a File from Your 

Computer 

✓ Scanning a File 

✓ Performing a Custom Scan 

✓ Inserting a Printout of a File 

✓ Creating a Link to a File 

✓ Modifying Linked Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Inserting Audio and Video Files 

✓ Inserting an Audio or Video File 

from Your Computer 

✓ Recording an Audio File 

✓ Recording a Video File 

✓ Using the Recording Tab 

✓ Modifying Audio and Video 

Containers 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Audio and Video Files 

✓ Viewing Inserted Media Files 

✓ Using the Playback Tab 

✓ Changing Audio and Video 

Settings 

✓ Searching Audio and Video Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Sending Information to OneNote 

✓ Copying Information into a Note 

✓ Using the Send to OneNote 

Command 

✓ Customizing Send to OneNote 

✓ Using the OneNote Printer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using OneNote with Microsoft 

Outlook 

✓ Marking a Note as an Outlook 

Task 

✓ Marking a Task as Complete 

✓ Deleting Outlook Tasks 

✓ Inserting Outlook Appointment 

and Meeting Details into a Note 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Advanced, Section 1 
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Managing Notebooks 

Course Overview and Learning Objectives 

Students will learn how to keep their pages, sections, and notebooks neat and tidy in this 

course. They will also learn how to create and manage section groups and subpages. 

Course Outline 

1.1. Organizing Your Notes 

✓ Creating a New Notebook 

✓ Creating New Pages 

✓ Creating Sections 

✓ Creating Section Groups 

✓ Managing Unfiled Notes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Pages 

✓ Inserting Pages and Subpages 

✓ Promoting and Demoting Pages 

✓ Moving and Copying Pages 

✓ Changing the Order of Pages 

✓ Deleting Pages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Sections and Section Groups, Part One 

✓ Renaming Sections and Section Groups 

✓ Deleting Sections and Section Groups 

✓ Changing the Color of Sections 

✓ Copying a Link to a Section 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Sections and Section Groups, Part Two 

✓ Moving Sections and Section Groups 

✓ Copying Sections and Section Groups 

✓ Merging Sections 

✓ Saving Sections 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Foundation, Section 5 
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Managing OneNote Files 

Course Overview and Learning Objectives 

To begin this course, students will learn how to back up their files and save their work in 

different formats. This course also discusses notebook properties and shows students 

how to manage the way OneNote saves information.  

Course Outline 

1.1. Backing up OneNote Files 

✓ Setting Backup Options 

✓ Changing the Backup Location 

✓ Running a Backup Manually 

✓ Opening and Restoring a Backup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving OneNote Files 

✓ Understanding Save Options 

✓ Saving a Section 

✓ Creating a Word Document 

✓ Creating a PDF or XPS File 

✓ Creating a Web Page 

✓ Creating a OneNote Package 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Notebook Properties 

✓ Modifying Notebook Properties 

✓ Changing the Display Name 

✓ Changing the Notebook Color 

✓ Moving the Notebook 

✓ Converting a Notebook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing OneNote Files 

✓ Protecting a Section with a 

Password 

✓ Optimizing OneNote Files 

✓ Changing the Cache Location 

✓ Changing the Save Location 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Intermediate, Section 1 
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Overview of OneNote’s Command Tabs 

Course Overview and Learning Objectives 

The basics of all ribbon commands will be covered in this course. Students will learn about 

the commands on the Home, Insert, Share, Draw, Review, and View tabs. 

Course Outline 

1.1. The Home Tab 

✓ Clipboard Commands 

✓ Basic Text Commands 

✓ Styles Commands 

✓ Tags Commands 

✓ Outlook Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Insert Tab 

✓ Insert Command 

✓ Tables Command 

✓ Images Commands 

✓ Links Command 

✓ Files Commands 

✓ Recording Commands 

✓ Time Stamp Commands 

✓ Symbols Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Share Tab 

✓ E-mail Command 

✓ Unread Commands 

✓ Shared Notebook Commands 

✓ History Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. The Draw Tab 

✓ Tools Commands 

✓ Insert Shapes Commands 

✓ Edit Commands 

✓ Convert Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Review Tab 

✓ Spelling Commands 

✓ Language Commands 

✓ Notes Command 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The View Tab 

✓ Views Commands 

✓ Authors Command 

✓ Page Setup Commands 

✓ Zoom Commands 

✓ Window Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Foundation, Section 3 
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Researching and Organizing Information 

Course Overview and Learning Objectives 

In this course, students will learn how to make the best use of OneNote’s research tools, 

including spelling, translation, and word lookup. Students will also learn how to customize 

these tools. Finally, students will learn how to create and use outlines in OneNote. 

Course Outline 

1.1. Using OneNote’s Research Tools 

✓ Checking Spelling 

✓ Using the Thesaurus 

✓ Using the Mini Translator 

✓ Performing a Full Translation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing OneNote’s Research Tools 

✓ Changing Spelling Options 

✓ Changing AutoCorrect Options 

✓ Setting Research Options 

✓ Setting Your Proofing Language 

✓ Changing Language Options 

✓ Setting Translation Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating an Outline with OneNote 

✓ Writing an Outline 

✓ Selecting Levels by Heading 

✓ Expanding and Collapsing Headings 

✓ Moving Outline Topics 

✓ Deleting an Outline 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Intermediate, Section 6 
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Searching, Viewing, and Printing Your Notebook 

Course Overview and Learning Objectives 

This course covers how to search pages, sections, and notebooks; how to use program 

layouts and views; and how to dock OneNote to the desktop for concurrent research and 

note-taking. This course also teaches students about the creation and usage of side notes, 

and how to print and e-mail their data. 

Course Outline 

1.1. Searching Your Notebook 

✓ Using the Find Command 

✓ Searching in OneNote 

✓ Navigating Through Search 

Results 

✓ Setting the Default Search Scope 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Layouts and Views 

✓ Using Normal View 

✓ Using Full Page View 

✓ Using Zoom 

✓ Keeping the Current Window on 

Top 

✓ Creating a New Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Docking OneNote to the Desktop 

✓ Docking and Undocking a 

Window 

✓ Using Linked Note Taking 

✓ Command Tabs Available in 

Docked Mode 

✓ Navigating in Docked Mode 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Side Notes 

✓ Creating a Side Note 

✓ Command Tabs Available in Side 

Notes 

✓ Switching to Normal View 

✓ Managing Side Notes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Printing Your Notebook 

✓ Using Print Preview 

✓ Choosing What to Print 

✓ Printing your Notebooks 

✓ E-mailing a Single Page 

✓ E-mailing a Page as an 

Attachment 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Foundation, Section 6 
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Sharing and Synchronizing OneNote Information 

Course Overview and Learning Objectives 

One of OneNote’s best features is the way it can be used to share content with others 

over multiple locations. This lesson will discuss how to create and share a notebook, keep 

notebooks up to date, and work with versioned files. OneNote’s collaboration tools and 

the OneNote Web App will also be introduced. 

Course Outline 

1.1. Creating Shared Notebooks 

✓ Getting Started 

✓ Creating a Shared Notebook 

✓ Sending Invitations 

✓ Opening Shared Notebooks 

✓ Stopping Sharing 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the OneNote Web App 

✓ Viewing Notebooks from the 

Internet 

✓ Using the Backstage View 

✓ Understanding the Command 

Tabs 

✓ Working with Online Notebooks 

✓ Opening Online Notebooks in 

OneNote 2010 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Keeping Notebooks Up to Date 

✓ Controlling Synchronization 

✓ Syncing All Notebooks 

✓ Syncing Individual Notebooks 

✓ Viewing Synchronization Status 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Versions 

✓ Viewing Page Versions 

✓ Salvaging Old Versions 

✓ Deleting Old Versions 

✓ Disabling Version History 

✓ Using the Notebook Recycle Bin 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Collaboration Tools 

✓ Using Author Indicators 

✓ Viewing New Content 

✓ Viewing Changes by Author 

✓ Marking Changes as Read or 

Unread 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Advanced, Section 3 
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Starting Out 

Course Overview and Learning Objectives 

In this course, students will be introduced to OneNote 2010 and its interface. They will 

learn how to browse a notebook, use text containers, and close their notebooks. 

Course Outline 

1.1. Meeting Microsoft Office OneNote 

2010 

✓ What is Microsoft Office 

OneNote 2010? 

✓ What’s New in Microsoft Office 

OneNote 2010? 

✓ Opening OneNote 

✓ Closing OneNote 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Interacting with OneNote 

✓ Understanding Notebooks 

✓ Interface Overview 

✓ Customizing the OneNote Screen 

✓ Interacting with OneNote 

✓ Using the OneNote Notification 

Icon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Your First Notebook 

✓ Getting to Know the Notebook 

Hierarchy 

✓ Using the Navigation Bar 

✓ Using the Page Tabs 

✓ Understanding Text Containers 

✓ Typing and Deleting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Containers 

✓ Selecting a Container 

✓ Moving a Container 

✓ Resizing a Container 

✓ Deleting a Container 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Your Notebook 

✓ How Does OneNote Use Files? 

✓ Saving Notebooks 

✓ Opening Notebooks 

✓ Using the Recently Closed 

Notebook List 

✓ Closing Notebooks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in OneNote 

✓ Getting Started with Office.com 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching Help 

✓ Online vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: 

Foundation, Section 1 
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Understanding and Customizing the OneNote Interface 

Course Overview and Learning Objectives 

Students will learn about the new ribbon interface featured in OneNote 2010. Topics 

include the File (Backstage) menu, the Quick Access toolbar, how to use tabs and groups, 

and how to customize ribbon commands. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu (Backstage View) 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Using Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ Minimizing and Maximizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Foundation, Section 2 
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Using Tables in OneNote 

Course Overview and Learning Objectives 

Tables are an easy way to add and organize all sorts of data. This course teaches students 

how to insert, edit, and format tables. Table and data alignment are also discussed. 

Course Outline 

1.1. Inserting Tables 

✓ Anatomy of a Table 

✓ Inserting Tables 

✓ Using the Table Tools – Layout Tab 

✓ Selecting Table Data 

✓ Deleting a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Tables 

✓ Moving Tables 

✓ Resizing Tables 

✓ Inserting Rows or Columns 

✓ Deleting Rows and Columns 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Tables 

✓ Arranging Tables 

✓ Hiding Borders 

✓ Changing Table Alignment 

✓ Formatting Table Data 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Intermediate, Section 3 
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Using Tags in OneNote 

Course Overview and Learning Objectives 

In this course, students will learn about one of OneNote’s most useful features: tags. This 

course will teach students how to use tags to flag important information. Tag 

customization and search functionality is also discussed. 

Course Outline 

1.1. Using Basic Tags 

✓ Understanding Tags 

✓ Tagging an Item 

✓ Removing Tags 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing Tags 

✓ Creating a Custom Tag 

✓ Editing an Existing Tag 

✓ Deleting a Tag 

✓ Changing the Order of Tags 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Searching for Tags 

✓ Opening the Tags Summary Pane 

✓ Navigating to a Tagged Item 

✓ Changing How Tags are Grouped 

✓ Changing the Search Scope 

✓ Creating a Summary Page 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Intermediate, Section 5 
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Working with Handwritten Text 

Course Overview and Learning Objectives 

This course will teach students how to make the most of OneNote while using touch-

capable technology. Topics include how to write text, turn handwriting into text or math, 

and create a custom pen or highlighter. Highlighting tags will also be discussed. 

Course Outline 

1.1. Adding Handwritten Text 

✓ Choosing a Pen 

✓ Creating a Custom Pen 

✓ Customizing Pen Mode 

✓ Handwriting Text 

✓ Using the Eraser 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Handwritten Text 

✓ Working with Handwritten Text 

✓ Converting Ink to Text 

✓ Converting Ink to Math 

✓ Deleting Handwritten Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using OneNote’s Highlighters 

✓ Highlighting with the Home Tab 

✓ Adding a Highlighting Tag 

✓ Highlighting by Hand 

✓ Creating a Custom Highlighter 

✓ Removing Custom Highlighting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2010: Advanced, Section 2 
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Microsoft Outlook 2010  

A Word Primer 

Course Overview and Learning Objectives 

This course will introduce students to some Microsoft Word features available when 

creating Outlook items, including text formatting tools, themes, Quick Styles, and mail 

formats. We will also look at objects that can be added to Outlook items: tables, pictures, 

Clip Art, screenshots, shapes, text boxes, WordArt, SmartArt, and charts. 

Course Outline 

1.1. Basic Text Tools 

✓ Cutting, Copying, and Pasting 

Text 

✓ Using the Office Clipboard 

✓ Using Find and Replace 

✓ Checking Your Spelling 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Text 

✓ Changing Font Face, Size, and 

Color 

✓ Applying Text Effects 

✓ Highlighting Text 

✓ Changing Text’s Case 

✓ Using the Font Dialog 

✓ Clearing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Applying Advanced Text Effects 

✓ Using the Format Painter 

✓ Applying a Quick Style 

✓ Changing the Style Set 

✓ Using Themes 

✓ Understanding Mail Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Paragraphs 

✓ Aligning and Justifying Text 

✓ Indenting a Paragraph 

✓ Changing Paragraph Spacing 

✓ Creating a Bulleted, Numbered, 

or Multilevel List 

✓ Adding Borders and Shading 

✓ Using the Borders and Shading 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Adding Word Elements, Part One 

✓ Adding Tables 

✓ Adding Pictures and Clip Art 

✓ Adding Screenshots 

✓ Adding Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Adding Word Elements, Part Two 

✓ Adding Text Boxes 

✓ Adding WordArt 

✓ Adding SmartArt 

✓ Adding Charts 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Intermediate, Section 3
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Advanced E-Mail Features  

Course Overview and Learning Objectives 

In this course, we will talk about creating and using signatures and stationery. Then, we 

will talk about attaching various items to an e-mail. Next, message options (such as 

priority, follow-up, receipts, voting options, and delayed delivery) will be discussed. 

Students will receive an introduction to the Outlook Options dialog to round out the 

course. 

Course Outline 

1.1. Customizing and Using Signatures 

✓ Creating a Signature 

✓ Editing a Signature 

✓ Setting Signature Options 

✓ Using Signatures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing and Using Stationery 

✓ Choosing an Office 2010 Theme 

for a Single Message 

✓ Choosing a Legacy Theme or 

Stationery for a Single Message 

✓ Setting a Default Theme and 

Stationery 

✓ Customizing Default Message 

Fonts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Attaching Items to an E-mail 

✓ Attaching a File 

✓ Adding a Calendar 

✓ Adding a Business Card 

✓ Adding Other Outlook Items 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Changing Message Options 

✓ Setting Message Priority 

✓ Marking a Message for Follow Up 

✓ Using Quick Click Flags 

✓ Showing and Hiding Fields 

✓ Working with Multiple E-Mail 

Accounts 

✓ Requesting Delivery and Read 

Receipts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Setting Advanced Message Options 

✓ Adding Voting Options 

✓ Changing the Reply-To Address 

✓ Delaying Delivery 

✓ Saving Your Message outside 

Sent Items 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using the Outlook Options Dialog 

✓ Opening the Options Dialog 

✓ Overview of the Options Dialog 

✓ Changing General Options 

✓ Changing Mail Options 

✓ Changing Mobile Options 

✓ Changing Language Options 

✓ Changing Advanced Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Advanced, Section 1 
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Advanced Information Management Tools  

Course Overview and Learning Objectives 

This course will focus on advanced calendar, task, and contact management tools. View 

creation and management will also be covered. 

Course Outline 

1.1. Advanced Calendar Options 

✓ Using the Time Zone Feature 

✓ Creating Recurring 

Appointments 

✓ Setting Calendar Options 

✓ Adding Holidays to Your 

Calendar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Task Options 

✓ Creating Recurring Tasks 

✓ Assigning Tasks 

✓ Receiving Assigned Tasks 

✓ Sending a Status Report 

✓ Marking a Task as Private 

✓ Changing Task Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Contact Management 

Options 

✓ Showing Additional Fields 

✓ Marking a Contact as Private 

✓ Using the Communicate Group 

✓ Changing Contact Options 

✓ Creating a New Contact Group 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced View Options 

✓ Creating a View 

✓ Resetting a View 

✓ Adding Columns to a View 

✓ Opening the Advanced View 

Settings Dialog 

✓ Managing Views 

✓ Applying a View to Other Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Advanced, Section 2 
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Advanced Topics 

Course Overview and Learning Objectives 

In this course, students will learn a few ways to improve their productivity in Outlook. 

First, linking items to each other using various methods (including the journal) will be 

covered. Then, creating, publishing, and using custom forms will be covered. (The 

OMSGCLAS utility will be included in this discussion.) A discussion on calendar sharing 

and the new Social Network Connector rounds out the course. 

Course Outline 

1.1. Linking Items 

✓ Linking Files 

✓ Linking Outlook Items 

✓ Linking a Business Card to an 

Outlook Item 

✓ Using the Journal to Link Items 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Custom Forms 

✓ Creating Custom Forms 

✓ Publishing Custom Forms 

✓ Using Custom Forms 

✓ Setting a Custom Form as the 

Default Form for a Folder 

✓ Applying Custom Forms to 

Existing Items 

✓ Using the Forms Manager 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Publishing Your Calendar 

✓ Publishing Your Calendar 

✓ Subscribing to a Calendar 

✓ Using Overlay Mode 

✓ Using Schedule View 

✓ Stopping Calendar Sharing 

✓ Saving Your Calendar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using the Social Network Connector 

✓ Installing the Connector 

✓ Setting up the Connector in 

Outlook 

✓ Using the Connector 

✓ Disabling Connectors 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Advanced, Section 3 
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Data Management 

Course Overview and Learning Objectives 

This course will show students how to manage Outlook profiles and data. Information on 

the Account Settings window, mailbox cleanup, AutoArchive, and importing and exporting 

data is also included. 

Course Outline 

1.1. Using the Account Settings Window 

✓ Opening the Account Settings 

Window 

✓ Using the E-mail Tab 

✓ Using the RSS Feeds Tab 

✓ Using the SharePoint Lists Tab 

✓ Modifying Published Calendars 

✓ Modifying Address Books 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Personal Folders 

✓ Managing Personal Folders 

✓ Creating Personal Folders 

✓ Setting a Personal Folders File as 

Default 

✓ Opening and Closing Personal 

Folders 

✓ Setting Personal Folders 

Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Managing Personal Folders 

✓ Setting AutoArchive Options 

✓ Archiving Manually 

✓ Using Mailbox Cleanup 

✓ Exporting Information 

✓ Importing Information 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Outlook Profiles 

✓ Overview of the Mail Icon in the 

Control Panel 

✓ Creating a New Profile 

✓ Deleting or Viewing a Profile 

✓ Setting Profile Options 

✓ Choosing Your Profile 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Advanced, Section 4 
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Information Management  

Course Overview and Learning Objectives 

This course will introduce students to the calendar, contacts, tasks, notes, and journal 

folders. 

Course Outline 

1.1. The Calendar 

✓ Opening the Calendar 

✓ Understanding the Home Tab 

✓ Understanding the Calendar 

Tools Tab 

✓ Creating and Editing 

Appointments 

✓ Using the Daily Task List 

✓ Using the Calendar Navigation 

Pane 

✓ Customizing Calendar Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Contacts Folder 

✓ Opening the Contacts Folder 

✓ Understanding the Home Tab 

✓ Creating a New Contact 

✓ Editing Contacts 

✓ Using the Contacts Navigation 

Pane 

✓ Customizing Contacts Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Tasks Folder 

✓ Opening the Tasks Folder 

✓ Understanding the Home Tab 

✓ Creating a New Task 

✓ Editing a Task 

✓ Using the Tasks Navigation Pane 

✓ Customizing Tasks Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Notes Folder 

✓ Opening the Notes Folder 

✓ Understanding the Home Tab 

✓ Creating a New Note 

✓ Editing a Note 

✓ Using the Notes Navigation Pane 

✓ Customizing Notes Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Journal Folder 

✓ Setting Journal Options 

✓ Opening the Journal Folder 

✓ Understanding the Home Tab 

✓ Creating a New Journal Entry 

✓ Editing a Journal Entry 

✓ Customizing Journal Views 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 6 
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Microsoft Exchange Server 

Course Overview and Learning Objectives 

This course will explore the features available when using Microsoft Outlook with an 

Exchange Server mailbox. First, students will learn how to set up and use an Exchange 

Server mailbox, both in Outlook and via Outlook Web Access. Next, students will learn 

about mailbox management tools, such as delegates and the Out of Office Assistant. Then, 

students will learn how to share their calendar and tasks, and how to schedule meeting 

requests with other Exchange users. 

Course Outline 

1.1. About Microsoft Exchange Server 

✓ Understanding Microsoft 

Exchange Server 

✓ Setting up an Exchange Mailbox 

✓ How an Exchange Mailbox Works 

✓ Supported Versions of Exchange 

Server with Outlook 2010 

✓ About Outlook Web Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Your Mailbox 

✓ Setting Permissions on Your 

Mailbox 

✓ Configuring Delegate Access 

✓ Viewing Another User’s Mailbox 

✓ Setting up the Out of Office 

Assistant 

✓ Using the Global Address Book 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Tasks and E-mail 

Messages 

✓ Recovering Deleted Items 

✓ Recalling Messages 

✓ Sending a Task Sharing Request 

✓ Responding to a Task Sharing 

Request 

✓ Viewing Another User’s Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Your Calendar 

✓ Sharing a Calendar 

✓ Responding to a Calendar Sharing 

Request 

✓ Viewing Another User’s Calendar 

✓ Using Schedule View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Scheduling Meetings with Exchange 

Server 

✓ Scheduling a Meeting 

✓ Using the Scheduling Assistant 

✓ Responding to a Meeting Request 

✓ Tracking Responses 

✓ Adding and Removing Attendees 

✓ Contacting Attendees 

✓ Cancelling a Meeting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Review Questions 

− Case Study 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Intermediate, Section 5
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Organizing Your E-mail (Part One) 

Course Overview and Learning Objectives 

In this course, students will learn how to create and manage folders. Next, students will 

learn about the Favorites list in the Navigation Pane. Then, students will learn about 

various search features, including search folders, the contextual Search Tools tab, the 

search box, and filters. 

Course Outline 

1.1. Managing Folders 

✓ Creating Folders 

✓ Renaming Folders 

✓ Moving Folders 

✓ Deleting Folders 

✓ Moving Messages to Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Favorites List 

✓ Adding Folders to the Favorites 

List 

✓ Reordering Favorite Folders 

✓ Removing a Folder from 

Favorites 

✓ Expanding and Collapsing the 

Favorites List 

✓ Enabling and Disabling the 

Favorites List 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. Using Search Folders 

✓ Creating Default Search Folders 

✓ Creating Custom Search Folders 

✓ Using Search Folders 

✓ Modifying Search Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Searching in Outlook 

✓ Using the Search Box 

✓ About the Search Tools Tab 

✓ Setting Search Options 

✓ Searching for Contacts 

✓ Filtering E-mail 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Intermediate, Section 1 
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Organizing Your E-mail (Part Two) 

Course Overview and Learning Objectives 

In this follow-up course, we will talk about various kinds of rules, as well as follow-up flags 

and new clean-up tools. We will also explore Quick Steps (a new feature in Outlook 2010) 

and categories. Finally, students will learn about Outlook’s spam management tools, 

including the junk mail filter, the phishing filter, and blocked and safe sender lists.  

Course Outline 

1.1. Using Rules and Cleanup Tools 

✓ Creating a Simple Rule 

✓ Modifying Rules 

✓ Using the Rules and Alerts 

Wizard 

✓ Marking a Message for Follow-Up 

✓ Cleaning up a Folder or 

Conversation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Quick Steps 

✓ Using Quick Steps 

✓ Creating Quick Steps 

✓ Managing Quick Steps 

✓ Resetting Quick Steps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Configuring Categories 

✓ Setting up Categories 

✓ Assigning a Category to an Item 

✓ About Quick Click 

✓ Upgrading Categories 

✓ Using Categories in a View 

✓ Creating Category Search 

Folders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Junk Mail 

✓ Using the Junk E-Mail Filter 

✓ Receiving Junk Mail 

✓ About the Phishing Filter 

✓ About Automatic Downloads 

✓ Managing Blocked and Safe 

Senders Lists 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Intermediate, Section 2 
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Outlook Security 

Course Overview and Learning Objectives 

This course covers the Outlook Address Book, Trust Center, and macros. 

Course Outline 

1.1. The Trust Center, Part 1 

✓ Opening the Trust Center 

✓ Identifying Trusted Publishers 

✓ Setting Privacy Options 

✓ Setting E-Mail Security Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Trust Center, Part 2 

✓ Controlling Attachment Handling 

✓ Automatic Download Settings 

✓ Dealing with Programmatic 

Access 

✓ Managing Add-Ins 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Outlook Address Book, Part 1 

✓ Opening the Outlook Address 

Book 

✓ Components of the Outlook 

Address Book 

✓ Searching the Address Book 

✓ Options in the Outlook Address 

Book 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Outlook Address Book, Part 2 

✓ Adding Entries 

✓ Editing Entries 

✓ Deleting Entries 

✓ Using the Outlook Address Book 

to Create Mail 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Macros 

✓ Setting Macro Security 

✓ Creating a Macro 

✓ Running a Macro 

✓ Editing a Macro 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Advanced, Section 5 
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Sending E-Mail  

Course Overview and Learning Objectives 

This course will delve deeper into everyday Outlook tasks, including composing new 

messages, answering e-mail messages, managing attachments, working with themes, using 

view tools, and using the Drafts folder. 

Course Outline 

1.1. Composing E-Mail 

✓ Creating a New Message 

✓ Adding Recipients 

✓ Typing a Subject Line 

✓ Creating Your Message 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Answering Mail 

✓ Replying to Messages 

✓ Forwarding Messages 

✓ Opening and Saving Attachments 

✓ Using the Attachment Previewer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing More with E-Mail 

✓ Adding Attachments 

✓ Creating Hyperlinks 

✓ Attaching Outlook Items 

✓ Using Themes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Viewing Tools 

✓ Choosing a View 

✓ Arranging and Grouping 

Messages 

✓ Understanding Conversations 

✓ Sorting E-Mail 

✓ Filtering E-Mail 

✓ About AutoPreview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using the Drafts Folder 

✓ Opening the Drafts Folder 

✓ Saving a Message as a Draft 

✓ Opening and Editing a Draft 

✓ Sending a Draft 

✓ Deleting a Draft 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 5 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 558 

Starting Out  

Course Overview and Learning Objectives 

Students will learn what Outlook is, how to perform basic tasks (including how to set up an 

e-mail account), and how to get help in the program. 

Course Outline 

1.1. Getting Started 

✓ What is Microsoft Office Outlook 

2010? 

✓ What’s New in Microsoft Office 

Outlook 2010? 

✓ Starting Outlook 

✓ The Outlook Interface 

✓ About the Notification Icon 

✓ Closing Outlook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Receiving E-Mail 

✓ Types of E-Mail Accounts 

✓ Setting up an E-Mail Account 

✓ Modifying E-Mail Account 

Settings 

✓ Sending and Receiving E-Mail 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with E-Mail Messages 

✓ About Outlook Folders 

✓ Opening Messages 

✓ Editing Messages 

✓ Deleting Messages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Printing E-Mail Messages 

✓ Print Commands 

✓ Choosing Print Options 

✓ Choosing a Print Preview View 

✓ Navigating Through Print 

Preview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Getting Help in Outlook 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 1 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 559 

Tab Overview (Mail Interface) 

Course Overview and Learning Objectives 

In this course, students will examine each tab in the mail interface in depth.  

Course Outline 

1.1. The Home Tab 

✓ New Commands 

✓ Delete Commands 

✓ Respond Commands 

✓ Quick Steps Commands 

✓ Move Commands 

✓ Tags Commands 

✓ Find Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Send/Receive Tab 

✓ Send & Receive Commands 

✓ Download Commands 

✓ Server Commands 

✓ Preferences Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Folder Tab 

✓ New Commands 

✓ Actions Commands 

✓ Clean Up Commands 

✓ Favorites Commands 

✓ Properties Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The View Tab 

✓ Current View Commands 

✓ Conversations Commands 

✓ Arrangement Commands 

✓ Layout Commands 

✓ People Pane Commands 

✓ Window Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 3 
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Tab Overview (Outlook Item Interface) 

Course Overview and Learning Objectives 

In this course, students will take a closer look at how tabs are set up for each of the major 

Outlook item types. 

Course Outline 

1.1. Understanding Tab Setup 

✓ About Tabs in Outlook Items 

✓ The Message Tab 

✓ The Options Tab 

✓ The Appointment Tab 

✓ The Meeting Tab 

✓ The Contact Tab 

✓ The Task Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Insert Tab 

✓ Include Commands 

✓ Tables Commands 

✓ Illustrations Commands 

✓ Links Commands 

✓ Text Commands 

✓ Symbols Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Format Text Tab 

✓ Clipboard Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Styles Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 4 
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Understanding and Customizing the Outlook Interface  

Course Overview and Learning Objectives 

In this course, students will examine the ribbon interface, including the Quick Access 

toolbar and how to customize the command tabs. An overview of the various Outlook 

panes is also included. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu (Backstage 

View) 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Outlook Panes 

✓ Using Outlook Today 

✓ Using the Navigation Pane 

✓ Using the Reading Pane 

✓ Using the To-Do Bar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Quick Access Toolbar 

✓ Using the Quick Access Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: 

Foundation, Section 2 
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Understanding E-Mail Accounts 

Course Overview and Learning Objectives 

This course will cover how to set up and use a basic e-mail account. SMS (text messaging) 

accounts and RSS feeds will also be covered. 

Course Outline 

1.1. Setting up a Basic E-Mail Account 

✓ Overview of E-mail Account Types 

✓ Setting up a POP3, IMAP, or HTTP E-mail Account 

✓ Using Your Mailbox 

✓ Understanding the Send/Receive Tab 

✓ Setting Send/Receive Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Configuring SMS Accounts 

✓ Setting up a Mobile Service Account 

✓ Viewing Text Messages 

✓ Creating a Text Message 

✓ Removing the Account 

✓ Skill Sharpener 

1.3. Configuring RSS Feeds 

✓ Setting up an RSS Feed in Outlook 

✓ Setting up an RSS Feed with Internet Explorer 

✓ Reading and Managing Feed Items 

✓ Sharing a Feed with a Friend 

✓ Removing an RSS Feed 

✓ Getting Help with RSS Feeds 

✓ Step-By-Step 

✓ Skill Sharpener 

− Review Questions 

− Case Study 

Corresponding Instructor-Led Course 

✓ Microsoft Outlook 2010: Intermediate, Section 4 
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Microsoft PowerPoint 2010  

Adding Art to Your Presentation 

Course Overview and Learning Objectives 

In this course, students will learn about adding shapes and advanced types of text to 

slides. 

Course Outline 

1.1. Drawing Shapes 

✓ Adding and Deleting Shapes 

✓ Using the Drawing Tools – 

Format Tab 

✓ Formatting Shapes with Styles 

✓ Formatting Shapes Manually 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Shapes 

✓ Editing Shapes 

✓ Arranging Shapes 

✓ Grouping and Ungrouping Shapes 

✓ Aligning and Distributing Shapes 

✓ Rotating and Flipping Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Text and Shapes 

✓ Adding Text to Shapes 

✓ Formatting Text with Styles 

✓ Formatting Text Manually 

✓ Using the Transform Command 

✓ Working with WordArt 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Shape Tasks 

✓ Using Guidelines and Grids 

✓ Using the Format Shape Dialog 

✓ Using the Format Text Effects 

Dialog 

✓ Using the Selection Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Intermediate, Section 3 
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Adding Diagrams, Charts, and Tables 

Course Overview and Learning Objectives 

In this course, students will learn about PowerPoint’s exciting SmartArt feature, plus how 

to add, edit, and format charts and tables. 

Course Outline 

1.1. Inserting Tables 

✓ Anatomy of a Table 

✓ Inserting Tables 

✓ Drawing Tables 

✓ About the Tables Tools Tabs 

✓ Adding an Excel Spreadsheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Tables 

✓ Selecting Table Data 

✓ Moving Tables 

✓ Adding and Deleting Rows and 

Columns 

✓ Resizing Rows, Columns, and 

Tables 

✓ Merging and Splitting Cells 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Tables 

✓ Applying Table Styles 

✓ Changing Formatting Options 

✓ Formatting the Table Manually 

✓ Applying WordArt Styles to Table 

Text 

✓ Formatting Table Text with the 

Home Tab and Mini Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Inserting Charts 

✓ Inserting a Chart 

✓ Moving, Resizing, and Deleting 

Charts 

✓ About the Chart Tools Tabs 

✓ Editing Chart Data 

✓ Changing the Chart’s Appearance 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Inserting SmartArt 

✓ Inserting SmartArt 

✓ Adding Text 

✓ Adding Photos 

✓ About the SmartArt Tools Tabs 

✓ Moving, Resizing, and Deleting 

SmartArt 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Formatting SmartArt 

✓ Changing the Layout 

✓ Recoloring SmartArt 

✓ Changing the Effects Style 

✓ Resetting the Graphic 

✓ Converting the Graphic 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Intermediate, Section 5 
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Adding Multimedia to a Presentation 

Course Overview and Learning Objectives 

In this course, students will learn about the different types of multimedia that can be 

added to enhance their presentations. We’ll discuss how to edit audio and video files and 

talk about the different tools available to help with those tasks. 

Course Outline 

1.1. Inserting Video Files 

✓ Inserting a Video from Your Computer 

✓ Inserting a Video from Clip Art 

✓ Using the Video Tools – Format Tab 

✓ Using the Video Tools – Playback Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Video Files 

✓ Cropping Videos 

✓ Correcting and Recoloring the Video 

✓ Applying a Poster Frame 

✓ Choosing a Style 

✓ Setting Playback Options 

✓ Setting Presentation Playback Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Audio Files 

✓ Inserting a File from Your Computer 

✓ Inserting a File from ClipArt 

✓ Using the Audio Tools – Format Tab 

✓ Using the Audio Tools – Playback Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Editing Audio Files 

✓ Trimming Audio 

✓ Changing the Audio Icon 

✓ Setting Playback Options 

✓ Recording an Audio Clip 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: Advanced, Section 1 
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Adding the Finishing Touches 

Course Overview and Learning Objectives 

This course will begin with an overview of PowerPoint’s research tools: spell check, the 

thesaurus, and the translator. Next, we’ll take a close look at themes, backgrounds, 

animations, and transitions. 

Course Outline 

1.1. Research Tools 

✓ Checking Spelling 

✓ Using the Research Pane 

✓ Using the Thesaurus 

✓ Using the Translator 

✓ Setting Your Language 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Themes and Backgrounds 

✓ Changing the Theme 

✓ Customizing Theme Colors 

✓ Customizing Theme Fonts 

✓ Customizing Theme Effects 

✓ Managing Theme Files 

✓ Choosing a Background Style 

✓ Using the Format Background 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Slide Transitions 

✓ Applying a Transition from the 

Gallery 

✓ Setting Effect Options 

✓ Customizing Transition Timing 

✓ Adding a Sound 

✓ Previewing Transitions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Basic Animations 

✓ Applying an Animation from the 

Gallery 

✓ Setting Effect Options 

✓ Customizing Animation Timing 

✓ Reordering Animations 

✓ Previewing Animations 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating Advanced Animations 

✓ Choosing an Effect 

✓ Designing a Motion Path 

✓ Choosing a Trigger 

✓ Using the Animation Painter 

✓ Using the Animation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Intermediate, Section 2 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 567 

Creating Advanced Types of Shows 

Course Overview and Learning Objectives 

Most people have probably seen some kind of slide show before. This course will deal with 

the various options available to the presenter, including the use of multiple monitors, 

hiding slides, adding narrations, and customizing other show elements. We’ll also take a 

look at how to package a presentation for CD and install the PowerPoint viewer. 

Course Outline 

1.1. Setting up Your Show 

✓ Using the Set Up Show Dialog 

✓ Choosing Show Elements 

✓ Hiding and Showing Slides 

✓ Rehearsing Timings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Presenting Your Show 

✓ Setting Monitor Options 

✓ Recording and Narrating a Show 

✓ Playing Back a Show 

✓ Using Presenter View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Custom Show 

✓ Creating a New Custom Show 

✓ Editing a Custom Show 

✓ Presenting a Custom Show 

✓ Deleting a Custom Show 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Presentation Techniques 

✓ Saving Slides to the Internet 

✓ Sending a Link to Your Slides 

✓ Broadcasting Slides 

✓ Creating a Video 

✓ Creating a Show-Only File 

✓ Packaging Your Presentation for 

CD 

✓ About the PowerPoint Viewer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Advanced, Section 4 

 

 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 568 

Creating Presentations  

Course Overview and Learning Objectives 

This course will go deeper into creating presentations. Topics will include using templates, 

managing text boxes, using editing tools, and formatting text. 

Course Outline 

1.1. Using Templates 

✓ Creating a Blank Presentation 

✓ Creating a Presentation from 

Local Templates 

✓ Creating a Presentation from 

Online Templates 

✓ Creating a Presentation from 

Themes 

✓ Using PowerPoint’s Sample Files 

✓ Creating a Presentation from 

Existing Files 

✓ Accessing Recently Used 

Templates 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Text Boxes 

✓ Drawing a Text Box 

✓ Editing Text 

✓ Resizing, Moving, or Deleting a 

Text Box 

✓ Rotating a Text Box 

✓ Formatting the Text Box 

✓ Advanced Text Box Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Basic Editing Tools 

✓ Using Selection Tools 

✓ Using Cut, Copy, and Paste 

✓ Using the Office Clipboard 

✓ Dragging and Dropping Text 

✓ Using Undo and Redo/Repeat 

✓ Using Find and Replace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Text, Part One 

✓ Applying Text Effects 

✓ Changing Case 

✓ Changing Font Face, Size, and 

Color 

✓ Changing Character Spacing 

✓ Removing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Formatting Text, Part Two 

✓ Changing Text Direction 

✓ Aligning and Justifying Text 

✓ Indenting Text 

✓ Changing Vertical Alignment 

✓ Creating a Bulleted or Numbered 

List 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Advanced Text Tools 

✓ Formatting Text into Columns 

✓ Using the Format Painter 

✓ Using the Font Dialog 

✓ Using the Paragraph Dialog 

✓ Using the Format Text Effects 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Foundation, Section 5 
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Managing PowerPoint Files  

Course Overview and Learning Objectives 

To begin this course, students will learn how to use Windows Explorer in PowerPoint and 

how to use other utilities like AutoRecover, the Document Inspector, the new 

Accessibility Checker, the Compatibility Checker, versioning, and media optimization 

tools. Students will also learn about security tools like passwords, encryption, digital 

signatures, and file properties. We’ll also look at using other file formats, such as PDF, 

XPS, and PPT.  

Course Outline 

1.1. Using Windows Explorer within 

PowerPoint 

✓ Navigating Using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. File Management Tools 

✓ Using AutoRecover 

✓ Publishing to PDF or XPS 

✓ Setting File Passwords 

✓ Opening and Converting 

Presentations in Office 2003 

Format 

✓ Saving Presentations in Older 

Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Using Presentation Tools, Part One 

✓ Optimizing Media Compatibility 

✓ Compressing Media 

✓ Marking a Presentation as Final 

✓ Encrypting a Presentation 

✓ Digitally Signing Presentations 

✓ Managing File Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Presentation Tools, Part Two 

✓ Viewing a Summary of Issues 

✓ Using the Document Inspector 

✓ Using the Accessibility Checker 

✓ Using the Compatibility Checker 

✓ Setting Compatibility Options 

✓ Managing Versions 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Intermediate, Section 1 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 570 

Printing and Viewing Your Presentation  

Course Overview and Learning Objectives 

This course will cover PowerPoint’s viewing and printing tools. 

Course Outline 

1.1. Using Layouts and Views 

✓ Using Normal View 

✓ Using Slide Sorter View 

✓ Using Notes Page View 

✓ Using Reading View 

✓ Using Zoom and Fit to Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Viewing a Slide Show 

✓ Starting the Show 

✓ Navigating the Show 

✓ Displaying a Blank Screen 

✓ Using Highlighting and Pen Tools 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Preparing Your Presentation 

✓ Checking Your Spelling 

✓ Changing the Theme 

✓ Adding Headers and Footers to Slides 

✓ Modifying Headers and Footers 

✓ Changing Slide Orientation 

✓ Using the Page Setup Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Printing Your Presentation 

✓ Print Commands 

✓ Using Print Preview 

✓ Setting Print Options 

✓ E-mailing Your Presentation 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: Foundation, Section 6 
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Reviewing Presentations 

Course Overview and Learning Objectives 

This course will focus on reviewing and editing presentations. We’ll take a look at 

comments and discuss how to add, edit, delete, and navigate through them. We’ll also take 

a look at previewing changes made during the editing process. 

Course Outline 

1.1. Using Comments 

✓ Inserting Comments 

✓ Viewing and Editing Comments 

✓ Navigating Through Comments 

✓ Deleting Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Reviewing a Presentation 

✓ Comparing Presentations 

✓ Viewing Changes 

✓ Working with Changes 

✓ Ending a Review 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: Advanced, Section 3 
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Setting Up Slide Masters 

Course Overview and Learning Objectives 

This course will focus on Slide Masters. We’ll discuss the three different types of masters 

which can be made, as well as how to use and edit them.  

Course Outline 

1.1. Creating a Slide Master 

✓ Understanding Slide Masters 

✓ Opening Slide Master View 

✓ Using the Slide Master Tab 

✓ Creating and Customizing Slide 

Layouts 

✓ Applying a Global Theme or 

Background 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Placeholders 

✓ About Placeholders 

✓ Inserting Placeholders 

✓ Modifying Placeholders 

✓ Moving or Deleting Placeholders 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Slide Masters 

✓ Saving Slide Masters 

✓ Creating a New Presentation 

with a Slide Master 

✓ Editing and Updating Master 

Slides 

✓ Removing a Master from a 

Presentation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Handout Masters 

✓ Understanding Handout Masters 

✓ Opening Handout Master View 

✓ Using the Handout Master Tab 

✓ Editing a Handout Master 

✓ Creating Handouts in Microsoft 

Word 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Notes Masters 

✓ Understanding Notes Masters 

✓ Opening Notes Master View 

✓ Using the Notes Master Tab 

✓ Editing a Notes Master 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Advanced, Section 2 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 573 

Starting Out 

Course Overview and Learning Objectives 

In this course, students will learn the basics of PowerPoint. Students will also learn how to 

create a basic slide show and how to get help in PowerPoint. 

Course Outline 

1.1. Meeting Microsoft Office 

PowerPoint 2010 

✓ What is Microsoft Office 

PowerPoint 2010? 

✓ What’s New in Microsoft Office 

PowerPoint 2010? 

✓ Opening PowerPoint 

✓ Interface Overview 

✓ Interacting with PowerPoint 

✓ Closing PowerPoint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a Presentation 

✓ Understanding Presentations 

✓ Creating a New Presentation 

✓ Adding New Slides 

✓ Adding Content to Slides 

✓ Deleting Slides 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Your Presentation 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Editing Your Presentation 

✓ Using the Slides/Outline Pane 

✓ Navigating Through Your Slides 

✓ Editing Slides 

✓ Changing Slide Layout 

✓ Resetting Slides 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Arranging Slides 

✓ Dragging and Dropping Slides 

✓ Duplicating Slides 

✓ Creating Sections 

✓ Viewing Sections 

✓ Moving Slides and Sections 

✓ Deleting Sections 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in PowerPoint 

✓ Getting Started with Office.com 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Foundation, Section 1 
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Tab Overview (Part One) 

Course Overview and Learning Objectives 

This course covers the main PowerPoint tabs in depth. 

Course Outline 

1.1. The Home Tab 

✓ Clipboard Commands 

✓ Slides Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Drawing Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Insert Tab 

✓ Tables Commands 

✓ Images Commands 

✓ Illustrations Commands 

✓ Links Commands 

✓ Text Commands 

✓ Symbols Commands 

✓ Media Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The View Tab 

✓ Presentation Views Commands 

✓ Master Views Commands 

✓ Show Commands 

✓ Zoom Commands 

✓ Color/Grayscale Commands 

✓ Window Commands 

✓ Macros Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Design Tab 

✓ Page Setup Commands 

✓ Themes Commands 

✓ Background Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Transitions Tab 

✓ Preview Command 

✓ Transition Gallery 

✓ Timing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Foundation, Section 3 
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Tab Overview (Part Two) 

Course Overview and Learning Objectives 

This course covers the remaining three default PowerPoint command tabs. An overview 

of contextual tabs is also provided. 

Course Outline 

1.1. The Animations Tab 

✓ Preview Command 

✓ Animation Gallery 

✓ Advanced Animation Commands 

✓ Timing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Slide Show Tab 

✓ Start Slide Show Commands 

✓ Set Up Commands 

✓ Monitors Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Comments Commands 

✓ Compare Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Contextual Tabs, Part One 

✓ The Developer Tab 

✓ Drawing Tools 

✓ Table Tools 

✓ Picture Tools 

✓ SmartArt Tools 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Contextual Tabs, Part Two 

✓ Chart Tools 

✓ Equation Tools 

✓ Video Tools 

✓ Audio Tools 

✓ Slide, Handout, and Notes Master 

Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Foundation, Section 4 
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Understanding and Customizing the PowerPoint Interface  

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and how to customize the command tabs. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu (Backstage 

View) 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Foundation, Section 2 
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Working with Pictures 

Course Overview and Learning Objectives 

This course will focus on adding different types of images to a presentation, including 

pictures from a file, Clip Art, screenshots, and photo albums. Students will also explore 

tools for managing, editing, and formatting pictures, including new artistic effects, new 

background removal tools, and picture styles. 

Course Outline 

1.1. Inserting Pictures 

✓ Adding a Picture from a File 

✓ Adding Clip Art 

✓ Adding a Screenshot 

✓ Adding a Photo Album 

✓ Overview of the Picture Tools – 

Format Tab 

✓ Overview of the Pictures Mini 

Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Pictures 

✓ Resizing Pictures 

✓ Moving Pictures 

✓ Arranging Pictures 

✓ Grouping and Ungrouping 

Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing More with Pictures 

✓ Cropping Pictures 

✓ Advanced Cropping Tools 

✓ Rotating and Flipping Pictures 

✓ Aligning and Distributing Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Pictures 

✓ Correcting Pictures 

✓ Recoloring Pictures 

✓ Applying Artistic Effects 

✓ Applying Picture Styles 

✓ Editing the Picture’s Background 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Managing Pictures 

✓ Using the Format Picture Dialog 

✓ Compressing Pictures 

✓ Changing the Picture 

✓ Resetting the Picture 

✓ Exporting Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft PowerPoint 2010: 

Intermediate, Section 4 
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Microsoft Project 2010 

Advanced Topics 

Course Overview and Learning Objectives 

This course will focus on a variety of advanced project tools. Topics will include working 

with variances, editing fixed tasks, adding hyperlinks and custom fields, managing project 

costs, and using the Work Breakdown Structure code. 

Course Outline 

1.1. Working with Variances 

✓ Using the Variance Table 

✓ Checking for Variances 

✓ Viewing Work Variances 

✓ Viewing Cost Variances 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Task Operations 

✓ Understanding Fixed Tasks 

✓ Modifying Fixed Tasks 

✓ Adding a Hyperlink to a Task 

✓ Adding Custom Fields to a Task 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Project Costs 

✓ Setting Currency Options 

✓ Entering Costs with the Resource 

Sheet 

✓ Entering Costs with the Resource 

Information Dialog 

✓ Using Cost Rate Tables 

✓ Fixed Costs vs. Cost Resources 

✓ Viewing Costs 

✓ Manually Updating Costs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Work Breakdown Structure 

Code 

✓ Understanding the WBS Code 

✓ Assigning a WBS Code to a Task 

✓ Viewing the WBS Code of a 

Project 

✓ Customizing the WBS Code 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Adding a Graphical Indicator 

✓ Understanding Graphical 

Indicators 

✓ Setting up the Field 

✓ Creating the Indicator 

✓ Using Formulas with Graphical 

Indicators 

✓ Importing Criteria from Other 

Files 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Advanced, Section 2

 

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 579 

Creating a Basic Project  

Course Overview and Learning Objectives 

In this course, students will learn how to create a basic project in various ways; add tasks 

to it; set constraints, milestones, and deadlines on those tasks; assign and manage 

resources; link, unlink, split, and inactivate tasks; and use lag and lead time. 

Course Outline 

1.1. Creating a Project 

✓ Creating a Blank Project 

✓ Creating a Project from Local 

Templates 

✓ Creating a Project from Online 

Templates 

✓ Creating a Project from an 

Existing Project 

✓ Creating a Project from an Excel 

Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Tasks 

✓ A Checklist of Basic Project 

Information 

✓ Using Cut, Copy, and Paste 

✓ Using Drag and Drop 

✓ Using AutoFill to Create and Edit 

Tasks 

✓ Choosing Automatic or Manual 

Scheduling 

✓ About Change Highlighting 

✓ Clearing Task Information 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Advanced Task Information 

✓ Opening the Task Information 

Dialog 

✓ Understanding the Task 

Information Dialog 

✓ Choosing the Task Type 

✓ Choosing the Task Calendar 

✓ Choosing View Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Milestones, Constraints, 

and Deadlines 

✓ Setting Milestones 

✓ Types of Constraints 

✓ Creating a Constraint 

✓ Setting Task Deadlines 

✓ Constraints versus Deadlines 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Tasks, Part One 

✓ Assigning Resources to Tasks 

✓ Removing or Replacing Resource 

Assignments 

✓ Linking Tasks 

✓ Unlinking Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Working with Tasks, Part Two 

✓ Creating Recurring Tasks 

✓ Splitting Tasks 

✓ Using Lag Time and Lead Time 

✓ Marking a Task as Inactive 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 4 
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Creating Reports  

Course Overview and Learning Objectives 

In this course, students will learn how to create text-based reports as well as visual 

reports with Microsoft Excel and Microsoft Visio. Students will also learn how to create 

and format network diagrams and calendars. 

Course Outline 

1.1. Creating Reports 

✓ Using the Reports Dialog Box 

✓ Creating a Pre-Defined Report 

✓ Creating a Custom Report 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Visual Reports 

✓ Opening the Visual Reports 

Dialog 

✓ Choosing a Report 

✓ Editing a Report 

✓ Creating a Template 

✓ Modifying a Template with Excel 

✓ Modifying a Template with Visio 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Network Diagram 

✓ Viewing a Network Diagram 

✓ Using the Network Diagram 

Tools – Format Tab 

✓ Changing the Network Diagram 

Layout 

✓ Formatting Boxes 

✓ Modifying Box Styles 

✓ Manually Creating a Network 

Diagram 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating a Calendar 

✓ Viewing the Calendar 

✓ Using the Calendar Tools – 

Format Tab 

✓ Viewing a Task List 

✓ Formatting the Calendar 

✓ Modifying Bar Styles 

✓ Formatting Gridlines 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Advanced, Section 4 
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Formatting Your Project  

Course Overview and Learning Objectives 

In this course, students will learn all about adding and formatting shapes in Project. They 

will also learn how to format the Gantt chart. 

Course Outline 

1.1. Adding a Shape 

✓ Drawing a Shape 

✓ Moving a Shape 

✓ Resizing a Shape 

✓ Deleting a Shape 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting a Shape 

✓ Changing the Order of Shapes 

✓ Changing the Line Color 

✓ Changing the Fill Color 

✓ Attaching a Shape to a Task 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting the Gantt Chart, Part One 

✓ Changing the Text Style 

✓ Changing Gridline Settings 

✓ Choosing a Layout 

✓ Formatting Columns 

✓ Wrapping Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting the Gantt Chart, Part Two 

✓ Formatting Bars 

✓ Modifying Bar Styles 

✓ Choosing Tasks to View 

✓ Choosing a Baseline 

✓ Showing and Hiding Task Information 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: Advanced, Section 3 
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Getting Started  

Course Overview and Learning Objectives 

In this course, students will learn the basics of Project: how to open and close it, how to 

use the new ribbon-based interface, how to plan and create a basic project, how to set up 

tasks and separate them into phases, how to save and open projects, and how to get help.  

Course Outline 

1.1. Starting Out 

✓ What is Microsoft Office Project 

2010? 

✓ What is a Project? 

✓ Why Use Project 2010? 

✓ What’s New in Project 2010? 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Meeting Project 

✓ Opening Project 

✓ Interface Overview 

✓ Interacting with Project 

✓ Understanding Gantt Chart View 

✓ Getting Started with Office.com 

✓ Closing Project 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Project Files 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open 

Projects 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating a Project 

✓ Planning Your Project 

✓ Creating a Project 

✓ Entering Project Information 

✓ Setting Working Time 

✓ Entering Tasks 

✓ Entering Resources 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating Tasks 

✓ Splitting Tasks into Phases 

✓ Linking Tasks 

✓ Moving a Task 

✓ Inserting a Task 

✓ Deleting a Task 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in Project 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Online Help vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 1
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Managing Resources 

Course Overview and Learning Objectives 

This teaches students how to assign and replace resources, work with the Team Planner 

to keep track of who’s doing what, detect and eliminate resource conflicts, and learn the 

art of resource leveling. 

Course Outline 

1.1. Resources and Tasks 

✓ Assigning a Resource to a Task 

✓ Using the Assign Resources Dialog 

✓ Removing a Resource 

✓ Replacing a Resource 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Team Planner 

✓ Opening the Team Planner 

✓ Viewing Resources in the Team Planner 

✓ Formatting the Team Planner 

✓ Resolving Unassigned Tasks 

✓ Allocating Work 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Resolving Resource Conflicts 

✓ Determining when Resource Conflicts Exist 

✓ Reassigning Resources 

✓ Scheduling Overtime 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Leveling Resources 

✓ Opening the Resource Leveling Dialog 

✓ Choosing the Leveling Range 

✓ Resolving Over-Allocations 

✓ Using Leveling Gantt View 

✓ Clearing Leveling 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: Intermediate, Section 4 
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Printing and Viewing a Project 

Course Overview and Learning Objectives 

This course will teach students how to arrange windows; sort, filter, highlight, group, and 

outline data; use the Timescale view; view their project in different ways; and print and 

export their file. 

Course Outline 

1.1. Arranging Windows 

✓ Using Minimize, Maximize, and 

Restore 

✓ Creating a New Window 

✓ Arranging Windows 

✓ Hiding and Unhiding Windows 

✓ Splitting a Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Changing How You View Data 

✓ Sorting Data 

✓ Filtering Data 

✓ Highlighting Data 

✓ Grouping Data 

✓ Outlining Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Changing Your View Scope 

✓ Viewing the Entire Project 

✓ Viewing Selected Tasks 

✓ Using Zoom 

✓ Choosing the Timescale 

✓ Formatting the Timescale 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Finishing Your Project 

✓ Saving a Project as PDF or XPS 

✓ Print Commands 

✓ Setting Print Options 

✓ Using Page Setup 

✓ Using Print Preview 

✓ E-mailing a Project 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 6 
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Project Monitoring Tools 

Course Overview and Learning Objectives 

This course will introduce students to the various ways they can keep watch over all the 

working parts of a project. Topics include setting and adjusting project baselines, working 

with interim plans, and managing the critical path. Other topics include using and 

interpreting progress lines and an overview of the different project tracking tools. 

Course Outline 

1.1. Setting a Project Baseline 

✓ Baseline Basics 

✓ Saving a Baseline 

✓ Viewing a Baseline 

✓ Clearing a Baseline 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Setting an Interim Plan 

✓ Interim Basics 

✓ Saving an Interim Plan 

✓ Viewing an Interim Plan 

✓ Clearing an Interim Plan 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. On the Critical Path 

✓ What is a Critical Path? 

✓ Viewing the Critical Path 

✓ Shortening the Critical Path 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.4. Creating Progress Lines 

✓ Displaying the Progress Line 

✓ Interpreting a Progress Line 

✓ Editing or Removing Progress 

Lines 

✓ Formatting a Progress Line 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Tracking Progress 

✓ Using the Tracking Gantt View 

✓ Tracking Overdue Tasks with 

Filters 

✓ Tracking Completed Tasks 

✓ Tracking Tasks with Grouping 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Intermediate, Section 5 
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The Project Tabs 

Course Overview and Learning Objectives 

In this course, students will examine each Project 2010: command tab in depth. Students 

will also learn about contextual tabs. 

Course Outline 

1.1. The Task Tab 

✓ View Commands 

✓ Clipboard Commands 

✓ Font Commands 

✓ Schedule Commands 

✓ Tasks Commands 

✓ Insert Commands 

✓ Properties Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Resource Tab 

✓ View Commands 

✓ Assignments Commands 

✓ Insert Commands 

✓ Properties Commands 

✓ Level Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Project Tab 

✓ Insert Commands 

✓ Properties Commands 

✓ Schedule Commands 

✓ Status Commands 

✓ Reports Commands 

✓ Proofing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The View Tab 

✓ Task Views Commands 

✓ Resource Views Commands 

✓ Data Commands 

✓ Zoom Commands 

✓ Split View Commands 

✓ Window Commands 

✓ Macros Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Contextual Tabs, Part One 

✓ Developer Tab 

✓ Gantt Chart Tools Tab 

✓ Calendar Tools Tab 

✓ Network Diagram Tools Tab 

✓ Task Usage Tools Tab 

✓ Task Sheet Tools Tab 

✓ Task Form Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Contextual Tabs, Part Two 

✓ Resource Usage Tools Tab 

✓ Resource Sheet Tools Tab 

✓ Resource Graph Tools Tab 

✓ Resource Form Tools Tab 

✓ Team Planner Tools Tab 

✓ Timeline Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 3 
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Updating and Polishing Your Project  

Course Overview and Learning Objectives 

In this course, students will learn how to update their project, perform basic editing tasks, 

format text, and format the Gantt chart.  

Course Outline 

1.1. Updating the Project 

✓ Updating Work Completed 

✓ Marking a Task as On Track 

✓ Using the Update Task Dialog 

✓ Rescheduling Tasks 

✓ Updating a Project as a Whole 

✓ Running the Task Inspector 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basic Editing Tasks 

✓ Using Undo and Redo 

✓ Checking Spelling 

✓ Using Find and Replace 

✓ Adding a Drawing 

✓ Formatting a Drawing 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Text 

✓ Changing Font Face and Size 

✓ Changing Font Color 

✓ Adding Text Effects 

✓ Changing the Cell Background 

Color 

✓ Using the Font Dialog 

✓ Using the Format Painter 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting the Gantt Chart 

✓ Changing Text Appearance 

Globally 

✓ Changing Text Alignment and 

Wrapping 

✓ Formatting Gridlines 

✓ Choosing a Chart Layout and 

Style 

✓ Formatting Individual Bars and 

Bar Types 

✓ Showing and Hiding Gantt Chart 

Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 5
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Using and Customizing the Project Interface  

Course Overview and Learning Objectives 

This course will focus entirely on Project’s new interface. Students will learn how to use 

the basic elements of the interface, customize the Quick Access toolbar, and customize 

the ribbon itself. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File (Backstage) Menu 

✓ Using the Status Bar 

✓ Using Right-Click Menus 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Foundation, Section 2
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Using Macros 

Course Overview and Learning Objectives 

This course will focus on creating macros in Project by recording them and by manually 

coding them. Introductory-level Visual Basic statements and coding techniques will also 

be covered. 

Course Outline 

1.1. Recording Macros 

✓ Recording a Macro 

✓ Playing Macros 

✓ Macro Security 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. More Macro Tasks 

✓ Deleting Macros 

✓ Copying Macros from Other Project Files 

✓ Assigning Shortcut Keys 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Visual Basic and Macros 

✓ Opening the Visual Basic Editor 

✓ Editing a Macro 

✓ Using Step Into 

✓ Adding Code to Your Macro 

✓ Adding Comments to Visual Basic Code 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Visual Basic Tasks 

✓ Declaring Variables 

✓ Creating Message Boxes 

✓ Using If-Then Statements 

✓ Iterating Through Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: Advanced, Section 6 
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Working with Multiple Projects 

Course Overview and Learning Objectives 

This course will begin with an overview of the versions of Microsoft Project, including 

Project Web Access and Project Server. Next, students will learn about resource pools, 

subprojects, and consolidated projects. Students will also learn how to view the critical 

path and baseline for master and consolidated projects. 

Course Outline 

1.1. Versions of Microsoft Project 

✓ Project 2010 Standard 

✓ Project 2010 Professional 

✓ Project Server 2010 

✓ Project Web Access 

✓ Comparing Project Professional, 

Standard, and Server 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Resource Pools 

✓ Starting a Resource Pool 

✓ Linking a Project to the Pool 

✓ Creating a Resource Pool from 

Multiple Projects 

✓ Unlinking a Project from a 

Resource Pool 

✓ Updating a Resource Pool 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Multiple Projects, Part 

One 

✓ Types of Multiple Projects 

✓ Inserting Subprojects 

✓ Unlinking or Removing 

Subprojects 

✓ Consolidating Projects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Multiple Projects, Part 

Two 

✓ Viewing a Master Project’s 

Critical Path 

✓ Saving Baselines for a Master 

Project 

✓ Saving Baselines for a 

Consolidated Project 

✓ Viewing Information about 

Inserted Projects 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Advanced, Section 5  
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Working with Project Files (Fundamentals) 

Course Overview and Learning Objectives 

In this course, students will learn how to use Windows Explorer within Project to help 

manage their files. Other topics include file management, assigning passwords, viewing 

and modifying file properties, creating and using project templates, and using different 

project views. 

Course Outline 

1.1. Using Windows Explorer within 

Project 

✓ Navigating Using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. File Management Tools 

✓ Understanding File Formats 

✓ Using Auto Save 

✓ Setting File Passwords 

✓ Managing File Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Templates 

✓ Creating a Template 

✓ Saving a Template 

✓ Creating a Project from Custom 

Templates 

✓ Editing a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Views 

✓ Overview of Task Views 

✓ Overview of Resource Views 

✓ Applying Advanced Views 

✓ Viewing Tables 

✓ Creating Custom Tables 

✓ Creating Custom Views 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Intermediate, Section 1
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Working with Project Files (Advanced) 

Course Overview and Learning Objectives 

In this course, students will learn how to import and export files, sync a task list with 

SharePoint, and import tasks from Microsoft Outlook. Students will also learn about using 

the Organizer, saving cube data, and comparing projects. 

Course Outline 

1.1. Working with Files 

✓ Importing a File 

✓ Exporting a File 

✓ Syncing Your Task List with 

SharePoint 

✓ Organizing the Global Template 

✓ Importing Tasks from Outlook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Organizer 

✓ Opening the Organizer 

✓ Copying Project Elements 

✓ Renaming Project Elements 

✓ Deleting Project Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Saving Cube Data 

✓ Choosing the OLAP Cube 

✓ Using the Field Picker 

✓ Saving the Cube 

✓ Saving a Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Comparing Projects 

✓ Choosing the Projects to 

Compare 

✓ Choosing the Fields to Compare 

✓ Using the Compare Projects Tab 

✓ Analyzing the Results 

✓ Comparing Resources 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Advanced, Section 1 
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Working with Resources 

Course Overview and Learning Objectives 

It’s hard to do a project without keeping track of resources, so this course will teach 

students how to schedule resources, edit resource characteristics, and view resource 

allotment and usage using a number of different views. 

Course Outline 

1.1. Resource Basics 

✓ Getting Started 

✓ The Work Units Duration 

Equation 

✓ Types of Resources 

✓ Creating a Resource List 

✓ Assigning Work and Material to a 

Resource 

✓ Using the Resource Information 

Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating the Project Calendar 

✓ Calendar Types 

✓ Setting up the Calendar 

✓ Creating a New Calendar 

✓ Using Calendar View 

✓ Adjusting the Timescale 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. Editing Resources 

✓ Changing a Resource Calendar 

✓ Editing Working Time 

✓ Grouping Resources 

✓ Removing a Resource 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Resource Views 

✓ Resource Sheet View 

✓ Resource Graph View 

✓ Resource Usage View 

✓ Resource Form View 

✓ Team Planner View 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Intermediate, Section 3 
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Working with Tasks 

Course Overview and Learning Objectives 

In this course, students will learn about Project’s new Timeline view as well as task 

creation, linking, and editing. This course also discusses the different ways to mark tasks 

as complete and update project status. 

Course Outline 

1.1. Using the Timeline View 

✓ Showing and Hiding Timeline 

View 

✓ Adding and Removing Tasks 

✓ Formatting Tasks 

✓ Exporting the Timeline 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Tasks 

✓ About Task Indicators 

✓ Assigning Task Calendars 

✓ Using Change Highlighting 

✓ Using the Task Inspector 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Linking Tasks 

✓ About Task Link Types 

✓ Linking Tasks within a Project 

✓ Unlinking Tasks within a Project 

✓ Linking Tasks Across Projects 

✓ Unlinking Cross-Project Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Editing Tasks 

✓ Changing the Task Type 

✓ Splitting a Task 

✓ Overlapping Tasks 

✓ Delaying Tasks 

✓ Assigning Variable Units to a Task 

✓ Contouring Resource Work 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Completing Tasks 

✓ Entering Task Completion 

✓ Updating Start and Finish Dates 

✓ Changing Task Duration 

✓ Changing Remaining Work 

✓ Updating the Project 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Project 2010: 

Intermediate, Section 2 
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Microsoft Publisher 2010  

Adding Pictures to Your Publication 

Course Overview and Learning Objectives 

This course will focus on working with images. First, we’ll talk about adding images to your 

publications (either your own pictures or Clip Art). We’ll also discuss ways to format and 

arrange pictures, as well as making last minute changes to pictures within the publication 

itself. 

Course Outline 

1.1. Inserting Pictures 

✓ Adding a Picture from Your 

Computer 

✓ Inserting Clip Art 

✓ Moving a Picture 

✓ Resizing a Picture 

✓ Rotating a Picture 

✓ Deleting a Picture 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Pictures 

✓ Touching Up Pictures 

✓ Adding a Picture Style 

✓ Changing the Picture Border 

✓ Changing the Picture Shape 

✓ Adding Shadow Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Pictures 

✓ Arranging Pictures 

✓ Cropping Pictures 

✓ Advanced Cropping Tools 

✓ Adding Captions 

✓ Using the Format Picture Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Changing Pictures 

✓ Choosing a New Picture 

✓ Resetting Picture Formatting 

✓ Swapping Pictures 

✓ Compressing Pictures 

✓ Adding and Using Picture 

Placeholders 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Intermediate, Section 5 
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Advanced Tabs and Customization 

Course Overview and Learning Objectives 

This course will give students an introduction to the more advanced Publisher 2010: 

command tabs, including contextual tabs. Students will also learn how to customize the 

ribbon. 

Course Outline 

1.1. The Page Design Tab 

✓ Template Commands 

✓ Page Setup Commands 

✓ Layout Commands 

✓ Pages Commands 

✓ Schemes Commands 

✓ Page Background Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Mailings Tab 

✓ Start Commands 

✓ Write & Insert Fields Commands 

✓ Preview Results Commands 

✓ Finish Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Drawing Tools Tab 

✓ Insert Shapes Commands 

✓ Shape Styles Commands 

✓ Shadow Effects Commands 

✓ 3-D Effects Commands 

✓ Arrange Commands 

✓ Size Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Text Box Tools Tab 

✓ Text Commands 

✓ Font Commands 

✓ Alignment Commands 

✓ Linking Commands 

✓ Effects Commands 

✓ Typography Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Contextual Tabs 

✓ Catalog Tools Tab 

✓ WordArt Tools Tab 

✓ Picture Tools Tab 

✓ Table Tools Tabs 

✓ Master Page Tab 

✓ Web Tab 

✓ Developer Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.7. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting All Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Foundation, Section 3 
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Advanced Topics 

Course Overview and Learning Objectives 

This course discusses a few tools that advanced users should know about, including the 

Graphics Manager and Design Checker. Students will then get an introduction to the 

world of commercial printing. Finally, students will learn how to customize Publisher, 

including changing the interface color scheme and using additional languages. 

Course Outline 

1.1. Using the Graphics Manager 

✓ Opening the Graphics Manager 

✓ Managing Graphics 

✓ Viewing Thumbnails 

✓ Choosing a Graphics Set 

✓ Sorting Graphics 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Design Checker 

✓ Opening the Design Checker 

✓ Choosing What to Check 

✓ Fixing Items 

✓ Setting Design Checker Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Commercial Print Settings 

✓ About Commercial Print Settings 

✓ Tips for Working with 

Commercial Printers 

✓ Choosing the Color Model 

✓ Managing Embedded Fonts 

✓ Changing Registration (Trapping) 

Settings 

✓ Packing your Publication for the 

Printer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Changing Common Publisher 

Options 

✓ Changing your User Name 

✓ Changing the Color Scheme 

✓ Installing Additional Languages 

✓ Changing Security Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Advanced, Section 4
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Creating Publications 

Course Overview and Learning Objectives 

In this course, students will learn how to use templates, modify global template options 

(such as color and font schemes), work with pages, use basic editing commands, use guides 

and alignment, work with Building Blocks, and apply advanced text effects (such as the 

Format Painter, styles, and columns). Students will also receive a crash course in graphic 

design. 

Course Outline 

1.1. Creating a New Publication 

✓ Creating a Blank Publication 

✓ Creating a Publication from 

Installed Templates 

✓ Creating a Publication from 

Online Templates 

✓ Using Recently Used Templates 

✓ Changing the Template in Use 

✓ Changing Template Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Setting Up Your Pages and 

Publications 

✓ Graphic Design 101 

✓ Choosing a Color and Font 

Scheme 

✓ Adding and Using Built-In Guides 

✓ Setting Guide Options 

✓ Toggling Alignment 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Pages 

✓ About the Page Navigation Pane 

✓ Adding Pages 

✓ Renaming Pages 

✓ Moving Pages 

✓ Deleting Pages 

✓ Right-Click Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Moving Text 

✓ Cutting, Copying, and Pasting 

Text 

✓ Using the Office Clipboard 

✓ Dragging and Dropping Text 

✓ Finding Text 

✓ Replacing Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Applying Advanced Text Effects 

✓ Applying a Style 

✓ Setting Horizontal Alignment 

✓ Setting Vertical Alignment 

✓ Formatting Text as Columns 

✓ Using the Format Painter 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Adding Building Blocks 

✓ Inserting a Building Block 

✓ Editing Building Blocks 

✓ Moving Building Blocks 

✓ Resizing Building Blocks 

✓ Rotating Building Blocks 

✓ Deleting Building Blocks 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Foundation, Section 4 
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Doing More with Text 

Course Overview and Learning Objectives 

In this course, students will learn about changing all aspects of a font; format text boxes;, 

change paragraph, text, and typography options (such as ligature styles and drop caps); 

and add page elements such as page numbers, headers and footers, and backgrounds. 

Course Outline 

1.1. Fonts on the Home Tab 

✓ Setting Font Face and Size 

✓ Applying Font Color 

✓ Applying Text Effects 

✓ Changing Case 

✓ Changing Character Spacing 

✓ Using the Font Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Setting Paragraph Options 

✓ Creating a Bulleted or Numbered 

List 

✓ Indenting Using the Home Tab 

✓ Changing Line Spacing 

✓ Changing Paragraph Spacing 

✓ Setting Text Box Margins 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Setting Text and Typography 

Options 

✓ Choosing Text Fit 

✓ Changing Text Direction 

✓ Adding Hyphenation 

✓ Adding Drop Caps 

✓ Choosing Number and Ligature 

Styles 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting the Text Box 

✓ Adding Special Effects 

✓ Changing a Text Box’s Shape 

✓ Applying a Style to a Text Box 

✓ Manually Formatting the Text 

Box 

✓ Setting Text Wrapping Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Text Boxes and 

Objects 

✓ Changing the Order of Objects 

✓ Grouping Objects 

✓ Aligning Objects 

✓ Rotating and Flipping Objects 

✓ Changing an Object’s Size 

✓ Using the Format Text Box Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Formatting the Page 

✓ Adding Page Numbers 

✓ Adding Headers and Footers 

✓ Editing Headers and Footers 

✓ Controlling Headers and Footers 

with the Page Navigation Pane 

✓ Choosing the Page Background 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Foundation, Section 5 
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Making a Publication Consistent 

Course Overview and Learning Objectives 

This course walks students through the concepts of master pages and two page masters. 

They will learn how to customize master pages, use headers and footers, and use layout 

guides. Next, students will learn how to add, modify, and use styles to create consistent 

text formatting. Finally, the course will introduce typographical tools which allow extra 

flourishes to be added to the font. 

Course Outline 

1.1. Creating Master Pages 

✓ Understanding Master Pages 

✓ Creating a Master Page 

✓ Creating a Two-Page Master 

✓ Adding Elements to a Master 

Page 

✓ Using Headers and Footers 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Applying Master Pages 

✓ Using the Master Page Tab to 

Apply Master Pages 

✓ Using the Page Design Tab to 

Apply Master Pages 

✓ Using the Page Navigation Pane 

to Apply Master Pages 

✓ Editing Master Pages 

✓ Using Layout Guides 

✓ Removing the Master 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Using Styles 

✓ Applying a Style 

✓ Creating a New Style 

✓ Changing Style Elements 

✓ Modifying Styles 

✓ Deleting Styles 

✓ Importing Styles 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Typography Tools 

✓ Choosing a Number Style 

✓ Choosing a Ligature Style 

✓ Choosing a Stylistic Set 

✓ Managing Swashes 

✓ Choosing Stylistic Alternates 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Advanced, Section 1
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Managing Your Publications 

Course Overview and Learning Objectives 

This course will start with a look at Windows Explorer and how it works inside Publisher. 

We’ll discuss working with Publisher files and business information and look at ways you 

can share your publications with others. In the last part of the course, we’ll spend some 

time working with Publisher templates. 

Course Outline 

1.1. Using Windows Explorer within 

Publisher 

✓ Navigating Using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Publisher Files 

✓ Using File Formats 

✓ Changing File Properties 

✓ Using AutoRecover 

✓ Importing Text from Other Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Business Information 

✓ Setting Up your Business 

Information 

✓ Adding Business Information to a 

Publication 

✓ Editing Business Information 

✓ Editing Business Information Sets 

✓ Adding Multiple Business 

Information Sets 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Sharing a Publication 

✓ Publishing to PDF or XPS 

✓ Protecting PDF Files 

✓ Packing your Files for Another 

Computer 

✓ Saving your Publication for a 

Commercial Printer with Pack 

and Go 

✓ Publishing to HTML 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Templates 

✓ Creating a Template 

✓ Saving a Template 

✓ Using a Template 

✓ Editing a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Intermediate, Section 1 
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Printing and Viewing Your Publication 

Course Overview and Learning Objectives 

This course will teach students about publication masters, viewing a publication in various 

ways, showing and hiding screen elements, applying finishing touches such as spell check, 

changing page setup, and printing or e-mailing a publication. 

Course Outline 

1.1. Using Layouts and Views 

✓ Understanding Publication Masters 

✓ Viewing a Single Page or Two-Page Spread 

✓ Customizing Screen Elements 

✓ Using Arrange All and Cascade 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Viewing Tools 

✓ Using Minimize, Maximize, and Restore 

✓ Using Zoom on the View Tab 

✓ Using Show Whole Page and Page Width 

✓ Using Zoom Controls on the Status Bar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Preparing Your Publication 

✓ Checking Your Spelling 

✓ Setting Margins 

✓ Changing Page Orientation 

✓ Setting Paper Size 

✓ Using the Page Setup Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Finishing a Publication 

✓ Print Commands 

✓ Using Print Preview 

✓ Setting Basic Print Options 

✓ Setting Printer Properties 

✓ E-Mailing a Publication 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: Foundation, Section 6 
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Starting Out 

Course Overview and Learning Objectives 

In this course, students will learn the basics of Publisher: how to open and close it, how to 

use the interface, how to create a basic publication, how to save and open publications, 

and how to get help. We’ll also look at the new Backstage View. 

Course Outline 

1.1. Meeting Microsoft Office Publisher 2010 

✓ What is Microsoft Office 

Publisher 2010? 

✓ What’s New in Microsoft Office 

Publisher 2010? 

✓ Opening Publisher 

✓ Interface Overview 

✓ Interacting with Publisher 

✓ Getting Started with Office.com 

✓ Closing Publisher 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a Publication 

✓ Choosing a Template 

✓ Creating a Text Box 

✓ Typing Text 

✓ Selecting Text 

✓ Deleting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Text 

✓ Creating a New Publication 

✓ Moving Text Boxes 

✓ Resizing Text Boxes 

✓ Rotating Text Boxes 

✓ Deleting Text Boxes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Your Publication 

✓ Adding Your Business 

Information to Publisher 

✓ Changing Font Face and Size 

✓ Applying Basic Text Effects 

✓ Using Undo and Redo/Repeat 

✓ Removing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Your Publication 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in Publisher 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Online Help vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Foundation, Section 1 
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The Publisher Interface 

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and the main tabs.  

Course Outline 

1.1. Getting Acquainted 

✓ Using the File (Backstage) Menu 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Home Tab 

✓ Clipboard Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Styles Commands 

✓ Objects Commands 

✓ Arrange Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Insert Tab 

✓ Pages Commands 

✓ Tables Commands 

✓ Illustrations Commands 

✓ Building Blocks Commands 

✓ Text Commands 

✓ Links Commands 

✓ Header and Footer Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The View Tab 

✓ Views Commands 

✓ Layout Commands 

✓ Show Commands 

✓ Zoom Commands 

✓ Window Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Foundation, Section 2 
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Using Formatting and Language Tools 

Course Overview and Learning Objectives 

We’ll start this course off with information on the Paragraph dialog box and how to use it. 

Next we’ll focus on special text elements and show you what you can do to spice up your 

publications. This course will also have lessons on creating custom schemes to help you 

create publications which are truly your own. We’ll also cover linking text boxes, 

Publisher’s spelling tools, AutoCorrect, and research tools.  

Course Outline 

1.1. Using the Paragraph Dialog 

✓ Opening the Paragraph Dialog 

✓ Changing Indents and Spacing 

✓ Setting Tabs with the Paragraph 

Dialog 

✓ Controlling Line and Paragraph 

Breaks 

✓ Setting Tabs with the Ruler 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Adding Special Text Elements 

✓ Adding Symbols 

✓ Inserting the Date and Time 

✓ Inserting Objects 

✓ Creating Hyperlinks 

✓ Creating Bookmarks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Custom Schemes 

✓ Creating Color Schemes 

✓ Creating Custom Colors 

✓ Creating Font Schemes 

✓ Setting Font Scheme Options 

✓ Setting Background Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Linking Text Boxes 

✓ Understanding Text Box Links 

✓ Linking Text Boxes 

✓ Navigating Through Linked Text 

Boxes 

✓ Working with Linked Text Boxes 

✓ Breaking Links 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Spelling Tools and 

AutoCorrect 

✓ Using the Spelling Context Menu 

✓ Running a Spelling Check 

✓ Setting Spelling and Proofing 

Options 

✓ About AutoCorrect and 

AutoFormat 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Using Research Tools 

✓ Setting Your Language 

✓ Performing Research 

✓ Using the Thesaurus 

✓ Translating a Word 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Intermediate, Section 2
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Working with Building Blocks 

Course Overview and Learning Objectives 

Building Blocks are pre-made elements that allow quick and easy construction of a 

publication. This course will walk students through the creation of page parts, calendars, 

borders, accents, and advertisements. They will also learn how to format, customize, and 

save their own Building Block creations for future use. 

Course Outline 

1.1. Adding Page Parts 

✓ Inserting a Page Part 

✓ Editing Page Parts 

✓ Modifying Page Parts 

✓ Adding a Page Part to the Gallery 

✓ Finding More Page Parts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Adding Calendars 

✓ Inserting a Calendar 

✓ Editing Calendars 

✓ Modifying Calendars 

✓ Formatting Calendars 

✓ Adding a Calendar to the Gallery 

✓ Finding More Calendars 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Borders and Accents 

✓ Inserting a Border or Accent 

✓ Modifying Borders and Accents 

✓ Formatting Borders and Accents 

✓ Adding Borders and Accents to 

the Gallery 

✓ Finding More Borders and 

Accents 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding Advertisements 

✓ Inserting Advertisements 

✓ Editing Advertisements 

✓ Modifying Advertisements 

✓ Formatting Advertisements 

✓ Adding Advertisements to the 

Gallery 

✓ Finding More Advertisements 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Advanced, Section 2
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Working with Illustrations 

Course Overview and Learning Objectives 

We’ll start this course by exploring how to add tables to publications and how to format 

them to get them just right. Then, we’ll talk about working with WordArt.  

Course Outline 

1.1. Adding Tables 

✓ Inserting a Table 

✓ Adding Data 

✓ Moving a Table 

✓ Resizing a Table 

✓ Rotating a Table 

✓ Deleting a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Tables 

✓ Adding or Deleting Rows and Columns 

✓ Applying a Table Style 

✓ Manually Formatting a Table 

✓ Using Borders 

✓ Arranging Tables 

✓ Changing Alignment and Text Direction 

✓ Using the Format Table Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with WordArt 

✓ Creating WordArt 

✓ Editing WordArt Text 

✓ Changing the WordArt Style 

✓ Manually Formatting WordArt 

✓ Arranging WordArt 

✓ Using the Format WordArt Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: Intermediate, Section 4 
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Working with Mail Merges 

Course Overview and Learning Objectives 

Mail merges are often misunderstood as a difficult concept – this course will prove that 

this is not the case! Students will learn the basics of a merge and learn how to use the Mail 

Merge Wizard. Next, they will learn how to perform a manual mail merge and perform a 

number of follow-up merge activities including printing and exporting the merge recipient 

list. Finally, this course will outline how to use the same mail merge fundamentals to 

create a catalog of products or services via a catalog merge. 

Course Outline 

1.1. Using the Mail Merge Wizard 

✓ Mail Merge Basics 

✓ Starting the Wizard 

✓ Selecting Recipients 

✓ Adding Recipient Information to 

Your Publication 

✓ Previewing Results 

✓ Creating the Publication 

✓ Completing an E-Mail Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Performing a Manual Mail Merge 

✓ Selecting a Starting Publication 

✓ Selecting and Editing Recipients 

✓ Adding and Formatting Fields 

✓ Previewing the Merge 

✓ Finishing the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Following Up on the Merge 

✓ Printing the Recipient List 

✓ Saving a Shortcut to the Recipient 

List 

✓ Exporting the Recipient List 

✓ Re-Performing the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating a Catalog 

✓ Getting Started with Catalogs 

✓ Choosing a Data Source 

✓ Creating a Data Source from 

Scratch 

✓ Choosing Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Completing your Catalog 

✓ Laying Out the Catalog 

✓ Adding and Formatting Fields 

✓ Previewing the Merge 

✓ Finishing the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: 

Advanced, Section 3 
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Working with Shapes 

Course Overview and Learning Objectives 

This course focuses entirely on shapes in Publisher. First, we’ll look at adding the shapes 

to publications and show students how to manipulate them. Next, we will look next at 

formatting and grouping shapes. 

Course Outline 

1.1. Adding Shapes 

✓ Drawing Shapes 

✓ Moving Shapes 

✓ Resizing Shapes 

✓ Rotating Shapes 

✓ Deleting Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Shapes 

✓ Applying a Shape Style 

✓ Manually Formatting a Shape 

✓ Arranging Shapes 

✓ Using the Format AutoShape Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Grouping Shapes 

✓ Selecting Multiple Shapes 

✓ Grouping Shapes 

✓ Ungrouping Shapes 

✓ Aligning Shapes to Each Other 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Publisher 2010: Intermediate, Section 3 
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Microsoft SharePoint Designer 2010  

Creating a Basic HTML Page  

Course Overview and Learning Objectives 

In this course, students will learn the basics of HTML, including how to create a basic 

HTML page with and without SharePoint Designer. Students will also learn the 

differences between Design and Code view, as well as how to use basic editing and 

formatting tools. 

Course Outline 

1.1. Getting Started with HTML, Part 

One 

✓ What is HTML? 

✓ Anatomy of HTML 

✓ Creating a Basic HTML Page 

✓ Creating an HTML Page Using 

SharePoint Designer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Getting Started with HTML, Part 

Two 

✓ Understanding Design View 

✓ Understanding Code View 

✓ Basic HTML Tags 

✓ Using the Quick Tag Selector and 

Editor 

✓ Creating and Inserting a Tag 

✓ Editing and Deleting a Tag 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Basic Editing Tools 

✓ Selecting Data 

✓ Dragging and Dropping Text 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo 

✓ Using Find 

✓ Using Replace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Text 

✓ Applying Text Effects 

✓ Changing Font Face, Size and 

Color 

✓ Aligning, Justifying, and Indenting 

Text 

✓ Creating a Bulleted or Numbered 

List 

✓ Clearing Formatting from Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Advanced Formatting Tasks 

✓ Using the Font Dialog 

✓ Using the Paragraph Dialog 

✓ Adding Borders to Text 

✓ Using the Borders and Shading 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Applying the Finishing Touches to a 

Page 

✓ Checking Your Spelling 

✓ Checking Accessibility 

✓ Checking Compatibility 

✓ Optimizing HTML 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Foundation, Section 3 
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Creating a Basic Site  

Course Overview and Learning Objectives 

This course will cover how to organize, create, manage, and modify pages. SharePoint 

Designer’s versioning tools will also be discussed. 

Course Outline 

1.1. Organizing Pages 

✓ Viewing Site Pages 

✓ Managing Site Pages 

✓ Creating Folders 

✓ Changing Page Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Pages 

✓ Creating Other Types of Pages 

✓ Saving an Object as a Template 

✓ Importing Files 

✓ Exporting Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Modifying the Home Page 

✓ Overview of the Home Page 

✓ Changing the Title and Description 

✓ Changing the Home Page 

✓ Changing the Site Settings 

✓ Changing the Site Theme 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Versions 

✓ Checking Out a Page 

✓ Viewing Version History 

✓ Restoring a Past Version 

✓ Checking in a Page 

✓ Undoing a Checkout 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2010: Foundation, Section 4 
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Creating Interactive SharePoint Pages  

Course Overview and Learning Objectives 

In this course, students will learn how to create different types of SharePoint pages. 

Topics will include HTML, ASPX, and master pages, as well as SharePoint controls. 

Course Outline 

1.1. Creating an HTML Page 

✓ Understanding Editing Options 

✓ Creating a New Page 

✓ Inserting an HTML Control 

✓ Using the Toolbox 

✓ Performing Common Control 

Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating an ASPX Page 

✓ Creating a New Page 

✓ Inserting an ASP.NET Control 

✓ Using the Toolbox 

✓ Performing Common Control 

Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Page with SharePoint 

Controls 

✓ Inserting a SharePoint Control 

✓ Using the Toolbox 

✓ Inserting a List Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Master Pages 

✓ Understanding Master Pages 

✓ Creating Master Pages 

✓ Managing Master Pages 

✓ Resetting Master Pages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Doing More with Master Pages 

✓ Attaching and Detaching a 

Master Page 

✓ Editing Content Regions 

✓ Setting a Master Page as the 

Default 

✓ Exporting Master Pages 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Intermediate, Section 2
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Customizing Your Site  

Course Overview and Learning Objectives 

This course will cover how to organize, manage, and modify a SharePoint site as a whole. 

Students will also learn how to create lists, libraries, workflows, and columns. 

Course Outline 

1.1. Understanding Other Content Types 

✓ Creating Lists 

✓ Creating Libraries 

✓ Using the Lists and Libraries Tab 

✓ Creating Workflows 

✓ Using the Workflows Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Customizing Site Columns 

✓ Understanding Site Columns 

✓ Using the Columns Tab 

✓ Modifying Site Columns 

✓ Creating a New Column 

✓ Renaming and Deleting Columns 

✓ Applying Your Changes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Customizing Site Security 

✓ Overview of Roles and 

Permissions 

✓ Using the Permissions Tab 

✓ Editing Permissions for a Site or 

Page 

✓ Adding Users 

✓ Deleting Users 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using the Recycle Bin 

✓ Opening the Recycle Bin 

✓ Sorting Recycle Bin Data 

✓ Restoring a Selection 

✓ Permanently Deleting a Selection 

✓ Emptying the Recycle Bin 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Managing Your Site 

✓ Renaming Your Site 

✓ Resetting a Site to the Template 

✓ Setting Site Options 

✓ Deleting a Site 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Foundation, Section 6 
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Doing More with Data Views 

Course Overview and Learning Objectives 

In this course, students will learn more about data views by configuring data views, 

managing data source connections, adding supplementary controls to data views, and 

managing data view web parts as a whole. 

Course Outline 

1.1. Configuring the Data View Display 

✓ Setting Paging Options 

✓ Adding and Removing Columns 

✓ Configuring Update Procedures 

✓ Enabling and Disabling Inline Editing 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Data 

✓ Managing Data Source Connections 

✓ Using the Data Source Details Pane 

✓ Refreshing Data 

✓ Changing the Folder Scope 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Adding Controls to the Data View 

✓ Inserting Controls 

✓ Using the Toolbox Pane 

✓ Adding a Form Action 

✓ Previewing the Data View 

✓ Resetting Data View Preview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing the Data View Web Part 

✓ Editing the Title 

✓ Changing Chrome Settings 

✓ Setting the Height and Width 

✓ Choosing What Action(s) to Allow 

✓ Saving the Web Part 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2010: Advanced, Section 2 
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Doing More with Pages  

Course Overview and Learning Objectives 

In this course, students will learn all about adding tables and images to their websites. 

Bookmarks, hyperlinks, ScreenTips, and symbols will also be covered. 

Course Outline 

1.1. Working with Tables 

✓ Inserting a Table 

✓ Anatomy of a Table 

✓ About the Table Tools – Layout 

Tab 

✓ Selecting Table Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Tables 

✓ Adding and Deleting Rows, 

Columns, and Cells 

✓ Resizing Rows, Columns, and 

Tables 

✓ Merging and Splitting Cells and 

Tables 

✓ Converting a Table to Text 

✓ Adding a Caption 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Tables 

✓ Changing Cell Alignment 

✓ Choosing a Header Cell 

✓ Changing Borders and Shading 

✓ Using the Table Properties Dialog 

✓ Using the Cell Properties Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding Images to Your Page 

✓ About the Images Folder 

✓ Inserting a Picture 

✓ Adding Clip Art 

✓ Using the Picture Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Doing More with Photos 

✓ Cropping and Resizing Photos 

✓ Recoloring and Correcting 

Photos 

✓ Arranging Pictures 

✓ Creating a Hotlink or Hyperlink 

✓ Creating a Thumbnail 

✓ Changing Picture Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Adding Other Elements to Your Page 

✓ Adding Bookmarks 

✓ Hyperlinking to Bookmarks 

✓ Creating ScreenTips 

✓ Inserting Symbols 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Foundation, Section 5 
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Integrating External Data with SharePoint  

Course Overview and Learning Objectives 

To begin the course, students will learn how to view, create, and manage data sources 

with SharePoint Designer. Students will also learn how to create XML, SOAP, and REST 

connections. 

Course Outline 

1.1. Viewing Existing Data Sources 

✓ Viewing Existing Data Sources 

✓ Using the Data Sources Tab 

✓ Copying and Modifying a Data Source 

✓ Arranging and Grouping Data Sources 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Doing More with Data Sources 

✓ Linking Data Sources 

✓ Viewing Data Source Properties 

✓ Deleting a Data Source 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Linking to Other External Files 

✓ Creating an XML Connection 

✓ About SOAP Connections 

✓ About REST Connections 

✓ Creating a SOAP or REST Connection 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2010: Intermediate, Section 1 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 617 

Starting Out 

Course Overview and Learning Objectives 

In this course, students will learn the basics of SharePoint Designer: how to open and 

close it, how to use the new ribbon-based interface, how to manage site objects (including 

pages), and how to get help.  

Course Outline 

1.1. Meeting Microsoft SharePoint 

Designer 2010 

✓ What is Microsoft SharePoint 

Designer 2010? 

✓ What is Microsoft SharePoint? 

✓ What’s New in Microsoft 

SharePoint Designer 2010? 

✓ Basic SharePoint Terminology 

✓ Skill Sharpener 

1.2. Getting Started with Microsoft 

SharePoint Designer 2010 

✓ Opening SharePoint Designer 

✓ Interface Overview 

✓ Opening a Site 

✓ Interacting with SharePoint 

Designer 

✓ Closing a Site 

✓ Closing SharePoint Designer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Site Objects, Part One 

✓ Using the Navigation Pane 

✓ Browsing Object Types 

✓ Pinning an Object Type 

✓ Renaming and Deleting an Object 

✓ Working with Tabs 

✓ Using the Breadcrumb Trail 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Site Objects, Part Two 

✓ Editing a Page 

✓ Changing Object Properties 

✓ Saving Changes to the Page 

✓ Refreshing the Page 

✓ Previewing the Page 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing Your Workspace 

✓ Arranging and Grouping Objects 

in the Gallery 

✓ Understanding Page Views 

✓ Customizing Page Display 

✓ Using the Ruler 

✓ Using the Grid 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in SharePoint Designer 

2010 

✓ Getting Started with Office.com 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Foundation, Section 1
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Using and Customizing the SharePoint Designer Interface  

Course Overview and Learning Objectives 

This course will focus entirely on SharePoint Designer’s new interface. Students will learn 

how to use the basic elements of the interface, customize the Quick Access toolbar, and 

customize the ribbon itself. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu 

✓ Using the Status Bar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Foundation, Section 2
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Using Data Views and Item Forms 

Course Overview and Learning Objectives 

In this course, students will learn about using data from a data source in SharePoint 

Designer. Students will learn how to create item forms, how to create and use data views, 

and how to format the data displayed by those views. 

Course Outline 

1.1. Linking Data to a Site Page 

✓ Setting Up an Internal Data 

Source 

✓ Creating an XSLT Data View from 

an Existing Data Source 

✓ Creating an Empty Data View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Item Forms 

✓ Creating a New Item Form 

✓ Editing an Item Form 

✓ Testing an Item Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Data View Tools Tabs 

✓ The Options Tab 

✓ The Design Tab 

✓ The Web Part Tab 

✓ The Table Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Organizing Data View Information 

✓ Filtering Data 

✓ Sorting and Grouping Data 

✓ Applying Conditional Formatting 

✓ Using Formulas and Parameters 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Formatting the Data View 

✓ Showing and Hiding Sample Data 

✓ Showing and Hiding the Totals 

Row 

✓ Applying a Style 

✓ Changing Toolbar Display 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Advanced, Section 1 
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Using InfoPath 2010 with SharePoint Designer 2010 

Course Overview and Learning Objectives 

In this course, students will about using Microsoft’s form creation tool, InfoPath 2010, to 

create forms for a SharePoint server. Students will also learn how to create and upload 

forms, create data connections to forms, and create and use InfoPath forms in conjunction 

with SharePoint workflows. 

Course Outline 

1.1. Getting Started 

✓ Understanding InfoPath 2010 

✓ Designing SharePoint Forms in InfoPath 

✓ Publishing Forms to the Forms Library 

✓ Submitting a Form to SharePoint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with InfoPath List Forms 

✓ Creating a List Form Web Part 

✓ Setting up a Connection 

✓ Modifying List Form Properties 

✓ Modifying Web Part Properties 

✓ Testing the Web Part 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Forms with SharePoint Workflows 

✓ Understanding Workflows 

✓ Adding a Choice Column 

✓ Creating a Workflow 

✓ Adding a Data Connection to Receive Workflow Information 

✓ Creating a New Form View for the Workflow 

✓ Changing the Form in Response to Workflow Status 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2010: Advanced, Section 3 
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Using Lists and Libraries  

Course Overview and Learning Objectives 

This course is all about lists and libraries. Topics include how to create, manage, preview, 

edit, and customize lists and libraries. 

Course Outline 

1.1. Lists and Libraries 

✓ Types of Available Lists and 

Libraries 

✓ Creating a New List or Library 

✓ Viewing Lists and Libraries 

✓ The Lists and Libraries Tab 

✓ Sorting List and Library 

Information 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Lists and Libraries 

✓ Renaming a List or Library 

✓ Deleting a List or Library 

✓ Changing List or Library Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Individual Lists and 

Libraries 

✓ Opening a List or Library 

✓ Changing the List or Library 

Name and Description 

✓ Changing List or Library 

Permissions 

✓ Previewing a List or Library in the 

Browser 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Columns 

✓ Editing List or Library Columns 

✓ Using the Columns Tab 

✓ Using the List Settings Tab 

✓ Validating Column Data 

✓ Adding New Columns to a List or 

Library 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing List or Library Behavior 

✓ Adding and Removing Content 

Types 

✓ Adding and Removing Views 

✓ Adding and Removing List Forms 

✓ Adding and Removing Workflows 

✓ Adding and Removing Custom 

Actions 

✓ Step-By-Step 

✓ Skill Sharpener 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Intermediate, Section 5 
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Using Microsoft SharePoint Workspace 2010 

Course Overview and Learning Objectives 

This course will discuss SharePoint Workspace 2010, the Office 2010 replacement for 

Groove. This program is a collaboration tool that allows users to work with SharePoint 

data on their local computer, even if they are disconnected from the Internet. Topics 

include how to set up an account and workspace, work with a site, have team discussions, 

and customize the program. 

Course Outline 

1.1. Getting Started with the Launchbar 

✓ Understanding Microsoft 

SharePoint Workspace 2010 

✓ Opening Microsoft SharePoint 

Workspace 2010 

✓ Configuring Microsoft 

SharePoint Workspace 2010 

✓ Launchbar Overview 

✓ Creating a Workspace 

✓ Creating a Shared Folder 

✓ Closing a SharePoint Workspace 

and the Launchbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the SharePoint Workspace 

Interface 

✓ Interface Overview 

✓ Using the Home Tab 

✓ Using the Sync Tab 

✓ Using the View Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Your Site 

✓ Viewing Documents 

✓ Adding a List Object 

✓ Viewing Server Objects 

✓ Syncing Your Changes 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Working with Team Discussions 

✓ Creating a New Discussion 

✓ Adding Messages to a Discussion 

✓ Collapsing and Expanding 

Threads 

✓ Deleting Discussions and 

Messages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing Your Workspace 

✓ Changing Connection Settings 

✓ Managing Alerts 

✓ Managing Your Accounts 

✓ Managing Messages and 

Contacts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Working with Your Space 

✓ Printing Objects 

✓ Exporting Your Account 

✓ Saving a Workspace Shortcut 

✓ Deleting a Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Advanced, Section 5
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Using Site Templates, Subsites, and Web Parts  

Course Overview and Learning Objectives 

In this course, students will learn about using SharePoint templates, creating sites, and 

creating subsites. Web parts, web part zones, and web part pages will also be covered. 

Course Outline 

1.1. Working with SharePoint Templates 

✓ Overview of Available Templates 

✓ Using a SharePoint Template 

✓ Changing the Site Theme 

✓ Creating a Blank Site 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Subsites 

✓ Viewing Subsites 

✓ Using the Subsites Tab 

✓ Adding a Subsite 

✓ Viewing, Renaming, and Deleting 

a Subsite 

✓ Saving a Subsite as a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Web Parts, Part One 

✓ Understanding Web Parts 

✓ Adding Parts to an Existing Page 

✓ Creating a Web Part Page 

✓ Using the Web Part Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Web Parts, Part Two 

✓ Adding a Data Connection 

✓ Modifying Your Web Part 

✓ Deleting Web Parts 

✓ Saving a Web Part 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Web Part Zones 

✓ About Web Part Zones 

✓ Creating a Web Part Zone 

✓ Customizing Web Part Zones 

✓ Controlling Web Part Zone 

Access 

✓ Deleting a Web Part Zone 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Intermediate, Section 4

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 624 

Using Styles and Cascading Style Sheets  

Course Overview and Learning Objectives 

This course will focus on how to create, manage, and use cascading style sheets (CSS). 

Styles will also be covered in depth. 

Course Outline 

1.1. Using Cascading Style Sheets 

✓ About Cascading Style Sheets 

✓ Moving CSS Files 

✓ Deleting CSS Files 

✓ Creating CSS Files 

✓ Using CSS Files with THMX Files 

✓ Integrating a CSS File with a 

Master Page 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Understanding the Style Tab 

✓ Using the Style Tab 

✓ Creating a New Style 

✓ Using the Apply Styles Pane 

✓ Using the Manage Styles Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Style Use 

✓ Choosing Style Mode 

✓ Setting Rules 

✓ Toggling Overlay 

✓ Attaching or Linking a CSS File 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Properties 

✓ Reusing Properties 

✓ Using the Tag Properties Pane 

✓ Using the CSS Properties Pane 

✓ Editing Page Properties 

✓ Editing Element Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Intermediate, Section 3 
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Using Visio 2010 with SharePoint Designer 2010 

Course Overview and Learning Objectives 

This course covers using Microsoft’s diagramming tool, Visio 2010, to illustrate the way 

workflows operate in SharePoint. Students will also learn how to import and export 

workflows to both Visio and SharePoint Designer. 

Course Outline 

1.1. Creating Workflow Diagrams 

✓ Understanding Visio 2010 

✓ Creating a SharePoint Workflow Diagram in Visio 2010 

✓ Using the Process Tab 

✓ Adding Start and Terminate Shapes 

✓ Adding Conditions 

✓ Adding Actions 

✓ Adding Connectors 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Completing Your Workflow Diagram 

✓ Checking the Diagram for Errors 

✓ Saving Your Drawing as a Visio 2010 Workflow Interchange File 

✓ Importing a Workflow Drawing into Visio 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Workflow in SharePoint Designer 

✓ Importing a Visio 2010 Drawing into a SharePoint Workflow 

✓ Setting the Variables 

✓ Checking the Workflow for Errors 

✓ Publishing the Workflow 

✓ Exporting a Workflow to Visio 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 2010: Advanced, Section 4 
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Using Workflows 

Course Overview and Learning Objectives 

This course covers how to create, edit, manage, view, publish, and test workflows. 

Course Outline 

1.1. Getting Started 

✓ Understanding Types of 

Workflows 

✓ Viewing Existing Workflows 

✓ Using the Workflows Tab 

✓ Copying and Modifying a 

Workflow 

✓ Renaming a Workflow 

✓ Deleting a Workflow 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a New Workflow 

✓ Creating a Workflow 

✓ Using the Workflow Tab 

✓ Adding Conditions 

✓ Adding Actions 

✓ Adding Steps 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Workflows 

✓ Changing Workflow Start 

Options 

✓ Changing Workflow Visibility 

✓ Associating Forms with a 

Workflow 

✓ Saving a Workflow Template 

✓ Exporting the Workflow to Visio 

✓ Importing Workflows from Visio 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Finishing the Workflow 

✓ Saving the Workflow 

✓ Checking for Errors 

✓ Publishing the Workflow 

✓ Testing the Workflow 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Designer 

2010: Intermediate, Section 6 
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Microsoft SharePoint Server 2010  

Advanced SharePoint Tasks 

Course Overview and Learning Objectives 

This course guides students through some of the more advanced SharePoint functionality. 

Students will learn how to use the Project Tasks list and will receive a crash course on 

basic project management. This course then moves on to discuss the basics of using 

programs designed to complement SharePoint: SharePoint Workspace 2010 and 

SharePoint Designer 2010. Finally, this course will give an overview of all the Web-

enabled administrative tasks available for SharePoint sites. 

Course Outline 

1.1. Project Tasks Lists 

✓ What is a Project Tasks List? 

✓ Project Management 101 

✓ Creating a Project Tasks List 

✓ Creating New Tasks 

✓ Working with Project Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using SharePoint Workspace 

✓ What is SharePoint Workspace 

2010? 

✓ Configuring SharePoint 

Workspace 

✓ Synchronizing Data with 

SharePoint Workspace 

✓ Interface Overview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using SharePoint Designer 

✓ What is SharePoint Designer 

2010? 

✓ Installing SharePoint Designer 

✓ Basics of SharePoint Designer 

✓ Exploring the Interface 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Modifying Site Administration 

Settings 

✓ Users and Permissions 

✓ Galleries 

✓ Site Administration 

✓ Site Collection Administration 

✓ Look and Feel 

✓ Site Actions 

✓ Reporting Services 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 

2010: complete, Section 4 
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Creating and Managing Content 

Course Overview and Learning Objectives 

This course discusses how to create, edit, and manage pages, sites, libraries, library views, 

and lists. The Recycle Bin and Site Collection Recycle Bin will also be covered. 

Course Outline 

1.1. Creating and Managing Pages 

✓ What are Pages? 

✓ Creating a New Page 

✓ The Editing Tools Tabs 

✓ Editing New and Existing Pages 

✓ Saving Pages 

✓ Managing Existing Pages 

✓ The Page Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Setting Up a New Site 

✓ What are Sites? 

✓ Types of Sites 

✓ Choosing a Site Template 

✓ Configuring a Site Template 

✓ Configuring an Existing Site 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Libraries 

✓ What are Libraries? 

✓ Creating a New Library 

✓ The Library Tools Tabs 

✓ Adding Items to the Library 

✓ Enabling and Using Versioning 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.4. Creating Views 

✓ What are Views? 

✓ Types of Views 

✓ Creating a View 

✓ Modifying a View 

✓ Deleting a View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating and Managing Lists 

✓ What are Lists? 

✓ Types of Lists 

✓ Creating a New List 

✓ The List Tools Tabs 

✓ Working with Lists 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The Recycle Bin 

✓ Opening the Recycle Bin 

✓ Restoring Items 

✓ Deleting Items 

✓ About the Site Collection Recycle 

Bin 

✓ Step-By-Step 

✓ Skill Sharpener 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 

2010: complete, Section 2
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Getting Started 

Course Overview and Learning Objectives 

In this course, students will be introduced to what SharePoint is and learn how to move 

around within the interface and site hierarchy. They will also be given a brief introduction 

to all the major SharePoint objects, learn a little about their personal homepage, and learn 

how to use the SharePoint Help file. 

Course Outline 

1.1. Introducing SharePoint Server 2010 

✓ What is SharePoint 2010? 

✓ A Brief History of SharePoint 

✓ How SharePoint Works 

✓ System Requirements 

✓ Types of SharePoint Users 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Navigating Through SharePoint 

✓ Understanding the Home Page 

Interface 

✓ Using the Quick Launch Pane 

✓ Using the Site Actions Menu 

✓ Navigating through SharePoint’s 

Pages 

✓ Viewing Your Profile Menu 

✓ Searching SharePoint 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Content Glossary, Part 1 

✓ About Pages 

✓ About Sites 

✓ About Calendars 

✓ About Discussions 

✓ About Libraries 

✓ About Lists 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Content Glossary, Part 2 

✓ About Blogs 

✓ About Tags & Notes 

✓ About Wikis 

✓ About Workspaces 

✓ About Check In/Check Out 

✓ About Versioning 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Your SharePoint Profile 

✓ Opening your Personal 

Homepage 

✓ Viewing your Profile 

✓ Editing your Profile Information 

✓ Logging Out and Logging Off 

✓ Closing your Profile Page 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help 

✓ Opening SharePoint Help 

✓ Browsing Help Categories and 

Topics 

✓ Navigating the Help File 

✓ Searching for Help 

✓ Printing Help Topics 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 

2010: complete, Section 1 
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Specialized SharePoint Content 

Course Overview and Learning Objectives 

This course will discuss how to do more with SharePoint content. It covers library 

management, including file check-in/out and file versioning. Students will also learn how 

to create blogs, wikis, workspaces, calendars, and workflows, and perform actions with 

each object. 

Course Outline 

1.1. Library Management 

✓ Checking Out Files 

✓ Checking in Files 

✓ Using File Versioning 

✓ Advanced Library Settings 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Blogs 

✓ What are Blogs? 

✓ Creating a New Blog 

✓ Exploring a Blog 

✓ Writing and Managing Blog 

Entries 

✓ The Editing Tools Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Wikis 

✓ What are Wikis? 

✓ Creating a New Wiki 

✓ Working with Wiki Content 

✓ Wiki Link Syntax 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Workspaces 

✓ What are Workspaces? 

✓ Types of Workspaces 

✓ Creating a New Workspace 

✓ Editing Workspace Content 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Calendars 

✓ What are Calendars? 

✓ Creating a New Calendar 

✓ The Calendar Tools Tabs 

✓ Adding and Editing Events 

✓ Using Multiple Calendars 

✓ Using Calendar Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Workflows 

✓ What are Workflows? 

✓ Creating a New Workflow 

✓ Assigning Workflows to Files 

✓ Managing Workflows 

✓ Working with Assigned 

Workflows 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft SharePoint Server 

2010: complete, Section 3
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Microsoft Visio 2010  

Adding Data to Your Graphics  

Course Overview and Learning Objectives 

In this course, students will learn how to add data to shapes manually and from a data 

source. Data graphics and legends will also be discussed. 

Course Outline 

1.1. Adding Data to Shapes 

✓ Using the Shape Data Window 

✓ Using the Define Shape Data 

Dialog 

✓ Configuring Shape Data Sets 

✓ Applying Shape Data Sets 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Linking External Data to Shapes 

✓ Manually Linking Shape Data 

✓ Using the External Data Window 

✓ Automatically Linking Shapes 

✓ Refreshing the Data Source 

✓ Removing Data Links 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Data Graphics 

✓ Understanding Data Graphics 

✓ Inserting Data Graphics 

✓ Creating Custom Data Graphics 

✓ Editing Data Graphics 

✓ Removing Data Graphics 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Legends 

✓ Adding a Legend 

✓ Editing a Legend 

✓ Adding Text to a Legend 

✓ Adding Shapes to a Legend 

✓ Removing a Legend 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Advanced, 

Section 4
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Adding Drawings and Charts to Your Diagram  

Course Overview and Learning Objectives 

In this course, students will learn how to add CAD drawings, objects, and charts to a 

diagram. 

Course Outline 

1.1. Inserting CAD Drawings 

✓ Inserting a Drawing 

✓ Moving a Drawing 

✓ Resizing a Drawing 

✓ Deleting a Drawing 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Inserting Objects 

✓ Inserting Objects 

✓ Moving Objects 

✓ Resizing Objects 

✓ Deleting Objects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Charts 

✓ Inserting a Chart 

✓ About the Chart Tools Tabs 

✓ Moving Charts 

✓ Resizing Charts 

✓ Deleting Charts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Charts 

✓ Editing Chart Data 

✓ Selecting Chart Data 

✓ Changing the Type of Chart 

✓ Applying a Chart Style 

✓ Formatting Individual Chart Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Advanced, Section 1 
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Adding the Finishing Touches  

Course Overview and Learning Objectives 

In this course, students will learn about Visio’s research tools, including spell check. Then, 

images and Clip Art will be discussed. 

Course Outline 

1.1. Using Visio’s Research Tools 

✓ Checking Spelling 

✓ Using the Research Pane 

✓ Using the Thesaurus 

✓ Using the Translator 

✓ Setting Your Language 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Inserting Pictures 

✓ Adding Pictures from a File 

✓ Adding Clip Art 

✓ Overview of the Picture Tools – 

Format Tab 

✓ Resizing Pictures 

✓ Moving Pictures 

✓ Deleting Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing More with Pictures 

✓ Arranging Pictures 

✓ Grouping and Ungrouping 

Pictures 

✓ Cropping Pictures 

✓ Rotating and Flipping Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Modifying Pictures 

✓ Adjusting the Brightness and 

Contrast 

✓ Using AutoBalance 

✓ Compressing Pictures 

✓ Adding a Border 

✓ Using the Format Picture Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Intermediate, Section 3 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 634 

Containers, Callouts, and More  

Course Overview and Learning Objectives 

This course will cover adding fields, symbols, ScreenTips, and data to shapes. Containers, 

callouts, and layers will also be discussed. 

Course Outline 

1.1. Doing More with Shapes 

✓ Using Paste Special 

✓ Inserting a Field 

✓ Adding Symbols 

✓ Adding ScreenTips 

✓ Adding Hyperlinks 

✓ Adding Data to Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Containers 

✓ Adding a Container 

✓ Using the Container Tools – 

Format Tab 

✓ Resizing a Container 

✓ Adding Shapes to a Container 

✓ Removing Shapes from a 

Container 

✓ Disbanding the Container 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Containers 

✓ Choosing a Container Style 

✓ Choosing a Heading Style 

✓ Selecting a Container’s Contents 

✓ Locking a Container 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding a Callout 

✓ Inserting a Callout 

✓ Moving a Callout 

✓ Changing the Position of the 

Callout Line 

✓ Resizing a Callout 

✓ Changing the Callout Style 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Layers 

✓ Adding a Layer 

✓ Showing and Hiding Layers 

✓ Activating a Layer 

✓ Preserving Group Member 

Layers 

✓ Coloring Layers 

✓ Locking Layers 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Intermediate, Section 2
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Creating Diagrams  

Course Overview and Learning Objectives 

In this course, students will learn how to start a diagram with a template, use basic editing 

commands, and set up and use guides. We will also explore how to edit, format, and 

arrange shapes. 

Course Outline 

1.1. Starting Points for Your Diagrams 

✓ Creating a Blank Drawing 

✓ Creating a Diagram from Local 

Templates 

✓ Creating a Diagram from Online 

Templates 

✓ Accessing Recently Used 

Templates 

✓ Using Visio’s Sample Files 

✓ Creating a Diagram from Existing 

Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Visio’s Editing Tools 

✓ Using the Selection Tools 

✓ Using Cut, Copy, and Paste 

✓ Using Undo and Redo/Repeat 

✓ Using Find 

✓ Using Replace 

✓ Using the Format Painter 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Editing Shapes 

✓ Setting up Guides 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Rotating Shapes 

✓ Duplicating Shapes 

✓ Deleting Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Shapes 

✓ Changing the Fill Color 

✓ Using the Fill Dialog 

✓ Changing the Line Color and Type 

✓ Using the Line Dialog 

✓ Adding a Shadow 

✓ Using the Shadow Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Arranging Shapes 

✓ Aligning Shapes 

✓ Distributing Shapes 

✓ Using Auto Align & Space 

✓ Arranging Shapes 

✓ Grouping and Ungrouping Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Foundation, Section 4

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 636 

Creating PivotDiagrams  

Course Overview and Learning Objectives 

This course will cover how to create, format, and customize PivotDiagrams. 

Course Outline 

1.1. Getting Started 

✓ Creating a PivotDiagram 

✓ About the PivotDiagram Tab 

✓ Adding Categories 

✓ Adding Totals 

✓ Showing and Hiding PivotDiagram Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing the Diagram 

✓ Applying Shapes 

✓ Moving Shapes 

✓ Collapsing Shapes 

✓ Promoting and Demoting Shapes 

✓ Merging and Unmerging Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using PivotDiagram Tools 

✓ Sorting Data 

✓ Changing the Direction of the Diagram 

✓ Aligning Shapes in the Diagram 

✓ Using the Re-Layout Command 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working With Your Data 

✓ Refreshing Data 

✓ Changing the Data Source 

✓ Changing PivotDiagram Options 

✓ Editing Data for Individual Shapes 

✓ Using Data Graphics in PivotDiagrams 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Advanced, Section 5 
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Creating Popular Diagrams  

Course Overview and Learning Objectives 

This course delves into creating process diagrams, cross-functional flowcharts, and 

organization charts. 

Course Outline 

1.1. Creating Process Diagrams 

✓ Creating a Process Diagram 

✓ Creating New Subprocesses 

✓ Linking Subprocesses 

✓ Editing Subprocess Links 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Validating Process Diagrams 

✓ Choosing Rules to Run 

✓ Importing Rules 

✓ Performing a Check 

✓ Showing and Hiding the Issues 

Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Cross-Functional 

Flowcharts 

✓ Getting Started 

✓ Adding Swimlanes and 

Separators 

✓ Changing Diagram Orientation 

and Direction 

✓ Modifying Swimlane Margins 

✓ Choosing a Flowchart Style 

✓ Modifying Flowchart Elements 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Organization Charts 

✓ Getting Started 

✓ Creating an Organization Chart 

✓ Modifying the Layout 

✓ Changing the Spacing 

✓ Arranging Shapes 

✓ Modifying Positioning 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Organization Charts 

✓ Creating and Using a 

Synchronized Copy 

✓ Importing Data 

✓ Exporting Data 

✓ Comparing Charts 

✓ Setting Organization Chart 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Intermediate, Section 4 
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Customizing Shapes  

Course Overview and Learning Objectives 

In this course, students will learn how to use My Shapes and Quick Shapes, as well as 

create new master shapes. Shape reports will also be discussed. 

Course Outline 

1.1. Using My Shapes and Quick Shapes 

✓ Understanding My Shapes 

✓ Understanding Quick Shapes 

✓ Adding Shapes to My Shapes or Quick Shapes 

✓ Organizing My Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Master Shapes 

✓ Creating a Master Shape 

✓ Renaming a Master Shape 

✓ Editing Master Shapes 

✓ Deleting a Master Shape 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Master Shapes 

✓ Editing Master Shape Properties 

✓ Adding Master Shapes to Another Stencil 

✓ Modifying Master Shape Icons 

✓ Using My Shapes and Quick Shapes with Master Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Shape Reports 

✓ Viewing Existing Reports 

✓ Creating a New Report 

✓ Modifying Reports 

✓ Deleting Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Advanced, Section 2 
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Customizing Templates and Stencils  

Course Overview and Learning Objectives 

This course covers creating and managing Visio templates and stencils. 

Course Outline 

1.1. Creating a Template 

✓ Creating a New Template 

✓ Saving a Template File 

✓ Using a Template 

✓ Editing a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Modifying Open Stencils 

✓ Changing the Appearance of the Shapes Task Pane 

✓ Reordering Stencils in the Shapes Task Pane 

✓ Editing a Stencil 

✓ Closing a Stencil 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Custom Stencils 

✓ Creating a New Stencil 

✓ Adding Shapes to Stencils 

✓ Removing Shapes from Stencils 

✓ Saving Stencils 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Organizing Stencils 

✓ Copying Shapes from One Stencil to Another 

✓ Using the Quick Shapes Stencil 

✓ Renaming Stencil Shapes 

✓ Editing Stencil Shapes 

✓ Resetting Stencils 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Intermediate, Section 5 
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Doing More with Diagrams  

Course Overview and Learning Objectives 

This course covers formatting text with the Home tab, using the Text dialog, creating and 

modifying text blocks, and working with freeform shapes. 

Course Outline 

1.1. Formatting Text, Part One 

✓ Changing Font Face and Size 

✓ Changing Font Color 

✓ Applying Text Effects 

✓ Changing Case 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Text, Part Two 

✓ Aligning and Justifying Text 

✓ Indenting Text 

✓ Creating a Bulleted List 

✓ Opening the Text Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Text Blocks 

✓ Drawing a Text Block 

✓ Editing Text 

✓ Resizing Text Blocks 

✓ Moving Text Blocks 

✓ Rotating Text Blocks 

✓ Deleting Text Blocks 

✓ Using the Text Block Tool 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding Freeform Shapes 

✓ Creating a Freeform Shape 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Rotating a Freeform Shape 

✓ Deleting a Freeform Shape 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Foundation, Section 5 
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Managing Visio Files  

Course Overview and Learning Objectives 

In this course, students will learn how to manage Visio files using Windows Explorer and 

other Visio tools. Page backgrounds will also be discussed. 

Course Outline 

1.1. Using Windows Explorer within Visio 

✓ Navigating Using Windows Explorer 

✓ Performing Basic Tasks with Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using File Management Tools, Part One 

✓ Using AutoRecover 

✓ Publishing to PDF or XPS 

✓ Setting File Passwords 

✓ Saving a Diagram as a Picture 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using File Management Tools, Part Two 

✓ Managing File Properties 

✓ Saving a Preview with a Diagram 

✓ Saving a Workspace with a Diagram 

✓ Removing Personal Information 

✓ Reducing File Size 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Adding and Editing Page Backgrounds 

✓ Adding a Background to a Single Page 

✓ Creating a Master Background Page 

✓ Apply a Master Background Page to Other Pages 

✓ Editing a Master Background Page 

✓ Removing a Master Background Page 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Intermediate, Section 1 
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Overview of the Command Tabs 

Course Overview and Learning Objectives 

This course will give students an introduction to each command tab. This course is 

intended to familiarize students with various tabs so that they can easily find commands 

in the new interface. 

Course Outline 

1.1. The Home Tab 

✓ Clipboard Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Tools Commands 

✓ Shape Commands 

✓ Arrange Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Insert Tab 

✓ Pages Commands 

✓ Illustrations Commands 

✓ Diagram Parts Commands 

✓ Links Commands 

✓ Text Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Design Tab 

✓ Page Setup Commands 

✓ Themes Commands 

✓ Backgrounds Commands 

✓ Layout Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Data Tab 

✓ External Data Commands 

✓ Display Data Commands 

✓ Show/Hide Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Comments Commands 

✓ Markup Commands 

✓ Reports Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The View Tab 

✓ Views Commands 

✓ Show Commands 

✓ Zoom Commands 

✓ Visual Aids Commands 

✓ Window Commands 

✓ Macros Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Foundation, Section 3 
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Printing and Viewing Your Diagram 

Course Overview and Learning Objectives 

This course will teach students about viewing a diagram in various ways, using zoom tools, 

applying finishing touches (such as spell check), working with themes, using the Page 

Setup dialog, and printing or e-mailing a diagram. 

Course Outline 

1.1. Using Visio’s Viewing Tools 

✓ Using Normal View 

✓ Using Full Screen View 

✓ Using Zoom Tools 

✓ Using Pan & Zoom 

✓ Using Fit to Window and Page 

Width 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Pages 

✓ Adding a Blank Page 

✓ Navigating Through Pages 

✓ Renaming a Page 

✓ Changing the Order of Pages 

✓ Deleting a Page 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Polishing Your Diagram 

✓ Checking Your Spelling 

✓ Rotating a Diagram 

✓ Changing the Diagram Layout 

✓ Changing the Theme 

✓ Customizing the Current Theme 

✓ Adding Borders and Titles 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Preparing a Diagram for Printing 

✓ Changing Page Orientation 

✓ Changing Page Size 

✓ Scaling the Diagram 

✓ Changing Page Properties 

✓ Changing Layout and Routing 

Options 

✓ Adding Shadows to the Diagram 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Printing Your Diagram 

✓ Changing Print Setup Options 

✓ Using Print Preview 

✓ Printing the Diagram 

✓ E-mailing Your Diagram 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Foundation, Section 6 
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Reviewing Diagrams  

Course Overview and Learning Objectives 

This course will cover Visio’s reviewing tools, including comments and ink markup. 

Course Outline 

1.1. Using Comments 

✓ Adding Comments 

✓ Editing Comments 

✓ Navigating Through Comments 

✓ Deleting Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Markup Tools 

✓ Marking up a Diagram with Ink 

✓ Showing and Hiding Markup 

✓ Using the Reviewing Pane 

✓ Deleting Markup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Ink Tools 

✓ Toggling Ink On or Off 

✓ Using the Ink Tools – Pens Tab 

✓ Using the Pen or Highlighter 

✓ Configuring Pen and Highlighter Appearance 

✓ Erasing Marks 

✓ Closing Ink Mode 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Advanced, Section 3 
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Starting Out 

Course Overview and Learning Objectives 

To begin this course, students will learn the basics of Visio: how to open and close it, how 

to use the interface, how to create a basic diagram, how to save and open drawings, and 

how to get help. We’ll also look at the new Backstage View. 

Course Outline 

1.1. Meeting Microsoft Office Visio 2010 

✓ What is Microsoft Office Visio 

2010? 

✓ What’s New in Microsoft Office 

Visio 2010? 

✓ Opening Visio 

✓ Interface Overview 

✓ Interacting with Visio 

✓ Closing Visio 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Visio Files 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Diagram 

✓ Planning Your Diagram 

✓ Understanding Templates, 

Stencils, and Shapes 

✓ Using the New Diagram Window 

✓ Finding and Adding Shapes 

✓ Connecting Shapes 

✓ Adding Text to Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using the Shapes Pane 

✓ Floating and Docking the Shapes 

Pane 

✓ Minimizing and Hiding the Shapes 

Pane 

✓ Floating and Docking Stencils 

✓ Searching for Shapes 

✓ Showing and Hiding Stencils 

✓ Re-Ordering Stencils in the 

Shapes Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Connecting Shapes 

✓ Customizing the Dynamic Grid, 

Static Grid, and Ruler 

✓ Changing Snap & Glue Options 

✓ Creating a Basic Connection 

✓ Customizing the Connector 

✓ Moving Connectors 

✓ Editing Connection Points 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in Visio 

✓ Getting Started with Office.com 

✓ Opening Help 

✓ Using the Help Screen 

✓ Using the Help Toolbar 

✓ Searching for Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: 

Foundation, Section 1 
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Understanding and Customizing the Visio Interface  

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and the various interface elements. Students will also learn how to 

customize the ribbon. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File Menu (Backstage View) 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Common Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

Corresponding Instructor-Led Course 

✓ Microsoft Visio 2010: Foundation, Section 2 
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Microsoft Word 2010  

Advanced Tabs and Customization  

Course Overview and Learning Objectives 

In this course, participants will learn about the more advanced tabs in Word. Contextual 

tabs and customizing the ribbon will also be covered. 

Course Outline 

1.1. The Page Layout Tab 

✓ Themes Commands 

✓ Page Setup Commands 

✓ Page Background Commands 

✓ Paragraph Commands 

✓ Arrange Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The References Tab 

✓ Table of Contents Commands 

✓ Footnotes Commands 

✓ Citations and Bibliography 

Commands 

✓ Captions Commands 

✓ Index Commands 

✓ Table of Authorities Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Mailings Tab 

✓ Create Commands 

✓ Start Mail Merge Commands 

✓ Write and Insert Fields 

Commands 

✓ Preview Results Commands 

✓ Finish Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Review Tab 

✓ Proofing Commands 

✓ Language Commands 

✓ Comments Commands 

✓ Tracking Commands 

✓ Changes Commands 

✓ Compare Commands 

✓ Protect Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Contextual Tabs 

✓ Drawing Tools 

✓ Equation Tools 

✓ SmartArt Tools 

✓ Table Tools 

✓ Chart Tools 

✓ Picture Tools 

✓ Header and Footer Tools 

✓ Developer Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Customizing the Ribbon 

✓ Getting Started 

✓ Adding or Removing Tabs 

✓ Arranging Tabs and Groups 

✓ Creating New Tabs and Groups 

✓ Customizing Group Commands 

✓ Resetting all Customizations 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 3 
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Advanced Topics  

Course Overview and Learning Objectives 

This course will cover macros, file objects, SharePoint workspaces, and blogging tools. 

Course Outline 

1.1. Creating Macros 

✓ Setting Macro Security 

✓ Recording a Macro 

✓ Running a Macro 

✓ Editing a Macro’s Code using 

Visual Basic for Applications 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Macro Tasks 

✓ Copying a Macro from a Template 

✓ Assigning a Macro to a Keystroke 

✓ Assigning a Macro to a Quick 

Access Toolbar Button 

✓ About Macro Names 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Embedding Objects in a Word 

Document 

✓ Adding Text from a File 

✓ Creating a New Object 

✓ Creating an Object from a File 

✓ Linking Objects to a Word 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Working with SharePoint Server 

✓ What is SharePoint? 

✓ System Requirements 

✓ Creating a Workspace 

✓ Accessing a Workspace 

✓ Publishing to a Workspace with 

Internet Explorer 

✓ Publishing to a Workspace with 

Word 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Publishing to Other Places 

✓ Publishing to Document 

Management Servers 

✓ Creating a Blog Post 

✓ Using Blogging Tools 

✓ Configuring a Blog Account 

✓ Publishing a Blog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Expert, 

Section 5 
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Creating Documents 

Course Overview and Learning Objectives 

This course will explore different methods for creating a document, as well as basic text 

editing and formatting tools. 

Course Outline 

1.1. Creating a New Document 

✓ Creating a Blank Document 

✓ Creating a Document from Local 

Templates 

✓ Creating a Document from 

Online Templates 

✓ Creating Documents from an 

Existing Document 

✓ Using the Recently Used 

Templates Area 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Selecting Text 

✓ Selecting Text with the Mouse 

✓ Selecting Text with the Keyboard 

✓ Selecting Text and Objects with 

the Home Tab 

✓ Tips and Tricks 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

 

 

1.3. Moving Text 

✓ Cutting, Copying, and Pasting 

Text 

✓ Using the Office Clipboard 

✓ Dragging and Dropping Text 

✓ Moving Text with the Navigation 

Pane 

✓ Finding Text 

✓ Replacing Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Applying Advanced Text Effects 

✓ Using the Format Painter 

✓ Adding Drop Caps 

✓ Applying a Quick Style 

✓ Aligning and Justifying Text 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 4 
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Creating Equations and Charts 

Course Overview and Learning Objectives 

This course will show students how to insert and create equations. Then, students will 

learn how to insert, edit, format, and analyze an Excel chart. 

Course Outline 

1.1. Working with Equations 

✓ Inserting Built-In Equations 

✓ Using the Equation Tools – Design Tab 

✓ Creating a Custom Equation 

✓ Saving an Equation to the Gallery 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Charts 

✓ Inserting a Chart 

✓ Moving, Resizing, and Deleting Charts 

✓ About the Chart Tools Tabs 

✓ Editing Chart Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Charts 

✓ Changing the Chart Type 

✓ Changing the Chart’s Layout 

✓ Changing the Chart Style 

✓ Adding Captions to a Chart 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Analyzing Chart Data 

✓ Adding Trendlines 

✓ Adding Other Line Types 

✓ Adding Up/Down Bars 

✓ Adding Error Bars 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Advanced, Section 5 
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Creating Forms  

Course Overview and Learning Objectives 

This course will show students how to create, modify, and distribute a form using Word 

2010. 

Course Outline 

1.1. Creating Forms 

✓ Enabling the Developer Tab 

✓ Using the Developer Tab 

✓ Creating a Form 

✓ Inserting Controls 

✓ Modifying Control Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Finishing Forms 

✓ Grouping Controls 

✓ Protecting a Form 

✓ Testing a Form 

✓ Distributing a Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Form Tasks 

✓ Using Legacy Controls 

✓ Using ActiveX Controls 

✓ Assigning Help to a Form Field 

✓ Using Multiple Sections 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Expert, Section 4 
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Creating Headers and Footers 

Course Overview and Learning Objectives 

This course covers how to use headers and footers. Students will learn how to add, edit, 

and customize headers and footers. Additionally, this course discusses how to use page 

numbering, insert the date and time, and use section breaks with headers and footers. 

Course Outline 

1.1. Creating Basic Headers and Footers 

✓ Using a Preset Header or Footer 

✓ Editing a Header or a Footer 

✓ Adding a Header or Footer to the 

Gallery 

✓ Navigating Through Headers and 

Footers 

✓ Removing a Header or Footer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Header & Footer Tools – 

Design Tab 

✓ The Header & Footer Group 

✓ The Insert Group 

✓ The Navigation Group 

✓ The Options Group 

✓ The Position Group 

✓ The Close Command 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Page Numbers 

✓ Inserting Page Numbers 

✓ Changing Page Numbers 

✓ Formatting Page Numbers 

✓ Removing Page Numbers 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Headers and 

Footers 

✓ Aligning Text 

✓ Adding Graphics 

✓ Inserting the Date and Time 

✓ Linking and Unlinking Headers 

and Footers 

✓ Positioning Headers and Footers 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Intermediate, Section 3
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Creating Tables 

Course Overview and Learning Objectives 

This course will focus entirely on adding a table to a document. To start, students will 

learn how to add various types of tables (including custom tables, Quick Tables, and Excel 

spreadsheets) to a document. Next, students will learn how to edit and format a table. 

Finally, advanced tasks (such as sorting, using formulas, and working with delimited text) 

will be covered. 

Course Outline 

1.1. Inserting Tables 

✓ Anatomy of a Table 

✓ Inserting Tables 

✓ Drawing Tables 

✓ About the Tables Tools Tabs 

✓ Inserting a Quick Table 

✓ Adding an Excel Spreadsheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Tables 

✓ Selecting Table Data 

✓ Moving Tables 

✓ Adding and Deleting Rows and 

Columns 

✓ Resizing Rows, Columns, and 

Tables 

✓ Merging and Splitting Cells 

✓ Splitting a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Tables 

✓ Applying Table Styles 

✓ Changing Formatting Options 

✓ Formatting the Table Manually 

✓ Formatting Table Text 

✓ Changing Cell Margins and 

Spacing 

✓ Aligning a Table and its Cells 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Table Data 

✓ Sorting Table Data 

✓ Calculating Data with Formulas 

✓ Converting a Table to Tabbed 

Text 

✓ Converting Tabbed Text to a 

Table 

✓ Using the Borders and Shading 

Dialog 

✓ Using the Table Properties Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Advanced, 

Section 4
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Doing More with Text 

Course Overview and Learning Objectives 

In this course, students will delve deeper into text formatting tools with lessons on the 

Font dialog, using tabs, and applying borders and shading. 

Course Outline 

1.1. Fonts on the Home Tab 

✓ Choosing a Font Face 

✓ Changing the Font Size 

✓ Applying Font Color 

✓ Applying Highlighting 

✓ Applying Advanced Underlining 

✓ Changing Case 

✓ Applying Text Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Font Dialog 

✓ Opening the Font Dialog 

✓ Using the Font Tab 

✓ Using the Advanced Tab 

✓ Setting your Default Font 

✓ Embedding Fonts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Tabs 

✓ Types of Tabs 

✓ Using Tabs 

✓ Setting Tabs 

✓ Moving or Removing Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Paragraph Options 

✓ Indenting Using the Ruler 

✓ Indenting Using the Home Tab 

✓ Changing Paragraph Spacing 

✓ Adding Borders or Shading Using 

the Home Tab 

✓ Using the Borders and Shading 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 5
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Finishing Your Document 

Course Overview and Learning Objectives 

This course will teach students how to use themes and color, font, and effect schemes. 

Students will also learn how to perform automatic and manual mail merges, fax 

documents, and include their document as an e-mail attachment. To conclude the course, 

students will learn about other electronic distribution tools included with Word. 

Course Outline 

1.1. Making Your Document Consistent 

✓ Using Themes 

✓ Using Theme Colors 

✓ Using Theme Fonts 

✓ Using Theme Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Mail Merge Wizard 

✓ Mail Merge Basics 

✓ Starting the Wizard and Choosing 

a Document 

✓ Selecting a Starting Document 

✓ Selecting Recipients 

✓ Creating Your Document 

✓ Previewing Your Document 

✓ Completing the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Performing a Manual Mail Merge 

✓ Using the Mailings Tab 

✓ Selecting a Starting Document 

✓ Selecting and Editing Recipients 

✓ Adding Fields 

✓ Adding Rules 

✓ Previewing and Finishing the 

Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Sending a Document Electronically 

✓ Faxing a Document 

✓ E-mailing a Document as an 

Attachment 

✓ E-mailing a Document as a PDF or 

XPS Attachment 

✓ Using E-mail Features 

✓ Other Sharing Features 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Intermediate, Section 5
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Managing Documents  

Course Overview and Learning Objectives 

In this course, students will learn how to comment a document, track changes, and 

manage markup. The Compare and Combine features will also be covered. Finally, 

students will learn how to use Outline view to create and modify an outline. 

Course Outline 

1.1. Using Comments 

✓ Getting Ready 

✓ Inserting Comments 

✓ Editing Comments 

✓ Navigating Through Comments 

✓ Deleting Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Tracking Changes 

✓ Tracking Changes 

✓ Reviewing Changes 

✓ Using the Reviewing Pane 

✓ Changing the Changes that You 

See 

✓ Setting Options for Tracking 

Changes 

✓ Finishing Your Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Multiple Versions of 

Documents 

✓ Comparing Documents 

✓ Combining Documents 

✓ Showing the Source Documents 

✓ Protecting Documents 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating an Outline 

✓ Using Outline View 

✓ Using the Outlining Tab 

✓ Creating an Outline 

✓ Expanding and Collapsing 

Headings 

✓ Promoting and Demoting 

Headings 

✓ Moving Headings 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Expert, 

Section 2
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Managing Your Documents 

Course Overview and Learning Objectives 

This course will teach users how to manage their document as an individual file. Topics 

include using Windows Explorer, saving files in different formats, using different formats, 

and working with multiple files at once. As well, students will learn how to use various 

checking utilities to make sure the document is ready for the target audience. 

Course Outline 

1.1. Using Windows Explorer within 

Word 

✓ Navigating Using Windows 

Explorer 

✓ Performing Basic Tasks with 

Windows Explorer 

✓ Using Views in Windows Explorer 

✓ Using the Windows Explorer 

Navigation Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving Your Files 

✓ Managing File Properties 

✓ Using File Formats 

✓ Publishing to PDF or XPS 

✓ Setting File Passwords 

✓ Using AutoRecover 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Finishing Your Files 

✓ About Compatibility Mode 

✓ Running the Document Inspector 

✓ Using the Accessibility Checker 

✓ Marking a Document as Final 

✓ Encrypting Documents 

✓ Digitally Signing Documents 

✓ Inserting a Signature Line 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Making Word Work Backwards 

✓ Opening Documents in Other 

Word Formats 

✓ Converting Documents from 

Older Word Formats 

✓ Running the Compatibility 

Checker 

✓ Setting Compatibility Options 

✓ Compatibility Packs for Microsoft 

Office 2003 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Viewing Your Files 

✓ Opening a Copy of a Document 

✓ Arranging Windows 

✓ Comparing Documents Side-by-

Side 

✓ Splitting a Document 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Intermediate, Section 1
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Printing and Viewing Your Document  

Course Overview and Learning Objectives 

This course will cover printing and viewing tools. Page setup tasks (such as changing 

orientation, setting paper size, and customizing margins) will also be covered. 

Course Outline 

1.1. Using Layouts and Views 

✓ Using Print Layout 

✓ Using Full Screen Reading 

✓ Using Web Layout 

✓ Using Outline View 

✓ Using Draft View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basic Viewing Tools 

✓ Using Minimize, Maximize, and 

Restore 

✓ Using Zoom on the View Tab 

✓ Using View Controls on the 

Status Bar 

✓ Using the Zoom Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced View Tools 

✓ Using the Document Browser 

✓ Showing and Hiding Screen 

Elements 

✓ Using the Navigation Pane 

✓ Showing Special Characters 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Preparing Your Document 

✓ Setting Up Your Page 

✓ Setting Margins 

✓ Changing Page Orientation 

✓ Setting Paper Size 

✓ Using the Page Setup Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Printing a Document 

✓ Print Commands 

✓ Print Preview 

✓ Using Basic Print Options 

✓ Other Print Options 

✓ Setting Printer Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 6

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 659 

Starting Out  

Course Overview and Learning Objectives 

In this course, students will learn the basics of Word. Students will also learn how to 

create a basic document and how to get help in Word. 

Course Outline 

1.1. Meeting Microsoft Office Word 

2010 

✓ What is Microsoft Office Word 

2010? 

✓ What’s New in Microsoft Office 

Word 2010? 

✓ Launching Word 

✓ Interface Overview 

✓ Interacting with Word 

✓ Getting Started with Office.com 

✓ Closing Word 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a Document 

✓ Creating a New Document 

✓ Typing Text 

✓ Deleting Text 

✓ The Basics of Selecting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Navigating in Your Document 

✓ Navigating Using the Mouse 

✓ Navigating Using the Scroll Bars 

✓ Navigating Using the Keyboard 

✓ Using the Go To Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Your Document 

✓ Using Basic Formatting 

✓ Using Advanced Formatting 

✓ Using Undo and Redo/Repeat 

✓ Removing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Your Document 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in Word 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Online Help vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 1
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The Word Interface 

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and the main tabs. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the File (Backstage) Menu 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ About the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Ribbon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Home Tab 

✓ Clipboard Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Styles Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Insert Tab 

✓ Pages Commands 

✓ Tables Commands 

✓ Illustrations Commands 

✓ Links Commands 

✓ Header and Footer Commands 

✓ Text Commands 

✓ Symbols Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The View Tab 

✓ Document Views Commands 

✓ Show Commands 

✓ Zoom Commands 

✓ Window Commands 

✓ Macros Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Foundation, Section 2 
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Using Formatting Tools 

Course Overview and Learning Objectives 

In this course, students will learn how to create, use, and customize document templates. 

This course also covers itemized lists, paragraph and column formatting, and cover pages. 

Other document features such as delineation tools, watermarks, and hyperlinks round out 

this course. 

Course Outline 

1.1. Working with Templates 

✓ Creating a Template 

✓ Saving a Template 

✓ Using a Template 

✓ Editing a Template 

✓ Attaching a Template to a 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Bullets and Numbering 

✓ Types of Lists 

✓ Creating a Basic List 

✓ Creating a Multilevel List 

✓ Creating Custom Bullets or 

Numbers 

✓ Continuing a List 

✓ Removing Bullets or Numbering 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Paragraph Dialog 

✓ Applying Alignment 

✓ Applying Indentation 

✓ Applying Spacing 

✓ Setting Defaults 

✓ Sorting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Delineation Tools 

✓ Using Columns 

✓ Inserting a Line Break 

✓ Inserting a Page Break 

✓ Inserting a Section Break 

✓ Setting Page and Line Break 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Pages 

✓ Adding a Cover Page 

✓ Creating a Blank Page 

✓ Changing the Page Color 

✓ Adding a Watermark 

✓ Adding a Page Border 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Adding Hyperlinks 

✓ Types of Links 

✓ Inserting a Link 

✓ Editing a Link 

✓ Following a Link 

✓ Removing a Hyperlink 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Intermediate, Section 2
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Using Styles  

Course Overview and Learning Objectives 

In this course, students will learn all about creating, using, and managing styles. 

Course Outline 

1.1. Using the Quick Style Gallery 

✓ Understanding Styles 

✓ Applying a Style 

✓ Changing Text’s Style 

✓ Removing a Style from Text 

✓ Using the Apply Styles Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Changing Your Styles 

✓ Changing Your Style Set 

✓ Changing Your Color Scheme 

✓ Changing Your Font Scheme 

✓ Making Changes Permanent 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Styles Pane 

✓ Opening the Styles Task Pane 

✓ Using the Styles Task Pane 

✓ Applying Styles 

✓ Modifying a Style 

✓ Deleting a Style 

✓ Modifying Styles Pane Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Styles 

✓ Creating Styles from Existing 

Text 

✓ Creating Styles Using the Task 

Pane 

✓ Modifying the Quick Style Gallery 

✓ Using the Style Inspector 

✓ Managing Styles 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Expert, 

Section 1
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Using Time Saving Tools 

Course Overview and Learning Objectives 

In this course, students will learn about the language tools available in Word, including the 

spelling and grammar checker, translation tools, online research tools, and the thesaurus. 

Students will also learn how to use and control AutoCorrect; add special symbols, 

characters, and equations to a document; and enable specialized text recognition 

(formerly called SmartTags). Finally, students will learn how to use the Navigation Pane 

for document searching and management. 

Course Outline 

1.1. Using Language Tools 

✓ Setting Your Language 

✓ Using the Spelling and Grammar 

Contextual Menu 

✓ Running a Spelling and Grammar 

Check 

✓ Setting Spelling and Grammar 

Options 

✓ Controlling Hyphenation 

✓ Performing a Word Count 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Research Tools 

✓ Performing Research 

✓ Using the Thesaurus 

✓ Translating a Word 

✓ Translating an Entire Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Pre-Defined Text 

✓ AutoCorrect 

✓ Inserting the Date and Time 

✓ Inserting a Symbol 

✓ Inserting Special Characters 

✓ Inserting an Equation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Specialized Text Recognition 

✓ Enabling Text Recognition 

✓ Types of Recognized Text 

✓ Making Word Recognize 

Different Text Features 

✓ Inserting a Date 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using the Navigation Pane 

✓ Overview of the Navigation Pane 

✓ Reordering Sections with the 

Navigation Pane 

✓ Navigation Pane Views 

✓ Searching in Your Document 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: 

Intermediate, Section 4
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Working with Advanced Graphics and Objects 

Course Overview and Learning Objectives 

In this course, students will learn about six different object types. To begin, students will 

learn how to insert and use text boxes. Next, WordArt will be covered, followed by 

SmartArt. Finally, students will learn about watermarks, Building Blocks, and Quick Parts. 

Course Outline 

1.1. Inserting Text Boxes 

✓ Inserting a Pre-Defined Text Box 

✓ Drawing a Text Box 

✓ Common Text Box Editing Tasks 

✓ Formatting Text Boxes 

✓ Linking Text Boxes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Inserting WordArt 

✓ Inserting WordArt 

✓ Common WordArt Editing Tasks 

✓ Adding an Outer Border to 

WordArt 

✓ Formatting WordArt with Styles 

✓ Formatting WordArt Manually 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating SmartArt 

✓ Adding SmartArt 

✓ Adding Text 

✓ Adding Photos 

✓ Moving, Resizing, and Deleting 

SmartArt 

✓ About the SmartArt Tools Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Editing SmartArt 

✓ Changing the Layout 

✓ Changing the Color Scheme 

✓ Changing the Effects Scheme 

✓ Resetting the Graphic 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Building Blocks and Quick 

Parts 

✓ Applying Built-In Watermarks 

✓ Creating and Saving Custom 

Watermarks 

✓ Inserting Quick Parts 

✓ Using the Building Blocks 

Organizer 

✓ Saving Quick Parts 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Advanced, 

Section 3
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Working with Pictures 

Course Overview and Learning Objectives 

This course will cover everything that students need to know about adding images to a 

Word document. To begin, they will learn how to add three different types of pictures to a 

document: images from a file, Clip Art, and screenshots. Then, they will explore the 

contextual Picture Tools tab and the mini toolbar for pictures. Editing tasks (such as 

resizing, moving, cropping, and rotating), picture correction options, image arrangement 

and grouping, and picture management tools will also be covered. 

Course Outline 

1.1. Inserting Pictures 

✓ Inserting a Picture from a File 

✓ Inserting Clip Art 

✓ Adding a Screenshot 

✓ Overview of the Picture Tools – 

Format Tab 

✓ Overview of the Pictures Mini 

Toolbar 

✓ Working with Images 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Pictures 

✓ Resizing Pictures 

✓ Moving Pictures 

✓ Changing Text Wrapping 

✓ Changing Picture Position on the 

Page 

✓ Arranging Pictures 

✓ Grouping and Ungrouping 

Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Doing More with Pictures 

✓ Cropping Pictures 

✓ Advanced Cropping Tools 

✓ Rotating Pictures 

✓ Aligning and Distributing Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Pictures 

✓ Correcting Pictures 

✓ Recoloring Pictures 

✓ Applying Artistic Effects 

✓ Applying Picture Styles 

✓ Formatting Pictures Manually 

✓ Editing the Picture’s Background 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Managing Pictures 

✓ Using the Format Picture Dialog 

✓ Compressing Pictures 

✓ Changing the Picture 

✓ Resetting the Picture 

✓ Exporting Pictures 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Advanced, 

Section 1
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Working with References  

Course Overview and Learning Objectives 

In this course, Word’s referencing tools will be discussed. These tools include references, 

citations, bibliographies, tables of contents, indexes, tables of figures, and tables of 

authorities. Master and subdocuments and document links will also be covered. 

Course Outline 

1.1. Creating a Table of Contents 

✓ The ABC’s of TOC’s 

✓ Marking Text Using Heading 

Styles 

✓ Marking Text Using Outline 

Levels 

✓ Marking Text Using the 

References Tab 

✓ Inserting a Table of Contents 

✓ Updating a Table of Contents 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating References within a 

Document 

✓ Adding Footnotes and Endnotes 

to a Document 

✓ Navigating and Editing Footnotes 

and Endnotes 

✓ Formatting Footnotes and 

Endnotes 

✓ Using Bookmarks 

✓ Adding Captions 

✓ Using Cross-References 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Bibliography 

✓ Inserting Citations 

✓ Managing Sources 

✓ Choosing a Style 

✓ Inserting a Bibliography 

✓ Updating a Bibliography 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Other Reference Pages 

✓ Marking Index Entries 

✓ Creating and Updating an Index 

✓ Creating and Updating a Table of 

Figures 

✓ Creating and Updating a Table of 

Authorities 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating References to Other 

Documents 

✓ Linking to Another Document 

✓ Creating and Working with a 

Master Document 

✓ Creating and Working with 

Subdocuments 

✓ Using the Master Document 

Group 

✓ Managing Subdocuments 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Expert, 

Section 3 
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Working with Shapes 

Course Overview and Learning Objectives 

In this course, students will learn all about adding shapes to a Word document. To start, 

they will learn how to draw shapes and use the contextual Drawing Tools tab. The 

remainder of the course will focus on editing, formatting, and arranging shapes. Students 

will also learn how to add text to shapes and use the various shape-related dialogs. A brief 

discussion on the Selection Pane and Word’s guide and grid features is also included. 

Course Outline 

1.1. Drawing Shapes 

✓ Adding and Deleting Shapes 

✓ Using the Drawing Tools – 

Format Tab 

✓ Formatting Shapes with Styles 

✓ Formatting Shapes Manually 

✓ Resizing Shapes 

✓ Moving Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Shapes 

✓ Editing Shapes 

✓ Arranging Shapes 

✓ Grouping and Ungrouping Shapes 

✓ Aligning and Distributing Shapes 

✓ Rotating and Flipping Shapes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Text and Shapes 

✓ Adding Text to Shapes 

✓ Formatting Text with Styles 

✓ Formatting Text Manually 

✓ Using the Transform Command 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Advanced Shape Tasks 

✓ Using Guidelines and Grids 

✓ Using the Format Shape Dialog 

✓ Using the Format Text Effects 

Dialog 

✓ Using the Selection Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2010: Advanced, 

Section 2
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Microsoft Office 2007 Courses 

Microsoft Access 2007  

Access and Windows 

Course Overview and Learning Objectives 

Most people have experienced a computer program crash at some point, so this course 

shows students what to do when that happens and how to resolve issues with Microsoft 

Office. Students will also learn about using the Access Viewer. A gentle introduction to 

SQL wraps up the course. 

Course Outline 

1.1. Access and Windows 

✓ Recovering Access 

✓ Starting Access on Windows Boot 

✓ Using Office Diagnostics 

✓ Checking for Updates 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Access Viewer 

✓ What is the Access Viewer? 

✓ Downloading the Viewer 

✓ Using the Viewer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. An Introduction to SQL 

✓ What is SQL? 

✓ Parts of an SQL Statement 

✓ SQL Keywords 

✓ Adding Where Clauses 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Advanced, Section 4 
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Add-ons to Access 

Course Overview and Learning Objectives 

In this course, students will learn how to use COM add-ins to enhance Access’ 

functionality. Digital signatures, Smart Tags, and database analysis tools will also be 

covered. The course wraps up with a quick look at customization with the Access Options 

dialog. 

Course Outline 

1.1. COM Add-Ins 

✓ What is a COM Add-In? 

✓ Using the Add-Ins Tab 

✓ Opening the Add-In Manager 

✓ Loading Add-Ins 

✓ Using the Trust Center 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Digital Signatures 

✓ What is a Digital Signature? 

✓ Obtaining a Digital Signature 

✓ Attaching Your Signature to a 

Database 

✓ Skill Sharpener 

1.3. Smart Tags 

✓ What is a Smart Tag? 

✓ Inserting Smart Tags into a 

Database 

✓ Customizing Smart Tags 

✓ Setting Smart Tag Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Your Database 

✓ Analyzing Performance 

✓ Analyzing Tables 

✓ Viewing Object Dependencies 

✓ Splitting a Database 

✓ Database Replication 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Customizing Access 

✓ Opening the Options Dialog 

✓ Overview of the Options Dialog 

✓ Changing User Information 

✓ Setting Security Options 

✓ Making Access Work Backwards 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Expert, 

Section 1 
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Advanced Data Management 

Course Overview and Learning Objectives 

In this course, students will learn about data management through table relationships, 

normalization, and referential integrity. This course also covers switchboards as well as 

the use of modal dialog boxes. 

Course Outline 

1.1. Referential Integrity 

✓ Using the Relationships View and 

Tab 

✓ Types of Relationships 

✓ Establishing Referential Integrity 

✓ Enforcing Referential Integrity 

✓ Testing Referential Integrity 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Table Relationships 

✓ About Join Lines 

✓ Normalizing Tables 

✓ Using Cascade Delete and 

Cascade Update 

✓ Setting Fields for Indexing 

✓ Using the Index 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

 

 

1.3. Switchboards 

✓ Using a Switchboard vs. Using the 

Navigation Pane and Tab 

✓ Using the Switchboard Manager 

✓ Creating a Switchboard 

✓ Editing a Switchboard 

✓ Deleting a Switchboard 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Modal Dialog Boxes 

✓ Creating a Modal Dialog Box 

✓ Adding Controls 

✓ Setting Properties 

✓ Formatting your Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Advanced, Section 1 
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Advanced File Tasks 

Course Overview and Learning Objectives 

In this course, students will learn how to perform file management tasks using Windows 

Explorer and how to repair and back up database files. This course also covers how to 

export database information to a variety of different file formats and how to link a 

database to other files. 

Course Outline 

1.1. Using My Computer within Access 

✓ Navigating with My Computer 

✓ Performing Basic Tasks with My 

Computer 

✓ Changing Views with my 

Computer 

✓ Using the My Places Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Database Management 

✓ Compact and Repair a Database 

✓ Backing up Your Database 

✓ Editing Database Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Saving Your Files 

✓ Using the Save As Dialog 

✓ Using the Save As Menu 

✓ Using File Properties 

✓ Using AutoRecover 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exporting Files 

✓ Exporting to PDF or XPS 

✓ Exporting to Word or Excel 

✓ Exporting to Other Destinations 

✓ Using Saved Exports 

✓ Exporting to a CAB File 

✓ Exporting to Older Versions of 

Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Linking Files 

✓ Linking to an Excel Spreadsheet 

✓ Linking to Another Database 

✓ Linking to a SharePoint Site 

✓ Other Types of Linked 

Documents 

✓ Creating a Hyperlink 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Intermediate, Section 1
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Advanced Form Tasks 

Course Overview and Learning Objectives 

This course will focus on advanced things that can be done with forms. Topics will include 

the creation and use of subforms, creating advanced types of form controls, exporting a 

form, and using Microsoft Outlook and SharePoint with Access.  

Course Outline 

1.1. Using Subforms 

✓ Creating a Subform 

✓ Modifying a Subform 

✓ Working with a Subform 

✓ Synchronizing Subform Data with a Main Form 

✓ Displaying a Subform within a Main Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Form Tasks 

✓ Limiting User Access to a Form 

✓ Creating Check Boxes and Command Buttons 

✓ Creating Event Procedures 

✓ Customizing Error Messages 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Exporting Your Form 

✓ Sending a Form via E-Mail 

✓ Managing Replies 

✓ Exporting your Form to XML 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Outlook and SharePoint with Access 

✓ Creating an RSS Feed for Outlook 

✓ Importing Contacts from Outlook 

✓ Importing Contacts from a SharePoint Server 

✓ Moving your Database to a SharePoint Server 

✓ Publishing to a Web Server 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Advanced, Section 2 
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Creating a Database 

Course Overview and Learning Objectives 

In this course, students will create their first database. To begin, planning steps will be 

discussed. Then, the basics of records, tables, and formatting tools will be covered.  

Course Outline 

1.1. First Steps 

✓ Planning a Database 

✓ Creating a Database from a 

Template 

✓ Creating a Blank Database 

✓ Using Database Objects 

✓ Setting Navigation Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. About Records 

✓ What is a Record? 

✓ Navigation Tips 

✓ Adding Records 

✓ Editing Records 

✓ Deleting Records 

✓ E-Mailing Records 

✓ Printing Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Table 

✓ About Tables 

✓ Creating a Table 

✓ Entering Data into a Table 

✓ Formatting a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Text 

✓ Using the Zoom Box 

✓ Selecting Data 

✓ Cutting, Copying, and Pasting 

✓ Using the Format Painter 

✓ Using Undo and Redo 

✓ Checking your Spelling 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Foundation, Section 3
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Doing More with your Database 

Course Overview and Learning Objectives 

This course focuses on creating and using forms, queries, and reports. Techniques for 

viewing, sorting, filtering, and printing data are also covered. 

Course Outline 

1.1. Creating Forms 

✓ What is a Form? 

✓ Bound vs. Unbound Controls 

✓ Creating a Form with the Wizard 

✓ Using Design View to Modify 

Your Form 

✓ Using Forms 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Queries 

✓ What is a Query? 

✓ Creating a Query with the Wizard 

✓ Using Design View to Modify a 

Query 

✓ Using Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Reports 

✓ What is a Report? 

✓ Creating a Report with the 

Wizard 

✓ Using Design View to Modify a 

Report 

✓ Using Reports 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.4. Sorting and Filtering Data 

✓ Using Find and Replace 

✓ Sort Ascending or Descending 

✓ Toggling Filter 

✓ Using Selection Sort 

✓ Using Advanced Sort 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Viewing Data 

✓ Using the View Menu 

✓ Using the View Icons 

✓ Using the Tabs 

✓ Closing Individual Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Printing a Database Object 

✓ Using the Print Menu 

✓ Using Print Preview 

✓ Using the Print Preview Tab 

✓ Printing vs. Exporting 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Foundation, Section 4
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Getting Started 

Course Overview and Learning Objectives 

In this course, students will learn the basics of Access as well as important database 

terminology. Database security and getting help in the program will also be discussed. 

Course Outline 

1.1. Starting Out 

✓ What is Microsoft Access? 

✓ What’s New in Access 2007? 

✓ Basic Terminology 

✓ Opening Microsoft Access 

✓ Interface Overview 

✓ Closing Microsoft Access 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Getting Started Window 

✓ Overview of the Window 

✓ Navigating Through the Window 

✓ Creating a Database from a 

Template 

✓ Creating a Blank Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Trust Center 

✓ Warnings You May See when 

Opening a Database 

✓ Enabling Content 

✓ About Digital Signatures 

✓ About Trusted Locations 

✓ Opening the Trust Center 

✓ Assigning a Password to your 

Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help 

✓ Opening the Help Screen 

✓ Overview of the Help Screen 

✓ Online Help vs. Offline Help 

✓ Searching for Help 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Foundation, Section 1 
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Pivoting Data 

Course Overview and Learning Objectives 

This course will focus entirely on PivotTables and PivotCharts. We’ll discuss how to 

create, modify, and enhance both PivotTables and PivotCharts. We’ll also show students 

how to import and export their data. 

Course Outline 

1.1. Creating a PivotTable 

✓ About PivotTables 

✓ Creating a PivotTable 

✓ More about PivotTable Fields 

✓ Completing your PivotTable 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a PivotChart 

✓ About PivotCharts 

✓ Creating a PivotChart 

✓ More about PivotChart Fields 

✓ Completing Your PivotChart 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using PivotTables and PivotCharts 

✓ Using a PivotTable 

✓ Using a PivotChart 

✓ Editing a PivotTable or a PivotChart 

✓ Common PivotTable and PivotChart Editing Commands 

✓ Creating a PivotTable and PivotChart from the Same Object 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Advanced, Section 3 
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SQL and Microsoft Access 

Course Overview and Learning Objectives 

This course is all about using Structured Query Language (SQL) in Access. Students will 

learn about SQL statements, conventions, and syntax. SELECT and ORDER BY statements 

will be covered in-depth. Joins, subqueries, and SQL databases are also discussed. 

Course Outline 

1.1. Understanding SQL 

✓ What is an SQL Database? 

✓ What is an SQL Statement? 

✓ What is an SQL Convention? 

✓ What is SQL Syntax? 

✓ Linking a Database to an SQL 

Server 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the SELECT Statement 

✓ Selecting All Data 

✓ Selecting Specific Data 

✓ Selecting Conditional Data 

✓ Using the ORDER BY Statement 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Subqueries 

✓ What is a Subquery? 

✓ Creating a Subquery 

✓ Subqueries with Equality 

✓ Subqueries with Aggregate 

Functions 

✓ Nested Subqueries and Uses of 

the IN Keyword 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using SQL Joins 

✓ Creating Simple Joins 

✓ Using an Alias 

✓ Sorting Joins 

✓ Creating Outer Joins 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Expert, 

Section 4
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The New Interface 

Course Overview and Learning Objectives 

In this course, students will closely examine the new ribbon interface, including the Quick 

Access toolbar and the command tabs. 

Course Outline 

1.1. Using the Quick Access Toolbar 

✓ About the Default Buttons 

✓ Adding Buttons 

✓ Removing Buttons 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basics of Tabs 

✓ About Tabs 

✓ Opening Dialog Boxes from the 

Ribbon 

✓ About the Office Menu 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Home Tab 

✓ Views 

✓ Clipboard 

✓ Font 

✓ Rich Text 

✓ Records 

✓ Sort and Filter 

✓ Find 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Create Tab 

✓ Tables 

✓ Forms 

✓ Reports 

✓ Other 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. External Data Tab 

✓ Import 

✓ Export 

✓ Collect Data 

✓ SharePoint Lists 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Database Tools Tab 

✓ Macro 

✓ Show/Hide 

✓ Analyze 

✓ Move Data 

✓ Database Tools 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Foundation, Section 2

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 679 

Using Access to Collaborate 

Course Overview and Learning Objectives 

In this course, students will learn about using Access with Microsoft SharePoint. First, 

students will learn about SharePoint and its workspaces. Then, students will learn about 

Access-specific SharePoint tasks, such as using lists and restricting permission. The course 

will conclude with information on working with SharePoint document spaces and lists. 

Course Outline 

1.1. SharePoint Basics 

✓ What is SharePoint? 

✓ System Requirements 

✓ Creating a Workspace 

✓ Accessing a Workspace 

✓ Publishing to a Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. SharePoint Data 

✓ Using Offline Lists 

✓ Exporting a List 

✓ Restricting Permission for Data Objects 

✓ Skill Sharpener 

1.3. Your Personal SharePoint Space 

✓ Public and Private Views 

✓ Shared and Private Documents 

✓ Creating a List 

✓ Creating a Page 

✓ Personalizing your Space 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Expert, Section 3 
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Using Scripts in Access 

Course Overview and Learning Objectives 

This course will show students how to build and use macros. Finally, we will introduce 

VBA and demonstrate some of its features. We’ll also touch on error handling and macro 

groups. 

Course Outline 

1.1. Macro Basics 

✓ Creating Macros 

✓ Playing Macros 

✓ Macro Security 

✓ Deleting Macros 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Other Macro Tasks 

✓ Embedding a Macro 

✓ Assigning a Macro to a Keystroke 

✓ Assigning a Macro to an Event 

✓ Assigning a Macro to a Control 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Visual Basic and Macros 

✓ Opening the Visual Basic Editor 

✓ Adding Code to your Macro 

✓ Adding Comments to VBA Code 

✓ Declaring Variables 

✓ Prompting for User Input 

✓ Using If-Then-Else Statements 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Macro Groups 

✓ Creating a Macro Group 

✓ Running a Macro Group 

✓ Editing a Macro Group 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Expert, Section 2 
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Working with Forms 

Course Overview and Learning Objectives 

In this course, students will learn the basics of creating forms using the Wizard as well as 

from scratch. Students will also learn how to work with form controls, format their form, 

and format the form’s controls, both in appearance and functionality.  

Course Outline 

1.1. Basic Form Controls 

✓ Adding a Control 

✓ Using the Control Wizard 

✓ Cutting, Copying, Pasting, and 

Moving a Control 

✓ Formatting a Control 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Form Controls 

✓ Modifying a Control’s Properties 

✓ Changing a Control’s Data Source 

✓ Changing a Control’s Default 

Value 

✓ Creating a Calculated Control 

✓ Using Form Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Formatting Your Form 

✓ Formatting Gridlines 

✓ Modifying the Font 

✓ Adding Logos 

✓ Changing the Layout 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Formatting Controls 

✓ Changing the Color of a Control 

✓ Using Control Properties 

✓ Aligning Controls 

✓ Applying Special Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Formatting Records 

✓ Modifying Fonts 

✓ Using AutoFormat 

✓ Using the Format Tab 

✓ Using the Arrange Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Intermediate, Section 3
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Working with Queries 

Course Overview and Learning Objectives 

This course will show students how to use multiple tables in queries, create calculated 

fields, and use the Expression Builder. Finally, we will cover how to create and use 

parameter, crosstab, make-table, append, delete, and update action queries. 

Course Outline 

1.1. Basic Queries 

✓ Review of Queries 

✓ Creating a Query 

✓ Sorting a Query 

✓ Filtering a Query 

✓ Hiding Fields 

✓ Using AND OR Operators 

✓ Use of IIF Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Multiple Table Queries 

✓ Creating a Multiple Table Query 

✓ Creating a Calculated Field 

✓ Using the Expression Builder 

✓ Using Queries to Summarize 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Queries 

✓ Creating a Parameter Query 

✓ Using Parameter Queries 

✓ Creating Crosstab Queries 

✓ Using Crosstab Queries 

✓ Using Make-Table Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Management (Action) Queries 

✓ Append Queries 

✓ Delete Queries 

✓ Update Queries 

✓ Exporting Queries 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Intermediate, Section 5
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Working with Reports 

Course Overview and Learning Objectives 

In this course, students will learn how to create and use reports, including formatting 

report sections, working with calculated controls, and grouping and sorting report data. 

This course also discusses how to format reports, with topics like using AutoFormat and 

adding logos. Finally, students will learn how to add images and page numbers, and use the 

Label Wizard. 

Course Outline 

1.1. Organizing Report Data 

✓ Adding and Removing Fields 

✓ Using Report Sections 

✓ Changing Section Properties 

✓ Grouping and Sorting in a Report 

✓ Changing Group Properties 

✓ Using Calculated Controls in a Report 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Reports 

✓ Formatting Gridlines 

✓ Modifying the Font 

✓ Adding Logos 

✓ Changing the Layout 

✓ Using AutoFormat 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Common Report Tasks 

✓ Adding a Photo 

✓ Adjusting Page Properties 

✓ Adding Headers and Footers 

✓ Adding Page Numbers 

✓ Using the Label Wizard 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: Intermediate, Section 4 
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Working with Tables 

Course Overview and Learning Objectives 

This course goes deeper into table creation. Topics include field properties, how to format 

tables, how to change field data types, and how to apply various tools to control what sort 

of data is permitted in a table. This course also expands on table data entry by explaining 

how to create and use lookup fields and value lists. 

Course Outline 

1.1. Customizing Tables 

✓ Understanding Field Properties 

✓ Adding a Primary Key to a Table 

✓ Indexing a Field 

✓ Inserting, Deleting, and Moving 

Fields 

✓ Importing a Table from another 

Source 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Formatting Tables 

✓ Formatting Number Fields 

✓ Formatting Text Fields 

✓ Adding Field Descriptions 

✓ Changing Field Data Types 

✓ Adding Captions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Controlling Table Data Entry 

✓ Setting a Default Value 

✓ Setting a Required Value 

✓ Creating and Using Input Masks 

✓ Creating and Removing Table 

Relationships 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Managing Table Data Entry 

✓ Using the Table Design Tab 

✓ How to Validate Data 

✓ Creating a Lookup Field 

✓ Modifying a Lookup Field 

✓ Creating a Value List 

✓ Modifying a Value List 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Access 2007: 

Intermediate, Section 2
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Microsoft Business Contact Manager 3 

Business Contact Manager Tools 

Course Overview and Learning Objectives 

This course begins with an in-depth look at using and customizing the dashboard. 

Additional topics include the Product and Service Items List, importing and exporting 

data, marketing campaigns, and form customization. 

Course Outline 

1.1. Using the Dashboard 

✓ Opening the Dashboard 

✓ The Home Tab 

✓ The Sales Tab 

✓ The Marketing Tab 

✓ The Projects Tab 

✓ Customizing the Dashboard 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Information Management Tools 

✓ Setting up the Product and 

Service Items List 

✓ Using the Product and Service 

Items List 

✓ Importing Data 

✓ Exporting Data 

✓ Generating Reports 

✓ The Reports Window 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.3. Marketing Campaigns 

✓ Creating a Basic Campaign 

✓ Tracking Campaign Results 

✓ Creating a Campaign through 

Word 

✓ Creating a Campaign through 

Publisher 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Customizing Forms 

✓ Creating a Custom Form 

✓ Editing Lists in a Form 

✓ Editing Lists Outside a Form 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Business Contact 

Manager 3, Section 3 
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Configuring Business Contact Manager 

Course Overview and Learning Objectives 

In this course, students will learn how to install and set up Business Contact Manager. 

Then, they will learn how to use the interface, create and manage a database, and get help. 

Course Outline 

1.1. Getting Started 

✓ What is Business Contact Manager? 

✓ Installing Business Contact Manager 

✓ Using Express Setup 

✓ Using Advanced Setup 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Business Contact Manager 

✓ Using the Business Contact Manager Dashboard 

✓ Viewing Business Contact Manager Folders 

✓ Using the Business Contact Manager Menu 

✓ Using the Business Contact Manager Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Business Contact Manager Data 

✓ Creating a Database 

✓ Removing a Database 

✓ Connecting to a Shared Database 

✓ Sharing Your Database 

✓ Managing Your Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help in Business Contact Manager 

✓ About the Welcome E-Mail 

✓ Using the Dashboard Links 

✓ Using “Learn About Business Contact Manager” 

✓ Using the Help Menu 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Business Contact Manager 3, Section 1 
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Using Business Contact Manager 

Course Overview and Learning Objectives 

This course will get into managing BCM data. Students will learn how to create and 

manage accounts, business contacts, opportunities, opportunities, business projects, and 

project tasks. Communication history and linking is also covered. 

Course Outline 

1.1. Accounts 

✓ Opening the Accounts Folder 

✓ Creating New Accounts 

✓ Editing an Account 

✓ Account Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Business Contacts 

✓ Opening the Business Contacts 

Folder 

✓ Creating a Business Contact 

✓ Editing a Business Contact 

✓ Business Contact Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Opportunities 

✓ Opening the Opportunities 

Folder 

✓ Creating an Opportunity 

✓ Editing an Opportunity 

✓ Opportunity Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Business Projects and Project Tasks 

✓ Opening the Business Projects 

and Project Tasks Folders 

✓ Creating a New Project with 

Tasks 

✓ Editing Business Tasks and 

Projects 

✓ Viewing Business Tasks and 

Projects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Communications History and 

Linking 

✓ Creating a History Item 

✓ Creating a Business Note in an 

Item 

✓ Creating a Business Note Outside 

an Item 

✓ Viewing the Communication 

History Folder 

✓ Using Link to Record 

✓ Using E-mail Auto-Linking 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Business Contact 

Manager 3, Section 2 
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Microsoft Excel 2007 

Add-ins, Smart Tags, and Digital Security 

Course Overview and Learning Objectives 

This course will discuss Excel security in depth. Topics include managing add-ins, using the 

Trust Center, using Information Rights Management, and using digital signatures. The 

course wraps up with a look at Smart Tags and XML. 

Course Outline 

1.1. Add-ins and the Trust Center 

✓ What is a COM Add-in? 

✓ Add-In Management 

✓ Installing Add-ins 

✓ Using the Trust Center 

✓ Add-Ins 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Information Rights Management 

✓ What is IRM? 

✓ Requirements for IRM 

✓ Downloading and Installing the 

Rights Management Client 

Software 

✓ Using IRM 

✓ Opening an IRM Protected 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Digital Signatures 

✓ What is a Digital Signature? 

✓ Obtaining a Digital Signature 

✓ Attaching your Signature to a 

Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Smart Tags and XML 

✓ What is a Smart Tag? 

✓ Setting Smart Tag Options 

✓ Inserting Smart Tags into a 

Worksheet 

✓ Creating Custom Smart Tags 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Expert, 

Section 1

 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 689 

Advanced Excel Tasks 

Course Overview and Learning Objectives 

This course will explore a few Excel features that we find handy for everyday chores. First, 

shared workbooks will be discussed. Then, custom AutoFill lists will be discussed, followed 

by the VLOOKUP function. The course will conclude with information on linking, 

consolidating, and combining Excel data. 

Course Outline 

1.1. Creating and Using Shared Workbooks 

✓ Sharing a Workbook 

✓ Opening and Editing a Shared Workbook 

✓ Tracking Changes 

✓ Resolving Conflicts in a Shared Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Custom AutoFill Lists 

✓ What is an AutoFill List? 

✓ Creating a Custom AutoFill List 

✓ Modifying a Custom AutoFill List 

✓ Using a Custom AutoFill List 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the VLOOKUP Function 

✓ Using VLOOKUP to Find Data 

✓ How to Find an Exact Match with VLOOKUP 

✓ Finding the Closest Match with VLOOKUP 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Linking, Consolidating, and Combining Workbooks 

✓ Linking Workbooks 

✓ Consolidating Workbooks 

✓ Combining Worksheets 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Advanced, Section 4 
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Advanced File Tasks 

Course Overview and Learning Objectives 

This course teaches students how to use the Open and Save dialogs to create new files 

and folders. It also covers file types that are compatible with Excel, how to work with 

older file formats, and how to create and use templates. 

Course Outline 

1.1. Using My Computer within Excel 

✓ Using the My Places Toolbar 

✓ Navigating with My Computer 

✓ Performing Basic Tasks with My Computer 

✓ Changing Views 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving your Files 

✓ File Formats 

✓ File Properties 

✓ AutoRecover 

✓ Upgrading a Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Templates 

✓ Opening a Template 

✓ Downloading a Template 

✓ Using a Template 

✓ Creating a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Intermediate, Section 1 
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Advanced Topics 

Course Overview and Learning Objectives 

In this course, students will learn how to use the Excel Options dialog, use Windows tools 

with Excel, and use the Excel Viewer. 

Course Outline 

1.1. Setting Excel Options 

✓ Changing Your User Name 

✓ Changing your Default Font 

✓ Changing Your Default File Format 

✓ Setting Formula Options 

✓ Changing the Appearance of Your Excel Interface 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Excel and Windows 

✓ Searching for Documents 

✓ Using Office Diagnostics 

✓ Checking for Updates 

✓ Starting Excel Automatically when Windows Boots 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Excel Viewer 

✓ What is the Excel Viewer? 

✓ Downloading the Excel Viewer 

✓ Using Excel Viewer 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Advanced, Section 1 
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Editing Your Workbook 

Course Overview and Learning Objectives 

This course will teach students how to make Excel do more than just display black and 

white data. Students will learn how to modify cells and cell data, perform a number of cell 

formatting operations, and use styles and borders. Students will also get a comprehensive 

introduction to creating and modifying different types of charts.  

Course Outline 

1.1. Modifying Cells and Data 

✓ Changing the Size of Rows or 

Columns 

✓ Adjusting Cell Alignment 

✓ Rotating Text 

✓ Creating Custom Number and 

Date Formats 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Cell Formatting 

✓ Conditional Formatting 

✓ The Format Painter 

✓ Cell Merging and AutoFit 

✓ Find and Replace Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Enhancing a Worksheet’s 

Appearance 

✓ Adding Patterns and Colors 

✓ Adding Borders 

✓ Working with Styles 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Working With Charts, Part 1 

✓ Creating a Chart 

✓ Formatting a Chart 

✓ Modifying Charts with the Layout 

Tab 

✓ Manipulating a Chart 

✓ Enhancing a Chart with Shapes 

and Graphics 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Charts, Part 2 

✓ Changing the Type of Chart 

✓ Changing the Source Data 

✓ Working with the Chart Axis and 

Data Series 

✓ Saving a Chart as a Template 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Foundation, Section 4
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Enhancing your Workbook 

Course Overview and Learning Objectives 

In this course, students will learn how to add shapes, SmartArt, text boxes, WordArt, 

ClipArt, and objects to their workbooks. 

Course Outline 

1.1. Customizing your Workbook 

✓ Inserting a Symbol or Special 

Character 

✓ Adding and Editing Shapes 

✓ Creating and Altering Diagrams 

✓ Changing the Diagram Type 

✓ Incorporating Text 

✓ Adding a Signature Line 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Text Boxes 

✓ Adding a Text Box 

✓ Selecting a Text Box 

✓ Manipulating a Text Box 

✓ Formatting a Text Box 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. WordArt 

✓ Adding WordArt to your 

Spreadsheet 

✓ Changing the Font Color 

✓ Changing the Outline Color 

✓ Adding Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. ClipArt 

✓ Finding ClipArt 

✓ Inserting ClipArt 

✓ Manipulating ClipArt 

✓ Inserting a Photographic Image 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Objects 

✓ Creating New Embedded Objects 

✓ Embedding Existing Files 

✓ Editing Embedded Objects 

✓ Embedding Parts of Files 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Intermediate, Section 4
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Excel and the Internet 

Course Overview and Learning Objectives 

In this course, students will learn about creating and using hyperlinks in Excel, saving 

workbooks (and various parts thereof) as a web page, and using web queries. A look at 

document management servers and Excel Services wraps up the course. 

Course Outline 

1.1. Excel and Hyperlinks 

✓ What is a Hyperlink? 

✓ Inserting Hyperlinks 

✓ Modifying Hyperlinks 

✓ Using Hyperlinks in Excel 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving Workbooks as Web Pages 

✓ HTM and MHTML Files 

✓ Saving a Workbook as a Web Page 

✓ Saving a Worksheet as a Web Page 

✓ Saving a Chart as a Web Page 

✓ Saving a Range as a Web Page 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Getting Data from the Internet 

✓ Importing from an External Data Source 

✓ Creating a Web Query 

✓ Saving a Web Query 

✓ Refreshing a Web Query 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Excel and Office Servers 

✓ Publishing to a Document Server 

✓ Saving to a Document Management Server 

✓ Using Excel with Excel Services 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Advanced, Section 3 
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Excel Basics 

Course Overview and Learning Objectives 

This course will teach students how to perform day-to-day tasks in Excel. Topics include 

creating worksheet labels; printing; using features like AutoSum, AutoFill, Smart Tags, and 

option buttons; and performing the ubiquitous Cut/Copy/Paste operations. Students will 

also be given a gentle introduction to using formulae, using Paste Special, dealing with 

advanced paste operations, performing Find and Replace operations, and checking their 

spelling.  

Course Outline 

1.1. Working With Excel 2007 

✓ Columns, Rows, Cells, and Ranges 

✓ Creating Worksheet Labels 

✓ Entering and Deleting Data 

✓ Printing Your Worksheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basic Excel Features 

✓ What is AutoFill? 

✓ What is AutoSum? 

✓ What is AutoComplete? 

✓ Working with Basic Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Moving your Data 

✓ Dragging and Dropping Cells 

✓ How to Cut, Copy, and Paste 

Cells 

✓ How to Cut, Copy, and Paste 

Multiple Cells and Items 

✓ How to Use Paste Special 

✓ How to Insert and Delete Cells, 

Rows, and Columns 

✓ Using Undo, Redo, and Repeat 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Smart Tags and Option Buttons 

✓ What Are Smart Tags? 

✓ Setting Smart Tag Options 

✓ The Error Option Button 

✓ The AutoFill Option Button 

✓ The Paste Option Button 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Editing Tools 

✓ Using AutoCorrect 

✓ Using Spell Check 

✓ Using Find and Replace 

✓ Adding Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Foundation, Section 3
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Expert Topics 

Course Overview and Learning Objectives 

This course will discuss a number of features useful for Excel power users. Students will 

learn how to create a form in an Excel workbook, use advanced financial and logical 

functions, and use SharePoint with Excel. 

Course Outline 

1.1. Form Controls 

✓ What is a Form Control? 

✓ Adding a Control to a Worksheet 

✓ Assigning a Macro to a Control 

✓ Using Form Controls 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Functions 

✓ Using Financial Functions (PMT 

and FV) 

✓ Understanding Logical Functions 

✓ Applying Logical Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using SharePoint 

✓ Creating a Document Workspace 

✓ Accessing a Workspace 

✓ Publishing to a Document 

Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. User Forms and ActiveX Controls 

✓ Creating a Blank User Form 

✓ Adding Controls to the Form 

✓ Adding Buttons and VBA Code 

✓ Starting the User Form with a 

Macro 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Expert, 

Section 3
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Finalizing Your Workbook 

Course Overview and Learning Objectives 

This course will discuss the file management tools and checkers that are used to scan 

workbooks for personal information and compatibility issues. Students will also learn how 

to use Microsoft Excel with Microsoft Word and Access. 

Course Outline 

1.1. Protecting your Workbook 

✓ Protecting your Workbook 

✓ Protecting your Worksheets 

✓ Unlocking Cells 

✓ Protecting your Excel Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Finishing Your Workbook 

✓ Using the Document Inspector 

✓ Using the Compatibility Checker 

✓ Marking a Workbook as Final 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Excel in Word 

✓ Inserting Excel Data in Word 

✓ Linking Excel Data in a Word 

Document 

✓ Modifying Excel Data after 

Insertion 

✓ Insert an Excel Chart into a Word 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Excel and Access 

✓ Linking an Excel Workbook to an 

Access Database 

✓ Importing Table, PivotTable, and 

PivotChart Data from Access 

✓ Transforming an Excel Workbook 

into an Access Database 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Excel With other Programs 

and Files 

✓ Using Outlook to Send Excel Data 

✓ Opening an Excel File in a 

Different Format 

✓ Importing Data from a Text File 

✓ Importing Data from External 

Data Sources 

✓ Publishing a Workbook as a PDF 

File 

✓ Faxing a Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Intermediate, Section 5 
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Getting Started 

Course Overview and Learning Objectives 

This course teaches students everything they need to know about opening, interacting 

with, and closing Excel. As well, students will learn about workbooks, worksheets, file 

types, and how to navigate around a spreadsheet. The Help feature is also covered in 

detail. 

Course Outline 

1.1. Starting Out 

✓ What is Microsoft Excel 2007? 

✓ Opening Microsoft Excel 

✓ Interacting with Excel 

✓ Closing Excel 

✓ Step-By-Step 

1.2. About Workbooks 

✓ Creating a New Workbook 

✓ Opening a Workbook 

✓ Saving a Workbook 

✓ About Excel File Types 

✓ Closing a Workbook 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Exploring your Workbook 

✓ Using Worksheets 

✓ The Active Cell 

✓ Selecting Cells 

✓ Exploring a Worksheet 

✓ The Zoom Feature 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help in Excel 2007 

✓ Using the Help Screen 

✓ About Online Help 

✓ About Offline Help 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Foundation, Section 1 
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Getting the Most From Your Data 

Course Overview and Learning Objectives 

To begin this course, students will learn about Excel’s automatic grouping, outlining, and 

subtotaling features. Students will also explore the Scenario Manager, one and two data 

input tables, Goal Seek, Solver, and PivotTables.  

Course Outline 

1.1. Getting the Most from Your Data 

✓ Using Automatic Outlining 

✓ Displaying and Collapsing Levels 

✓ Grouping Data Manually 

✓ Creating Subtotals 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. PivotTables 

✓ What is a PivotTable? 

✓ Creating a PivotTable 

✓ Creating a PivotTable Frame 

✓ Specifying PivotTable Data 

✓ Rearranging PivotTable Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. More About PivotTables 

✓ Modifying PivotTable 

Calculations 

✓ Formatting a PivotTable 

✓ Refreshing a PivotTable 

✓ Charting a PivotTable 

✓ Creating a PivotTable Based on 

External Data 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Exploring Scenarios 

✓ What is a Scenario? 

✓ Creating a Scenario 

✓ Creating a Scenario Summary 

Report 

✓ Saving Multiple Scenarios 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. What If Analysis 

✓ Using a One and Two Input Data 

Table 

✓ Using Goal Seek 

✓ Using Solver 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Advanced, 

Section 2 
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Macros, VBA, and Excel Programming 

Course Overview and Learning Objectives 

This course will explore how to automate Excel tasks with macros. We will cover 

recording, running, and editing both basic and relative reference macros. Information on 

assigning a keyboard shortcut to a macro and managing macro security is also included. 

Then, Visual Basic tasks will be covered, including copying macros, using the Visual Basic 

Editor, declaring variables, iterating over a range, prompting for user input, and using 

conditional (If…Then…Else) statements. 

Course Outline 

1.1. Macros 

✓ Recording Macros 

✓ Playing a Macro 

✓ Macro Security 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. More Macro Tasks 

✓ Recording a Relative Reference Macro 

✓ Running a Relative Reference Macro 

✓ Assigning a Keystroke to a Macro 

✓ Copying a Macro from a Workbook or Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Visual Basic and Macros 

✓ Opening the Visual Basic Editor 

✓ Adding Code to your Macro 

✓ Adding Comments to VBA Code 

✓ Declaring Variables 

✓ Prompting for User Input 

✓ Iteration over a Range 

✓ Using If-Then-Else Statements 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Expert, Section 2 
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Managing Tables 

Course Overview and Learning Objectives 

Tables are an important part of Excel because they inherently contain a lot of useful 

functionality, including sorting and filtering. This course teaches students how to add and 

edit tables, edit table information, perform sort and filter operations, and even how to use 

Excel as a database. 

Course Outline 

1.1. Working with Tables 

✓ What is a Table? 

✓ Creating Tables 

✓ Modifying Tables 

✓ What is the Total Row? 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Records and Fields 

✓ What are Records and Fields? 

✓ Adding Fields by Inserting 

Columns 

✓ Adding Records by Inserting 

Rows 

✓ Quickly Adding Records to a Data 

table 

✓ Deleting Records or Fields 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Tables and Filters 

✓ Sorting Data in a Table 

✓ What is an AutoFilter? 

✓ Custom AutoFilters 

✓ Using an Advanced Filter 

✓ Copying Filtered Records 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Excel as a Database 

✓ Filtering with Wildcard 

Characters 

✓ Validating Your Data 

✓ What are Database Functions? 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Intermediate, Section 3
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Printing and Viewing your Workbook 

Course Overview and Learning Objectives 

This course will help students display their data in different ways. Topics include an in-

depth examination of the View tab, how to work with multiple windows and workbooks at 

once, and how to print a worksheet.  

Course Outline 

1.1. Using the View Tab 

✓ Using Normal View 

✓ Using Full Screen View 

✓ Using Page Layout View 

✓ Page Break Preview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing a Single Window 

✓ Creating a New Window 

✓ Hiding a Window 

✓ Unhiding a Window 

✓ Freezing a Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Managing Multiple Windows 

✓ Switching Between Open Workbooks 

✓ Arranging Workbooks 

✓ Comparing Workbooks Side by Side 

✓ Synchronous Scrolling, Resetting a Window, and Saving a Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Printing your Workbook 

✓ Opening Print Preview 

✓ Using the Print Preview Tab 

✓ Quick Printing 

✓ The Print Dialog 

✓ Using Page Setup 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: Foundation, Section 2 
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The New Interface 

Course Overview and Learning Objectives 

In order to get the most out of Excel, students need to know where to find commands. This 

course covers the basics of the Quick Access toolbar and the basics of the Home, Insert, 

Page Layout, Formulas, Data, and Review tabs. A high-level overview of each tab and its 

associated command groups is included, along with exercises that experiment with some 

of these commands. 

Course Outline 

1.1. The Quick Access Toolbar 

✓ The Default Buttons 

✓ Adding Buttons 

✓ Removing Buttons 

✓ Customizing the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Home Tab 

✓ Clipboard 

✓ Font 

✓ Alignment 

✓ Number 

✓ Style 

✓ Cells 

✓ Editing 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Insert Tab 

✓ Tables 

✓ Charts 

✓ Illustrations 

✓ Shapes 

✓ Links 

✓ Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Page Layout Tab 

✓ Themes 

✓ Page Setup 

✓ Scale to Fit 

✓ Sheet Options 

✓ Arrange 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Formulas Tab 

✓ The Function Library 

✓ Defined Names 

✓ Formula Auditing 

✓ Calculation 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The Data Tab 

✓ Get External Data 

✓ Connections 

✓ Sort and Filter 

✓ Data Tools 

✓ Outline 

✓ Step-By-Step 

✓ Skill Sharpener 

1.7. The Review Tab 

✓ Proofing 

✓ Comments 

✓ Changes 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Foundation, Section 2
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Working with Functions and Formulas 

Course Overview and Learning Objectives 

In this course, students will learn how to properly reference cells, use mathematical 

operators, and check their formulas for errors. This course also covers how to browse, 

insert, and use functions to perform complex mathematical operations. Students will also 

learn how to use the IF function, use nested functions to perform multiple operations, and 

define and use range names. Finally, array formulas will be discussed. 

Course Outline 

1.1. Using Formulas in Excel 

✓ Understanding Relative and 

Absolute Cell References 

✓ Basic Mathematical Operators 

✓ Using Formulas with Multiple Cell 

References 

✓ The Formula Auditing Buttons 

✓ Fixing Formula Errors 

✓ Displaying and Printing Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Exploring Excel Functions 

✓ What are Functions? 

✓ Finding the Right Function 

✓ Some Useful and Simple 

Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Functions in Excel 

✓ Inserting Functions 

✓ Using Functions and AutoFill to 

Perform Difficult Calculations 

✓ Using the IF Function 

✓ Working with Nested Functions 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Names and Ranges 

✓ What Are Range Names? 

✓ Defining and Using Range Names 

✓ Selecting Nonadjacent Ranges 

✓ Using AutoCalculate 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Array Formulas 

✓ What are Array Formulas? 

✓ Using Basic Array Formulas 

✓ Using Functions with Array 

Formulas 

✓ Using the IF function in Array 

Formulas 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Excel 2007: 

Intermediate, Section 2 
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Microsoft OneNote 2007  

Advanced OneNote Features 

Course Overview and Learning Objectives 

Students will begin this course by learning how to use the OneNote Options dialog. Then, 

they will learn how to export, back up, sync, and share notebooks. 

Course Outline 

1.1. Setting OneNote Options 

✓ Opening the Options Dialog 

✓ Overview of the Options Dialog 

✓ Removing OneNote’s E-mail 

Signature 

✓ Setting Audio and Video Devices 

✓ Setting Backup Options 

✓ Configuring Password Protection 

✓ Installing OneNote Mobile 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced File Options 

✓ Publishing as PDF or XPS 

✓ Restoring a Backup 

✓ Syncing Notebooks 

✓ Sending Notes via E-mail 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Sharing a Notebook 

✓ About the Share Menu 

✓ Creating a Shared Notebook 

✓ Sending a Shared Notebook 

✓ Stop Sharing Notebooks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using a Live Sharing Session 

✓ Starting a Live Session 

✓ Joining a Session 

✓ Leaving a Session 

✓ Viewing Session Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: 

Complete, Section 6
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Creating Notes 

Course Overview and Learning Objectives 

This course is all about creating data in a notebook. First, students will learn how to create 

pages, subpages, and side notes. Then, students will learn how to add screen clippings, 

audio recordings, videos, pictures, files, program data, tables, and Outlook information to 

their notebook. Handwriting tools are also covered. 

Course Outline 

1.1. Creating Basic Notes 

✓ Creating a Page 

✓ Creating a Subpage 

✓ Creating a Side Note 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating Advanced Notes 

✓ Adding a Screen Clipping 

✓ Adding an Audio Recording 

✓ Adding a Video Recording 

✓ Adding Pictures 

✓ Adding Files 

✓ Sending To OneNote 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating Outlook Items 

✓ Adding Outlook Meeting Details 

✓ Creating an Outlook 

Appointment 

✓ Creating an Outlook Meeting 

✓ Creating an Outlook Contact 

✓ Creating an Outlook Task 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working With Writing Tools 

✓ Using Pen Mode 

✓ Using OneNote Pens to Add Text 

✓ Using the Eraser 

✓ Using Lasso 

✓ Converting Handwriting to Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating Tables 

✓ Creating a Table 

✓ Selecting a Table, Cells, Rows, or 

Columns 

✓ Adding Rows or Columns 

✓ Deleting Rows or Columns 

✓ Resizing a Table 

✓ Moving a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: 

Complete, Section 2
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Editing Notes 

Course Overview and Learning Objectives 

This course will explore how to manage OneNote data. First, basic commands (such as 

select, cut, copy, paste, move, and resize) are covered. Then, editing and language tools 

(including spellcheck, the Research pane, and the find feature) are covered. The course 

concludes with information on organizing data using lists and tags. 

Course Outline 

1.1. Working With Notes as Objects 

✓ Selecting Objects 

✓ Using Cut, Copy, and Paste 

✓ Using the Order Commands 

✓ Moving an Object 

✓ Resizing an Object 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Tools 

✓ Using AutoCorrect 

✓ Using Spell Check 

✓ Using the Font Task Pane 

✓ Tagging Notes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Language Tools 

✓ Setting Your Language 

✓ Using the Research Pane 

✓ Using the Find Tool 

✓ Modifying Find Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Organizing Data 

✓ Using Bullets and Numbers 

✓ Creating Lists 

✓ Using Levels 

✓ Customizing Tags 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: 

Complete, Section 3 
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Getting Started 

Course Overview and Learning Objectives 

In this course, students will be introduced to OneNote 2007 and its interface. They will 

also learn how to use the notification icon and get help. 

Course Outline 

1.1. Starting Out 

✓ What is OneNote? 

✓ What’s New in OneNote 2007? 

✓ Opening OneNote 

✓ Interface Overview 

✓ Closing OneNote 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. About the OneNote Notification Icon 

✓ Icon Overview 

✓ Disabling the Icon 

✓ Enabling the Icon 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Interacting With OneNote 

✓ Using Menus 

✓ Using the Standard Toolbar 

✓ Using the Formatting Toolbar 

✓ Using Notebook Tabs 

✓ Using Page Tabs 

✓ Using the Navigation Bar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Getting Help in OneNote 

✓ Using the Help Menu 

✓ Using the Help Screen 

✓ Searching For Help 

✓ Step-By-Step 

✓ Skill Sharpener 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: Complete, Section 1 
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Organizing, Printing, and Viewing Your Notebook 

Course Overview and Learning Objectives 

In this course, students will learn how to sort through pages, customize the OneNote 

interface, manage windows, use Page Setup, use Print Preview, and print notes. 

Course Outline 

1.1. Using the View Menu 

✓ Sorting Pages 

✓ Using Full Page View 

✓ Showing and Hiding Toolbars 

✓ Showing and Hiding the Task 

Pane 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Managing Windows 

✓ Creating a New Window 

✓ Creating a Side Note Window 

✓ Switching Between Open 

Notebooks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Page Setup 

✓ Opening the Page Setup Task 

Pane 

✓ Using the Paper Size Section 

✓ Setting Print Margins and Rule 

Lines 

✓ Setting Page Color and Title 

✓ Setting the Page Background 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Print Preview 

✓ Opening Print Preview 

✓ Using Print Preview 

✓ Modifying Print Options 

✓ Navigating Print Preview 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Printing Notes 

✓ Printing Commands 

✓ Using the Print Dialog 

✓ Setting Print Preferences 

✓ Printing a Selection 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: 

Complete, Section 5
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Working With Notes 

Course Overview and Learning Objectives 

In this course, students will learn about page templates and how to set up pages in their 

notebook. The course also teaches students how to work with sections and manage 

notebooks, 

Course Outline 

1.1. Using Stationery & Templates 

✓ Applying Stationery 

✓ Opening a Template 

✓ Using a Template 

✓ Setting the Default Template 

✓ Saving the Current Page as a 

Template 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with Sections, Part 1 

✓ Creating a Section 

✓ Renaming a Section 

✓ Deleting a Section 

✓ Moving a Section 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Sections, Part 2 

✓ Saving Sections 

✓ Changing a Section’s Color 

✓ Adding a Password to a Section 

✓ Using Section Groups 

✓ Using the Unfiled Notes Section 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. About Notebooks 

✓ Creating a Notebook 

✓ Changing a Notebook’s Color 

✓ Opening a Notebook 

✓ Saving a Notebook 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft OneNote 2007: 

Complete, Section 4
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Microsoft Word 2007  

Advanced Tabs 

Course Overview and Learning Objectives 

In this course, students will learn about the more advanced tabs in Word. Contextual tabs 

will also be covered. 

Course Outline 

1.1. The Page Layout Tab 

✓ Themes Commands 

✓ Page Setup Commands 

✓ Page Background Commands 

✓ Paragraph Commands 

✓ Arrange Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The References Tab 

✓ Table of Contents Commands 

✓ Footnotes and Endnotes 

Commands 

✓ Citations and Bibliography 

Commands 

✓ Captions Commands 

✓ Index Commands 

✓ Table of Authorities Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. The Mailings Tab 

✓ Create Commands 

✓ Start Mail Merge 

✓ Write and Insert Fields 

✓ Preview Results 

✓ Finish the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Review Tab 

✓ Proofing Tools 

✓ Comments Commands 

✓ Tracking Commands 

✓ Changes Commands 

✓ Compare Commands 

✓ Protect Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Contextual Tabs 

✓ WordArt Tools 

✓ Text Box Tools 

✓ Equation Tools 

✓ SmartArt Tools 

✓ Table Tools 

✓ Chart Tools 

✓ Picture Tools 

✓ Header and Footer Tools 

✓ Developer Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Foundation, Section 3 
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Advanced Topics 

Course Overview and Learning Objectives 

This course will cover a variety of topics useful for Microsoft Word power users, including 

using the Word Options dialog, protecting documents with Information Rights 

Management, and optimizing Word with Windows tools. 

Course Outline 

1.1. Modifying Basic Word Options 

✓ Opening the Options Dialog 

✓ Using the Options Dialog 

✓ Changing Your User Name 

✓ Changing Word’s Color Scheme 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Modifying Advanced Word Options 

✓ Controlling Display Options 

✓ Setting Spelling Options 

✓ Setting AutoRecover Options 

✓ Customizing the Recent Documents List 

✓ Controlling Paste Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Information Rights Management 

✓ System Requirements 

✓ Installing Information Rights Management Client Software 

✓ Using Information Rights Management 

✓ Viewing a Document Protected by Information Rights Management 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Word and Windows 

✓ Starting Word on Windows Boot 

✓ Using Office Diagnostics 

✓ Checking for Office Updates 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, Section 6 
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Creating Documents 

Course Overview and Learning Objectives 

This course will explore different methods for creating a document, as well as basic text 

editing and formatting tools. 

Course Outline 

1.1. Creating a New Document 

✓ Creating a Blank Document 

✓ Creating a Document from Local Templates 

✓ Creating a Document from Online Templates 

✓ Creating Documents from an Existing Document 

✓ Using the Recently Used Templates Area 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Selecting Text 

✓ Selecting Text with the Mouse 

✓ Selecting Text with the Keyboard 

✓ Selecting Text and Objects with the Home Tab 

✓ Tips and Tricks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Moving Text 

✓ Cutting, Copying, and Pasting Text 

✓ Using the Office Clipboard 

✓ Dragging and Dropping Text 

✓ Finding Text 

✓ Replacing Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Applying Advanced Text Effects 

✓ Using the Format Painter 

✓ Adding Drop Caps 

✓ Applying a Quick Style 

✓ Aligning and Justifying Text 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Foundation, Section 4 
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Creating Forms and Using Macros 

Course Overview and Learning Objectives 

This course will show students how to create, modify, and distribute a form using Word 

2007. Students will also learn how to create and use macros. 

Course Outline 

1.1. Creating Forms 

✓ Using the Developer Tab 

✓ Creating a Form 

✓ Inserting Controls 

✓ Modifying Control Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Finishing Forms 

✓ Grouping Controls 

✓ Protecting a Form 

✓ Testing a Form 

✓ Distributing a Form 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced Forms Tasks 

✓ Using Legacy Controls 

✓ Using ActiveX Controls 

✓ Assigning Help to a Form Field 

✓ Using Multiple Sections 

✓ Step-By-Step 

✓ Skill Sharpener 

 

1.4. Macros 

✓ Setting Macro Security 

✓ Recording a Macro 

✓ Running a Macro 

✓ Editing a Macro’s Code Using the 

Visual Basic Editor 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Advanced Macro Tasks 

✓ Copying a Macro from a Template 

✓ Assigning a Macro to a Keystroke 

✓ Assigning a Macro to a Quick 

Access Toolbar Button 

✓ About Macro Names 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Expert, 

Section 1 
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Creating Headers and Footers 

Course Overview and Learning Objectives 

This course covers how to use headers and footers. Students will learn how to add, edit, 

and customize headers and footers. Additionally, this course discusses how to use page 

numbering, insert the date and time, and use section breaks with headers and footers. 

Course Outline 

1.1. Creating Basic Headers and Footers 

✓ Using a Preset Header or Footer 

✓ Editing a Header or a Footer 

✓ Adding a Header or Footer to the 

Gallery 

✓ Navigating Through Headers and 

Footers 

✓ Removing a Header or a Footer 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Header and Footer Tools 

Design Tab 

✓ Header and Footer Tools 

✓ Insert Commands 

✓ Navigation Commands 

✓ Header and Footer Options 

✓ Position Options 

✓ Closing Header and Footer View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Inserting Page Numbers 

✓ Inserting Page Numbers 

✓ Changing Page Numbers 

✓ Formatting Page Numbers 

✓ Removing Page Numbers 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Headers and 

Footers 

✓ Aligning Text 

✓ Adding Graphics 

✓ Inserting the Date and Time 

✓ Linking and Unlinking Headers 

and Footers 

✓ Positioning Headers and Footers 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Intermediate, Section 3 
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Doing More with Tables 

Course Overview and Learning Objectives 

This course begins with a look at advanced table tasks, including sorting, using formulas, 

working with delimited text, and creating Excel spreadsheets inside Word. Then, students 

will learn how to create equations and charts to display data. 

Course Outline 

1.1. Advanced Table Tasks 

✓ Sorting Table Data 

✓ Converting a Table to Tabbed Text 

✓ Converting Tabbed Text to a Table 

✓ Creating an Excel Spreadsheet 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Advanced Data Tasks 

✓ Using Formulas 

✓ Inserting Equations 

✓ Using the Equation Tools Tab 

✓ Saving an Equation to the Gallery 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Chart Tools 

✓ Inserting a Basic Chart 

✓ Using the Chart Tools Design Tab 

✓ Using the Chart Tools Layout Tab 

✓ Using the Chart Tools Format Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Working with Charts 

✓ Creating a Chart from an Existing Table 

✓ Analyzing Chart Data 

✓ Using the Format Chart Dialogs 

✓ Adding Captions 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, Section 4 
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Doing More with Text 

Course Overview and Learning Objectives 

In this course, students will delve deeper into text formatting tools with lessons on the 

Font dialog, using tabs, and applying borders and shading. 

Course Outline 

1.1. Fonts on the Home Tab 

✓ Choosing a Font Type 

✓ Changing the Font Size 

✓ Applying Font Color 

✓ Applying Highlighting 

✓ Applying Advanced Underlining 

✓ Changing Case 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Font Dialog 

✓ Opening the Font Dialog 

✓ Using the Font Tab 

✓ Using the Character Spacing Tab 

✓ Setting your Default Font 

✓ Embedding Fonts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using Tabs 

✓ Types of Tabs 

✓ Using Tabs 

✓ Setting Tabs 

✓ Moving or Removing Tabs 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Paragraph Options 

✓ Indenting Using the Ruler 

✓ Indenting Using the Home Tab 

✓ Changing Paragraph Spacing 

✓ Adding Borders or Shading Using 

the Home Tab 

✓ Using the Borders and Shading 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Foundation, Section 5 
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Expert Topics 

Course Overview and Learning Objectives 

This course will cover SharePoint workspaces, blogging tools, and using XML in Word. 

Course Outline 

1.1. Working with SharePoint Server 

✓ What is SharePoint? 

✓ System Requirements 

✓ Creating a Workspace 

✓ Accessing a Workspace 

✓ Publishing to a Workspace 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Publishing to Other Places 

✓ Publishing to Document Management Servers 

✓ Creating a Blog Post 

✓ Using Blogging Tools 

✓ Publishing a Blog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with XML 

✓ An XML Primer 

✓ About the New XML File Type 

✓ Opening the XML Structure Task Pane 

✓ Applying an XML Schema to a Document 

✓ The Power of XML 

✓ Using the Schema Library 

✓ Creating a Custom Smart Tag 

✓ Step-By-Step 

✓ Skill Sharpener 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Expert, Section 4 
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Finishing Your Document 

Course Overview and Learning Objectives 

This course will teach students how to use themes and color, font, and effect schemes. 

Students will also learn how to perform automatic and manual mail merges, fax 

documents, and include their document as an e-mail attachment.  

Course Outline 

1.1. Making Your Document Consistent 

✓ Using Themes 

✓ Using Theme Colors 

✓ Using Theme Fonts 

✓ Using Theme Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using the Mail Merge Wizard 

✓ Mail Merge Basics 

✓ Starting the Wizard and Choosing 

a Document 

✓ Selecting a Starting Document 

✓ Selecting Recipients 

✓ Creating Your Document 

✓ Previewing Your Document 

✓ Completing the Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Performing a Manual Mail Merge 

✓ Using the Mailings Tab 

✓ Selecting a Starting Document 

✓ Selecting and Editing Recipients 

✓ Adding Fields 

✓ Adding Rules 

✓ Previewing and Finishing the 

Merge 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Sending a Document Electronically 

✓ Faxing a Document 

✓ E-Mailing a Document as an 

Attachment 

✓ E-Mailing a Document as a PDF 

or XPS Attachment 

✓ Using E-Mail Features 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Intermediate, Section 5 
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Managing Documents 

Course Overview and Learning Objectives 

In this course, students will learn how to comment a document, track changes, and 

manage markup. The Compare and Combine features will also be covered. Finally, 

students will learn how to use Outline view to create and modify an outline. 

Course Outline 

1.1. Using Comments 

✓ Getting Ready 

✓ Inserting Comments 

✓ Editing Comments 

✓ Navigating Through Comments 

✓ Deleting Comments 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Tracking Changes 

✓ Tracking Changes 

✓ Reviewing Changes 

✓ Using the Reviewing Pane 

✓ Changing the Changes that You 

See 

✓ Setting Options for Tracking 

Changes 

✓ Finishing Your Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with Multiple Versions of 

Documents 

✓ Comparing Documents 

✓ Combining Documents 

✓ Showing the Source Documents 

✓ Protecting Documents 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating an Outline 

✓ Using Outline View 

✓ Using the Outlining Tab 

✓ Creating an Outline 

✓ Expanding and Collapsing 

Headings 

✓ Promoting and Demoting 

Headings 

✓ Moving Headings 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Expert, 

Section 2 
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Managing Your Documents 

Course Overview and Learning Objectives 

This course will teach users how to manage their document as an individual file. Topics 

include using Windows Explorer, saving files in different formats, using different formats, 

and working with multiple files at once. As well, students will learn how to use various 

checking utilities to make sure the document is ready for the target audience. 

Course Outline 

1.1. Using My Computer within Word 

✓ Navigating Using My Computer 

✓ Performing Basic Tasks with My 

Computer 

✓ Using Views in My Computer 

✓ Using the My Places Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Saving Your Files 

✓ Using File Formats 

✓ Publishing to PDF or XPS 

✓ Setting File Passwords 

✓ Using AutoRecovery 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Finishing Your Files 

✓ Using File Properties 

✓ Running the Document Inspector 

✓ Marking a Document as Final 

✓ Encrypting Your Documents 

✓ Digitally Signing Your Documents 

✓ Inserting a Signature Line 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Viewing Your Files 

✓ Opening a Copy of Your 

Document 

✓ Arranging Windows 

✓ Comparing Documents Side-By-

Side 

✓ Splitting a Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Making Word Work Backwards 

✓ Opening Documents in Word 97-

2003 Format 

✓ Converting Documents in Word 

97-2003 Format 

✓ Running the Compatibility 

Checker 

✓ Saving Documents in Word 97-

2003 Format 

✓ Setting Compatibility Options 

✓ Compatibility Packs for Microsoft 

Office Word 2003 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Intermediate, Section 1
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Printing and Viewing Your Document 

Course Overview and Learning Objectives 

This course will cover printing and viewing tools. Page setup tasks (such as changing 

orientation, setting paper size, and customizing margins) will also be covered. 

Course Outline 

1.1. Using Layouts and Views 

✓ Using Print Layout 

✓ Using Full Screen Reading 

✓ Using Web Layout 

✓ Using Outline View 

✓ Using Draft View 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Basic Viewing Tools 

✓ Using Minimize, Maximize, and 

Restore 

✓ Using Zoom on the View Tab 

✓ Using View Controls on the 

Status Bar 

✓ Using the Zoom Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Advanced View Tools 

✓ Using the Document Browser 

✓ Using the Show/Hide Tools 

✓ Using the Document Map 

✓ Using Thumbnails 

✓ Showing Special Characters 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Print Preview 

✓ Opening Print Preview 

✓ Using the Print Preview Tab 

✓ Navigating Print Preview 

✓ Closing Print Preview 

✓ Print Preview versus Print Layout 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Using Page Setup 

✓ Using the Page Setup Group 

✓ Setting Margins 

✓ Changing Page Orientation 

✓ Setting Paper Size 

✓ Using the Page Setup Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Printing a Document 

✓ Print Commands 

✓ Using Basic Print Options 

✓ Using Advanced Print Options 

✓ Setting Printer Properties 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

− Microsoft Word 2007: Foundation, 

Section 6
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Starting Out 

Course Overview and Learning Objectives 

In this course, students will learn the basics of Word. Students will also learn how to 

create a basic document and how to get help in Word. 

Course Outline 

1.1. Meeting Microsoft Office Word 

2007 

✓ What is Microsoft Office Word 

2007? 

✓ What’s New in Microsoft Office 

Word 2007? 

✓ Launching Word 

✓ Interface Overview 

✓ Interacting with Word 

✓ Closing Word 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating a Document 

✓ Creating a New Document 

✓ Typing Text 

✓ Deleting Text 

✓ The Basics of Selecting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Navigating in Your Document 

✓ Navigating Using the Mouse 

✓ Navigating Using the Scroll Bars 

✓ Navigating Using the Keyboard 

✓ Using the Go To Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Your Document 

✓ Using Basic Formatting 

✓ Using Advanced Formatting 

✓ Using Undo and Redo/Repeat 

✓ Removing Formatting 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Your Document 

✓ Saving Files 

✓ Opening Files 

✓ Using the Recent Documents List 

✓ Switching Between Open Files 

✓ Closing Files 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Getting Help in Word 

✓ Opening Help 

✓ Using the Help Screen 

✓ The Help Toolbar 

✓ Searching for Help 

✓ Online Help vs. Offline Help 

✓ Using the Table of Contents 

✓ Getting Help in a Dialog Box 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Foundation, Section 1
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The New Interface 

Course Overview and Learning Objectives 

In this course, students will closely examine the ribbon interface, including the Quick 

Access toolbar and the main tabs. 

Course Outline 

1.1. Getting Acquainted 

✓ Using the Office Menu 

✓ Using the Status Bar 

✓ Using the Mini Toolbar 

✓ Using Dialog Boxes 

✓ Using Right-Click Menus 

✓ Keyboard Shortcuts 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. The Quick Access Toolbar 

✓ Using the Toolbar 

✓ Adding and Removing Buttons 

✓ Moving the Quick Access Toolbar 

✓ Using the Options Dialog to 

Customize the Toolbar 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Tabs and Groups 

✓ About Tabs 

✓ About Groups 

✓ About Option Buttons 

✓ Minimizing the Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. The Home Tab 

✓ Clipboard Commands 

✓ Font Commands 

✓ Paragraph Commands 

✓ Styles Commands 

✓ Editing Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. The Insert Tab 

✓ Pages Commands 

✓ Tables Commands 

✓ Illustration Commands 

✓ Link Commands 

✓ Header and Footer Commands 

✓ Text Commands 

✓ Symbols Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. The View Tab 

✓ Document Views Commands 

✓ Show/Hide Tools 

✓ Zoom Tools 

✓ Window Commands 

✓ Macro Commands 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Foundation, Section 2 
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Using Formatting Tools 

Course Overview and Learning Objectives 

In this course, students will learn how to create, use, and customize document templates. 

This course also covers itemized lists, paragraph tools, and column formatting. Other 

document features such as delineation tools, watermarks, and hyperlinks round out this 

course. 

Course Outline 

1.1. Working with Templates 

✓ Creating a Template 

✓ Saving a Template 

✓ Opening a User Created 

Template 

✓ Using a Template 

✓ Attaching a Template to a 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Bullets and Numbering 

✓ Types of Lists 

✓ Creating a Basic List 

✓ Creating a Multilevel List 

✓ Creating Custom Bullets or 

Numbers 

✓ Continuing a List 

✓ Removing Bullets or Numbering 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Paragraph Dialog 

✓ Applying Alignment 

✓ Applying Indentation 

✓ Applying Spacing 

✓ Setting Defaults 

✓ Sorting Text 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Delineation Tools 

✓ Using Columns 

✓ Inserting a Line Break 

✓ Inserting a Page Break 

✓ Inserting a Section Break 

✓ Setting Page and Line Break 

Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Working with Pages 

✓ Adding a Cover Page 

✓ Creating a Blank Page 

✓ Changing the Page Color 

✓ Adding a Watermark 

✓ Adding a Page Border 

✓ Step-By-Step 

✓ Skill Sharpener 

1.6. Adding Hyperlinks 

✓ Types of Links 

✓ Inserting a Link 

✓ Editing a Link 

✓ Following a Link 

✓ Removing a Hyperlink 

✓ Step by Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Intermediate, Section 2 



Velsoft eLearning Course Catalog – Computer 
 

 P a g e  | 726 

Using Styles 

Course Overview and Learning Objectives 

In this course, students will learn all about creating, using, and managing styles. 

Course Outline 

1.1. Using the Quick Style Gallery 

✓ Understanding Styles 

✓ Applying a Style 

✓ Changing Text’s Style 

✓ Removing a Style from Text 

✓ Using the Apply Styles Window 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Changing Your Styles 

✓ Changing Your Style Set 

✓ Changing Your Color Scheme 

✓ Changing Your Font Scheme 

✓ Making Changes Permanent 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Using the Styles Pane 

✓ Opening the Styles Task Pane 

✓ Using the Styles Task Pane 

✓ Applying Styles 

✓ Modifying a Style 

✓ Deleting a Style 

✓ Modifying Style Pane Options 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Doing More with Styles 

✓ Creating Styles from Existing Text 

✓ Creating Styles Using the Task Pane 

✓ Modifying the Quick Style Gallery 

✓ Using the Style Inspector 

✓ Managing Styles 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, Section 5 
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Using Tables 

Course Overview and Learning Objectives 

This course will focus entirely on adding a table to a document. To start, students will 

learn how to add various types of tables (including custom tables and Quick Tables) to a 

document. Then, students will learn how to edit and format a table.  

Course Outline 

1.1. Creating Tables 

✓ Anatomy of a Table 

✓ Inserting a Table 

✓ Drawing a Table 

✓ Using Quick Tables 

✓ Selecting Cells, Columns, or Rows 

✓ Inserting and Deleting Rows and 

Columns 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Editing Tables 

✓ Using the Table Tools Design Tab 

✓ Using the Table Tools Layout Tab 

✓ Merging and Splitting Cells 

✓ Resizing Cells, Columns, or Rows 

✓ Moving and Resizing a Table 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Applying Basic Formatting 

✓ Applying a Table Style 

✓ Aligning a Table and its Cells 

✓ Changing Cell Margins and 

Spacing 

✓ Changing Text Direction 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Applying Advanced Formatting 

✓ Using AutoFit and Distribute 

✓ Manually Formatting a Table 

✓ Using the Borders Buttons 

✓ Using the Borders and Shading 

Dialog 

✓ Using the Table Properties Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, 

Section 3 
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Using Time Saving Tools 

Course Overview and Learning Objectives 

In this course, students will learn about the language tools available in Word, including the 

spelling and grammar checker, translation tools, online research tools, and the thesaurus. 

Users will also learn how to use and control AutoCorrect, insert special characters and 

symbols, and enable SmartTags.  

Course Outline 

1.1. Using Language Tools 

✓ Setting Your Language 

✓ Using the Spelling and Grammar 

Context Menu 

✓ Running a Spelling and Grammar 

Check 

✓ Setting Spelling and Grammar 

Options 

✓ Controlling Hyphenation 

✓ Performing a Word Count 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Using Research Tools 

✓ Performing Research 

✓ Using the Thesaurus 

✓ Translating a Word 

✓ Translating a Document 

✓ Step-By-Step 

✓ Skill Sharpener 

 

 

1.3. Inserting Pre-Defined Text 

✓ Using and Customizing 

AutoCorrect 

✓ Inserting the Date and Time 

✓ Inserting a Symbol 

✓ Inserting Special Characters 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Smart Tags 

✓ Enabling Smart Tags 

✓ Types of Smart Tags 

✓ Making Smart Tags Appear 

✓ Using Smart Tags 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: 

Intermediate, Section 4 
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Working with Advanced Graphics and Objects 

Course Overview and Learning Objectives 

In this course, students will learn about some different object types. To begin, students 

will learn about watermarks, Building Blocks, and Quick Parts. Then, SmartArt, text boxes, 

WordArt, and file objects will be covered.  

Course Outline 

1.1. Using Building Blocks 

✓ Adding Watermarks 

✓ Inserting Quick Parts 

✓ Adding Quick Parts 

✓ Using the Building Blocks 

Organizer 

✓ Inserting Building Blocks 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating SmartArt 

✓ Adding SmartArt 

✓ Using the Text Pane 

✓ Using the SmartArt Tools Design 

Tab 

✓ Using the SmartArt Tools Format 

Tab 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Editing SmartArt 

✓ Resizing and Moving Your 

Diagram 

✓ Changing the Layout 

✓ Changing the Color Scheme 

✓ Changing the Effects Scheme 

✓ Working with Shapes 

✓ Adding Text Effects 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using Text Boxes 

✓ Inserting a Pre-Defined Text Box 

✓ Drawing a Text Box 

✓ Working with Text Boxes 

✓ Using the Text Box Tools Tab 

✓ Changing the Appearance of a 

Text Box 

✓ Adding Shadow and 3-D Effects 

✓ Linking Text Boxes 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Embedding Objects 

✓ Adding Text from a File 

✓ Creating a New Object 

✓ Creating an Object from a File 

✓ Linking Objects to a Word 

Document 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, 

Section 2 
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Working with Graphics 

Course Overview and Learning Objectives 

In this course, students will learn how to add pictures, ClipArt, WordArt, and shapes to a 

document. Then, they will learn how to arrange and manage those objects. 

Course Outline 

1.1. Working with Images 

✓ Inserting a Picture from a File 

✓ Working with Images 

✓ Using the Picture Tools Tab 

✓ Adding Styles and Effects 

✓ Resizing Images 

✓ Adding Captions 

✓ Using the Format Picture Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Working with ClipArt 

✓ Using the ClipArt Task Pane 

✓ Inserting ClipArt 

✓ Formatting ClipArt 

✓ Moving ClipArt 

✓ Resizing ClipArt 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Working with WordArt 

✓ Inserting WordArt 

✓ Using the WordArt Tools Tab 

✓ Editing Text 

✓ Changing the Style 

✓ Manually Formatting WordArt 

✓ Resizing WordArt 

✓ Using the Format WordArt 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Using AutoShapes 

✓ Inserting AutoShapes 

✓ Using the Drawing Tools Tab 

✓ Formatting AutoShapes 

✓ Using 3-D Effects and Shadows 

✓ Using the Format AutoShape 

Dialog 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Arranging Graphics 

✓ Positioning Shapes 

✓ Using Text Wrapping 

✓ Rotating Shapes 

✓ Ordering Shapes 

✓ Grouping Images 

✓ Using Align and Distribute 

✓ Using the Grid 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Advanced, 

Section 1
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Working with References 

Course Overview and Learning Objectives 

In this course, Word’s referencing tools will be discussed. These tools include references, 

citations, bibliographies, tables of contents, indexes, tables of figures, and tables of 

authorities. Master and subdocuments and document links will also be covered. 

Course Outline 

1.1. Creating a Table of Contents 

✓ The ABCs of TOCs 

✓ Marking Text Using Heading 

Styles 

✓ Marking Text Using Outline 

Levels 

✓ Marking Text Using the 

References Tab 

✓ Inserting a Table of Contents 

✓ Updating a Table of Contents 

✓ Step-By-Step 

✓ Skill Sharpener 

1.2. Creating References within a 

Document 

✓ Adding Footnotes and Endnotes 

to a Document 

✓ Navigating and Editing Footnotes 

and Endnotes 

✓ Using Bookmarks 

✓ Using Cross-References 

✓ Step-By-Step 

✓ Skill Sharpener 

1.3. Creating a Bibliography 

✓ Inserting Citations 

✓ Managing Sources 

✓ Choosing a Style 

✓ Inserting a Bibliography 

✓ Updating a Bibliography 

✓ Step-By-Step 

✓ Skill Sharpener 

1.4. Creating Other Reference Pages 

✓ Marking Index Entries 

✓ Creating and Updating an Index 

✓ Creating and Updating a Table of 

Figures 

✓ Creating and Updating a Table of 

Authorities 

✓ Step-By-Step 

✓ Skill Sharpener 

1.5. Creating References to Other 

Documents 

✓ Linking to Another Document 

✓ Creating and Working with a 

Master Document 

✓ Creating and Working with Sub-

Documents 

✓ Other Master and Subdocument 

Tasks 

✓ Step-By-Step 

✓ Skill Sharpener 

− Case Study 

− Review Questions 

Corresponding Instructor-Led Course 

✓ Microsoft Word 2007: Expert, 

Section 3

 


